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Foreword 

Thank you very much for choosing and using the 3671 series vector network analyzer produced by 

Ceyear Technologies Co., Ltd. Please read carefully this guide before use. 

With maximally meeting your requirements as our duty, we will provide you with high-quality 

measuring instruments as well as first-class after-sales service. With the consistent tenet of "high 

quality and considerate service", we promise to provide the users with satisfactory products and 

services. 

Manual No 

AV2.733.1181SSCN 

Version 

B.2   2021.05 

Manual Authorization 

The contents of this manual are subject to change without notice. The final right to interpret the 

contents and terms used in this manual belongs to Ceyear Technologies Co., Ltd. 

The copyright of this Manual belongs to Ceyear Technologies Co., Ltd. Without authorization, any 

unit or individual shall not modify or tamper with the contents of this Manual or replicate or 

disseminate this Manual for profit.  Ceyear Technologies Co., Ltd. reserves the right to pursue 

legal liabilities against infringers. 

Product Warranty 

The product warranty period is 18 months starting from the delivery. The instrument manufacturer 

will repair or replace the damaged components as required within the warranty period. For this 

purpose, the user shall return the product to the manufacturer and prepay the mailing fee. The 

manufacturer will return the fee to the user together with the product after maintenance. 

Product Quality Certification 

This product is guaranteed to meet the specifications in this manual from the date of shipment. The 

calibration and measurement are completed by measuring bodies with national qualification, with 

relevant data to be provided for reference by users. 

Quality/Environmental Management 

This product complies with the quality and environmental management systems during R&D, 

manufacturing and testing.  Ceyear Technologies Co., Ltd. already has the required qualifications 

and has passed the certification of ISO 9001 and ISO 14001 management systems. 

Safety Precautions 

 

 

The warning sign indicates a potential risk. It reminds the user of certain operation process, 

operation method or similar situation. In case of any failure of observing the rule or maloperation, 

personal injury can occur. Proceed to the next step only after fully understanding and meeting the 

warning conditions indicated. 

 

 

 

Note mark, indicating some important information which will not cause danger. It reminds the user 

of certain operation process, operation method or similar situation. Failure to observe the rules or 

operate correctly may cause damage to the instrument or loss of important data. Proceed to the next 

step only after fully understanding and meeting the note conditions indicated

Note 

Warning !
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1. Manual Navigation 

This chapter introduces the user manual function, chapter structure and main content for the 3671 

series vector network analyzer and describes the instrument related documents provided to users. 

 About the Manual……………………………………………………………………………11 

 Related Documents……………………………………………………………..……………12 

1.1 About the Manual 

This Manual introduces the purpose, performance indicators, basic working principles, usage 

methods, precautions, etc. of the 3671 series vector network analyzer produced by  Ceyear 

Technologies Co., Ltd. to help you become familiar with and master the operation methods and 

key points of the instrument. Please read this Manual carefully and follow the instructions to 

perform correct operations. 

Due to tight schedule and limited ability of the author, there might be some inevitable errors or 

omissions in this guide, so please do not hesitate to give your commends if you find such 

problems! We apologize for any mistake that may cause inconvenience to you. 

This manual contains the following chapters: 

 Overview 

It describes the characteristics and usage precautions of 3671 series vector network analyzers, 

mainly including product overview and safe use guide. 

 Quick Start 

It introduces the preparations before use of the 3671 series vector network analyzer, routine 

maintenance, front panel overview, rear panel overview, operation interface of the system and 

instrument, menus, traces, channels and windows of the analyzer, and how to analyze and save 

measurement data, etc. 

 Measurement setup 

It introduces various setting items during the use of the network analyzer in detail, including: 

resetting analyzer, selecting measurement parameters, setting frequency range, setting signal 

power level, setting sweep, selecting trigger mode, selecting data format and ratio, observing 

multiple traces, opening multiple channels, setting analyzer display, etc. 

 Menus 

This part introduces the menu structure and menu items according to the functions to facilitate the 

users to query for reference. 

 Measurement optimization 

It shows how to optimize the measurement accuracy through reasonable settings and adjustments, 

including: reducing impact of accessories, improving reflection accuracy of low-loss two-port 

devices, increasing dynamic range, improving measurement results of electrical length devices, 

improving phase measurement accuracy, reducing trace noise, reducing receiver crosstalk, 

increasing number of data points, improving measurement stability, increasing sweep speed, 

increasing multi-state measurement efficiency, conducting fast data transmission, using macros, 

etc. 

 Calibration 

It introduces the calibration types and methods of the 3671 series vector network analyzer, to 
improve the accuracy in the measurement process. 
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 Fundamentals of network measurement 

It introduces the basic concepts and related theoretical knowledge of advanced network parameter 

measurement for users. 

 Remote Control 

The methods for remote control of the instrument are summarized to make users get familiar with 

remote control quickly. It includes four parts: the fundamentals of program control, introducing 

the concepts, software configuration, program-controlled ports, SCPI commands, etc. related to 

the program control; instrument port configuration methods, introducing the connection methods 

and software configuration methods of the program-controlled ports of the 3671 series vector 

network analyzer; programming methods of VISA interface, giving basic programming examples 

in the form of text descriptions and sample codes, so that users can quickly grasp the 

programming methods of program control; I/O function library, introducing the basic concepts of 

the instrument driver and the basic installation and configuration instructions of the 

IVI-COM/IVI-C driver. 

 Troubleshooting and Repair 

This part includes the introduction of the working principles of the instrument, troubleshooting, 

error information description and repair methods. 

 Technical Indicators and Testing Methods 

It introduces the main technical indicators of 3671 series vector network analyzers and the test 

methods recommended for users. 

 Annexes 

It provides the instructions for using the software options of the 3671 series vector network 

analyzer. 

1.2 Related Documents 

The product documents of the 3671 series vector network analyzer include: 

 User’s Manual 

 Program Control Manual 

 Quick start guide 

 Online Help 

User’s Manual 

This manual describes the functions and operation methods of the instrument in detail, including 

configuration, measurement, program control and maintenance, etc. The purpose is to guide users 

to fully understand the functional characteristics of the product and master common testing 

methods of the instrument. Main chapters include: 

 Manual Navigation 

 Overview 

 Quick Start 

 Measurement setup 

 Menus 

 Measurement optimization 
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 Calibration 

 Fundamentals of network measurement 

 Remote Control 

 Troubleshooting and Repair 

 Technical indicators and measurement methods 

 Annexes 

Program Control Manual 

This manual introduces the remote programming fundamentals, SCPI fundamentals, SCPI 

commands, programming examples, I/O drive function library, etc. in detail. The purpose is to 

guide users to quickly and comprehensively master the program control commands and methods 

of the instrument. Main chapters include: 

 Remote Control 

 Program Control Commands 

 Programming Examples 

 Error Description 

 Annexes 

Quick start guide 

This manual introduces the instrument configuration and the basic measurement method, with the 

aim to enable users to quickly understand the characteristics of the instrument, master the basic 

settings and basic operation methods. Main chapters include: 

 Get Prepared 

 Typical Applications 

 Get Help 

Online Help 

Online help is integrated in the instrument product, providing quick text navigation help, which is 

convenient for users to operate locally and remotely. Both the hard keys on the front panel of the 

instrument or the user interface tool bar offer corresponding shortcut keys to activate this function. 

The main chapters included are the same as those in the user manual. 
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2 Overview 

This chapter introduces the main performance characteristics, main scope of application and main 

technical indicators of the 3671 series vector network analyzer. It also gives introductions on 

correct operation of the instrument and precautions such as electrical safety. 

 Product Overview……………………………………………………………………………11 

 Safe Operation Guide…………………………..………………………………….…………19 

2.1 Product Overview  

The 3671 series vector network analyzer is updated from the vector network analyzer launched by 

Ceyear Technologies Co., Ltd. In terms of hardware, new design concepts and technical solutions 

are adopted to significantly improve key technical performance indicators such as the sweep speed 

of the complete machine and the dynamic range of the system; in terms of software, embedded 

computers equipped with high-performance microprocessor chips and the platform environment 

based on Windows 7 operating system are adopted to greatly improve the interconnectivity and 

usability of the complete machine. 

The 3671 series vector network analyzer provides a variety of calibration methods such as 

frequency response, single-port, response isolation, enhanced response, full dual-port, electrical 

calibration, etc., and can accurately measure the amplitude-frequency characteristics, 

phase-frequency characteristics and group delay characteristics of microwave networks with 

logarithmic magnitude, linear magnitude, standing wave, phase, group delay, Smith chart, polar 

coordinates and other display formats, as well as USB, LAN, GPIB, VGA, HDMI and other 

standard interfaces. 

This product can be widely used for efficient and accurate measurement in various fields such as 

microwave passive devices & components, cable assemblies and amplifiers, and is a indispensable 

test equipment in development and production processes of radars, communication systems, 

microwave radio frequency devices & components, etc. 

Features: 

 12.1 inch high-resolution multi-point capacitive touch screen 

 Windows operating system, Chinese menu with English language option 

 With single port, full dual port, response isolation, TRL, wizard calibration, electrical 

calibration and other calibration methods 

 Up to 32 display windows with each displaying up to 16 traces at the same time, and 64 

independent measurement channels to quickly execute complex test schemes 

 Record/run, one-button operation greatly simplifies the measurement setup steps and 

improves the work efficiency 

 Multiple display formats such as logarithmic magnitude, linear magnitude, standing wave, 

phase, group delay, Smith chart, and polar coordinates 

 USB, GPIB and LAN interconnection interfaces, as well as VGA and HDMI display output 

interfaces 

 Optional single-source excitation two-port vector network analyzer and dual-source 

excitation four-port vector network analyzer 

 Optional functions such as time domain measurement, frequency offset measurement, and 

gain compression two-dimensional sweep measurement, in addition to the classic 

S-parameter measurement function. 
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1) Humanized user interface is simple and intuitive, easy to operate, and can improve test 

efficiency 

The touch screen, panel keys, and mouse can effectively guide users to correctly operate and use 

this product. In the Windows system environment, the user's operation is fast and intuitive, which 

can greatly improve the test efficiency. 

 

     

Figure 2.1: 12.1 Inch 1280*800 Resolution Touch Screen 

 

  

The soft panel can be set on 

the left side or  right side of 

the screen or hided to 

facilitate operation.

Figure 2.2: Soft Panel Interface 

 

 

The 3671 series vector network 

analyzer uses a 12.1-inch 1280*800 

resolution touch screen, as shown in 

Figure 2.1, which is easy to operate. 
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The favorite keys can be set 

together among soft shortcut 

keys to simplify operation 

steps and facilitate operation.

 

Figure 2.3: Shortcut Soft Keys 

2) Multi-window and multi-channel measurement display 

The 3671 series vector network analyzer supports up to 64 channels, and can display up to 32 

measurement windows at the same time, and each window can display up to 16 test traces at the 

same time, so as to simplify the testing process by measuring multiple parameters of the tested 

part without multiple instrument state calls. 

 

Figure 2.4: Multi-window and Multi-channel Measurement Display 

3) Wide dynamic range 

The 3671 series vector network analyzer adopts the design concept of fundamental wave mixing 

and reception, which effectively expands the test dynamic range of the complete machine, and 

meets the increasing test requirements of users for a large dynamic range. 
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Figure 2.5: Filter Measurement Results 

4) Automated testing 

The automated testing can save a lot of test time, and the flexible automated environment can 

effectively reduce the test cost: 

1) Use SCPI commands to control the vector network analyzer to complete the automated 

testing; 

2) Execute code directly from vector network analyzer or external PC through LAN, USB or 

GPIB interface; 

3) The application can be run directly on this product without an external PC. 

Figure 2.6: Automated Testing 

The user can send the test results to a 

local/networked printer or transmit to a 

remote data processing service terminal to 

facilitate the post analysis and processing of 

the test data. 
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5) GPIB interface 

The 3671 series vector network analyzer provides a 24-pin D-type female GPIB connector that 

complies with the IEEE-488.2 standard for sending and receiving GPIB/SCPI commands. 

6) USB interface 

The 3671 series vector network analyzer provides 9 fast USB interfaces (including 6 USB3.0 

(type A configuration), 2 USB2.0 (type A configuration) and 1 USB2.0 (type B configuration)), to 

facilitate the connection with keyboard, mouse, printer, electronic calibration kit and other 

peripheral devices with a USB interface. 

7) Printing function 

The 3671 series vector network analyzer provides a powerful printing function, which can output 

or print the measurement result to a specified file through a printer. The printer can be either local 

or network type using LAN or USB interfaces, and can print the measurement result as long as it 

is added in the Windows 7 operating system. 

 

2.2 Safe Operation Guide 

Please read carefully and strictly observe the following precautions! 

We will spare no effort to ensure that all production processes meet the latest safety standards and 

provide users with the highest safety guarantee. The design and testing of our products and the 

auxiliary equipment used meet relevant safety standards, and a quality assurance system has been 

established to monitor the product quality and ensure the products to always comply with such 

standards. In order to keep the equipment in good condition and ensure operation safety, please 

observe the precautions mentioned in this manual. If you have any questions, please feel free to 

consult us. 

In addition, the correct use of this product is also your responsibility. Please read carefully and 

observe the safety instructions before starting to use this instrument. This product is suitable for 

use in industrial and laboratory environments or field measurement. Always use the product 

correctly according to its restrictions to avoid personal injury or property damage. You will be 

responsible for problems caused by improper use of the product or noncompliance with the 

requirements, and we will not be held responsible. Therefore, in order to prevent personal 

injury or property damage caused by dangerous situations, please always observe the safety 

instructions. Please keep the basic safety instructions and the product documentation properly 

and deliver them to end users. 

 Safety marks…………………………………………………………………………20 

 Operation Status and Locations……………………………………………………21 

 Electrical Safety……………………………………………………………………22 

 Operation Precautions………………………………………………………………23 

 Maintenance………………………………………………………………………… 23 

 Battery and power module…………………………………………………………24 

 Transportation…………………………………………………………………………24 

 Waster Disposal/Environmental Protection………………………………………24 
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2.2.1 Safety Marks 

2.2.1.1 Product-related Marks 

Safety marks on the products are described as follows (Table 2.1): 

Table 2.1 Products safety marks 

Symbol Meaning Symbol Meaning 

 

 

 

Caution, reminding users of 

information to be paid special 

attention to. 

It reminds users of the operation 

information or instructions to be 

paid attention to. 

 

    

 

 

Turn On/Off the power 

 

 

 

Note, handling heavy equipment. 
 

 

Standby indication 

 

 

 

Danger! Hazard of electric shock.  

 

DC 

 

 

 

Warning! Hot surface.  

 

AC 

 

 

 

Protective conductive end  

 

DC/ AC 

 

 

 

Grounding  

 

Reinforced insulation protection 

of the instrument 

 

 

 

Ground terminal  

 

 

EU mark for batteries and 

accumulators. 

Please refer paragraph 1 of "2.2.8 

Waster Disposal/Environmental 

Protection" in this section for 

specific instructions. 

 

 

 

Caution, handle classical sensitive 

devices with care. 

 

 

 

 

EU mark for of separate collection 

of electronic devices. Please refer 

paragraph 2 of "2.2.8 Waster 

Disposal/Environmental 

Protection" in this section for 

specific instructions. 



2 Overview 

2.2 Safe Operation Guide 

      21 

 

 

 

 

Warning! Radiation. 

For specific instructions, please 

refer to item 7 in 2.2.4 "Operation 

precautions". 

 

 

 

 

 

2.2.1.2 Manual-related Marks 

In order to remind users to operate the instrument safely and pay attention to relevant information, 

the following safety warning marks are used in the product manual, which are explained as 

follows: 

 

     

Danger mark, personal injury or equipment damage may be caused if not avoided. 

 

 

Warning mark, personal injury or equipment damage may be caused if not avoided. 

 

 

Caution mark, slight or medium personal injury or equipment damage may be caused if not 

avoided. 

 

 

Note mark, indicating some important information which will not cause danger. 

 

 

Tips tell the information about the instrument and its operation. 

2.2.2 Operation Status and Locations 

Please note before operating the instrument: 

1) Unless otherwise stated, the operating environment of the 3671 series vector network 

analyzer must meet the following requirements: stable instrument, IP protection: 2X, and indoor 

operation. The maximum altitude at which the instrument is operated is not more than 2,000 

meters, and when transporting the instrument, the maximum altitude is not more than 4,500 meters. 

The actual power supply voltage is allowed to vary within ±10% of the specified voltage, and the 

power supply frequency is allowed to vary within ±5% of the specified frequency. The 

overvoltage level is 2, and the pollution intensity is 2. 

2) Do not place the instrument on surfaces with water, vehicles, cabinets, tables and other 

objects that are not fixed and do not meet the load conditions. Please place the instrument securely 

and fix it on the surface of a solid object (e.g., an ESD workbench). 

3) Do not place the instrument on the surface of a heat-dissipating object (e.g., a radiator). The 

operating environment temperature shall not exceed the value specified in the description of 

Danger !      

Warnin

g 
!

      

Caution !

      

Note 

Tip 
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relevant indicators of the product. Overheating of the product will lead to electric shock, fire and 

other risks. 

2.2.3 Electrical Safety 

Precautions for electrical safety of the instrument: 

1) Before the instrument is powered on, the actual supply voltage should match the supply 

voltage marked on the instrument. If the supply voltage changes, change the instrument fuse type 

at the same time. 

2) According to the power requirements of the real panel of the instrument, a three-core power 

cord should be adopted while ensuring reliable grounding of the ground wire during operation. 

Either floating ground or poor grounding may cause damage to the instrument and even cause 

injury to operators. 

3) Do not damage the power cord, otherwise electric leakage will be caused, resulting in 

damage to the instrument and even injury of the operators. If an external power cord or extension 

socket is used, it should be checked before use to ensure electrical safety. 

4) If the power supply socket does not provide an on/off switch, to cut the power of the 

instrument, you can just directly unplug the instrument, and therefore, it should be ensured that the 

power plug can be inserted or drawn conveniently. 

5) Do not use damaged power cords. Before connecting the instrument to the power cord, check 

the integrity and safety of the power cord, and properly place the power cord to avoid the impact 

due to human factors, such as, too long power cord that may trip the operator. 

6) The instrument needs to use TN/TT power network with a maximum rated fuse current of 

16A (if you use a fuse with a higher rated current, you need to discuss with the manufacturer to 

determine). 

7) Keep the socket clean and tidy, and ensure the plug and the socket in good contact and 

reliable engagement. 

8) Neither the socket nor the power cord can be overloaded, otherwise fire or electric shock will 

be caused. 

9) In order to avoid damage to the instrument during the test in a circuit with a voltage Vrms> 

30 V, appropriate protective measures shall be taken (for example: using suitable test instrument, 

installing fuse, limiting current value, conducting electrical isolation and insulation, etc.). 

10) The instrument shall comply with IEC60950-1/EN60950-1 or IEC61010-1/EN 61010-1 

standards for connection to PC or IPC. 

11) Unless otherwise allowed, do not open the housing of the instrument, which may expose 

internal circuits and devices of the instrument and cause unnecessary damage. 

12) If the instrument needs to be fixed at the test site, a qualified electrician is required to install 

the protective earth wire between the test site and the instrument first. 

13) Take appropriate overload protections to prevent overload voltage (caused by lightning, for 

instance) from damaging the instrument or causing personal injury. 

14) When opening the housing of the instrument, do not place objects not belonging to the 

interior of the instrument, otherwise, short circuit, damage to the instrument and even personal 

injury may be caused. 

15) Unless otherwise stated, the instrument has not received any waterproof treatment, so keep 

the instrument from contacting with liquid to prevent damage to the instrument or even personal 

injury. 
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16) Do not place the instrument in an environment where fog is easily formed, for example, 

moving the instrument in a environment where cold and heat are in alternation, where water 

droplets formed on the instrument may cause electric shock and other hazards. 

2.2.4 Operation Precautions 

1) Instrument operators need to have certain professional and technical knowledge, good 

psychological quality, and certain emergency response capabilities. 

2) Before moving or transporting the instrument, please refer to the relevant instructions in 

"2.2.7 Transportation” of this section. 

3) The inevitable use of substances (e.g. nickel) in the production process of the instrument may 

cause allergy to personnel. If an operator of the instrument has allergic symptoms (e.g. rash, 

frequent sneezing, ophthalmia or dyspnea) during the operations, please seek medical care in time 

to find out the reason and solve the symptoms. 

4) Before disassembling the instrument for disposal, please refer to relevant instructions in 

"2.2.8 Disposal/environmental protection". 

5) RF instruments will generate high electromagnetic radiation, during which period, pregnant 

women and operators with cardiac pacemakers need special protection. If the radiation level is 

high, corresponding measures may be taken to remove the radiation sources to prevent personal 

injury. 

6) In case of fire, the damaged instrument will release toxic substances. Therefore, the operators 

should wear appropriate protective equipment (e.g. Protective masks and exposure suits) for 

safety. 

7) Laser products need to be marked according to the laser category warning signs, because the 

radiation characteristics of the laser and such devices have a high intensity electromagnetic power 

characteristics, will produce harm to the human body. If this product is integrated with other laser 

products (e.g. CD/DVD drive), no other functions will be provided in addition to the settings and 

functions described in the product manual in order to prevent the laser beam from harming 

humans. 

8) Electromagnetic compatibility level (in accordance with EN 55011/CISPR 11, EN 

55022/CISPR 22 and EN 55032/CISPR 32 standards) 

-Class A equipment: 

Unsuitable for residential areas and low-voltage power supply environments. 

Note: Class A equipment is suitable for industrial operating environments, and operators need to 

take relevant measures to reduce the impact of wireless communication disturbances in residential 

areas. 

-Class B equipment: 

Suitable for residential areas and low-voltage power supply environments. 

2.2.5 Maintenance 

1) Only authorized and specially trained operators are allowed to open the casing of the 

instrument. Before such operations, it is required to disconnect the power cord to prevent damage 

to the instrument or even personal injury. 

2) The repair, replacement and maintenance of the instrument should be performed by dedicated 

electronic engineers of the manufacturer, and the parts subject to replacement and maintenance 

should receive safety tests to ensure safe use of the product in the future. 
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2.2.6 Battery and power module 

Before using the battery and power module, you need to read the relevant information carefully to 

avoid explosion, fire or even personal injury. In some cases, discarded alkaline batteries (such as 

lithium batteries) need to be disposed of in accordance with EN 62133 standards. on error 

Precautions for use： 

1) Do not damage the battery. 

2) Do not expose the battery and power module to heat sources such as open flame; store them 

out of direct sunlight and keep them clean and dry; and use a clean and dry soft cotton cloth to 

clean the connection ports of the battery or power module. 

3) Do not short-circuit batteries or power modules. Do not store multiple batteries or power 

modules in a cardboard box or drawer because contact with each other or other conductors may 

cause a short circuit; do not remove the original packaging before using the batteries and power 

modules. 

4) Do not expose the battery and power module to mechanical shock. 

5) If the battery leaks, please do not contact with skin and eyes, otherwise flush with plenty of 

water and seek medical attention promptly. 

6) Please use the manufacturer's standard battery and power module, any incorrect replacement 

and rechargeable alkaline batteries (for example: lithium batteries) are prone to explosion. 

7) Waste batteries and power modules need to be recycled and disposed of separately from other 

waste items. Due to the toxic substances inside the battery, it needs to be reasonably discarded or 

recycled according to local regulations, 

2.2.7 Transportation 

1) If the instrument is heavy, please handle it with care. If necessary, use tools (a crane, for 

instance) to move the instrument so as to prevent damaging the body. 

2) The handle of the instrument is suitable for personal handling of the instrument and cannot be 

fixed on the transportation equipment when during the transportation of the instrument. In order to 

prevent property loss and personal injury, please follow the manufacturer's safety regulations on 

the transportation of the instrument. 

3) When operating the instrument on the vehicle, the driver should drive carefully to ensure 

transportation safety, and the manufacturer is not responsible for any emergencies during the 

transportation. Therefore, please do not use this instrument during the transportation, and 

reinforcement and preventive measures should be taken to ensure the transportation safety of the 

product. 

2.2.8 Waster Disposal/Environmental Protection 

1) Do not dispose of devices marked with batteries or accumulators together with unclassified 

waste; Insteads, such devices should be collected separately and disposed of in a suitable 

collection location or through the customer service center of the manufacturer. 

2) Do not dispose of waste electronic devices together with unclassified waste; Instead, such 

devices should be collected separately. The manufacturer has the right and responsibility to help 

end users dispose of waste products. If necessary, please contact the customer service center of the 

manufacturer for corresponding disposal so as not to damage the environment. 

3) During mechanical or thermal processing of the product or its internal components, toxic 

substances (dust of heavy metals, such as lead, beryllium, and nickel, etc.) may be released. 

Therefore, specially trained technicians with relevant experience are required to disassemble the 

product to avoid personal injury. 
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4) During the reprocessing, please refer to the safety operation rules recommended by the 

manufacturer to dispose of toxic substances or fuel released from the product with specific 

methods to avoid causing personal injury. 
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3 Quick Start 

This chapter introduces the precautions before use, front and rear panel browsing, common basic 

measurement methods, and data file management of the 3671 series vector network analyzer. so 

that users can have a preliminary understanding of the instrument itself and its Measure processes. 

 Get Prepared…………………………………………………………………………27 

 Front and Real Panels………………………………………………………………44 

 Interface of analyzer…………………………………………………………………56 

 Trace, channel and window of analyzer……………………………………………57 

 Data analysis…………………………………………………………………………59 

 Data output…………………………………………………………………………86 

 

3.1 Get Prepared 

 Preparation before operation………………………………………………………27 

 System recovery and installation procedure of analyzer…………………………38 

 Routine Maintenance ………………………………………………………………43 

3.1.1 Preparations before Operation 

This chapter introduces the precautions before initial setup and use of the 3671 series vector 

network analyzer. 

 

 

 

Avoid damaging the instrument 

Pay attention to the follow to avoid electric shock, fire and personal injury: 

 Do not open the cabinet arbitrarily; 

 Do not try to disassemble or refit any part of the instrument not mentioned in the manual. 

Otherwise, such consequences as reduced electromagnetic shielding property and internal 

component damage can occur, affecting product reliability. In this case, we will not provide any 

free maintenance any more even if the product is still in the warranty period. 

 Carefully read the related content in "2.2 Safe use guide" of this manual, and the following 

operating safety precautions, and also pay attention to the specific operating environment 

requirements involved in the data page. 

 

 

 

Electrostatic protection 

Take electrostatic protection measures at workplaces to avoid any damage caused by the 

instrument. For details, see relevant contents in “2.2 Safety operation instruction” of the user 

manual. 

Warning !

      

Note 
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Pay attention to the following when operating the instrument: 

Improper operating or measuring position can damage the instrument or the one connected to it. 

Pay attention to the following before powering on the instrument: 

 Keep the fan blade and heat emission hole unblocked, with a distance of at least 10cm away 

from the wall; 

 Keep the instrument dry; 

 Keep the instrument level, and arrange it properly; 

 Make sure the environment temperature meets with the requirement noted in the data page; 

 Make sure the port input signal amplitude is within the range specified; 

 Make sure the signal output port is connected properly, without any overload. 

 

 

 

Effect of electromagnetic interference (EMI): 

Since EMI can affect the measurement result, pay attention to the following: 

 Select proper shield cables. For example, to use the double-shielded RF/network connection 

cable; 

 Please timely close the open and temporarily unused cable port or connect the matched load 

to the port; 

 Please refer to the electromagnetic compatibility (EMC) level marking in the data page. 

 

 Unpacking…………………………………………………………………..……….………28  

 Environmental requirements………………………………………………………...………30  

 Power on/off…………………………………………………………………………………31  

 Correct Use of Connectors…………………………………………………………..………34  

3.1.1.1 Unpacking 

1) Visual examination 

Step 1. Check whether the outer package and the shockproof packing of the instrument are 

damaged. If there is any damage, keep the outer package for standby and 

proceed with the following examination steps. 

Step 2 Unpack, and check the mainframe and articles provided in the package for any damage; 

Step 3 Check carefully the articles mentioned above as per Table 3.1 for any problem; 

Step 4 In case of any outer package damage, or damage or problem to the instrument or articles 

provided in the package, never power the instrument on or start it up! Please contact our 

Tip 

Note 



3 Quick Start 

3.1 Get Prepared 

      29 

 

company's service consultation center  

through the service consultation hotline in the manual, and we will provide the repair or 

replacement service quickly according to the situation. 

 

 

 

Movement: Due to the heavy weight of the instrument and the packing box, two people shall 

work together to handle them gently. 

 

2) Model confirmation 

Table 3.1: List of 3671 Accompanying Items and Options 

Name Quant

ity 

Function 

Mainframe:   

 3671 Series Vector Network 

Analyzer 

1 — 

Standard Configuration:  

 3-core power cord 1 — 

 USB mouse 1 — 

 User’s Manual 1 — 

 Packing list 1 — 

 Product Certificate of 

Conformity 
1 — 

Options:   

 006 English options 1 Provided with English front and rear 

panels, English operating system 

 400 four-port measurement 1 Expanded to four-port vector network 

analyzer 

 S07 automatic fixture removal 

option 

1 Used for automatic testing and removal of 

single-ended and balanced device 

measuring fixtures (AFR) 

 S10 time domain measurement 

option 

1 Used for time domain measurement to 

determine and analyze discontinuities in 

devices, fixtures or cables 

 S11 advanced time domain 

analysis option 

1 Used for TDR time domain impedance test, 

eye diagram analysis, etc. 

3671C/D/E options:   

Note 
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 31121 mechanical calibration 

kit 

1 For complete machine calibration 

 20403 electronical calibration 

piece               

1      Electronic calibration of two-port complete 

machine (10MHz~26.5GHz) 

 20405 electronical calibration 

piece 

1 Electronic calibration of four-port complete 

machine (10MHz~20GHz) 

 FB0HA0HB025.0 1 3.5mm amplitude & phase stable cable, 

used for complete machine measurement 

 FB0HA0HC025.0 1 3.5mm amplitude & phase stable cable, 

used for complete machine measurement 

3671G options:   

 31123 mechanical calibration 

kit 

1 For complete machine calibration 

 20404 electronical calibration 

piece 

1 Used for electronic calibration of complete 

machine (10MHz~50GHz) 

 FE0BN0BM025.0 
1 2.4mm amplitude & phase stable cable, 

used for complete machine measurement 

 FE0BN0BL025.0 
1 2.4mm amplitude & phase stable cable, 

used for complete machine measurement 

 

 

 

For more options, please refer to the latest version of the product catalog, or consult our company 

directly. 

 

3.1.1.2 Environmental Requirements 

The operating environment of the 3671 series vector network analyzer shall meet the following 

requirements: 

1) Operating Environment 

The operating environment should meet the following requirements: 

 

Table 3.2: 3671 Operating Environment Requirements 

Temperature 0°C ~ 40°C 

Temperature range for 

error adjustment 

23°C ±5°C (allowable temperature deviation during error 

adjustment <1°C) 

Humidity <+29 °C, the hygrometer measurement value range: 20%-80% 

(non-condensed) 

Tip 
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Elevation 0 ~ 2,000 m (0 ~ 6,561 ft) 

Vibration No more than 0.21 G, 5 Hz-500 Hz 

 

 

The above environmental requirements are only applicable to the operating environment factors of 

the instrument, and are not with the scope of technical indicators. 

 

2) Heat dissipation requirements 

In order to ensure that the working environment temperature of the instrument is within the 

temperature range required by the operating environment, the following heat dissipation space 

requirements of the instrument shall be met: 

Table 3.3: 3671 Heat Dissipation Requirements 

Instrument part Heat dissipation distance 

Backside ≥120 mm 

Left and right sides ≥100 mm 

3) Electrostatic protection 

Static electricity is extremely destructive to electronic components and equipment. Usually we 

take two anti-static measures: conductive table mat and wrist strap; Conductive floor mat and 

ankle strap. Using the above two anti-static measurements at the same time can provide good 

antistatic protection. If using one of them, only the former can provide antistatic protection. 1MΩ 

earth isolation resistor must be provided for the antistatic components at least for ensuring user 

safety. 

Correctly take the following antistatic measures to techniques to reduce electrostatic damages: 

 Ensure all instruments are grounded properly, so as to avoid any static electricity; 

 Let the internal/external conductor of the cable contact the ground shortly before connecting 

the coaxial cable with the instrument； 

 Operators must wear anti-static wrist straps or take other antistatic measures before touching 

the joints, core or conducting any assembly. 

 

 

Voltage range 

The above-mentioned anti-static measures cannot be applied when the voltage exceeds 500V. 

 

3.1.1.3 Turning On/Off the power 

1) Precautions before turning on the power 

Pay attention to the following when turning on the power of the instrument: 

a) Confirming power supply parameters 

The 3671 series vector network analyzer adopts the three-core power line interface, which 

Note 

Warning !      
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complies with international safety standards. Before the analyzer is energized, you must confirm 

that the protective earth wire of the power socket is reliably grounded, and then plug the power 

line into a standard three-pin socket. Floating grounding or poor grounding may damage the 

instrument and even cause personal injury. Never use a power line without a protective earth wire. 

Table 3.4 lists the requirements for external power supply during the normal operation of network 

analyzer. 

Table 3.4: 3671 Working Power Supply Parameter Requirements 

 

 

Prevent mutual interference of power supplies  

In order to prevent the mutual interference among multiple devices through the power supply, 

especially the damage to the instrument hardware by the spike pulse interference generated by the 

high-power device, it is recommended to use 110V/220V AC stabilized power supply to power the 

vector network analyzer. 

b) Confirm and connect the power cord 

The 3671 series vector network analyzer adopts the three-core power line interface, which 

complies with national safety standards. Before the network analyzer is energized, you must 

confirm that the protective earth wire in the power line of the network analyzer is reliably 

grounded. Floating grounding or poor grounding may cause damage to the instrument and even 

injury to the operator. Using a power cord without protective grounding is strictly prohibited. 

When the instrument is connected to a suitable power outlet, the power cord connects the housing 

of the instrument to the ground. For the power line, the rated voltage shall be greater than or equal 

to 250V, and the rated current greater than or equal to 6A. 

When connecting the instrument to the power supply: 

Step 1.  Confirm that the working power cord is not damaged; 

Step 2. Use the power line to connect the power supply plug of the instrument rear panel to a 

well-grounded three-core power socket. 

 

 

Grounding 

Poor or wrong grounding may cause damage of the instrument or personal injury. Before the 

network analyzer is energized, make sure that the earth wire is in good contact with the earth wire 

of the power supply. 

Please use a power outlet with grounding protection. Do not use any external cable, power line or 

autotransformer without any protective grounding as the protective grounding line. If an 

autotransformer is necessary, you need to connect the common terminal to the protective earth 

wire of the power connector. 

Power supply 

parameter 
Applications 

Voltage, frequency 110V/220V±10%, 60Hz/50Hz±5% 

Rated output current >3A 

Power consumption >500W 

Tip 

Warning !      
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2) Initial energization 

Precautions for turning on/off the power of the instrument are as follows: 

a) Connecting the Power supply 

Before the initial energization, please confirm the power supply parameters and power line. For 

details, please refer to the precautions before energization in 3.1.1.3 of the user manual. 

Step 1. Connect the power line: use the power line that matches the network analyzer in the 

packing box or the three-core power line that meets the requirements to connect the power socket 

on the rear panel of the network analyzer (as shown in Figure 3.1), indicate the voltage parameter 

indicator required by the network analysis next to the power socket to remind the user that the 

voltage used shall meet the requirements. Connect the other end of the power line to an AC power 

supply that meets the requirements; 

Step 2. Turn on the power switch on the rear panel: as shown in Figure 3.2, observe whether 

the standby indicator light above the power switch on the front panel (as shown in Figure 3.3) 

turns yellow; 

Step 3. Turn on the power switch on the front panel: as shown in Figure 3.3, please do not 

connect any equipment to the network analyzer before turning it on. If everything is normal, you 

can turn it on, and then the indicator light above the power switch on the front panel will turn 

green. 

 

b) Turning on/off the power 

i. Start up 

Step 1. Turn on the power of the front panel (“|”); 

Step 2. Press the power switch button at the lower left corner of the front panel, and the power 

indicator light above the power switch will change from yellow to green. 

Step 3. It will take about 1 minute for the network analyzer to start the Windows 7 system, which 

will start to run the main measurement program after performing a series of self-check and  

adjustment programs. 

The instrument is in the operable status. 

 

 

Cold start and warm-up of the instrument 

When the 3671 series vector network analyzer is cold-started, the network analyzer shall be 

warmed up for at least 30 minutes before the measurement, so as to make the instrument meet the 

specified performance indicators. 

 

Tip 
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Run the analyzer application 

The application is automatically run when the network analyzer is turned on. If the application 

exits, you can re-run the measurement program by the following methods: 

Method 1. Click [Start] in the task bar at the lower left corner of the screen, point to [Program] 

in the start menu, point to [Vector Network Analyzer]  

in the program submenu, and click [Vector Network Analyzer] in the pop-up submenu, then the 

analyzer starts to run the measurement application, or you can double-click the shortcut on the 

desktop to run the program. 

Method 2. Press [Reset] in the function key area, then the analyzer starts to run the 3671 series 

vector network analyzer application. 

 

ii. Shutdown 

Step 1. Turn off the power switch in the lower left corner of the front panel (as shown in Figure 

3.3). At this time, the instrument enters the shutdown process (software and hardware need to be 

processed before power off). After more than ten seconds, the instrument is powered off and the 

power indicator light above the power switch changes from green to yellow; 

Step 2. Turn off the power switch on the rear panel ("O") or disconnect the power supply of the 

instrument. 

The instrument is turned off. 

 

 

 

Power cut of the instrument 

When the instrument is in normal operation, it can only be shut down by operating the power 

switch on the front panel. Do not directly operate the power switch of the rear panel or 

directly disconnect the power connection with the instrument. Otherwise, the instrument 

cannot enter the normal shutdown state, which may cause damage to instrument or loss of the 

current instrument status/measurement data. Please shut down the instrument with the correct 

method. If the instrument fails to be shut down normally due to the abnormal operating system or 

application, you can press the [Power/Standby] button for at least 4 seconds to turn off the 

analyzer. 

 

c) Power cut 

Under abnormal circumstances, it is necessary to power off the network analyzer urgently to avoid 

personal injury. In this case, just pull up the power cord (from the AC outlet or from the power 

outlet on the rear panel of the instrument). Therefore, sufficient operating space should be 

reserved when operating the instrument to facilitate direct shutdown when necessary. 

3.1.1.4 Correct Use of Connectors 

Connectors are often used during various tests performed by the network analyzer. Although the 
connectors of the calibration kits, test cables, and analyzer measurement ports are designed and 

manufactured in accordance with the highest standards, all these connectors have a limited service 

Tip 

Note 
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life. Due to the inevitable wear and tear during normal use, the performance indicators of the 

connectors will decrease or even be unable to meet the measurement requirements. Therefore, 

correct maintenance and measurement connection of the connectors can not only ensure accurate 

and repeatable measurement results, but also prolong the service life of the connectors and reduce 

the measurement costs. In actual use, the following aspects should be paid attention to: 

1) Connector check 

When conducting connector inspection, anti-static wrist band should be worn. It is recommended 

to use a magnifier to check the following items: 

1) Whether the electroplated surface is worn or not and whether there are deep scratches; 

2) Whether the thread is deformed; 

3) Whether there are foreign materials such as metal debris on the thread and joint surface of the 

connector; 

4) Whether the inner conductor is bent or broken; 

5) Whether the screw sleeve of the connector rotates improperly. 

 

 

 

Check the connector to prevent damaging ports of the instrument 

Any damaged connector may damage the good connector connected to it even in the first 

connection. In order to protect each interface of the network analyzer, the connector must be 

checked before the connector operation. 

 

2) Connector cleaning 

When cleaning the connectors, always wear antistatic wrist straps and observe the following steps: 

1) Remove loose particles on the thread and joint plane of the connectors with clean 

low-pressure air, and thoroughly inspect the connectors. If further cleaning treatment is required, 

proceed as follows: 

2) Soak (but not thoroughly soak) a lint-free cotton swab with isopropyl alcohol; 

3) Remove the dirt and debris from the joint plane and threads of the connectors with cotton 

swabs. When cleaning the inner surface of a connector, be careful not to apply external force to 

the central inner conductor and not to leave the fibers of cotton swabs on the central conductor of 

the connector. 

4) Let the alcohol volatilize, then blow the surface clean with compressed air; 

5) Check the connector to make sure that it is free of particles and residues. 

6) If any defects of the connector is still obvious after cleaning, it indicates that the connector 

may have been damaged and should not be used again. Make clear the cause of the connector 

damage before connection. 

3) Connection method 

Before the connection, the connectors should be inspected and cleaned to ensure cleanness and 

intactness. Anti-static wrist straps should be worn before connection. The correct connection 

method and steps are as follows: 

Caution !      



3 Quick Start 

3.1 Get Prepared 

36  

 

Step 1. As shown in Figure 3.4, align the axes of the two interconnected devices to ensure that the  

pin of the male connector slide concentrically into the jack of the female connector. 

 

Figure 3.4 Axes of interconnected devices in a straight line 

Step 2. As shown in Figure 3.5, move the two connectors straight together so that they can be 

smoothly joined. Rotate the threaded sleeve of the connector (rather than the connector itself) until 

it is tightened. During the connection, there shall be no relative rotational movement between the 

connectors. 

 

Figure 3.5: Connection Method 

Step 3. As shown in Figure 3.6, use a torque wrench to complete the final connection. Pay 

attention that the torque wrench does not exceed the initial bending point, and an auxiliary wrench 

can be used to prevent the connector from rotating. 

 

 

 

Figure 3.6 Finishing the connection with a torque wrench 

4) Disconnection 

Step 1. Support the connectors to prevent any connector from being twisted, shaken or bent; 

Step 2. An open-ended wrench can be used to prevent the connector body from rotating; 

Step 3. Loosen the screw sleeve of the connector with another wrench; 

Step 4. Rotate the threaded sleeve of the connector by hand to complete the final disconnection; 

Step 5. Pull the two connectors straight apart. 

5) Usage of a torque wrench 

The use of a torque wrench is shown in Figure 3.7. The following points should be paid attention 
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to when using it: 

 Confirm that the torque of the torque wrench is correct set before use; 

 Before applying force, make sure that the angle between the torque wrench and another 

wrench (used to support the connector or cable) is 
   

 

within 90°; 

 Gently grasp the end of the torque wrench handle and apply force in the direction 

perpendicular to the handle until the bending point of the wrench is reached. 

 

 

 

Figure 3.7 Usage of a torque wrench 

6) Use and storage of connectors 

1) A protective sheath shall be provided if the connector is not in use; 

2) Do not mix various connectors, air lines and standard calibration pieces in a box because this 

is one of the most common causes of connector damage. 

3) Keep the connectors and the analyzer at the same temperature. Holding a connector by hand 

or cleaning a connector with compressed air will significantly change its temperature. The 

connectors should be calibrated after its temperature is stable. 

4) Do not touch the joint plane of the connectors because the grease and dust particles on the 

skin are difficult to be removed from the joint plane; 

5) Do not put the contact surface of a connector downward on a hard table surface. Contact with 

any hard surface may damage the electroplated layer and the joint surface of the connector. 

6) Always wear anti-static wrist straps and work on a grounded conductive workbench pad, 

which can protect the analyzer and the connectors from electrostatic discharge. 

7) Use of adapters 

When the measuring port of the analyzer and the connector type used are different, adapters must 

be used for the connection before measurement. In addition, even if the measuring port of the 

analyzer and the connector type of port of the tested piece are the same, it is also advisable to use 

adapters. Both cases can protect the measuring port, prolong its service life and reduce the 

maintenance cost. Before connecting an adapter to the measuring port of an analyzer, it is required 

to carefully check and clean the adapter. And a high-quality adapter should be used to reduce the 

influence of mismatching on measurement accuracy. 

8) Joint plane of connectors 

An important concept in microwave measurement is the reference plane. For the analyzer, it is the 

datum reference plane for all measurements. During the calibration, the reference plane is defined 

as the plane where the measuring port and the calibration standard are engaged. Good connection 

and calibration depend on thorough and level contact between the connectors on the joint plane. 

Direction 

of moment 

Stop applying force when 

the handle is bent 
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Figure 3.8: Calibration Plane 

3.1.2 System recovery and installation procedures of analyzer 

3.1.2.1 System recovery of network analyzer 

If the user shuts down the analyzer abnormally, the analyzer is infected with the virus, or another 

software is installed on the analyzer, the analyzer operating system may fail to work abnormally. 

At this time, a system recovery is required to restore the analyzer to the factory default state as 

follows: 

1) Turn off the analyzer and connect the keyboard to the USB interface; 

2) Press the [Power/Standby] button on the lower left corner of the front panel. When the 

indicator light on the connected keyboard is on, and the page shown in Figure 3.9 appears, press 

the [↑]/[↓] key on the keyboard to select System Recovery, and then press the [Enter] key on the 

keyboard for automatic system recovery; 

 

Figure 3.9: Power-on Page Display 
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Figure 3.10: System Recovery Interface 

3) Subsequently, the page shown in Figure 3.10 appears, and the system recovery starts. The 

whole process takes about 10 minutes, and the analyzer needs to be restarted after the system 

recovery is completed. 

3.1.2.2 Installation of updated network analyzer program 

For the updating of program file and installation of new program of the 3671 series vector network 

analyzer, double-click D:\3671 installation program, follow the [3671 series vector network 

analyzer installation program] menu wizard, directly click [Next], select [Complete] installation 

when [Select installation type] appears, and click [Cancel] directly when any other menu appears. 

Then, double-click the 3671 series vector network analyzer icon on the desktop or press [Reset] to 

start the program. 

The specific operation steps are shown in Figure 3.11 ~ 3.17. 
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Figure 3.11: Installation Program Startup Interface 

 

Figure 3.12: License Agreement Interface 
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Figure 3.13: User Information Input Interface 

 

Figure 3.14: Installation Directory Selection Interface 
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Figure 3.15: Installation Type Selection Interface 

 

Figure 3.16: Waiting Interface during Installation 
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Figure 3.17: Installation Complete Interface 

3.1.3 Routine Maintenance 

This section introduces the daily maintenance methods of the 3671 series vector network analyzer. 

3.1.4.1 Cleaning 

1) Cleaning instrument surface 

Please follow the steps below when cleaning the surface of the instrument: 

Step 1.   Shut down the instrument and disconnect the power cord connected to it. 

Step 2.   Wipe the surface gently with dry or slightly wet soft cloth, and do not wipe the inside of 

the instrument. 

Step 3.   Do not use chemical cleaners, such as alcohol, acetone or dilutable cleaners. 

2) Cleaning the display 

After a period of use, the display needs to be cleaned. Please follow the steps below: 

Step 1.   Shut down the instrument and disconnect the power cord connected to it. 

Step 2.   Dip a piece of clean and soft cotton cloth into the cleaner and then gently wipe the 

display panel. 

Step 3.   Dry the display with a piece of clean and soft cotton cloth. 

Step 4.   Connect the power cord only after the cleaner is completely dried. 
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Display cleaning 

There is an antistatic coating on the surface of the display. Do not use cleaners containing fluoride, 

acid and alkaline. Do not spray the cleaner directly onto the display panel, otherwise it may 

penetrate into the instrument and damage the instrument. 

 

3.2 Front and Real Panels 

This chapter introduces the elementary composition and functions of the front panel, rear panel 

and operation interface of the 3671 series vector network analyzer. 

 Front Panel………………………………………………………………………..…………44 

 Real Panel……………………………………………………………………………………51 

3.2.1 Front Panel 

This section introduces the composition and functions of the front panel of the 3671 series vector 

network analyzer. The front panel is shown in Figure 3.18. 

 

Figure 3.18 Front Panel of 3671 series 

1) Input key area 

These keys are used to input measurement settings, as shown in Figure 3.19. 

Note 
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Figure 3.19: 3671 Input Key Area 

a) 【Windows】key 

Used to call up the Windows system start menu and taskbar. 

b) 【Soft keyboard】key 

Used to call up the Windows 7 system soft keyboard. 

c) 【Backspace/←】key 

After inputting a value, press this key to move the cursor back to delete the value. 

d) Number key 

Including numbers 0-9, input the value during the measurement setup, and then press the 

corresponding unit key to complete the input. 

e) Unit key 

Used to end the numeric input and assign a unit to the input value. The units corresponding to 

each key are as follows: 

【T/p】 Tera/Pico (10
12

/10
-12

) 

【G/n】 Giga/Nano (10
9
/10

-9
) 

【M/μ】 Mega/Micro (10
6
/10

-6
) 

【K/m】 Kilo/Milli (10
3
/10

-3
) 

【】basic unit: dB, dBm, degree, second, Hz or dB/GHz, it can also be used for inputting unitless 

values, and has the function of Enter key. 

2) Adjustment key area 

Including navigation keys and adjusting knob, as shown in Figure 3.20. 



3 Quick Start 

3.2 Front and Real Panels 

46  

 

 

Figure 3.20: 3671 Adjustment Key Area 

a) Adjusting knob 

Rotate the knob to adjust the setting in the currently active input box. 

b) [←Tab] and [→Tab] keys 

 Move to the left or right to select the menu. 

 Switch the active option in the dialog box. 

c) [↑] and [↓] keys 

Move up and down in the menu to select menu items. In addition, they can be used in the dialog 

box to: change the value, select the item in the drop-down list, and select the desired option in a 

group of option buttons. 
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1) Set key area 

The function key area includes 6 commonly used set keys, as shown in Figure 3.21. 

 

Figure 3.21: 3671 Set Key Area 

a) [Frequency] key 

Shortcut key for frequency setting. In the normal mode, you can set the start frequency, stop 

frequency, center frequency, frequency span, frequency offset, etc. In the multi-function option 

measurement, you can set the frequency of the corresponding measurement. 

b) [Power] key 

Shortcut key for power setting. In the normal mode, you can set the power level, power state 

on/off, power and attenuation, power ramp, etc. In the multi-function option measurement, you 

can set the power for the corresponding measurement. 

c) [Measurement] key 

Shortcut key for measurement setup, can be used to set the measurement parameters of the current 

trace. In the normal mode, you can set the S parameters and the receiver, in the multi-function 

option measurement, you can set the measurement parameters of the corresponding mode, such as 

"Gain at compression point CompGain21" in the amplifier gain compression measurement mode. 

d) [Sweep] key 

Shortcut key for sweep setup, you can set the sweep time, number of sweep points, sweep type, 

etc. 

e) [Trigger] key 

Shortcut keys for trigger setup, you can set the current sweep mode to hold, single sweep, group 

sweep, continuous sweep, etc. 

f) [Scale] key 

Shortcut key for scale setting, you can set the current trace scale, reference value, reference 

position, etc., to facilitate trace observation. 
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2) Menu key area 

The menu key area includes 9 main menu set keys except Help, as shown in Figure 3.22. 

 

Figure 3.22: 3671 Menu Key Area 

a) [File] key 

Open the file main menu, and display the first-level menu in the auxiliary menu bar: save, call 

back, print, minimize application, and exit. 

b) [Trace] key 

Open the track main menu, and display the first-level menu in the auxiliary menu bar: create trace, 

delete trace, select trace, move trace, trace title, and maximize trace. 

c) [Channel] key 

Open the channel main menu, automatically select the current channel, and display the first-level 

menu in the auxiliary menu bar: channel 1/2/3/4, open channel, close channel, select channel, copy 

channel, hardware setting. 

d) [Excitation] key 

Open the main excitation menu, and display the first-level menus in the auxiliary menu bar: 

frequency, power, sweep, and trigger. 

e) [Response] key 

Open the response main menu, and display the first-level menus in the auxiliary menu bar: 

measurement, format, scale, display, and average. 

f) [Calibration] key 

Open the calibration main menu, and display the first-level menu in the auxiliary menu bar: 

calibration, correction on/off, interpolation on/off, port extension, fixture, edit calibration kit, 

attribute, power calibration. 

g) [Cursor] key 

Open the cursor main menu, and display the first-level menu in the auxiliary menu bar: cursor, 

cursor function, cursor search, cursor attribute, cursor display. If no cursor is currently open, 

cursor 1 is automatically opened by default. If a cursor is currently open, it is automatically 

selected. 

h) [Analysis] key 
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Open the analysis main menu, and display the first-level menu in the auxiliary menu bar: storage, 

test, trace statistics, door, window, time domain, structural return loss, formula editor. 

i) [System] key 

Open the system main menu, and display the first-level menu in the auxiliary menu bar: 

configuration, record/run, spread spectrum, Windows taskbar, reset, define user reset state, 

language. 

3) Function key zone 

The function key area includes 4 commonly used function keys, which are on the left side of the 

display screen, as shown in Figure 3.23. 

 

Figure 3.23: 3671 Function Key Area 

a) [Help] key 

Open the help main menu, and display the first-level menu in the auxiliary menu bar: user manual, 

programming manual, technical support, error message, and about. 

b) [Macro/Local] key 

If the analyzer is under program control mode, press this key to switch to macro; otherwise, press 

this key to open the macro menu. 

c) [Record/Run] key 

Shortcut key for analyzer recording/running. Press this key to start recording automatically or start 

running automatically if the recording operation is already performed. This key is only valid for 

Record/Run 1 and cannot control Record/Run 2. 

d) [Reset] key 

Reset shortcut key of analyzer, if the user has saved the reset state and checked "enable user reset 

state", press this key to restore to the state saved by the user, otherwise, restore to the system reset 

state. 

4) USB interface 

The USB interface can be used to connect a keyboard, mouse or other USB devices. The front 

panel provides a total of four USB interfaces meeting the USB2.0 specifications. The interface 
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jack is a type A configuration (embedded with 4 contacts: contact 1 is on the left), and the 

characteristics of each interface are as follows: 

 Contact 1: Vcc, 4.75V～5.25V, maximum output current 500mA. 

 Contact 2: Data-. 

 Contact 3: Data+. 

 Contact 4: Earthing. 

 

Figure 3.24: USB Interface 

5) Display screen 

The screen display of the analyzer is shown in Figure 3.25. The analyzer uses a TFT liquid crystal 

display, with the technical indicators shown as follows: 

 12.1 inch touch screen 

 Resolution: 1280×800 

 Vertical refresh rate: 60Hz 

 Horizontal refresh rate: 48.4kHz 

For detailed information about the functions and settings of each display element on the screen, 

please refer to "4.9 Analyzer Display Setting". 

 

Figure 3.25: Analyzer Display Screen 

6) 【Power/Standby】key and indicator light 

The [Power/Standby] key and indicator light are shown in Figure 3.26. The power switch is used 

to turn on the analyzer or put the analyzer in a standby state. 

 The indicator light is green when the analyzer is turned on. 
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 The indicator light is orange when the analyzer is in standby. 

 Press the power button when the analyzer is turned on, the analyzer automatically runs the 

Windows 7 operating system, and loads the analyzer application measurement program. 

 Press the power button in the standby state, the analyzer will automatically exit the 

application, turn off the power, and enter the standby state.  

 This switch is only a standby switch, which is not directly connected to the external power 

supply and cannot disconnect the instrument from the external power supply. The external power 

supply of the analyzer can be turned off through the power switch on the rear panel, and the 

analyzer can be completely disconnected from the external power supply by the removal of the 

power line. 

 

Figure 3.26 [Power/Standby] Key and Indicator Light 

7) Test port 

The test port is shown in Figure 3.27. There are two test ports for the analyzer: 50Ω, 

3.5mm/2.4mm (positive), which can be switched between the RF source and the receiver, so that 

the test device can be measured in two directions. The green light is used to indicate the source 

output port. 

 

Figure 3.27: Test Port of Analyzer 

3.2.2 Real Panel 

This section introduces the composition and functions of the rear panel of the 3671 series vector 

network analyzer. The rear panel is shown in Figure 3.28. 

 

Figure 3.28: Rear View of 3671 Vector Network Analyzer 

1) 10MHz reference connector 
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Figure 3.29: 10MHz Reference Connector 

a) 10MHz reference input 

As shown in Figure 3.29, this BNC (female) connector allows the analyzer to be used with an 

external reference signal. If a 10MHz external reference signal is detected on this port, it will be 

used as the frequency reference of the instrument instead of the internal frequency reference. The 

10MHz reference input port has the following characteristics: 

 Input frequency: 10MHz±1ppm 

 Input level: 0 ~ +20dBm 

 Input impedance: 200 ohms 

b) 10MHz reference output 

The BNC (female) connector can provide external reference signals with the following 

characteristics: 

 Output frequency: 10MHz±1ppm 

 Signal type: sine wave 

 Output level: 13dBm±4dB into 50 ohms 

 Output impedance: 50 ohms 

 

2) General purpose interface bus connector 

As shown in Figure 3.30, it is a 24-pin D-type female connector that meets the IEEE-488.2 

standard, and used to send and receive GPIB/SCPI commands. 

 

Fig. 3.30 General Purpose Interface Bus Connector 

3) LAN connector 

As shown in Fig. 3.31, this is a 10/100/1000BaseT Ethernet connector with a standard 8-pin 

structure and automatic selection among three data rates. 
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Fig. 3.31 LAN Connector 

4) USB connector 

As shown in Fig. 3.32, the connector jacks can be divided into two types: type A configuration (4 

embedded contacts: contact 1 on the left) and type B configuration. The rear panel is equipped 

with totally four type A configuration connectors for connecting USB mouse, keyboard and other 

USB interface equipment. Interface characteristics are as follows: 

 Contact 1: Vcc, 4.75 V ~ 5.25 V, maximum 500mA 

 Contact 2: Data- 

 Contact 3: Data+ 

 Contact 4: Earthing 

Type B configuration connector is a reserved interface, and is mainly used to complete the control 

function. The network analyzer can be controlled through SCPI to realize the interconnection with 

external computers or remote equipment. 

 

Fig. 3.32 USB Connector (type B configuration on the left and type A configuration on the right) 

5) Output connector of video graphics adapter 

As shown in Fig. 3.33, this product is equipped with external display connection interfaces, 

namely, HMDI and VGA interfaces respectively. The monitor (VGA) interface is a 15-pin female 

D-sub connector for connecting the external VGA display with the corresponding resolution, so 

that users can observe the internal and external displays at the same time. HMDI interface 

supports the HMDI 1.4 protocol interface. 

 

Fig. 3.33 Output Connector of Video Graphics Adapter 

Click the right mouse button on the Windows desktop and configure the multi-display mode 

through the right-click menu, as shown in Fig. 3.34. 
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Fig. 3.34 Configuration of Multi-display Mode 

 When [Monitor] is checked, only the external VGA/HDMI display can be used to observe 

the measurement display, and the LCD inside the analyzer is not available. 

 When [Laptop] is checked, only the LCD inside the analyzer can be used to observe the 

measurement, and the external VGA/HDMI display is not available. 

 When [Monitor + Laptop] is checked, both the internal LCD and the external VGA/HDMI 

display can be used to observe the measurement results. 

6) Automated testing interface connector 

As shown in Fig. 3.35, the interface is a 36-pin female connector. This interface can be used for 

signaling interaction between network analyzer and automatic mechanical device (Material 

Handler), thus providing a stable and reliable automated testing environment for users. 

 

Fig. 3.35 Automated Testing Interface Connector 

The port is composed of the TTL array, and its electrical characteristics are as follows: 

a)  Input voltage range: -0.5V ~ 5.5V 

TTL high level: 2.0 V ~ 5.0 V 

TTL low level: 0 V ~ 0.5 V 

b)  Output current/voltage range: -10mA ~ 10mA 

Output current: 

TTL high level: -5mA 

TTL low level: 3mA 

Output voltage: 

TTL high level: 2.0V～3.3V 

TTL low level: 0V～0.8V 

Pin definitions and descriptions are as follows: 

1 18 
19 36 
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Table 3.6 Pins of Automated Testing Interface Connector 

Pin Function description: 

1 (lower left 

corner) 

Earthing wire 

2 Input 1 

3 and 4 Inputs 1 and 2 

5 ~ 12 Output ports A0-A7 

13 ~ 17 and 19 Output Port B0- B5 

22 ~ 25 Input/output ports C0-C3 

26 ~ 29 Input/output Port D0- D3 

18 External trigger 

20 Output port B6/ index signal 

21 Output port B7/ trigger ready 

30 and 31 Port C/D status 

32 Write confirmation at output port 

33 Pass/Fail status information 

34 End of sweep 

35 and 36 +5V, Pass/Fail status information confirmation 

7) Trigger input/output interface connector 

As shown in Fig. 3.36, this interface is an external and auxiliary trigger input/output interface. 

Specific functions are as follows: 

 External trigger input - after being enabled, the vector network analyzer will be triggered by 

the connector signal; 

 External trigger ready - after being enabled, the vector network analyzer will send a "ready" 

signal to external equipment through this interface; 

 Auxiliary trigger input 1/2 - after being enabled, the external equipment will a "confirmation" 

signal to the vector network analyzer through this connector (the external equipment is ready to 

receive the trigger signal); 

 Auxiliary trigger output 1/2 - after being enabled, the vector network analyzer will transmit a 

"confirmation" signal through this interface before (or after) one measurement. 

 

Fig. 3.36 Trigger Input/Output Interface Connector 
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3.3 Interface of analyzer 

Analyzer interface refers to the method for users to use and set the analyzer, including front panel 

interface and user interface. 

 Front panel interface…………………………………………………………………56 

 Mouse interface…………………………………………………………………… 56  

3.3.1 Front panel interface 

As shown in Fig. 3.37, users can set and operate the analyzer by using the buttons on the front 

panel in two ways, and the analyzer can be set quickly by the following four steps: 

 Press the corresponding front panel button to activate the auxiliary menu bar. 

 Observe the function items in the auxiliary menu bar. 

 Press the corresponding button to select the required function. 

 Input a value, if necessary. 

Entry key 
zone

Entry key 
zone

Adjust key 
zone

Adjust key 
zone

Menu key 
zone

Menu key 
zone

Setup key 
zone

Setup key 
zone

USB zoneUSB zone

 

Fig. 3.37 Front Panel Interface 

3.3.2 Display interface 

As shown in Fig. 3.38, the mouse or touch screen can be used to perform the following operations: 

 Click the menu bar to display the drop-down menu; 

 Click the input toolbar to adjust the size of the input value; 

 Click the cursor toolbar to use the cursor function; 

 Click the measurement toolbar to add the measurement trace; 

 Click the sweep toolbar to control the sweep of the analyzer; 
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 Click the excitation toolbar to set the sweep excitation; 

 Click the time domain toolbar to set time domain parameters; 

 Press the right mouse button on the screen to display the right-click menu; 

 Click on the trace bar to select the current activation trace; 

 Press the right mouse button on the trace bar to display the right-click menu, so as to set the 

current active trace; 

 Click the auxiliary menu bar and shortcut toolbar to make corresponding settings. 

Title bar

Menu bar

Title bar

Input toolbar

Measurement 

toolbar

Time domain 

toolbar

Cursor toolbar

Scanning 

toolbar

Excitation 

toolbar

Status bar

Table

Trajectory 

status bar

Window

Shortcut

menu bar

Auxiliary

menu bar

Shortcut bar

push/pull button

Fig. 3.38 Analyzer Display Screen 

Push-pull button for shortcut keys: Push-pull operation of side key panel can be realized by this 

button, which can be pulled out completely or only the auxiliary menu bar. Side panel can be 

pushed and pulled to the left or right side of the window. The push-pull button sometimes obscures 

a part of the display, and the software provides an option, namely, pressing and holding the 

push-pull button for 5s to automatically hide the push-pull button. After hiding, the soft panel can 

still be dragged. The push-pull button can be recovered through clicking the edge of the soft key 

area for 5s. 

Input toolbar: The activation input box on the toolbar is customized. It only receives valid 

numbers, decimal points and unit characters, and adopts certain display precision according to 

different display units and display modes. It is a general control and is used in many dialog boxes. 

 

3.4 Trace, channel and window of analyzer 

 Trace……………………………………………………………………………… 57 

 Chanel ………………………………………………………………………………58 

 Window………………………………………………………………………………58 

3.4.1 Trace 

Trace is a series of measurement data points. The settings of trace affect the mathematical 
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operation and display of measurement data, and can be changed only when the trace is active. 

Trace can be activated through clicking the corresponding trace status button. For the detailed 

setting method, please refer to "Change of activation status of trace" in "4.2 Selecting 

measurement parameters". Trace settings include: 

 Measurement parameters 

 Display Format 

 Scale 

 Trace operations 

 Cursor 

 Electrical delay 

 Phase deviation 

 Smoothing 

 Transform 

3.4.2 Channel 

Each channel can contain multiple traces, and the analyzer can support up to 64 channels. The 

channel settings determine how to measure the traces in the channel, and the traces in the same 

channel have the same channel settings. Different channels can be set up differently. The channel 

settings can be changed only when it is active. As long as the traces in the channel are activated, 

the channel is also activated. For the detailed setup method of trace activation, please refer to 

"Change of activation status of trace" in "4.2 Selecting measurement parameters". Channel 

settings include: 

 Frequency span 

 Power 

 Standard data 

 IFBW 

 Sweep Points 

 Sweep settings 

 Avgs 

 Trigger (some settings) 

3.4.3 Window 

Windows are used to observe the measurement traces. The analyzer supports up to 32 windows, 

and each window displays up to 16 traces. The window display can be set through the [View] 

menu. For details, please refer to "4.9 Analyzer display setting". 

1) Creating a new window 

Menu path: clicking [Response] → [Display] → [Window] → [New Window]. The analyzer will 

create a new window, and the default setting of the trace in the window is S11, channel 1. 
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Fig. 3.39 New Window Menu 

2) Using full screen to observe a window 

When there are too many windows opened at the same time, the traces will be unclear due to the 

small windows. At this time, a window can be displayed in full screen to better observe the traces 

in the window. 

There are following three ways to use a mouse to display the window in full screen: 

 If the title bar is open, click the Max button in the title bar of the window. 

 If the title bar is closed, double-click the mouse in the window to be maximized. 

 Use the following menu: [Display] → [Window] → [Max]. 

3.5 Analysis data 

 C u r s o r … … … … … … … … … … … … … … … … … … … … … … … … 6 0 

 Trace operations and statistics…………………………………………………… 68 

 Limit test………………………………………………………………………………71 

 R i p p l e  t e s t … … … … … … … … … … … … … … … … … … … … … … … … … 7 4 

 B a n d w i d t h  t e s t … … … … … … … … … … … … … … … … … … … … … … … … 7 6 

 Formula editor…………………………………………………………………………78 
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3.5.1 Cursor 

The cursor can be used to read measurement data, search for specific types of values or change 

excitation settings. Each trace can use up to 9 normal cursors and 1 reference cursor. 

 C rea t ing  cu r so r………………………………………………………………… 60 

 M o vi n g  c u r s o r … … …… … …… … …… …… …… … …… … …… …… …… … 6 2 

 C u r s o r  s e a r c h … … … … … … … … … … … … … … … … … … … … … … … … … 6 2 

 Cursor function…………………………………………………………………… 66 

 Advanced cursor option settings…………………………………………………67 

 Cursor  tab le……………………………………………………………………… 68 

3.5.1.1 Creating cursor 

1) Use steps of cursor function 

a) Cursor toolbar 

Menu path: clicking [Response] → [Display] → [Toolbar], and clicking [Cursor] in the toolbar 

submenu to display the cursor toolbar. 

Select the cursor to be opened in the [Cursor] box. 

Set the excitation value of the cursor in the [Excitation] box. 

Click [Open] checkbox. 

 

Fig. 3.40 Creating Cursor with Cursor Toolbox 

b) Cursor menu 

Menu path: clicking [Cursor] → [Cursor] to display the cursor submenu. 

Click to select the cursor to be opened in the submenu. 
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Fig. 3.41 Creating Cursor with Cursor Menu 

c) Cursor dialog box 

Menu path: clicking [Cursor] → [Cursor] → [Cursor...] to display the cursor dialog box. 

Select the cursor to be opened in the [Cursor] box. 

Set the excitation value of the cursor in the [Excitation] box. 

Click [Open] checkbox. 

 

Fig. 3.42 Creating Cursor with Cursor Dialog Box 

2) Cursor dialog box 

a) [Cursor] box 

Select the cursor to be defined. 

b) [Excitation] box 

Define the excitation value of the x axis of the selected cursor. 

c) [Open] checkbox 

Check to open the cursor in the cursor dialog box, and delete to close the cursor in the cursor 

dialog box. 

d) [△ Cursor] checkbox 

Check to display the relative value between the selected cursor and the reference R cursor. If the 
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R cursor is not activated, the reference R cursor will be activated automatically. 

e) [Advanced Cursor ...] button 

Click to display the advanced cursor dialog box. 

f) [Close All Cursors] button 

Click to close all open cursors. 

3.5.1.2 Moving cursor 

1) Use one of the three methods described above to select the cursor to be moved to activate it. 

2) Use one of the following methods to move the cursor: 

a) Click [Excitation] box in the cursor dialog box and use the following method to move the 

cursor: 

i. Directly input the cursor excitation value. 

ii. Turn the knob to move the cursor. 

iii. Click the up and down arrow buttons in [Excitation] box to change the cursor excitation 

value. 

iv. Press [↑] or [↓] key in the adjustment key area to change the cursor excitation value. 

b) Click [Excitation] box in the cursor toolbar and use the following method to move the cursor: 

i. Directly input the excitation value. 

ii. Turn the knob to move the cursor. 

iii. Click the up and down arrow buttons in [Excitation] box to change the cursor excitation 

value. 

iv. Press [↑] or [↓] key in the adjustment key area to change the cursor excitation value. 

c) Use the following method to move the cursor in the input toolbar: 

i. Directly input the excitation value. 

ii. Turn the knob to change the excitation value. 

iii. Press [↑] or [↓] key in the adjustment key area to change the cursor excitation. 

iv. Click the up and down arrow buttons in input box to change the cursor excitation value. 

3.5.1.3 Cursor search 

Use the cursor search function to search specific measurement values. If there is no matching 

measurement data, the cursor will remain at the current position. 

1) Cursor search method 

Menu path: [Cursor] → [Cursor Search]. 

Set cursor search in the dialog box, click [Execute] button to search cursor, and click [OK] button 

to close the dialog box. 
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Fig. 3.43 Cursor Search 

2) Cursor search dialog box 

a) Cursor area 

Select the cursor for search definition. 

b) Search domain area 

Define the cursor search range. The default search domain is full bandwidth. In addition, 9 

user-defined search ranges are supported. When selecting user settings, user settings must be 

defined in the user domain range area. The user-defined search domains can overlap each other, 

and different cursors can use the same search domain. Fig. 3.44 shows a group of user-defined 

search domains: 

Fig. 3.44 Schematic Diagram of User-defined Search Domain of Cursor 

c) User domain range area 

The [Start] box and [End] box of the user domain range area are used to define the user-defined 

search domain. 

d) Search type area 

Define the types of cursor search. The analyzer supports the following 10 search types: 

 Minimum Search the smallest measurement data point. 

 Maximum Search the largest measurement data point. 

 Right peak value Search the next valid peak on the right side of the cursor position, and 

User 
User 

User 

settings 3 
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define the peak first. 

A perk is defined by [Threshold] and [Excursion]. [Threshold] defines the minimum peak point. 

The peak point of the valid peak must be greater than the threshold value, and the valley points on 

both sides can be less than the threshold value. [Excursion] box defines the minimum vertical 

distance between peak and valley. The vertical distance between the valid peak value and the 

valley values on both sides must be greater than the excursion value, as shown in Fig. 3.45. The 

analyzer settings are as follows: 

Threshold: -50dB 

Excursion: 10dB 

Scale: 10dB/ grid 

i. Peak A is a valid peak, and both threshold and peak meet the requirements. 

ii. Peak B is not a valid peak, and the excursion does not meet the requirements; 

iii. Peak C is not a valid peak, and the threshold does not meet the requirements. 

Fig. 3.45 Schematic Diagram of Peak Value in Cursor Domain 

 Left peak value Search the next valid peak on the left side of the cursor position, and define 

the peak first. 

 Next peak value Search the next valid peak lower than the current cursor amplitude, and 

define the peak first. 

 Target Enter the search target value in [Log Value] box, click the [Execute] button to move 

the cursor to the first target value on the right side of the current cursor position, click [Execute] 

button continuously to move the cursor to the next target value on the right side until the highest 

end of the excitation value, and then return to the lowest end of the excitation value to search the 

target value. 

① Check [Discrete Cursor] checkbox in the Advanced Cursor dialog box, and move the 

cursor to the discrete data point equivalent to the target value.   

② Check [Discrete Cursor] checkbox in the Advanced Cursor dialog box, and move the 

cursor to the interpolated data point equivalent to the target value. 

 Left target Search only the target value on the left side of the current cursor. 

 Right target Search only the target value on the right side of the current cursor. 

 Bandwidth When bandwidth search function is selected, set the level (-3dB by default) drop 

from the peak on both sides in the level box, and measure the bandwidth at this level, as shown in 

Fig. 3.46. Use cursors 1-4 for measurement. Use cursor 1 to search the maximum peak value, 

cursor 2 to search the defined level drop point on the left side of the peak value, cursor 3 to search 

B 

C 

A 

--50d

B 



3 Quick Start 

3.5 Analysis data 

      65 

 

the defined level drop point on the right side of the peak value, and cursor 4 to search the center 

point of the bandwidth. Display the following information after the measurement: 

Bandwidth: frequency difference between right cutoff frequency point and left cutoff frequency 

point; 

Center: frequency at the midpoint between right cutoff frequency point and left cutoff frequency 

point; 

Q: the value obtained by dividing the center frequency by the bandwidth; 

Loss: the measured value at the bandwidth center frequency point; 

Left cutoff: the lowest frequency in two points below the specific bandwidth level of the signal 

peak; 

Right cutoff: the highest frequency in two points below the specific bandwidth level of the signal 

peak. 

 

Fig.3.46 Bandwidth Search 

 Filter test The analyzer specially sets a shortcut function for the filter test, and the 

parameters obtained from the test can be automatically displayed on the screen, which is 

convenient for users to see the test results visually. The filter test function reduces the manual 

setting in the test process, thus greatly increasing the test speed, as shown in Fig. 3.46. 

Eight parameters of filter test are displayed on the upper left of the trace. When the filter test is 

opened, the bandwidth search function will be opened automatically, and the six parameters of 

bandwidth test will also be displayed on the upper right of the trace. 

Level of bandwidth 1: set the level value of bandwidth 1 in the input box; 

Level of bandwidth 2: set the level value of bandwidth 2 in the input box; 

Frequency difference percentage: set the frequency difference percentage value in the input box. 
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Fig. 3.47: Filter Test 

e) [Execute] button 

Click [Execute] button to conduct a cursor search of the specified type. 

f) [Track] checkbox 

When [Track] checkbox is selected, the analyzer will perform the search function according to the 

current search type and the settings of the search domain after each sweep, which can ensure that 

the cursor is at the desired position after each sweep. 

3.5.1.4 Cursor function 

1) Use steps of cursor function 

The settings of some instruments can be changed by activating the cursor position, such as, start 

frequency, stop frequency, etc. The setup method is as follows: 

Menu path: [Cursor] → [Cursor Function]. 

 

Fig. 3.48 Measurement Setup with Cursor Function Dialog Box 

 

 

 

Cursor function softkey toolbar 

The cursor function softkey toolbar provides five analyzer setup functions: start, stop, center, 

reference and delay. 

 

2) Cursor function dialog box 

a) [Cursor-> Start] button 

Click to set the start value of sweep equivalent to the excitation value of the activated cursor. 

Tip 
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b) [Cursor-> Stop] button 

Click to set the stop value of sweep equivalent to the excitation value of the activated cursor. 

c) [Cursor-> Center] button 

Click to set the center value of sweep equivalent to the excitation value of the activated cursor. 

d) [Cursor-> Reference] button 

Click to set the reference value of sweep equivalent to the excitation value of the activated cursor. 

e) [Cursor-> Delay] button 

When the [Cursor → Delay] button is clicked, the analyzer will use the phase slope at the 

activated cursor to adjust the electrical delay of the receiving path, which can smoothen the phase 

trace near the activated cursor. This function can be used to measure the electrical length and 

phase deviation. This function is only applicable to the ratio measurement. 

f) [Cursor-> Span] button 

Click to set the sweep span value equivalent to the difference between the activated cursor and the 

reference cursor (△ cursor value). This button is only effective when the activated cursor opens 

△ cursor function. 

3.5.1.5 Advanced cursor option settings 

1) Use steps of advanced cursor option function 

Menu path: clicking [Cursor] → [Cursor] → [Cursor...] to display the cursor dialog box. 

Click [Advanced Cursor...] button to display the advanced cursor dialog box. 

 

Fig. 3.49 Advanced Cursor Dialog Box 

2) Advance cursor option dialog box 

a) [Cursor] box 

Select to set the cursor. 

b) [Open] checkbox 

Check to display the corresponding cursor on the screen, and delete to close the cursor display. 

c) [Discrete Cursor] checkbox 

Check to display the data of the actual measurement point by the cursor, and delete to display the 

interpolated data point between measurement points. 

d) [Format] box 

Select the format of cursor display data. The format of cursor data can be different from that of 
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screen trace data. By default, both data are the same. 

e) Cursor type area 

i. [Normal] radio button 

The standard cursor has a fixed X-axis position, and the Y-axis position changes with the 

amplitude of trace data. The cursor position on the X-axis can be moved left and right by changing 

the cursor excitation value. 

ii. [Fixed] radio button 

According to the position on the trace when the cursor is set as a fixed type, the fixed X-axis and 

Y-axis coordinates of cursor are kept unchanged, and not moved with the change of the trace data 

amplitude. Its position on the X-axis can be moved by changing the cursor excitation value, but 

the Y-axis coordinates remain unchanged. Such type of cursor is mainly used to observe the 

change of trace data. For example, a fixed type of cursor can be used to compare the change of 

insertion loss before and after filter tuning. 

3.5.1.6 Cursor table 

1) Cursor table 

The cursor table can be opened to display all cursor data of the active trace, and the cursor data is 

displayed in the format specified by each cursor. 

Open and close the display of cursor table by the following methods: 

2) Open/close mode 

Menu path 1: clicking [Cursor] → [Cursor] → [Show Cursor Table] to open cursor table/ 

clicking [Hide Cursor Table] to close cursor table. 

Fig. 3.50 Setup of Cursor Table through Cursor Menu 

Menu path 2: [Response] → [Display] → [Table] → [Cursor Table] 

“√" in front of an option indicates open, otherwise, close. 

 

Fig. 3.51 Setup of Cursor Table Display through View Menu 

3.5.2 Trace operations and statistics 

The analyzer can perform four types of mathematical operations on the current activated trace and 
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memory trace, and also provides three trace statistics functions: mean value, deviation value and 

peak-to-peak value. 

 Trace operations……………………………………………………………………………69 

 Trace statistics……………………………………………………………………………70 

3.5.2.1 Trace statistics 

1) Setup method of trace operation 

Before executing any type of trace operation, a trace must be stored in memory. Trace operation is 

a vector operation of complex data before formatting and displaying. The setup method of trace 

operation is as follows: 

Menu path: clicking [Analysis] → [Save] → [Operation/Save...] to display the operation/save 

dialog box. 

 

Fig. 3.52 Setup of Trace Operation 

2) Operation/save dialog box 

a) [Data-> Memory] button 

Store the current measurement data in memory. 

b) [Trace Operation] selection box 

[Trace Operation] box is used to select the type of trace operation. The analyzer supports the 

following trace operations: 

i. Data 

Do not perform any type of mathematical operation. 

ii. Data + storage 

The displayed trace data is the measured data plus the stored trace data. 

iii. Data-Memory 

The displayed trace data is the measured data minus the stored trace data, so this function can be 

used for simple error correction: firstly, the measured vector error is stored in the memory, and 

then the measured error is subtracted from the measured data of DUT. 

iv. Data*Memory 



3 Quick Start 

3.5 Analysis data 

70  

 

The displayed trace data is the measured data multiplied by the stored trace data. 

v. Data/Memory 

The displayed trace data is the measured data divided by the stored trace data, which is mainly 

used for ratio measurement, such as gain and attenuation measurement. 

c) Data display selection area 

i. [Data trace] radio button 

Only display the data trace.  

ii. [Memory trace] radio button 

Only display memory traces 

iii. [Data and Memory] radio button 

Display both data trace and memory trace. 

3.5.2.2 Trace statistics 

The analyzer provides five trace statistics functions: mean value, deviation value, peak-to-peak 

value, maximum value and minimum value, and can calculate the statistical values within the full 

excitation bandwidth or user-defined bandwidth. Each channel supports 9 user-defined ranges, 

which are the same as the user-defined search domains in cursor search, and use the same memory 

address, so they share the same excitation settings. If the user-defined search domain is defined 

through cursor search function, the same excitation settings can be called by selecting the 

corresponding user settings in trace statistics, and the ranges of these user settings can also overlap 

each other. 

The peak-to-peak value of passband ripple can be measured conveniently through the trace 

statistics function, without searching the maximum and minimum values. Trace statistics are 

calculated according to the format of data display: 

 Rectangular coordinate format: calculates statistical values according to displayed scalar 

data; 

 Polar coordinates and Smith chart format: calculates statistical values according to the 

displayed values of data in logarithmic magnitude format. 

1) Activation trace statistics 

Menu path: clicking [Analysis] → [Trace Statistics] to display the trace statistics dialog box. 

 

Fig. 3.53 Trace Statistics Dialog Box 

2) Trace statistics dialog box 
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a) [Statistics-Mean, Deviation, Peak-to-Peak] checkbox 

Click to open the trace statistics function, and delete to close the trace statistics function. 

b) [Span] box 

Select the span setup of trace statistics, which can be full bandwidth or customized 9 user settings, 

or customized user settings can be made through cursor search dialog box. 

c) User domain definition area 

i. [Start] box 

Defines the starting value of the user settings span. 

ii. [Stop] box 

Defines the stop value of the user settings span. 

3.5.3 Limit test 

The limit test function compares the measured data with the defined constraints (limits), and the 

user-defined limits are visually displayed on the screen in the form of limit lines. The use of limit 

lines has the following advantages: 

 Provide a visual indication for device debuggers. 

 Provide a criterion for qualified device characteristic index.  

 Provide a visual comparison between the measured data of the device and the index 

requirements. 

The limit test function compares the measured data with the defined limit, and provides PASS and 

FAIL information. Each trace supports up to 100 discrete limit segments to accurately define the 

limit. 

 Creating and editing limit lines……………………………………………………71 

 Limit table……………………………………………………………………………72 

 S e t up  o f  l i mi t  t e s t…………………………………………………………… 7 3 

3.5.3.1 Creating and editing limit lines 

The analyzer supports creating limit lines for all measurement traces. The limit lines are composed 

of several discrete limit line segments, and each line segment is defined by four coordinate values: 

the start and stop excitation values of X axis, the start and stop response values of Y axis. The 

limit lines are created and edited through the limit table. 

1) Menu path: clicking [Analysis] → [Test] → [Limit Test] to display the test dialog box; 

2) Click [Display Table] button in the dialog box to open the limit table display; 

3) Click [OK] button to close the dialog box; 

4) Click [Limit Type] box in the limit test dialog box, and select the limit test type from the 

drop-down box. 
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Fig. 3.54 Limit Test 

3.5.3.2 Limit table 

 T

ype 

Start stimulus Stop stimulus Start 

response 

Stop 

response 

Limit 

type 

1 M

AX 

100.000kHz 100.000kHz -100.000dB -100.000dB SLOP 

2 M

IN 

100.000kHz 3.000GHz -100.000dB -100.000dB FLAT 

3 O

FF 

100.000kHz 3.000GHz -100.000dB 100.000dB SLOP 

 

Fig. 3.55 Limit Table 

Type box 

The type box sets the type of limit test: 

·MAX: when the trace is above the limit line segment, the limit test fails 

·MIN: when the trace is below the limit line segment, the limit test fails 

·Off: close this limit segment test 

Start excitation box and stop excitation box 

Set the start and stop excitation values of limit line segment (the start and stop coordinates of X 

axis of limit line segment) 

Start response box and end response box 

Set the start and stop response values of limit line segment (the start and stop coordinates of Y axis 

of limit line segment) 

Limit type box 

Set the type of limit line of limit test to be displayed: 

·SLOP: displays the inclined limit line 

·Flat: displays the horizontal limit line 

·Point: displays the point-like limit line 
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3.5.3.3 Setup of limit test 

After creating the limit line, you can choose to show or hide the limit line of a trace. When the 

limit line is hidden, the corresponding limit test is still valid. The limit test cannot be performed on 

the memory trace, so it can be indicated by giving a warning sound and displaying a FAIL sign 

when the limit test fails. When the limit test function is opened, the trace display of the failed limit 

test is red by default, which can be changed by the limit failure color in the color setup of the 

right mouse button menu, while the color of passed limit test remains unchanged. 

1) Setup method 

a) Menu path: clicking [Analysis] → [Test] → [Limit Test] to display the test dialog box; 

b) Set the limit test in the dialog box. 

c) Click [OK] button to close the dialog box; 

The limit test is only carried out at actual sweep measuring points. In case of less sweep points, 

the performance index of DUT may not meet the requirements, but it can still pass the limit test. 

Therefore, in actual measurement, sufficient sweep points must be used for limit test. 

2) Limit test dialog box 

[Limit Test (ON/off)] checkbox 

Check to open the limit test function of the activated trace, and delete to close the limit test 

function of the activated trace. 

[Limit Line Display (ON/off)] checkbox 

Check to display the limit line of the activated trace on the screen, and delete to close the limit line 

display of the activated trace, without influencing the limit test function. 

[Failure Sound Warning] checkbox 

When checked, the buzzer will give a warning tone when the test of trace data points fails. 

[Fail Sign (ON/off)] check box 

When checked, the fail sign will be displayed on the screen when the test of trace data points fails. 

[Point] radio button 

When selecting, use symbols "v" (measurement type is MAX) and "^” (measurement type is MIN) 

to indicate the discrete limit values corresponding to the measurement data points. 

[Line] radio button 

When selecting, connect all discrete limit setup points with lines. 

[Show Table] button 

When clicked, the limit table is displayed for editing, and this button becomes disabled when the 

limit table is opened. 

[Hide Table] button 

When clicked, the limit table display is closed, and this button becomes disabled when the limit 

table is closed. 

[Export Table] button 

When clicked, the memory dialog box pops up. You can select the storage path and save it as a file 

in *.csv format. 
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[Import Table] button 

When clicked, the memory dialog box pops up. You can select the storage path of the file to be 

opened, and open the file in *.csv format. 

[Limit Test Type] drop-down selection box 

Click the drop-down selection box to select totally four types of limit tests: multi-type limit line, 

inclined limit line, single point limit line and horizontal limit line. 

3.5.4 Ripple test 

Ripple test can be used to evaluate whether the test result is qualified by setting fluctuation limit. 

The test compares the measured data with the defined fluctuation limit, and provides PASS and 

FAIL information, and the test results are visually displayed on the screen. Each trace supports up 

to 12 discrete limit segments, each limit segment can be set with start excitation, stop excitation 

and maximum fluctuation values, and the excitation settings of different segments can overlap. 

3.5.4.1 Creating and editing ripple limit lines 

Ripple limit test can be carried out on multiple traces at the same time, and the setup of ripple 

limit can be carried out only after the traces are activated. 

1) Setup method 

a) Menu path: clicking [Analysis] → [Test] → [Ripple Test] to display the test dialog box; 

b) Click [Display Table] button in the dialog box to open the ripple table display; 

 

 

Fig. 3.56 Display Table Test Dialog Box 

2) Ripple limit table 

 Type Start stimulus Stop stimulus Maximum 

fluctuation 

1 ON 100.000kHz 2.000GHz 5.000dB 

2 ON 2.000GHz 3.000GHz 10.000dB 

3 OFF 100.000kHz 3.000GHz 100.000dB 

 

Fig. 3.57 Ripple Limit Table 

Type box 

The type box sets the type of limit test: 
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ON: activates this limit segment test. 

Off: closes this limit segment test. 

Start excitation box and stop excitation box 

Set the start and stop excitation values of ripple limit line segment. 

Maximum fluctuation box 

Set the maximum fluctuation value that the limit line can display in the ripple limit segment test. 

3.5.4.2 Setup of ripple test 

After creating the ripple limit line, you can choose to show or hide the ripple limit line of a trace. 

When the limit line is hidden, the corresponding ripple test is still valid. You can choose to give a 

warning sound and display a FAIL sign when ripple test fails to indicate the test. When the ripple 

test function is opened, the trace display of the failed limit test is red by default, which can be 

changed by the limit failure color in the color setup of the right mouse button menu, while the 

color of passed limit test remains unchanged. 

Menu path: clicking [Analysis] → [Test] → [Ripple Test] to display the test dialog box; 

The ripple test is only carried out at actual sweep measuring points. In case of less sweep points, 

the performance index of DUT may not meet the requirements, but it can still pass the ripple test. 

Therefore, in actual measurement, sufficient sweep points must be used for test. 

Ripple test dialog box 

[Ripple Test (on/OFF)] checkbox 

Check to open the ripple test function of the activated trace, and delete to close the ripple test 

function of the activated trace. 

[Ripple Line Display (on/OFF) checkbox 

Check to display the ripple line of the activated trace on the screen, and delete to close the ripple 

line display of the activated trace, without influencing the ripple test function. 

[Failure Sound Warning (on/OFF)] checkbox 

When checked, the buzzer will give a warning tone when the test of trace data points fails. 

[Fail Sign (on/OFF)] check box 

When checked, the FAIL sign will be displayed on the screen when the test of trace data points 

fails. 

[Show Table] button 

When clicked, the ripple limit table is displayed for editing, and this button becomes disabled 

when the table is opened. 

[Hide Table] button 

When clicked, the ripple limit table display is closed, and this button becomes disabled when the 

table is closed. 

[Export Table] button 

When clicked, the memory dialog box pops up. You can select the storage path and save it as a file 

in *.csv format. 

[Import Table] button 
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When clicked, the memory dialog box pops up. You can select the storage path of the file to be 

opened, and open the file in *.csv format. 

[Ripple Value Type] drop-down selection box 

Click the drop-down selection box to select the type of ripple value: none, absolute value and 

margin. The startup default value of the analyzer is absolute value. 

[Fluctuation Limit Segment] drop-down selection box 

Click the drop-down selection box to select the number of open fluctuation limit segments, up to 

12 segments. 

3.5.4.3 Display of ripple test results 

If the measurement results of ripple test pass, "PASS" will be displayed on the upper left of the 

screen, otherwise, "FAIL" will be displayed. If multiple traces are tested at the same time, each 

trace will display "PASS" or "FAIL" respectively. The excitation ranges of different ripple limit 

segments can overlap and set different fluctuation limits. 

 

Fig. 3.58 Ripple Test Results 

3.5.5 Bandwidth test 

The bandwidth test function is mainly used to test the bandwidth of the bandpass filter. 

The bandwidth test can detect the signal peak in the passband, and locate two points at specific 

magnitudes on both sides of the passband, which are lower than the signal peak, and can be 

adjusted by setting the N dB point (the default setting is 3dB). The frequency range between these 

two points is the bandwidth of the measured filter. 

Bandwidth test can set the minimum bandwidth and maximum bandwidth allowed by the user 

before the test, and the measured bandwidth will be automatically compared with these two values. 

If the result is not compliant, the analyzer will prompt the FAIL information on the screen or give 

a voice prompt, which is convenient for the user to see more visually whether the characteristics 

of DUT meet the requirements. 
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3.5.5.1 Opening and setup of bandwidth test 

Before bandwidth test, it is necessary to set bandwidth threshold (N dB point), maximum 

bandwidth and minimum bandwidth first. Multiple traces can be set. 

1) Menu path: clicking [Analysis] → [Test] → [Bandwidth Test] to display the test dialog box; 

2) Check the [Bandwidth Test (on/OFF)] checkbox in the dialog box to open the bandwidth 

test; 

3) Check the [Bandwidth Value Display (on/OFF)] checkbox in the dialog box to display the 

measured bandwidth value on the screen; 

4) Click the [Bandwidth Marker Display (on/OFF)] checkbox in the dialog box to display the 

positioning mark of bandwidth on the screen; 

 

5) Click the [N dB Point] box to set the bandwidth threshold; 

6) Click the [Minimum Bandwidth] box to set the minimum bandwidth. 

7) Click the [Maximum Bandwidth] box to set the maximum bandwidth. 

8) Check [Failure Sound Warning (on/OFF)] checkbox in the dialog box to give a voice 

prompt when the bandwidth test fails; 

9) Check [Fail Sign (on/OFF)] checkbox in the dialog box to display FAIL prompt when the 

bandwidth test fails; 

10) Click [OK] to complete the setup of bandwidth test 

 

Fig. 3.59 Bandwidth Test Dialog Box 

3.5.5.2 Display of bandwidth test results 

Bandwidth test results are displayed in the upper left corner of the trace, and PASS prompt will be 

displayed when the test passes. The red T-shaped bandwidth markers are distributed on both sides 

of the bandwidth. 
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Fig. 3.60 Display of Bandwidth Test Results 

3.5.5.3 Closing bandwidth test 

1) Click [Analysis] → [Test] → [Bandwidth Test] to display the test dialog box; 

2) Click the [Bandwidth Test (on/OFF)] checkbox, and uncheck it to close the bandwidth test; 

3) Click the [Bandwidth Value Display (on/OFF)] checkbox, and uncheck it to close the 

display of tested bandwidth value; 

4) Click the [Bandwidth Marker Display (on/OFF)] checkbox, and uncheck it to close the 

display of bandwidth locating marker; 

5) Click [OK] to close the bandwidth test 

3.5.6 Formula editor 

 Overview…………………………………………………………………………… 78 

 Use method of formula editor………………………………………………………80 

 Data used in formula editor and considerations ……………………………84 

 Data saving of formula editor……………………………………………………85 

3.5.6.1 Overview 

For convenience of explanation, the following two nouns should be defined first: 

Reference trace: the trace in the formula is used as data. 

Formula trace: the trace after formula operation, which will be displayed in the current activated 

traces. 

The formula editor allows the user to input an algebraic expression, which can perform 

mathematical operation on the measured data, and the operation result can be displayed in the way 

of data trace. The measurement data used by the formula trace can be data of the same channel or 

different channels. Mathematical expressions entered by users can be composed of basic operators, 

built-in functions and parameters. The measurement parameters or trace data used in the formula 

are taken from vector network analyzer. When a calculable formula is input into the formula input 
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box and the activation box is checked, the current activated trace will become a formula trace, the 

data of the formula trace is the calculated data, and the formula trace curve can be updated in real 

time as the data changes. For example, enter the formula S21/(1-S11), and the data of each point 

on the formula trace calculated by this expression is calculated by dividing S21 data of the 

corresponding point by 1 and subtracting S11 data. If the trace has 201 points, this expression will 

be operated 201 times, that is, one point will be operated once. 
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For example, if a three-port DUT is measured, it is not a routine measurement task for the analyzer, 

and this task can be completed by the formula editor. If a result expected by the user is a formula 

trace in logarithmic format, it can be expressed as S21+S23-S13. However, the data used by the 

formula editor is the nonformatted complex data, so the formula that the user needs to input has to 

be changed to S21*S23/S13 to achieve the goal, as shown in Fig. 3.61. After entering the formula, 

it will be displayed as Eq=S12*S23/S13 on the current active trace of vector network analyzer, as 

shown in Fig. 3.62. 

 

Fig. 3.61 Formula Editor Dialog Box 

 

Fig. 3.62 Display of Formula Trace 

3.5.6.2 Use method of formula editor 

1) Opening formula editor dialog box 

The user can open the dialog box of the formula editor by clicking the vector network analyzer 

menu [Analysis] → [Formula Editor], as shown in Fig. 3.63. 
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Fig. 3.63 Formula Editor Menu 

2) How to enter a formula in the formula editor dialog box 

a) Entering a function 

You can enter a function in the formula input box by clicking the function list under [Functions 

and Constants] in Fig. 3.61, or you can enter a function directly through the keyboard. 

b) Entering an operator 

You can enter an operator in the formula input box by clicking the operator list under [Operator], 

or you can enter an operator through the keyboard. 

c) Entering a trace and channel 

You can click the drop-down list options under [Trace] or [Channel Parameters] to enter trace and 

channel parameters as parameters or variables of formulas, or you can enter operators through the 

keyboard. 

d) Entering data 

You can enter numbers by clicking the number button on the right, or you can enter operators 

through the keyboard. 

3) Activating checkbox 

The default state of activating the check box is checked. Only when it is checked, the correctness 

of the formula entered by the user will be judged. If the formula is computable, it will be 

calculated. The expression Eq=XXX of the current formula can be displayed through the activated 

trace of the current activation window of Vector Network. If the activation checkbox is not 

checked, the input expression will not be calculated regardless of whether it can be calculated or 

not. In addition, if the activation checkbox is checked, but the entered formula is not calculable 

(for example, enter "2+1+"), the checkbox will become a gray button. 

4) Saving and deleting a formula 

The user can save any expression entered by the user in the formula input box by clicking the 

[Save Formula] button, and these formulas are saved in the drop-down menu of the formula input 

box. The user can click the drop-down arrow on the right side of the formula input box, and then 

click the formula to be used in the drop-down list. 

In addition, the user can delete the formula in the formula input box by clicking [Delete 

Formula]. 

5) Backspace button 
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[<-Backspace]: This button is used to delete the character in front of the cursor. If there is no 

character on the left side, the cursor position will not change. 

6) Cursor left and right 

[<-]: cursor left button, which is used to move the current cursor to the left by one character, 

without deleting the character on the left side of the cursor. If there is no character on the left side, 

the cursor position will remain unchanged. 

[->]: cursor right button, which is used to move the current cursor to the right by one character, 

without deleting the character on the right side of the cursor. If there is no character on the right 

side, the cursor position will remain unchanged. 

7) Selecting a function/ constant 

The default is the built-in function library option. There are commonly used formulas and constant 

variables under the built-in function library option, which can be selected by clicking. The effects 

of functions/constants are shown in Table 3.10. It should be noted that if the parameter of a 

function is of complex number type, users can also use scalar as its parameter for use, and scalar 

data is a complex number with imaginary quantity of zero. 

Table 3.10 List of Functions/Constants 

acos(scalar a) return the inverse cosine value of parameter a in radians, and 

parameter a is of scalar type 

asin(scalar a) return the inverse cosine value of parameter a in radians, and 

parameter a is of scalar type 

atan(scalar a) return the arcsine value of parameter a in radians, and 

parameter a is of scalar type 

atan2 return the phase of  complex number a in radians. 

There are two parameter forms: 

atan2(complex a) - return  the phase in radians, and parameter 

a is of complex type; 

atan2(scalar a, scalar b)- return the phase in radians, and 

parameters a and b are scalar  type; 

conj(complex a) return the conjugate complex number of  complex number a 

cos(complex a) calculate the cosine of complex number a. The real and 

imaginary quantities of a are radians 

cpx(scalar a, scalar b) return a complex value (a+jb), where a and b are scalar type 

getNumPoints() Return the number of currently swept points 

im(complex a) return the imaginary quantity value of complex number a 

kfac(rComplex a, rComplex b, 

rComplex c, rComplex d ) 

return value k = (1 - |a|^2 - |d|^2 + |a*d-b*c|^2 ) / (2 * |b*c|), 

and parameters a, b, c and d are complex numbers 

ln(complex a) return the natural logarithm of complex number a 

log10(complex a) return the logarithm of 10 of complex number a 
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mag(complex a) return the modulus of complex number a, and parameter a is a 

complex number 

mu1(complex a, complex b, 

complex c, complex d ) 

return value mu1 = (1 - |a|^2) / ( |d - conj(a) * (a*d-b*c)| + 

|b*c| ), and parameters a, b, c and d are complex numbers 

mu2(complex a, complex b, 

complex c, complex d ) 

return valuemu2 = (1 - |d|^2) / ( |a - conj(d) * (a*d-b*c)| + 

|b*c| ), and parameters a, b, c and d are complex numbers 

phase(complex a) return atan2(a), that is, calculate the phase, the unit is radian, 

and the parameter is of complex number type 

PI Constant π with a value of 3.141592 

re(complex a) return the real quantity of complex number a, and parameter a 

is a complex number 

sin(complex a) return the sine value of complex number a, and parameter a is a 

complex number and the unit is radian 

sqrt(complex a) return the square root of complex number a, and parameter a is 

a complex number 

tan(complex a) return the tangent value of complex number a, and parameter a 

is a complex number and the unit is radian 

8) Selection of operators 

Operators are shown in Table 3.11. Users can click the mouse to select the four basic operators, 

such as "+", "-", "*" and "/", and the left bracket or right bracket. In addition, the formula editor 

also supports direct input of complex data for operation. For example, if the user wants to input a 

complex constant 2+j3, he must input < 2:3 > in the formula editor to represent the complex 

constant 2+j3. If the formula that the user wants to input is (2+j3)*S11, the calculation can only be 

performed if the input expression is < 2:3>*S11. 

Table 3.11 List of Operators 

+ Addition operator 

- Subtraction operator 

* Multiplication operator 

/ Division operator 

( Left bracket 

) Right bracket 

, Comma, used to separate multiple parameters 

< Enter the start character of the complex number 

: Used to separate the real and imaginary quantities of a complex 

number 

> Enter the end character of the complex number 
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9) Trace data  

The user can select a trace or trace storage data in the list below, but cannot select the currently 

activated trace. 

10) Channel parameter data 

The user can only select the S parameter of the currently active channel as the parameter data of 

the input expression. 

11) Number keypad 

Users can input numbers by clicking the number keys on the number keypad, and positive and 

negative symbols by clicking [+/-], and decimal point by clicking [•]. 

3.5.6.3 Data used in formula editor and considerations 

The data of each point of the formula trace will be calculated by using the data of the 

corresponding point of the reference trace. If the trace has 201 points, the formula will be 

calculated 201 times, that is, every data point will be calculated once. For example, if the current 

trace is Tr4 and the formula is Tr2+S11, then Tr4 will become the formula trace, and Tr1 and S11 

are the reference traces of the equation trace. And the currently activated trace Tr4 will be 

displayed as Tr4 Eq= Tr2+S11 on the display window of the vector network analyzer. as shown in 

Fig. 3.64. 

 

 

 

 

Considerations for use of formula editor 

1) If the formula is active and computable, the current activated trace will not display the      

original measurement parameter name, but become a formula trace. For example, the current 

activated trace is Tr4 S22, which will become a formula trace Tr4EQ = Tr2+S11 immediately after 

entering the formula Tr2+S11. However, if the input formula is not computable, it will be 

displayed as the original trace name. For example, if the user inputs Tr2+S11+, the current 

activated trace will be displayed as the original Tr4 S22. 

2) The formula trace cannot use the current activated trace as a reference trace. For example, if 

the current activated trace is Tr4, Tr4 can no longer be input as a parameter in the formula. 

3) The reference trace can be selected from the S parameter and memory trace. If the memory 

trace is used as the parameter, it must be guaranteed that the memory trace already exists, 

otherwise, the formula cannot be calculated. 

4) When using the traces of other channels as reference traces, it should be noted that the 

reference traces must be displayed traces and must be referenced by Trx, and the data points of 

reference traces and formula traces must be the same before calculation. For example, the number 

of data points of the reference trace is 201 points, and the number of data points of the formula 

trace is also 201 points. 

Note 
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Fig. 3.64 Formula Trace Display Window 

3.5.6.4 Data saving of formula editor 

Formula data can be saved as *.cti, *.prn and *.dat format data, but the name of the test parameter 

in the saved file is still the name of the original measurement parameter. For example, the original 

name of Tr2 is S22. If the input formula is 10+S22, the name of the saved measurement parameter 

will remain the same as S22, but the data will become the value of 10+S22, so the equation trace 

cannot be saved as a data file in *.snp format. 
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3.6 Data output 

 Saving and cal l ing back f i les………………………………………………… 86 

 Print ing display measurement………………………………………………… 91 

3.6.1 Saving and calling back files 

The 3671 series vector network analyzers support the functions of saving and calling back files in 

various formats. 

3.6.1.1 Saving files 

1) Method for saving files 

Menu path: [File] → [Save] → [Save]/[Save As ...]. 

 

Fig. 3.65 Saving Files 

2) [Save] file menu item 

When [Save] is clicked, the analyzer will save the instrument status and calibration data to the 

default file (defaut.cst) in the specified directory. If the default file already exists, the analyzer will 

display a dialog box to confirm whether to overwrite it. 

3) [Save As ...] file menu item 

Open the save as dialog box to save the file. 

a) [Save in] drop-down box 

Display and set the path where files are saved. 

b) File list box 

Display the folder under the current path and all files matching the save type. Click the file to set 

the saved file name, and click the folder to change the current path. 

c) [File Name] box 

Display the file name entered or clicked in the file list box. 

d) [Save Type] box 

Select the file saving type. The analyzer supports the following file types: 
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i. Cst type file 

Cst file saves the status and calibration data of the instrument. 

ii. sta type file 

sta file only saves the status data of the instrument. 

iii. cal type file 

Cal file only saves the calibration data of the instrument. 

iv. dat type file 

When the user selects the dat type file, the analyzer will open the data saving setup dialog box 

and saves the trace data file according to the user's requirements. 

v. prn 

The prn file only saves the data of the currently activated trace. 

vi. bmp file 

Bmp file saves the display information of the screen in bitmap format. 

4) Autosave 

Open and define the autosave dialog box through the front panel button and side button menu 

[File] → [Save] → [Defined Autosave ...] to automatically save the measurement data during 

every sweep according to the user configuration. 

 

Fig. 3.66 Autosave 

a) Storage directory 

Select the file directory to be stored; 

b) File prefix 

Specify the file prefix, which will be named by prefix+serial number, and the serial number will 

automatically increase according to the number of cycles; 

c) File type 

Select the save file type; 

d) Enabling circular saving 
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Circular saving and saving times are set in pairs. After selecting OK, the program will be 

automatically saved after each sweep, and the saving times will be -1. After opening the dialog 

box, the display will be updated to the current remaining saving times. If it is greater than 0, 

automatic saving is selected by default; otherwise, automatic saving is not checked, indicating that 

automatic saving has been completed. 

e) Merging file 

After selection, all saved data are merged into a large file in sequence; 

3.6.1.2 Calling back files 

1) Calling back status and calibration data: 

f) sta file 

The sta file saves the instrument status data, including instrument settings, trace data, limit lines, 

and cursors. 

g) cal file 

The cal file only saves the calibration data and does not contain instrument status data. The 

correction accuracy of the calibration data is related to the instrument status settings. To obtain the 

highest measurement accuracy, make sure that the instrument settings at the time of writing file 

back are the same as those at the time of calibration, otherwise the accuracy of calibration cannot 

be guaranteed. 

h) cst file 

The cst file saves all measurement status and calibration data of the instrument. It will save the 

testing time by calling the cst file. 

2) How to call back files: 

Path of Menu: clicking [File] → [call back...], displays the Open dialog. 

Select the type of file to be loaded in the [File type] box. 

Set the directory of the call back file from the [Find Scope] box and the [File List] box below. 

 

 

Fig. 3.67 Calling back file 

How to load the call back file: 

i. Double-click the call back file in the [File List] box. 
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ii. Click the call back file in the [File List] box and then click the [Open] button. 

iii. Enter the file name of the call back file in the [File name] box and click the [Open] button. 

3.6.1.3 Data file 

Measurement data will be saved in ASCII format, which can be edited using text editing software, 

spreadsheet software, but cannot be called up by the analyzer itself. The analyzer saves data files 

in the following three types: 

1) dat file 

A dat file stores the measurement data of the active trace or all traces with its data stored in a 

formatted or unformatted form, which is defined via the Data Save Settings dialog. 

How to save a dat file: 

a) Path of Menu: clicking [File] → [Save As...], which will display the Save As dialog. 

b) Set the type of the file to be saved as the data file (*.dat) in the [Save as type] box. 

c) Set the directory where file is saved with the [Save in:] box and the [File List] box. 

d) Set the name of the file to be saved in the [File name] box. 

e) Click the [Save] button to display the Data Save Settings dialog. 

f) Set the content and format of the file to be saved in the dialog, click the [Formatted Data] or 

[Nonformatted] button to save the data file, and close the dialog. 

 

Fig. 3.68 Data Save Settings dialog 

Data holding area 

The Data Holding Area defines which trace data will be saved to a file. 

a) [Default] single checkbox 

Save the data of activated traces from all the windows. 

b) [One trace] single checkbox 

Save the data of activated traces from current window. 

c) [Window trace] single checkbox 

Save the data of all activated traces from current window. 

d) [All traces] single checkbox 

Save the data of all activated traces. 

Save type area 

a) [Auto] single checkbox 
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Save the trace data in the actual displayed format. 

b) [Log format] single checkbox 

Save the trace data in the logarithmic magnitude format. 

c) [Linear format] single checkbox 

Save the trace data in the linear magnitude format. 

d) [Real Quantity Format] single checkbox 

Save the trace data in the real quantity format. 

e) [Imaginary Quantity Format] single checkbox 

Save the trace data in the imaginary quantity format. 

[Formatted Data] button 

Save the trace data in the format set in the Save Format area. 

[Nonformatted Data] button 

Save the trace data as the real/imaginary quantity format. 

2) snp (s1p and s2p) file 

Files with snp format can be called by computer-aided engineering (CAE) software (such as 

Agilent's ADS). It is a data output file, but it cannot be called by the analyzer itself. The s1p file 

contains the characteristics of a single-port device and incorporates only 1 S parameter (i.e. S11 or 

S22), while the s2p file contains the characteristics of a dual-port device and incorporates 4 S 

parameters. If the full dual-port correction is enabled, all 4 S parameters will be saved in the s2p 

file. If the full dual-port correction is disabled, the analyzer will save as much of the measurement 

data as possible in the s2p file. For example, if the full dual-port correction is disabled, the current 

active trace is S11, while there are also S21 measurements in the channel, the measurements of S11 

and S21 will be saved in the s2p file, because there are no valid measurements of S22 and S12, and 

the corresponding data in the s2p file is 0. 

The snp file will be saved as follows: 

a)  Path of Menu: clicking [File] → [Save] →[Save As...], which will display the Save As 

dialog. 

b)  Set the type of the file to be saved as the data file (*.dat) or the data file (*.s2p) in the 

[Save as type] box. 

c)  Set the directory where file is saved with the [Save in:] box and the [File List] box. 

d)  Set the name of the file to be saved in the [File name] box. 

e)  Click the [Save] button to save the data. 

3) prn file 

The prn file contains the measurement data of the activated traces in rows and columns. Each row 

corresponds to a measurement point, the first column corresponds to the measured excitation value, 

the second column corresponds to the measured response value, and the columns are separated by 

commas (,). The data will be saved in the following format: 

S11            Log Mag 

LIN_SWEEP(Hz)   ， LOG_FORMAT(dB) 

3.000000e+005  ， -9.232986e+000 
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7.502250e+008  ， -3.219671e-001 

1.500150e+009  ， -6.892332e+000 

2.250075e+009   ， -1.146303e+000 

3.000000e+009   ， -1.245240e+001 

How to save a prn file: 

Path of Menu: clicking [File] → [Save] → [Save As...], which will display the Save As dialog. 

Set the type of the file to be saved as the data file (*.prn) in the [Save as type] box. 

Set the directory where file is saved with the [Save in:] box and the [File List] box. 

Set the name of the file to be saved in the [File name] box. 

Click the [Save] button to save the file and close the dialog. 

3.6.2 Print measurements 

The analyzer supports the output of the measurement display via printer or printing to a specified 

file. The printer can be either local or network type using parallel, serial or USB interfaces, as long 

as the printer is added through the Windows operating system. 

3.6.2.1 Printing page setup 

How to setup the printing pages 

Path of Menu: clicking the [File] → [Print] → [Page Setup] to display the Page Setup dialog. 

 

Fig. 3.69 Setup printing pages 

Page setup dialog 

1) Window information area 

a) [Print] checkbox 

Prints window track information if it is checked, and does not print when cleared. The following 

two checkboxes are only valid if this checkbox is selected: 

b) [Print One Window Per Page] checkbox 

If it is selected, only one window is printed on each page, and if it is cleared, the contents of all 

windows are printed continuously without page breaks. 
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c) [Print Active Window] single checkbox 

Print current active window when it is checked. 

d) [Print All Windows] single checkbox 

Print current active window when it is checked. 

2) Other information chart area 

a) [Print] checkbox 

Print the channel setting information when it is checked, and the checkbox below is valid when it 

is selected; 

b) [Segment Table], [Limit Table], [Cursor Table], [Channel Status], and [Time] 

checkboxes. 

Print the corresponding information when they are selected. 

3) [Print Windows and Other Information Separately] checkbox 

The window and other information are printed separately if it is selected and will be printed in a 

combined manner when they are cleaned. 

3.6.2.2 Print 

After the printer is added and the print content is set in the analyzer, the measurement information 

can be output through the printer as follows: 

Path of Menu: clicking the [File] → [Print] → [Printing...] to display the Print Setting dialog. 

 

Fig. 3.70 Printing measurement information 

3.6.2.3 Print to files 

The analyzer supports outputting the printed content to a bitmap (bmp) file. If multiple pages are 

needed for printing, it will automatically create multiple bitmap files each corresponding to one 

page, and the other files are identified by 'file name (number).bmp', such as amp.bmp, 

amp(1).bmp, amp(2) .bmp, which are printed as follows. 

On menu: [File] → [Print] → [Print to file...] . 

Set the directory and file name where the file is stored in the dialog. 

Click the [Save] button to store the file. 
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4 Measurement Setting 

This chapter mainly describes the operation of 3672 series network analyzers in measurement, 

creation of the measurement of the known state by analyzer resetting, selection of 

measurement setting, adjustment of the analyzer display so as to better observe measurement 

results, specifically including: 

● Resetting of analyzer………………………………………………………………………...93 

● Selection of measurement parameter………………………………………………………...98 

● Setting of frequency range………………………………………………………………….102 

● Setting of signal power level……………………………………………………………….103 

● Setting of sweep……………………………………………………………………………106 

● Trigger mod……………………………………………………………………………...…110 

● Setting of data format and scale……………………………………………………………117 

● Observation of multiple traces and opening of multiple channels…………………………121 

● Setting of analyzer display…………………………………………………………………124 

4.1 Resetting of Analyzer 

● Default reset state……………………………………………………………………………93 

● User reset state………………………………………………………………………………96 

● Resetting of analyzer……………………………………………………………...…………97 

4.1.1 Default Reset State 

Press the [Reset] on the front panel to return to the known default state, i.e. reset state. The 

reset state is set as follows: 

1) Measurement parameter: S11 

2) Frequency setup: 

a) Start frequency: 10MHz 

b) Stop frequency: 13.5GHz/26.5GHz/43.5GHz/50GHz/67GHz 

c) CW frequency: 2GHz 

3) Power setup: 

a) Test port power: -5dBm 

b) Coupling port power: open 

c) Attenuation: auto 

d) Attenuation values: 0dB 

e) Power slope: closed 

f) Slope: 0dB/GHz 

4) Sweep setup: 
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a) Sweep type: linear frequency 

b) Sweep time: automatic 

c) Number of sweep points: 201 

5) Segment sweep setup: 

a) Number of open segments: 1 

b) Start frequency: 10MHz 

c) Stop frequency: 13.5GHz/26.5GHz/43.5GHz/50GHz/67GHz 

d) Number of points: 21 

e) Power: -5dBm 

f) Intermediate frequency bandwidth: 1kHz 

6) Trigger setup: 

a) Trigger source: internal 

b) Trigger type: continuous sweep 

7) Display format: 

Format: logarithmic amplitude 

The details of various formats are shown in Table 4.1. 

Table 4.1 Default Format Setting of 3672 Series Vector Network Analyzers 

Format Scale Reference 

position 

Reference 

value 

Logarithmic 

amplitude 

≤10 dB 5 0dB 

phase 45o 5 0o 

Group delay 10ns 5 10fs 

Linear amplitude 100mU 5 500mU 

Standing wave ratio 1U 5 6U 

Real part 2U 5 0U 

Imaginary part 2U 5 0U 

Polar coordinate 1U None 1U 

Smith chart 1U None 1U 

8) Response setup: 

a) Number of channels: 1 

b) Intermediate frequency bandwidth: 1kHz 

c) Average: closed 

d) Average factor: 1 

e) Smoothing: closed 

f) Smoothing factor: 2.49% of the value range 

g) Electrical delay: 0s 
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h) Velocity factor: 1 

i) Phase shift: 0° 

j) Track display: data 

9) Calibration setup: 

a) Correction: closed 

b) Interpolation: open 

c) Calibration type: none 

d) Calibration kit number: current calibration kit number 

e) System impedance: 50Ω 

f) Port extension: closed 

g) Port extension value: 0s 

10) Marker setup: 

a) Initial frequency: full range of center frequency 

b) Reference marker R: closed 

c) Discrete marker: closed 

d) Format: trace format 

e) Type: standard 

f) Marker search type: minimum 

g) Search range: full bandwidth 

h) Marker table: empty 

11) Limit test setup: 

a) Limit test: closed 

b) Limit line display: closed 

c) FAIL sound warning: closed 

12) Limit table setup: 

a) Type: OFF 

b) Initial stimulus: 10MHZ 

c) Stop stimulus: 13.5GHz/26.5GHz/43.5GHz/50GHz/67GHz 

d) Initial response: -100dB 

e) Stop response: 100dB 

13) Time domain transformation setup (optional): 

a) Time domain transformation: closed 

b) Transformation mode: bandpass 

c) Transformation start: -5ns 
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d) Transformation end: 5ns 

e) Kaiser window β factor: 6.0 

f) Gate state: closed 

g) Gate start value: -5ns 

h) Gate stop value: 5ns 

i) Gate shape: standard 

j) Gate type: bandpass 

14) Full display setup: 

a) Track state: open 

b) Frequency/stimulus: open 

c) Marker reading: open 

d) State bar: closed 

4.1.2 User Reset State 

The analyzer can be reset into the known default state or user-defined state. In the default 

mode, the analyzer is reset into the default state. It can be reset into the user-defined state by 

means of setting. Specific steps of setting the user reset state are as follows. 

1) Menu path: [System] > [Define User State...]. Then the [Define User State...] dialog box 

will appear. 

2) Click [Enable User Reset State] and tick the check box. 

Notes: a) If you tick [Save final state as user preset], the final state before exiting the 

program will be saved as the user reset state. 

b) Click [Save current state as user state]. Then the current settings of the analyzer will be 

saved as the user reset state. 

c) To use the known state, click [Load exist file as user reset state]. Select the state in the 

dialog box, and open the file. Then the selected file will be used as the user reset state file of the 

analyzer. 

 

Fig. 4.1 Definition of User Reset State 
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4.1.3 Resetting of Analyzer 

Menu path: [System] > [Preset] 

If the user reset state has been set, click [Preset]. 

 

Fig. 4.2 Resetting of Analyzer 
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Prompt 

[Reset] shortcut key 

The [Reset] shortcut key is set in the functional key zone and shortcut menu bar. 

4.2 Selection of Measurement Parameter 

The following parameters can be set in an 3672 series vector network analyzer to measure the 

electrical characteristics of devices. 

 S parameter (fixed ratio) 

 Any ratio (custom ratio for measurement) 

 Non-ratio power measurement (absolute power measurement) 

● S parameter ················································································································································ 98 

● Any ratio ·················································································································································· 100 

● Non-ratio power measurement ·················································································································· 101 

● Change of trace measurement type ··········································································································· 102 

4.2.1 Parameter S 

1) Overview of Parameter S 

The parameter S (scattering parameter) is used to describe the change of input signal and the 

reflection and transmission characteristics of the DUT. The S-parameter is shown in the prescribed 

digit row, and indicates the proportion of two complex vectors, i.e. Soutput/input, including the 

amplitude and phase information. The output refers to the output signal port number of the DUT, 

and the input refers to the input signal port number of the DUT. The analyzer is equipped with 

four test ports to test single-port, double-port, three-port and four-port devices. 

For example, when one double-port device is connected to Port 1 and 2, four parameters (S) 

can be measured at the same time. 

In this case, the four parameters (S) of the double-port device are respectively S11, S12, S21 

and S22. Fig. 4.3 further shows the parameter S, where: 

 a refers to the stimulus signal from the input to DUT. 

 b refers to the reflection and transmission signal (response signal) of the DUT. 

The parameter S is a plural linear value. The measurement accuracy depends on the 

indicators of the calibrator and the adopted technology of measurement connection, and is 

also associated with the connection of the non-measurement port (non-excited port). 

2) Application of parameter S 

The following parameters can be measured with S. 

a) Reflection measurement: SXX (X=1, 2, 3, 4) 

i. Return loss 

ii. Standing wave ratio (SWR) 

iii. Reflection coefficient 

file:///C:/Users/guozhenxing/Desktop/3672%20Series%20Vector%20Network%20Analyzer%20User%20Manual.docx%23_4.2.1_Parameter_S
file:///C:/Users/guozhenxing/Desktop/3672%20Series%20Vector%20Network%20Analyzer%20User%20Manual.docx%23_4.2.1_Parameter_S
file:///C:/Users/guozhenxing/Desktop/3672%20Series%20Vector%20Network%20Analyzer%20User%20Manual.docx%23_4.2.2_Any_Ratio
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iv. Impedance 

v. S11, S22, S33 and S44 

b) Transmission measurement: SXY (X=1, 2, 3, 4; Y=1, 2, 3, 4; X≠Y) 

i. Insertion loss 

ii. Transmission coefficient 

iii. Gain 

iv. Group delay 

v. SXY 

The measurement of the double-port device with Port 1 and 2 is taken as an example below 

to introduce the parameter S. 

 

Fig. 4.3 Definition of Parameter S 

3) New S measurement trace 

Menu path: [Trace] > [New Trace]. Click the S-parameter in the dialog box. 
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Fig. 4.4 Definition of Parameter S 

4) [New Trace] dialog box 

a) [Parameter selection] zone 

Select the S parameter measurement trace to be created. 

b) [Receivers] button 

Open the dialog box to create any ratio or non-ratio power measurement trace. 

c) [Balance parameter] button 

Open the dialog box to create the balance parameter measurement trace. 

d) [Channel Number] box 

Select the channel where the new trace is located. 

e) [Create in new window] check box 

If this check box is selected, a trace will be created in the new window. If this check box is 

cleared, a trace will be created in the current active window. 

4.2.2 Any Ratio 

The input signal and reference signal are selected from the receiver A, B, C, D, R1, R2, R3 or 

R4 for ratio measurement. 

1) Create measurement trace of any ratio 

Menu path: [Trace] > [New Trace]. Click “Receivers” in the dialog box. 
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Fig. 4.5 Definition of S-Parameter 

4.2.3 Non-ratio Power Measurement 

The absolute power of the receiver A, B, C, D, R1, R2, R3 and R4 can be measured in the 

non-ratio power measurement mode, however, the phase, group delay and other items under 

the “average” function cannot be measured. 

1) New non-ratio power measurement trace 

Menu path: [Trace] > [New Trace]. Click “Receivers” in the dialog box. 

2) [New Trace] dialog box (any ratio and non-ratio power measurement) 

a) [Active] check box 

Tick it to create a new trace. 

b) [Numerator] zone 

Select the numerator of any ratio measurement or the receiver for non-ratio power 

measurement. 

c) [Denominator] zone 

Select the denominator of any ratio measurement. The value is 1 in non-ratio power 

measurement. 

d) [Source] box 

Select the source signal output port of the analyzer. 

e) [Channel Number] box 

Select the channel for the new trace. 

f) [Create in new window] check box 

If this check box is selected, a trace will be created in the new window. If this check box is 
cleared, a trace will be created in the current active window. 
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g) [Auto-Create Window] check box 

If this check box is ticked and the number of traces in the window exceeds 8, excessive traces 

will be automatically created in a new window. 

If this check box is cleared and the number of traces in the window exceeds 8, excessive 

traces will not be created. 

4.2.4 Measurement mode of trace change 

The trace must be activated before setting and modification. 

1) Change the trace state 

Click the [Track state] button in the window. The corresponding trace will be activated. 

 

Fig. 4.6 Change of Track Activation State 

2) Change the measurement parameter of active trace 

Menu path: [Response] > [Measure]. The measure sub-menu will appear. Or, right-click the 

trace title bar, and click [Measure] in the menu, as shown in Fig. 4.7. 

 

Fig. 4.7 Setting of Parameter S Measurement Mode of Activated Trace 

4.3 Setting of Frequency Range 

Frequency range: 10MHz-13.5GHz/26.5GHz/43.5GHz/50GHz/67GHz 

Frequency resolution: 1Hz 

1) Two ways of frequency range setting 

a) Specify the start and stop frequency. 

b) Specify the center frequency and frequency span. 

2) Setting of start and stop frequency 

Menu path: [Stimulus] > [Freq] 
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Fig. 4.8 Setting of Start and Stop Frequency 

3) Setting of center frequency and frequency span 

Menu path: [Stimulus] > [Freq] 

 

Fig. 4.9 Setting of Center Frequency and Frequency Span 

Prompt 

[Frequency] shortcut key 

The frequency can be rapidly set with the [Frequency] shortcut key in the functional key zone of the front 

panel. 

4.4 Setting of Signal Power Level 

The power level refers to the power level of the output signal of the test port. The power level 

indicators of the port of 3672 series vector network analyzer are as follows. 

Table 4.2 Power Level Indicators of Source Output Signal 

Frequency range Source frequency 

range (dBm) 

Configuration 

10MHz ~ 

13.5GHz/26.5GHz/43.5GHz/50GHz/67GH

z 

-25 ~ +20 Standard 

configuration 

10MHz ~ 13.5GHz/26.5GHz -95 ~ +20 Option: 

program-controlled step 

attenuator 

10MHz ~ 43.5GHz/50GHz -85 ~ +20 Option: 

program-controlled step 

attenuator 

10MHz ~ 67GHz -75 ~ +20 Option: 

program-controlled step 

attenuator 

 

1) Setting of power level 

Menu path: [Stimulus] > [Power]. Also, the [Power] shortcut key is set in the functional 

key zone of the front panel and the shortcut menu bar. 
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Fig. 4.10 Setting of Power Level 

2) Cutoff of port power 

Menu path: [Stimulus] > [Power] > [Power ON/off]. Or, switch the power by changing the 

setting of the [Power ON/off] check box in the [Power setting] dialog box. 

3) Manual setting of attenuation 

Menu path: [Stimulus] > [Power] > [Power and Attenuators...]. The [Power and 

Attenuators] will appear. Click to clear the [Auto] zone check box. Click the [Attenuation] input 

box and enter the attenuation value. 

4) Setting of power slope 

Menu path: [Stimulus] > [Power] > [Power...]. The [Power] dialog box will appear. Click 

[Slope] check box. Click the [Slope] input box and enter the power slope. 

5) [Power] dialog box 

a) [Power ON/off] check box 

If this check box is ticked, the port will normally output the power. If this check box is 

cleared, the port output power will be cut off. 

b) [Power-port 1] 

Set the power level of the port 1. 

c) [Channel Power Slope] check box 

Tick the [Channel Power Slope] check box and enter the slope value in the [Slope] input 

box to enable the power slope function. 

The power slope is used to compensate the power loss of the cable and test fixture as a result 

of frequency increase. 
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 If the power slope function is enabled, the output power of the test port will increase (or 

decrease) with the increase of sweep frequency. 

 Unit of power slope: dB/GHz. 

 Power slope setting range: -2 to +2. 

6) [Power and Attenuator] dialog box 

a) [Power ON/off] check box 

If this check box is ticked, the port will normally output the power. If this check box is 

cleared, the port output power will be cut off. 

b) [Port Powers Coupled] check box 

If the [Port Powers Coupled] check box is ticked in the default mode, the power level 

settings of two ports of the analyzer will be identical. However, different power levels are required 

for ports in some measurement applications. For example, the power of each port must be set 

separately to measure the gain and reverse isolation of one high-gain amplifier, as the power of the 

input port of the amplifier is lower than that of the output port. If the [Port Powers Coupled] 

check box is cleared, the power level of each port can be set separately in the analyzer. 

c) [State] bar 

It is [Auto] in the default mode. In this case, the power ON/OFF state can be switched 

according to the measurement needs. [ON] indicates the port power is always ON, while [OFF] 

indicates the port power is always OFF. 

d) [Port Power] bar 

Set the port power. 

e) [Automatic] bar 

If this check box is ticked, any power level can be set within the allowable range of the 

instrument. If this check box is cleared, the source power and attenuation can be set manually 

for certain measurement, such as the reflection amplifier (oscillator or unsteady-state 

amplifier) measurement. In this case, the matching source impedance (better than the return 

loss of 20dB) should be set within a wide frequency range. 

f) [Attenuator] bar 

Set the attenuator. 

g) [Leveling Mode] bar 

Set the leveling mode, including [Internal], [Receiver] and [Open loop]. The amplitude is 

not fixed in the [Open loop] mode. 

h) [Channel Power Slope] check box 

Tick the [Channel Power Slope] check box and enter the slope value in the [Slope] input 

box to enable the power slope function. The power slope is used to compensate the power loss of 

the cable and test fixture as a result of frequency increase. 

 If the power slope function is enabled, the output power of the test port will increase (or 

decrease) with the increase of sweep frequency. 

 Unit of power slope: dB/GHz. 

 Power slope setting range: -2 to +2. 

i) Attenuator Settings and power range 
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The programmable attenuator is used to cover the whole power range. It can adjust the power 

level of the DUT while the power level of the reference path of the analyzer remains 

unchanged. Thus, higher accuracy and characteristic indicates and more accurate matching of 

source output signals can be realized. 

The fully accurate error correction can be done at the power point for measurement 

calibration. If the power level is changed in the same attenuator settings as those of 

measurement calibration, the accuracy of error correction is higher in ratio measurement but 

poorer in non-ratio measurement. 

4.5 Setting of Sweep 

Sweep refers to the process of continuously measuring data points according to the stimulus 

values in the specified sequence. 

● Overview of sweep types……………………………………..…………………………………………………...106 

● Setting of sweep type………………………………………………………….….…………………………………107 

● Sweep time…………………………………………………………………………….…………………………….……109 

● Sweep setting………………………………………………………………………….…………………………………109 

4.5.1 Overview of Sweep Types 

The network analyzer supports six sweep types shown below. 

1) Linear frequency 

This is the default sweep type of the instrument. The whole frequency range is covered 

continuously by the frequency linearity. 

2) Logarithmic frequency 

In the logarithmic frequency mode, the source frequency increases in logarithmic steps, and 

the frequency ratio of every two adjacent frequency points is identical. 

3) Power sweep 

The power is swept at the point frequency. The maximum sweep range is 50dB. The default 

frequency sweep range is -25dBm to +20dBm. 

4) Point frequency 

In the point frequency sweep mode, a single sweep frequency is set in the analyzer, 

measurement data are accurately and continuously samples at the intervals determined 

according to the sweep time and the number of measurement points, and changes of 

measurement data with time are displayed. 

5) Segment sweep 

Segment sweep aims to start sweep of several segments. The power level, intermediate 

frequency bandwidth and sweep time of each segment can be set independently. After 

calibration of all segments, one or several segment(s) can be measured according to the 

calibrations. Segments are defined according to the frequency increase sequence, and the 

frequency range must be prevented from overlapping. The attenuator settings of the power 

levels of all segments must be identical to prevent damage caused by frequent switching of 

the attenuator. If the attenuator settings of the current segment and defined segment are 

different, the analyzer will automatically change the power level and attenuator settings of 

the defined segment. 

6) Phase sweep 
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Sweep the phase of one or several source(s) relative to another source. The measured value is 

-360° to +360°. 

4.5.2 Setting of Sweep Type 

1) Setting of sweep type 

Menu path: [Stimulus] > [Sweep] > [Sweep Type]. 

Select the corresponding sweep type in the auxiliary menu bar or in the [Setting of sweep 

type] dialog box. 

 

Fig. 4.11 Setting of Linear Frequency Sweep Type 

2) Setting of segment sweep type 

Menu path: [Stimulus] > [Sweep] > [Sweep Type]. 

Auxiliary menu bar: click [Segment Sweep] or select [Segment Sweep] in the [Sweep Type] 

dialog box. 

 

Fig. 4.12 Setting of Segment Sweep Type 
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Dialog box setting instructions: 

a) [Independent Power Levels] check box: tick it to set the independent power level of each 

segment. In this case, the attenuator settings must be identical. 

b) [Independent IF Bandwidth] check box: tick it to set the independent intermediate 

frequency bandwidth of each segment. 

c) [Independent Sweep Time] check box: tick it to set the independent sweep time of each 

segment. 

d) [Show Table] button: click it to create and edit the sweep table. 

e) [Hide Table] button: click it to hide the segment sweep table. 

3) Segment insertion and deletion 

Only the displayed segment table can be edited. 

Menu path: [Stimulus] > [Sweep] > [Segment Table] > [Show Table]. The segment table 

sub-menu will appear. 

Tick [Show Table] in the segment table sub-menu. Click [Insert Segment] in the segment 

table sub-menu to add a new segment in front of the selected segment. Click [Delete Segment] in 

the segment table sub-menu to delete the selected segment. Click [Delete All Segments] to delete 

the whole segment table. 

 

 
Fig. 4.13 Segment Insertion and Deletion 

4) Editing of segment table 

a) Double-click the [State] box of the segment and select “ON” or “OFF” to open or close the 

segment. 

b) Double-click the [Start] box of the segment and enter the start frequency of the segment. 

c) Double-click the [Stop] box of the segment and enter the stop frequency of the segment. 

d) Double-click the [Points] box of the segment and enter the number of sweep points of the 

segment. 

e) Double-click the [Power Level] box of the segment and enter the power level of the 

segment (the independent power level option is opened). 

f) Double-click the [IF Bandwidth] box of the segment and enter the intermediate frequency 

bandwidth of the segment (the intermediate frequency bandwidth option is opened). 

g) Double-click the [Sweep Time] box of the segment and set the sweep time (the 

independent sweep time option is opened). 
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4.5.3 Sweep Time 

After setting of measurement, the minimum sweep time will be adopted by the analyzer. The 

sweep time can be increased to meet certain requirements of measurement. If the sweep time 

is set as 0, the minimum sweep time will be adopted automatically by the analyzer. If the 

sweep is no less than 300ms, a sweep indicator will be displayed on the analyzer, indicating 

the point-to-point measurement sweep. The measurement indicator is a small upward arrow, 

showing the point at which measurement is just completed on the trace. 

1) Setting of sweep time 

Menu path: [Stimulus] > [Sweep] > [Sweep Time...]. The dialog box of sweep time will 

appear. 

Enter the sweep time directly in the [Sweep Time] box. For setting of the sweep time with 

the keys and auxiliary menu bar, directly enter the sweep time in the input toolbar. 

 

Fig. 4.14 Setting of Sweep Time 

4.5.4 Setting of Sweep 

1) Sweep setting 

Menu path: [Stimulus] > [Sweep] > [Sweep Setup...]. The [Sweep Setup] dialog box will 

appear. 
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Fig. 4.15Sweep Setting 

2) [Sweep Setup] dialog box 

a) [Channel] box 

Select the channel applicable to sweep setting. 

b) [Stepped Sweep] check box 

In the step sweep mode, the source is tuned to a frequency point and the frequency point is 

measured after the specified dwell time. Then the source is tuned to next frequency point. A device 

of long electrical delay can be accurately measured. If this check box is cleared, the analyzer may 

work in the analog sweep or step sweep mode, depending on the setting of the sweep time and 

intermediate frequency bandwidth. 

c) [Dwell time] input box 

Set the dwell time at each point before obtaining the measurement data. This is only 

applicable to the step sweep mode. 

d) [Sweep Delay] input box 

Set the waiting time of the analyzer before obtaining the measurement data. It refers to the 

delay before measurement of the first point. 

e) [Fast Sweep] check box 

If the [Fast Sweep] check box is selected, analog sweep will be started. Data are collected in 

the sweep process, thus reducing the waiting time of sweep. 

4.6 Trigger Mode 

The trigger signal is used to enable measurement sweep of the analyzer. The sweep mode and 

time to stop sweep and return to the holding state are determined by trigger settings. The 

vector network analyzer has high flexibility in trigger setting. 

● Simple trigger setting……………………………………………………………………………………….…………109 

● Detailed trigger setting…………………………………………………………………………………………………111 

● [Trigger] dialog box………………………………………………………………………………………….…………112 

4.6.1 Simple Trigger Setting 

Only the trigger mode of the current active channel can be set by simple trigger setting. 

Menu path: [Stimulus] > [Trigger]. The trigger sub-menu will appear. 

Click [Continuous], [Single] or [Hold] in the sub-menu and select the trigger mode. 
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Fig. 4.16 Simple Trigger Setting 

4.6.2 Detailed Trigger Setting 

Menu path: [Stimulus] > [Trigger] > [Trigger...]. The trigger dialog box will appear. 

 

Fig. 4.17 Trigger Sub-menu 



4 Measurement Setting 

4.6 Trigger Mode 

112  

 

 

Fig. 4.18 Trigger Setting Dialog Box 

4.6.3 [Trigger] Dialog Box 

1) Trigger setting options 

a) Trigger source zone 

The source of the channel trigger signal is determined by trigger source setting of the trigger 

source zone. The effective trigger signal is generated when sweep is not done by the vector 

network analyzer. Three trigger sources can be selected: internal, manual and external. The set 

trigger source will be used as the trigger source of all channels. 

 [Internal] (default) 

1) Trigger signal generation is controlled automatically by the analyzer. 

2) One trigger signal is generated immediately after one measurement. 

 [Manual] 

The manual trigger signal is generated in the following methods. 

1) Click the [Manual] button in the [Trigger] dialog box. 

2) Click the [Manual item in the [Trigger] sub-menu under the [Stimulus] menu of the 

menu bar. 

 [External] 

1) The trigger signal is input by [External] of the BNC connector on the rear panel. 

2) The signal is TTL level. 

3) Level trigger: the high or low level can be set in the [External] dialog box. 

4) The pulse width is 1μs at and must not be longer than the sweep time (otherwise, the 
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trigger may be enabled several times). 

b) Range zone 

The measurement channel receiving the trigger signal is determined by trigger range setting. 

Two types of trigger range can be set: global and channel. 

 [Global] 

This is the default setting of the analyzer. Except the channel in the holding mode, all 

channels can receive the trigger signal. 

 [Channel] 

Next channel which is not in the holding mode will receive the trigger signal. After the 

current channel is measured, next channel will be selected automatically. Except the channel in the 

holding mode, all channels will be selected in sequence. The trigger source should be set in the 

manual mode to make the above setting effective. Set the [Channel] to enable the spot sweep 

function. 

c) Trigger setting zone 

The number of trigger signals to be received by one channel is determined by trigger setting. 

Four channel triggering states are provided: 

 [Continuous] 

The channel will receive a number of trigger signals. Sweep will be done continuously. 

 [Groups] 

The channel will only receive the trigger signals, the number of which is set in the [Group] 

input box. Sweep will be done for the set times, and then the channel will enter the holding mode. 

 [Single] 

The channel will receive one trigger signal. Sweep will be done once, and then the channel 

will enter the holding mode. 

 [Hold] 

The channel will not receive the trigger signal, and sweep will be stopped. 

 [Spot] ([Trigger mode] check box) 

The spot sweep mode can be selected only when the trigger source is manual or external 

and the trigger range is the channel. In the spot sweep mode, next data point will be measured in 

sweep after the channel receives the trigger signal. The channel will continuously receive the 

trigger signal until all measurements in the channel are done. Then next channel which is not in 

the holding mode will be triggered. 

 [Channel] ([Trigger mode] check box) 

All traces in the channel will be triggered. 

 [Sweep] ([Trigger mode] check box) 

The sweep trigger mode can be selected only when the trigger source is manual or 

external and the trigger range is the channel. The traces sharing one source port in the channel 

will be triggered. 

2) Measurement Trigger options 

a) Main trigger input zone 
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Set the nature of the external trigger signal to be received in the trigger input zone. 

 [Global/channel Trigger Delay] 

[Delay]: Enter the delay time in the delay input box. When the instrument receives the 

external trigger signal, sweep will be started after the delay time. 

 [Source] 

Set the external trigger signal input interface, including the BNC interface and automatic test 

interface (18-pin). 

 [Level/Edge] 

Set the trigger mode of the external trigger signal, including high level, low level, rising edge 

and falling edge. 

 [Accept trigger before armed] 

If this item is ticked, corresponding sweep will be executed immediately after the vector 

network analyzer receives the trigger signal; otherwise, all the received trigger signals will be 

ignored. 

 [Ready for Trigger Indicator] 

The trigger READY signal is sent by the BNC interface and automatic test interface (21-pin). 

High level and low level of the signal are optional. 

 

Fig. 4.19 Measurement Trigger Dialog Box 

3) Auxiliary 1/2 trigger option 

a) Auxiliary trigger output zone 

 [Enable] 

Tick the check box to open the external trigger output of the corresponding channel; 

otherwise, the external trigger output will be closed. 

 [Polarity] 
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Set the polarity of the trigger output signal in the radio box: [Positive pulse] or [Negative 

pulse]. 

 [Position] 

Set the time to send the trigger output signal in the radio box: [Before data capturing] or 

[After data capturing]. 

 [Pulse Duration] 

Input the pulse duration of the trigger output signal in the input box. 

 [Enable Wait-for-Device Handshake] 

If this check box is ticked, data will not be captured until the vector network analyzer 

receives the specific level from the auxiliary trigger input (1&2) connector of the rear panel. 

This signal indicates that the external device is ready and the network analyzer is allowed to 

capture data. Otherwise, the network analyzer will not wait. However, a trigger signal will be sent 

when the network analyzer is ready. This signal cannot be used to trigger the network analyzer. It 

is generated by the internal, manual or external source. 

 [Aux Trig] 

When the network analyzer is ready, a confirmation signal will be sent to the auxiliary 1 & 2 

connection port. The signal can be in the rising edge, falling edge, high level or low level 

form. 

 [Delay] 

When the network analyzer receives the holding signal, data will be captured after the 

corresponding delay time. 

 

Fig. 4.20 Auxiliary 1/2 Trigger Dialog Box 

4) Pulse trigger options 

a) Synchronous pulse input zone 
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Select the internal or external source to synchronize the internal pulse generator of the 

analyzer. 

 [Pulse Sync Trigger] 

1) Internal: the pulse generator is synchronized according to the periodic signal generated in 

the analyzer, and the output pulse train period is determined according to the pulse repetition 

period in the pulse measurement interface. 

2) External: the pulse repetition period specified by the user is ignored. One pulse train will 

be output once an effective external pulse synchronization signal is detected by the analyzer. The 

delay and width of the pulse generator can be set respectively in the pulse measurement interface. 

The external pulse synchronization input signal will be input through the pulse input/output 

interface of the rear panel of the analyzer. The configurable synchronization trigger signal can be 

input to the analyzer according to the pulse synchronization input signal. If the level is trigger, the 

analyzer will output a pulse train. If the level is continuously effective, the analyzer will continue 

to output another pulse train. If the edge is triggered, the analyzer will be triggered by one 

effective edge signal to output a pulse train. The pulse train length is the maximum value (delay + 

width) in all the enabled pulse generators. 

 [Level/Edge] 

Set the characteristics of the effective external pulse synchronization input signal to be 

received by the analyzer: high level, low level, rising edge or falling edge. 

b) Receiver output zone 

 [Synchronize receiver to pulse] 

It is used to measure the broadband synchronization pulse. When this function is enabled, the 

pulse generator output and data collection are allowed to be synchronized. 

 [Delay] 

Set the delay time before collection of AD data. 
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Fig. 4.21 Pulse Trigger Dialog Box 

4.7 Setting of Data Format and Scale 

The data format refers to the display of measurement data in the graphical form. Select the 

data format which is the most favorable to understand the characteristics of the DUT. This 

section introduces nine data formats and the method of scale setting so as to better display the 

measurement information. 

● Data format…………………………………………………………………………………………………………………117 

● Data format setting………………………………………………………………………………………………..……120 

● Scale………………………………………………………………………………………………………………….………120 

4.7.1 Data Format 

1) Rectangular coordinate format 

Seven of nine formats of measurement data are in the rectangular coordinate form. This 

format is also known as the Cartesian format, X/Y format or linear format and is suitable to 

display the frequency response information of the DUT. For example, the rectangular 

coordinates in Fig. 4.23 show the following information. 

 Stimulus value (frequency, power or time) in the linear scale form on the X-axis in the 

default mode. 

 Response value corresponding to the stimulus value on the Y-axis. 

 

Fig. 4.22 Rectangular Coordinate Format 

a) Logarithmic amplitude format 

 Display the amplitude information (no phase information). 

 Y-axis unit: dB 

 Applicable typical measurement: return loss, insertion loss and gain. 

b) Phase format 

 Display the phase information (no amplitude information). 
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 Y-axis unit: phase (degree) 

 Applicable typical measurement: linear phase deviation. 

c) Group delay format 

 Display the signal transmission time through the DUT. 

 Y-axis unit: time (second) 

 Applicable typical measurement: group delay. 

d) Linear amplitude format 

 Only display the positive value. 

 Y-axis: no unit (U) in ratio measurement and milliwatt (mW) in non-ratio measurement. 

 Applicable typical measurement: reflection and transmission coefficient (amplitude) value 

and time domain transformation 

e) Standing wave ratio format 

 Display the reflection measurement data calculated by the equation (1+ρ)/(1-ρ), where ρ is 

the reflection coefficient. 

 Effective in reflection measurement. 

 Y-axis: no unit. 

 Applicable typical measurement: standing wave ratio. 

f) Real part format 

 Display the real part of the measurement complex. 

 It is similar to the linear amplitude format, but both the positive value and negative value can 

be displayed. 

 Y-axis: no unit. 

 Applicable typical measurement: time domain and auxiliary input voltage for maintenance 

purposes. 

g) Imaginary part format 

 Only display the imaginary part of measurement data. 

 Y-axis: no unit. 

 Applicable typical measurement: impedance measurement in design of matching network. 

2) Polar coordinate format 

The polar coordinate format shown in Fig. 4.24 includes the amplitude and phase information. 

The vector value can be read in the following method. 

a) The amplitude of any point is determined by the displacement of this point relative to the 

central point (or zero point). In the default mode, the amplitude is a linear scale, and the 

excircle scale is set as 1. 

b) The phase of any point is determined by the angle relative to the X-axis. 

c) The frequency information can only be read through the marker. The default marker format 

includes the real part and imaginary part. The marker dialog box can be opened in the 

marker/analysis menu. Other formats can be selected in the advanced marker menu. 
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Fig. 4.23 Polar Coordinate Format 

3) Smith chart format 

Smith chart shown in Fig. 4.25 is a tool to map the reflection measurement data of the DUT 

into impedance. Each point of the chart represents the complex impedance composed of the 

real resistance (R) and virtual reactance (±jX). The resistance, reactance, equivalent 

capacitance and inductance can be read through the marker. 

 

Fig. 4.24 Smith Chart Format 

a) The horizontal axis of the center of Smith chart represents the pure resistance, and the 

center of the horizontal axis represents the system impedance. The leftmost resistance on the 

horizontal axis is zero, indicating a short circuit. The rightmost resistance of the horizontal 

axis is infinite, indicating an open circuit. 

b) The points on the intersecting circle of Smith chart and horizontal axis have the same 

resistance. 

c) The points on the tangent of Smith chart and horizontal axis have the same reactance. 

d) The reactance of the upper part of Smith chart is positive. Therefore, the upper part is the 

sensitive zone. 

e) The reactance of the lower part of Smith chart is negative. Therefore, the lower part is the 
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capacitive zone. 

4.7.2 Data Format Setting 

Menu path: [Response] > [Format]. The format sub-menu will pop up. 

 

Fig. 4.25 Setting of Data Format 

4.7.3 Scale 

The scale refers to the scale of the vertical part of the display grid. In the polar coordinate and 

Smith chart format, the scale refers to the full scale of the excircle. The display mode of 

measurement data on the screen are determined by scale and format settings. In the log 

format, the scale setting range is 0.001dB/grid to 500dB/grid. 

1) Scale setting 

Menu path: [Response] > [Scale]. The scale sub-menu will pop up. 

Set the appropriate scale, reference location and reference level by clicking the corresponding 

input zone or keys. 

 

Fig. 4.26 Setting of Scale 

2) Scale setting dialog box 
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a) Scale zone 

 [Scale] box 

Enter the set scale value. 

 [Auto] button 

Click the [Auto] button. The analyzer will automatically select the vertical scale to better 

display the active trace in the vertical grid of the screen. The stimulus value will not be affected, 

and only the scale value and reference value are changed. 

i. An appropriate scale factor will be selected so that data are displayed in 80% of the screen. 

ii. The center value of the trace on the screen will be selected as the reference value. 

 [Auto All] button 

Click the [Auto All] button. The analyzer will select appropriate scales of all traces in the 

window so that the traces are better displayed in vertical grids of the window. 

b) Reference setting zone 

 [Position] button 

The reference position refers to the position of the reference line in the rectangular coordinate 

figure. The position of the bottom line in the figure is 0, the position of the top line is 10, and 

the default value of the reference position is 5. 

 [Level] button 

The reference value refers to the value of the reference line in the rectangular coordinate 

format, and the value of the excircle in the polar coordinate and Smith chart format. The 

setting range is -500dB to +500dB in the logarithmic amplitude format. 

4.8 Observation of Multiple Tracks and Opening of Multiple Channels 

A convenient method is provided in the pre-configuration function of the analyzer for 

multi-trace, multi-channel and multi-window measurement. The analyzer has four 

preconfigured measurement settings. If one kind of setting is selected, the current trace and 

window will be closed, and a new trace and window will be created. The window 

arrangement of four pre-settings is as follows. 
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Fig. 4.27 Preconfigured Window Arrangement 

 Setup A 

Four traces will be created in Window 1: S11, S21, S12 and S22, in the logarithmic format in 

Channel 1. 

 Setup B 

Four traces will be created in four windows, in the logarithmic format in Channel 1. S11 will 

be displayed in Window 1, S21 in Window 2, S12 in Window 3 and S22 in Window 4. 

 Setup C 

Three traces will be created in three windows of Channel 1. S11 will be displayed in the 

Smith chart format in Window 1, S22 in the Smith chart format in Window 2 and S21 in the 

logarithmic format in Window 3. 

 Setup D 

Four traces will be displayed in two windows, in the logarithmic format in two channels. S11 

and S21 will be displayed in Window 1 of Channel 1, and S12 and S22 in Window 2 of 

Channel 2. 

1) Preconfigured measurement setting 

Menu path: [Response] > [Display] > [Meas Setups...]. The measurement setup dialog box 

will appear. 

Select the preconfigured measurement setting in the dialog box. 
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Fig. 4.28 Preconfigured Measurement Setting 

2) Window arrangement 

a) Several methods of window adjustment are provided in the analyzer. 

 Use the mouse to move and adjust the window. 

 Arrange the windows of the analyzer by the [Title], [Cascade], [Maximize] and [Minimize] 

items of the window menu. 

 Arrange the windows by the [Overlap 1X], [Stack 2X], [Split 3X] and [Quad 4X] items of 

the display menu. 

 Use the [Minimize], [Maximize/reduce down] and [Close] button in the top right corner of 

the window to adjust or hide the window. 

b) The display menu of the analyzer provides four kinds of window arrangement. The 

existing traces are distributed into different windows according to a certain algorithm. 

 One-window arrangement 

All traces are displayed in one window in a cascading manner. 

 Two-window arrangement 

All traces are displayed in two windows which are vertically overlapped. 

 Three-window arrangement 

All traces are displayed in three windows. Two of the three windows are arranged in the 

upper part, and the other in the lower part. 

 Four-window arrangement 

All traces are displayed in four windows which respectively cover one fourth of the screen. 
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c) Setting of window arrangement 

Menu path: [Response] > [Display]. The display sub-menu will pop up. Select the window 

arrangement mode in the display sub-menu. 

 

Fig. 4.29 Setting of Window Arrangement 

4.9 Setting of Analyzer Display 

You can use the display menu of the analyzer to display or hide the display elements and 

customize the screen. These display elements are usable for measurement observation, setting 

and modification, including the state bar, toolbar, list, measurement display, data trace, 

memory trace and title bar. 

● State bar……………………………………………………………………………………….……………………………124 

● Toolbar………………………………………………………………………………………………………………………125 

● Table………………………………………………………………………………………………….………………………127 

● Display contents………………………………………………………………….………………………………………129 

● Title bar………………………………………………………………………………………………..……………………130 

4.9.1 State Bar 

 

1) The opened state bar will be displayed at the bottom of the screen, including the following 

contents: 

 Current active channel 

 Measurement parameter of active trace 

 Mathematical operation of active trace 

 Error correction state of active trace 

 If the average function is enabled, the average factor of the current active channel and the 
average times will be displayed. 
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 If the smoothing function is enabled, the number of smoothing points will be displayed. 

 If the function of time domain transformation is enabled, “TRANSFORM: ON” will be 

displayed. 

 If the gate setting function is enabled, “GATE: ON” will be displayed. 

 GPIB state: LOCAL or REMOTE. 

 Reference (REF) signal state: INT or EXT 

2) Display of trigger status bar 

Menu path: [Response] > [Display]. Tick [Status Bar] in the display sub-menu to open the 

status bar display and clear [Status Bar] to close the status bar display. Or, press the status bar 

opening/closing item of the auxiliary menu bar to open or close the status bar. 

 

Fig. 4.30 Display of Trigger Status Bar 

4.9.2 Tool bar 

1) Six different toolbars can be displayed at the same time. Measurement can be easily 

set through the toolbar. 

a) Input toolbar 

 

Input the value through the input toolbar to set the measurement parameter. 

b) Marker toolbar 

 

Set and modify the marker, including: 

 Marker number 
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 Marker ON/OFF check box 

 Stimulus value 

 Marker function: △marker, maximum/minimum value, start/stop value and center/span 

value. 

Click the [Stimulus] value of the marker toolbar and rotate the knob on the front panel to 

change the marker position. 

c) Measurement toolbar 

 

The measurement toolbar is used to create the S parameter trace in the current active window 

or new window. If the left button of the measurement toolbar is lifted ( ), the S parameter 

trace will be created in the current active window. If this button is pressed ( ), the S 

parameter trace will be created in a new window. 

d) Sweep control toolbar 

 

The buttons of the sweep control toolbar are respectively used to set the following modes of 

the active channel in sequence: 

 Holding mode 

 Single sweep 

 Continuous sweep 

e) Stimulus toolbar 

 

f) The stimulus toolbar is used to observe, set and modify the sweep stimulus, including: 

 Start stimulus value (CW frequency in the CW mode) 

 Stop stimulus value (time in the CW mode) 

 Number of sweep points 

g) Time domain toolbar 

 Time domain ON/OFF check box 

 Gate ON/OFF check box 

 Sweep type 

 Start stimulus value 

 Stop stimulus value 

 More 

2) Trigger toolbar display 

Menu path: [Response] > [Display]. Point to the toolbar in the display sub-menu. 

Click the toolbar item to be set in the toolbar sub-menu. Tick the item to open the toolbar 
display and clear it to close the toolbar display. 
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Fig. 4.31 Trigger Toolbar Display 

4.9.3 List 

1) Display the marker, limit and segment table so that the user can observe and modify 

the settings (except the marker table). The list is displayed in the lower part of the window. 

Only one table can be displayed in each window. 

a) Marker table 

 

Fig. 4.32Marker Table 

The marker table is used to display the marker parameters, including: 

 Marker number 

 Reference marker (for relative measurement) 

 Stimulus value 

 Response value 

b) Limit table 

 

Fig. 4.33 Limit Table 

The limit table is used to display, set and modify the limit test parameters, including: 

 Type (minimum, maximum or closed) 
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 Start and stop stimulus value 

 Start and stop response value 

c) Segment table 

 

Fig. 4.34 Segment Table 

The segment table is used to display, set and modify the segment sweep parameters, 

including: 

 State (ON/OFF) 

 Start and stop stimulus value 

 Number of sweep points 

 Power level (separately set for each segment) 

 Intermediate frequency bandwidth (separately set for each segment) 

 Sweep time (separately set for each segment) 

2) Triggering of table display 

Menu path: [Response] > [Display]. Point to the [Tables] in the display sub-menu. 

Click the table to be triggered in the sub-menu. Tick this item to display the table and clear it 

to hide the table. 

 

Fig. 4.35 Triggering of Table Display 
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4.9.4 Display Contents 

1) Six kinds of measurement information can be displayed or hided so that the user can 

observe the current measurement state, including: 

 Title 

 Track state 

 Frequency/stimulus state 

 Marker display 

 Display time state 

a) Title 

One title can be set for each window. The title will be created through the title input dialog 

box, and the entered title will be displayed in the upper left corner of the window. If required, 

delete the title through the [Input] box of the title input dialog box. Click [OK] to close the 

dialog box. 

 

Fig. 4.36 Title Input Dialog Box 

b) Track state 

The trace state will be displayed in the upper left corner of each window on the screen, 

including: 

 Measured parameters 

 Format 

 Scale 

 Reference value 

The trace state button can be used to set the corresponding trace as the current active trace so 

as to set the trace. Point to the button and right-click the mouse. Delete the trace or set the 

trace scale, color and line through the right-click menu. 

c) Frequency/stimulus state 

The frequency/stimulus information will be displayed under each window on the screen. The 

display can be hided for security purposes. The following information will be displayed. 

 Channel number 

 Start stimulus value 

 Stop stimulus value 

d) Marker display 
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The marker display information includes the marker reading ON/OFF, trace marker ON/OFF, 

large font ON/OFF, leftward movement of display position, and downward movement of 

display position. The marker reading information is displayed in the upper right corner of 

each window on the screen. The following information will be displayed: 

 Marker number 

 Stimulus value 

 Response value 

e) Display time state 

If the display time is ON, the system time will be displayed in the upper right corner of the 

screen. 

2) Triggering of display items 

Menu path: [Response] > [Display]. Point to [Display Items] in the display sub-menu. 

Tick or click the auxiliary menu bar in the drop-down menu of the menu bar to display or 

hide the corresponding contents. 

 

Fig. 4.37 Triggering of Display Contents 

4.9.5 Title bar 

The title bar includes the application program title bar and window title bar, including the 

title name and window control button. Click [Hide title bar] to hide all title bars on the screen. 

In this case, the display of measurement results on the screen can be maximized. 

Triggering of title bar display 

Menu path: [Response] > [Display]. Click [Title Bars] in the display sub-menu. Tick this 

item to display the title bar and clear it to hide the title bar. 
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5 Menu 

The menu is used to operate and set the vector network analyzer. 3672 series vector network 

analyzers are configured with a complex menu system and setting dialog boxes under the 

menus at all levels. Be familiar with the menu system of the network analyzer to facilitate 

operation. The menu system of 3672 series vector network analyzers is divided into the main 

menu, primary menu, secondary menu, etc. The analyzer can be directly and partially set and 

operated through the menus at all levels. The setting and input dialog boxes under the menus 

at various levels should be opened for some settings and operations. 

● Menu structure……………………………………………………….…………..…………130 

● Menu description……………………………………………………………………………150 

5.1 Menu structure 

The menus at various levels are as follows: 

● File………………………………………………………………………………………………………………….….…….132 

● Track……………………………………………………………………………………………………………….…….….133 

● Channel………………………………………………………………………………………………………….………….134 

● Stimulus…………………………………………………………………………………………………………..………..135 

● Response………………………………………………………………………………………………………….…….….138 

● Calibration……………………………………………………………………………………………………….……..….142 

● Marker……………………………………………………………………………………………………………….…..….143 

● Analysis………………………………………………………………………………………………………………....….146 

● System………………………………………………………………………………………………………………..….….149 

● Help………………………………………………………………………………………………………….…………...….151 
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5.1.1 File 

 

Note: Press the menu with an ellipsis (...) to open the corresponding dialog box, the same 

below. 

Fig. 5.1 File Menu 
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5.1.2 Track 

 

Fig. 5.2 Track Menu 
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5.1.3 Channel 

 

Fig. 5.3 Channel Menu 
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5.1.4 Excitation 

 

Fig. 5.4 Excitation Menu I 
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Fig. 5.5 Excitation Menu II 
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Fig. 5.6 Excitation Menu III 
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5.1.5 Response 

 

Fig. 5.7 Response Menu I 
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Fig. 5.8 Repsonse Menu II 
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Fig. 5.9 Response Menu III 
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Fig. 5.10 Response Menu V 

 

Fig. 5.11 Response IV 
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5.1.6 Calibration 

 

Fig. 5.12 Calibration Menu 
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5.1.7 Marker 

 

Fig. 5.13 Cursor Menu I 
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Fig. 5.13 Cursor Menu II 
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Fig. 5.15Marker Menu III 
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5.1.8 Analysis 

 

Fig. 5.16 Analysis Menu I 
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Fig. 5.17 Analysis Menu II 
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Fig. 5.18 Analysis Menu III 
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5.1.9 System 

 

Fig. 5.19 System Menu I
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Fig. 5.20 System Menu I  
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5.1.10 Help 

 

Fig. 5.21 Help Menu 

1) Main menu 

3672 series vector network analyzers are configured with 10 main menus. 

 File: used to save, recall and print test data, minimize the window and exit the program. 

 Trace: used for relevant operations of traces. 

 Channel: used for relevant operations of channels. 

 Stimulus: used for relevant setting of the excitation signal. 

 Response: used for signal reception and measurement display setting. 

 Cal: used for analyzer calibration and calibration setting. 

 Marker: used for relevant operations of the marker system. 

 Analysis: used for analysis and statistics of test results and relevant setting of the time 

domain function. 

 System: used for relevant configuration setting, macro setting, pulse function setting, 

language setting, resetting and other settings of the analyzer. 

 Help: used to recall the user manual, program control manual and technical support, and 

view the error log and software version information. 
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2) Sub-menu 

The sub-menu of the main menu is the primary menu, the sub-menu of the primary menu is 

the secondary menu, and so on. In principle, the menu of higher level should be opened 

before opening the menu of lower level. For convenience, the commonly used secondary 

menus are displayed in parallel to the menus of higher level. 

3) Menu opening 

Menus at various levels can be opened in the following three methods. 

 By the menu bar: click the main menu, and the primary menu will appear. Click the 

corresponding menu, and the menu of lower level or corresponding dialog box will appear. 

 By keys of the front panel: press the main menu key in the functional key zone of the front 

panel, and the auxiliary menu bar will pop up, displaying the primary menu. Click the 

corresponding menu in the auxiliary menu bar, and the menu of lower level or corresponding 

dialog box will appear. 

 For convenience, the shortcut menu bar is set on the right side of the auxiliary menu bar, 

including the commonly used menus. Drag the shortcut bar push-pull button on the left side 

of the auxiliary menu bar to display and hide the shortcut menu bar and auxiliary menu bar. 

Prompt 

In order to facilitate introduction, the screenshots used in the manual are for menu opening by the 

menu bar. 

5.2. Description of menu 

This section introduces the details of the functions, parameters, etc. of menu items. 

● File…………………………………………………………………………………………………………………………….152 

● Trace………………………………………………………………………………………………………………………….155 

● Channel……………………………………………………………………………………………………….…………….157 

● Stimulus…………………………………………………………………………………………………………………….158 

● Response………………………………………………………………………………………………….……………….165 

● Calibration………………………………………………………………………………………………….….………….175 

● Marker……………………………………………………………………………………………………….….………….178 

● Analysis………………………………………………………………………………………………………….………….187 

● System……………………………………………………………………………………….…………………….……….197 

● Help……………………………………………………………………………………………………………….………….200 

5.2.1 File 

Press the [File] key on the front panel or the menu item [File] on the user interface. The 

file-related menu will pop up, including [Save>>], [Call>>] and [Print>>]. The specific 

description of menu items is as follows. 

5.2.1.1 Save>> 

This menu is used to save data. Click it to enter the menu of lower level. The specific menu 

includes: 
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Table 5.2 Save 

Menu 

 Save 

 Save As... 

 Save data as… 

 Automatic saving 

1) Save 

Function description: 

Save user settings and calibration information in the data (*.CST) file. 

The current user settings and calibration information will be saved in the latest user data file. 

If this item is clicked, the [Whether to cover previous data] dialog box will pop up. Click 

“Yes” to cover previous data and save current data; and click “No” to abandon saving. 

Parameter description: 

None 

2) Save as… 

Function description: 

Save the data file required by the user. 

The data required by the user will be saved in different types of files. The user can set the file 

name. File types include: state and calibration file (*.CST), state file (*.STA), calibration file, 

(*CAL), data file (*.DAT, *.CTI and *.S1P), bitmap file (*.BMP), etc. 

Parameter description: 

None 

3) Save data as… 

Function description: 

Save the file required by the user. 

The parameters required by the user will be saved in different types of files. The user can set 

the file name. File types include the data file (*.DAT, *.CTI, *.S1P and *.S2P) and list file 

(*.PRN). 

Parameter description: 

None 

4) Automatic saving 

Function description: 

Save user settings and calibration information in the data (*.CST) file. 

If this item is clicked, a new state and calibration (*.CST) file will be created, and the current 

user settings and calibration information will be saved in the file. 

Parameter description: 
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None 

5.2.1.2 Call>> 

This menu is used to call the saved data. Click it to enter the menu of lower level. The 

specific menu includes: 

Table 5.3 Call 

Menu 

 Call 

1) Call 

Function description: 

Call the saved state file or calibration file. 

If this item is clicked, a state file or calibration file will be recalled. File types includes the 

state and calibration file (*.CST), state file (*.STA), calibration file (*CAL) and data file 

(*.DAT, *.CTI and *.S1P). 

Parameter description: 

None 

5.2.1.3 Print>> 

This menu is used to print data. Click it to enter the menu of lower level. The specific menu 

includes: 

Table 5.4 Print 

Menu 

 Print 

 Print into file 

 Page Setup 

1) Print 

Function description: 

Click this menu to enter the printer setting page. 

Set the printer options, paper and direction according to the prompts. 

Parameter description: 

None 

2) Print into file 

Function description: 

Click this menu to save the test curve as a figure. 

The test curve can be saved in the figure (*.BMP and *.JPJ) form according to the prompts. 

Parameter description: 
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None 

3) Page Setup 

Function description: 

Click this menu to enter the page setting interface. 

The window information and other information can be set on this page. Window information 

includes: “Print active window”, “Print all windows” and “Print one window on each page”. 

Other information includes: printing of the segment table, limit table, marker table, channel 

state and time. The user can print the corresponding page information according to the needs. 

Parameter description: 

None 

5.2.2 Trace 

Press the [Track] key on the front panel or click the [Track] menu item on the user interface. 

The trace-related menu will pop up. Specific items include: [New Trace], [Delete trace>>], [Select 

trace], [Move trace], [Trace title] and [Trace maximization ON/OFF]. The specific description of 

menu items is as follows. 

Prompt 

Track setting 

The trace refers to a series of measurement data point. Track setting affects the mathematical operation and 

display of measurement data. Only the active trace can be set. Click the corresponding trace state button to 

activate the trace. 

5.2.2.1 New trace 

Function description: 

Click this menu, and the [New Trace] dialog box will pop up. The user can select different 

trace types, including S-parameter (S11, S12, S22 and S21) and receiver (R1, R2, A and B). 

Parameter description: 

None 

5.2.2.2 Delete trace>> 

This menu is used to delete the trace. Click it to enter the menu of lower level, as shown in 

the following table. 

Table 5.5 “Delete trace” 

Menu 

 Delete trace 1 

 Delete trace 2 

 Delete trace 3 

 Delete trace 4 

 Delete active trace 
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 Delete trace… 

1) Delete trace 1-Delete trace 4 

Function description: 

Click it to rapidly delete the existing data trace (the existing trace is highlighted if displayed 

and dark if deleted). 

Parameter description: 

None 

2) Delete active trace 

Function description: 

Click this menu to delete the current active trace (click once to delete one active trace, until 

all active traces are deleted). 

Parameter description: 

None 

3) Delete trace… 

Function description: 

Click this menu, and the trace deletion list will pop up, showing the existing traces. Select the 

trace to be deleted, click [Apply] to delete the trace and continue the above operation. Click 

[OK] to exit the program. 

Parameter description: 

None 

5.2.2.3 Move trace 

Function description: 

Click this menu, and the trace movement list will pop up, showing the existing windows. The 

user can move the current active trace into any window (if [New window] is selected, a new 

window will be created). Click [Apply] to move the trace and continue the above operation. 

Click [OK] to exit the program. 

Parameter description: 

None 

5.2.2.4 Track title 

Function description: 

Click this menu to change the default name of the current active curve. Enter the curve title, 

select the [Enable] check box and click [OK]. Thus the trace title is changed. 

Parameter description: 

None 

5.2.2.1 Track maximization ON/OFF 

Function description: 

Click this menu to maximize the current active trace and hide other trace curves. Click once 



5 Menu 

5.2. Description of menu 

      157 

 

to maximize the trace, and [Track maximization ON/OFF] will appear. Click again to recover 

all traces, and [Track maximization ON/OFF] will appear. 

Parameter description: 

OFF [OFF|ON]. 

5.2.3 Channel 

Press the [Channel] key on the front panel or the [Channel] menu item on the user interface, 

and the channel-related menu will pop up for setting of channel parameters. Specific items 

include: [Open channel], [Close channel], [Select channel], [Copy channel] and [Hardware 

setting]. The specific description of menu items is as follows. 

Prompt 

Channel and trace 

The channel includes the trace. The analyzer supports 64 channels in total. Tracks in one channel are subject to 

the same channel settings. Only the settings of the active channel can be changed. Once the trace in the channel is 

activated, the channel will also be activated. 

5.2.3.1 Open channel 

Function description: 

Click this menu, and the [Open channel] list will pop up, showing the closed channels. The 

user can select the channel to be opened (if [New window] is selected, a new window will be 

created). Click [Apply] to open the channel and continue the above operation. Click [OK] to 

exit the program. 

Parameter description: 

None 

5.2.3.2 Close channel 

Function description: 

Click this menu, and the [Close channel] list will pop up, showing the open channels. The 

user can select one channel, click [Apply] to close the channel and then click [OK] to exit the 

program. 

Parameter description: 

None 

5.2.3.3 Select channel 

Function description: 

Click this menu, and the [Select channel] list will pop up, showing the existing channels. The 

user can select the channel to be activated, click [Apply] to select the channel and then click 

[OK] to exit the program. 

Parameter description: 

None 

5.2.3.4 Copy channel 

Function description: 
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Click this menu, and the [Copy channel] list will pop up. The user can select the target 

channel from the existing channels in the drop-down menu of [Copy channel], click [Apply] 

to copy the channel and then click [OK] to exit the program. 

Parameter description: 

None 

5.2.3.5 Hardware setting 

This menu is used for hardware setting. Click it to enter the menu of lower level, as shown in 

the following table. 

Table 5.6 Hardware Setting 

Menu 

 Path configuration 

 Graphic configuration 

1) Path configuration 

Function description: 

Click this menu to configure the corresponding RF path. 

Parameter description: 

None 

2) Graphic configuration 

Function description: 

Click this menu to configure the filter/high power mode of the source and the reference mixer 

switch. 

Parameter description: 

None 

5.2.4 Excitation 

Press the [Excitation] key on the front panel or the [Excitation] menu item on the user 

interface, and then excitation-related menu will pop up for setting of excitation parameters. 

Specific items include: [Frequency], [Power], [Sweep] and [Trigger]. The specific description 

of menu items is as follows. 

5.2.4.1 Frequency 

This menu is used to set the frequency. Click it to enter the menu of lower level. The specific 

menu includes: 

Table 5.7 Frequency 

Menu 

 Freq Start 

 Freq Stop 

 center frequency 
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 Frequency span 

 Frequency offset 

 CW 

 CW ON/OFF 

 

Prompt 

Frequency unit 

All the frequency parameters are in Hz. The digital input must be ended with four frequency units (GHz, MHz, 

kHz or Hz). When input ends, new frequency value is displayed in appropriate unit. 

 

Attention 

The stop frequency must not exceed the start frequency. 

The sweeper can only sweep upward under stepped sweep mode, so the stop frequency must be not less than 

start frequency. If the start frequency is more than stop frequency, the stop frequency should be equal to the 

start frequency; and if the stop frequency is less than the start frequency, the start frequency should be equal to 

the stop frequency. 

1) Freq Start 

Function description: 

Set the start point of the sweep frequency. 

Set and adjust the parameter by the mouse/keyboard or the knob, number keys and stepping 

keys on the front panel. 

Parameter description: 

10MHz[10MHz ~ 13.5GHz/26.5GHz/43.5GHz/50GHz/67GHz]. 

2) Freq Stop 

Function description: 

Set the stop point of sweep frequency. 

Set and adjust the parameter by the mouse/keyboard or the knob, number keys and stepping 

keys on the front panel. 

Parameter description: 

13.5GHz/26.5GHz/43.5GHz/50GHz/67GHz[ 10MHz ~ 

13.5GHz/26.5GHz/43.5GHz/50GHz/67GHz 

3) Center Frequency 

Function description: 

Set the center point of sweep frequency. 

Set and adjust the parameter by the mouse/keyboard or the knob, number keys and stepping 
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keys on the front panel. 

Parameter description: 

6.755GHz/13.255GHz/21.755GHz /25.005GHz /33.505GHz 

[ 10MHz ~ 13.5GHz/26.5GHz/43.5GHz/50GHz/67GHz ]. 

4) Frequency span 

Function description: 

Set the span of frequency. 

Set and adjust the parameter by the mouse/keyboard or the knob, number keys and stepping 

keys on the front panel. 

Parameter description: 

13.49GHz/26.49GHz/43.49GHz/49.99GHz/66.99GHz 

[ 10MHz ~ 13.5GHz/26.5GHz/43.5GHz/50GHz/67GHz]. 

5) Frequency offset 

Function description: 

Set the frequency offset. 

This menu is used for relevant settings of the frequency offset. See details in “Appendix 3: 

Frequency Offset Measurement”. 

Parameter description: 

None 

6) CW 

Function description: 

Set the CW frequency. 

Set and adjust the parameter by the mouse/keyboard or the knob, number keys and stepping 

keys on the front panel. 

Parameter description: 

2GHz [ 10MHz ~13.5GHz/26.5GHz/43.5GHz/50GHz/67GHz]. 

7) CW ON/OFF 

Function description: 

Activate dot frequency to set frequency of dot frequency. 

Parameter description: 

OFF [OFF|ON]. 

5.2.4.2 Power 

This menu is used to set the power. Click it to enter the menu of lower level. The specific 

menu includes: 

Table 5.8 Power 
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Menu 

 Power 

 Power and attenuation 

 

Prompt 

Power unit 

All power parameters are in dBm. Click [OK] on the panel after entering. Thus the power setting is completed. 

1) Power 

Function description: 

Set the power ON/OFF, power level, sweep start/stop power and power slope. 

Parameter description: 

None 

2) Power and Attenuator 

Function description: 

Set the power attenuator mode, leveling mode, etc. 

Parameter description: 

None 

5.2.4.3 Sweep 

This menu is used for sweep setting. Click it to enter the menu of lower level. The specific 

menu includes: 

Table 5.9 Sweep: Segment Table 

Menu Sub-menu 

 Sweep time 

 Points 

 Sweep type 

 Sweep setup 

 Phase control 

 Pulse 

 Segment table>> 

 

 

 

 

 

 

Segment table ON/OFF 

Add segment 

Insert segment 

Delete segment 

Independent power levels ON/OFF 

Independent IF bandwidth ON/OFF 

Independent sweep time ON/OFF 

1) Sweep time 
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Function description: 

Set the total time of sweep from the start frequency to stop frequency. 

Set and adjust the parameter by the mouse/keyboard or the knob, number keys and stepping 

keys on the front panel. 

Reference note: (201points) 

198ms [198ms-86400s]. 

2) Points 

Function description: 

Set the total point number of sweep from the start frequency to stop frequency. 

Set and adjust the parameter by the mouse/keyboard or the knob, number keys and stepping 

keys on the front panel. 

Parameter description: 

201[1~32001]. 

3) Sweep type 

Function description: 

Set the sweep type. 

Optional sweep types include: linear frequency, logarithmic frequency, power sweep, CW, 

segment sweep and phase sweep. 

Parameter description: 

None 

4) Sweep setting 

Function description: 

Set the sweep function. 

The sweep functions include the step sweep, quick sweep, dwell time and sweep delay. 

Parameter description: 

None 

5) Phase control 

Function description: 

Set the phase of the test port, including the start phase, stop phase, phase ON/OFF, etc. 

Parameter description: 

0°[0°-360°] 

6) Pulse 

Function description: 

Set the pulse measurement function. See details in “Appendix 4: Pulse Measurement”. 

Parameter description: 

Pulse width: 33ns-60s 
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Pulse rising/falling time: 30ns 

7) Segment table 

This menu is used for relevant setting of the segment table. Click it to enter the menu of 

lower level. The specific menu includes: 

Table 5.10 Segment Table 

Menu 

 Segment table ON/OFF 

 Add segment 

 Insert segment 

 Delete segment 

 Independent power levels ON/OFF 

 Independent IF bandwidth ON/OFF 

 Independent sweep time ON/OFF 

a) Segment table ON/OFF 

Function description: 

If this menu is selected, all menu items will be lit, allowing the user to set the segment sweep 

function. 

Parameter description: 

OFF [OFF|ON]. 

b) Add segment 

Function description: 

Add a new segment behind the existing segment. 

Parameter description: 

None 

c) Insert segment 

Function description: 

Insert a new segment in front of the selected segment. 

Parameter description: 

None 

d) Delete segment 

Function description: 

Delete the selected segment. 

Parameter description: 

None 
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e) Independent power levels ON/OFF 

Function description: 

Allow to set different power levels for different segments. 

Parameter description: 

OFF [OFF|ON]. 

f) Independent IF bandwidth ON/OFF 

Function description: 

Allow to set different IF bandwidths for different segments. 

Parameter description: 

OFF [OFF|ON]. 

g) Independent sweep time ON/OFF 

Function description: 

Allow to set different periods of sweep time for different segments. 

Parameter description: 

OFF [OFF|ON]. 

5.2.4.4 Trigger 

This menu is used for trigger setting. Click it to enter the menu of lower level. The specific 

menu includes: 

Table 5.11 Trigger 

Menu 

 Hold 

 Single 

 Groups 

 Continuous  

 Re-sweep 

 Manual trigger 

 Trigger 

1) Hold 

Function description: 

If this menu is selected, the system will stop sweep and be kept at the current CW. 

Parameter description: 

None 

2) Single 

Function description: 
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If this menu is selected, the system will automatically enter the holding mode after sweep 

once. 

Parameter description: 

None 

3) Groups 

Function description: 

If this menu is selected, the system will automatically enter the holding mode after the set 

sweep process. 

Parameter description: 

None 

4) Continuous 

Function description: 

If this menu is selected, the system will restart sweep after sweep once. 

Parameter description: 

None 

5) Re-sweep 

Function description: 

If this menu is selected, the system will restart sweep from the start frequency. 

Parameter description: 

None 

6) Manual trigger 

Function description: 

Set the trigger menu to light up this menu. If this menu is selected, manual triggering will be 

done once. 

Parameter description: 

None 

7) Trigger 

Function description: 

Select this menu to enter the trigger function setting interface. See details in “4.6 Trigger 

Mode”. 

Parameter description: 

None 

5.2.5 Response 

Press the [Response] key on the front panel or the [Response] menu item on the user interface, 

and the response-related menu will pop up. Specific items include: [Measurement], [Format], 

[Scale], [Display] and [Average]. The specific description of menu items is as follows. 

5.2.5.1 Measurement 
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This menu is used to set measurement. Click it to enter the menu of lower level. The specific 

menu includes: 

Table 5.12 Measurement 

Menu 

 Measurement S-parameter 

 Measurement balance parameter 

 Measuring type 

 Receivers 

1) Measurement S-parameter 

Function description: 

Select this menu to select the S-parameter. 

Parameter description: 

None 

2) Measurement balance parameter 

Function description: 

Select this menu to select the balance parameter. 

Parameter description: 

None 

3) Measuring type 

Function description: 

Select this menu to enter the multi-functional measurement option setting interface, such as 

the mixer measurement. See details in “Appendix 6: Mixer Measurement”. 

Parameter description: 

None 

4) Receivers 

Function description: 

Select this menu to select the receiver parameter, such as R1, R2, A, B, etc. 

Parameter description: 

None 

5.2.5.2 Format 

This menu is used to set measurement. Click it to enter the menu of lower level. The specific 

menu includes: 

Table 5.13 Format 

Menu 
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 Log Mag 

 Phase 

 Group Delay 

 Smith Chart 

 Unwrapped Phase 

 Lin Mag 

 SWR 

 Real 

 Imaginary 

 Polar 

 Positive phase 

 Imped 

 Format 

1) Log Mag 

Function description: 

Select this menu to sweep in the logarithmic format. 

Parameter description: 

None 

2) Phase 

Function description: 

Select this menu to display the phase curve. 

Parameter description: 

None 

3) Group Delay 

Function description: 

Select this menu to display the group delay curve. 

Parameter description: 

None 

4) Smith Chart 

Function description: 

Select this menu to display the Smith chart curve. 

Parameter description: 

None 
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5) Unwrapped Phase 

Function description: 

Select this menu to display the linear phase curve. 

Parameter description: 

None 

6) Lin Mag 

Function description: 

Select this menu to display the linear amplitude curve. 

Parameter description: 

None 

7) SWR 

Function description: 

Select this menu to display the standing wave ratio curve. 

Parameter description: 

None 

8) Real 

Function description: 

Select this menu to display the real part curve. 

Parameter description: 

None 

9) Imaginary 

Function description: 

Select this menu to display the imaginary part curve. 

Parameter description: 

None 

10) Polar 

Function description: 

Select this menu to display the polar coordinate curve. 

Parameter description: 

None 

11) Positive phase 

Function description: 

Select this menu to display the positive phase curve. 

Parameter description: 
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None 

12) Imped 

Function description: 

Select this menu to display the impedance curve. 

Parameter description: 

None 

13) Format 

Function description: 

If this menu is selected, the display format table will pop up. Multiple format curves can be 

selected. 

Parameter description: 

None 

5.2.5.3 Scale 

This menu is used to set the scale. Click it to enter the menu of lower level. The specific 

menu includes: 

Table 5.14 Format 

Menu 

 Autoscale 

 Autoscale All 

 Scale 

 Electrical Delay 

 Phase Deviation 

 Amplitude Deviation 

 Scale Coupling 

1) Autoscale 

Function description: 

If this menu is selected, the vertical scale will be selected automatically so that the active 

trace can be better displayed in the vertical grid of the screen. The stimulus is not affected, 

and only the scale value and reference value are changed. 

The appropriate scale factor will be selected so that data can be displayed in 80% of the 

screen. 

Select the center value of the trace on the screen according to the reference value. 

Parameter description: 

None 

2) Autoscale All 

Function description: 
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If this menu is selected, the appropriate scale will be set for all traces in the window so that 

the trace can be better displayed in the vertical grids of the window. 

Parameter description: 

None 

3) Scale 

Function description: 

Select this menu and enter the set scale value. 

Set and adjust the parameter by the mouse/keyboard or the knob, number keys and stepping 

keys on the front panel. 

Parameter description: 

10dB[0.001dB-500dB]. 

4) Electrical delay 

Function description: 

Select this menu to set the electrical delay. 

Set and adjust the parameter by the mouse/keyboard or the knob, number keys and stepping 

keys on the front panel. 

Parameter description: 

0s[-1000s to 1000s]. 

5) Phase deviation 

Function description: 

Select this menu to set the phase deviation. Set and adjust the parameter by the 

mouse/keyboard or the knob, number keys and stepping keys on the front panel. 

Parameter description: 

0°[-1000° to 1000°]. 

6) Amplitude deviation 

Function description: 

Select this menu to set the amplitude deviation. 

Set and adjust the parameter by the mouse/keyboard or the knob, number keys and stepping 

keys on the front panel. 

Parameter description: 

0dB [-1000dB~1000dB]。 

7) Scale coupling 

Function description: 

Select this menu to set scale coupling. 

Parameter description: 

None 
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5.2.5.4 Display 

This menu is used to set the scale. Click it to enter the menu of lower level. The specific 

menu includes: 

Table 5.15 Format 

Menu 

 1-window/2-window/3-window/4-window 

 Window 

 Measurement setup 

 Display Items 

 Soft key calibration ON/OFF 

 Hide soft key 

 Minimize application program 

 Toolbar 

 Title bar ON/OFF 

 State bar ON/OFF 

 Table 

1) 1-window/2-window/3-window/4-window 

Function description: 

Select this menu for one-window/two-window/three-window/four-window display. 

Parameter description: 

None 

2) Window 

Function description: 

Select this menu to create more windows and close unnecessary windows. 

Parameter description: 

None 

3) Measurement setup 

Function description: 

This menu includes various default system setup. 

Four traces will be created in Window 1: S11, S21, S12 and S22, in the logarithmic format in 

Channel 1. 

Four traces will be created in four windows, in the logarithmic format in Channel 1. S11 will 

be displayed in Window 1, S21 in Window 2, S12 in Window 3 and S22 in Window 4. 

Three traces will be created in three windows of Channel 1. S11 will be displayed in the 

Smith chart format in Window 1, S22 in the Smith chart format in Window 2 and S21 in the 

logarithmic format in Window 3. 
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Four traces will be displayed in two windows, in the logarithmic format in two channels. S11 

and S21 will be displayed in Window 1 of Channel 1, and S12 and S22 in Window 2 of 

Channel 2. 

Parameter description: 

None 

4) Display items 

Function description: 

Select this menu to control part of display items, such as the title, trace state, 

frequency/stimulus state, marker display, display time, etc. 

Parameter description: 

None 

5) Soft key calibration ON/OFF 

Function description: 

Select this menu to calibrate keys in the soft keyboard form to facilitate the user of old users. 

Parameter description: 

OFF [OFF|ON]. 

6) Hide soft key 

Function description: 

Select this menu to hide the soft keyboard on the right side of the display. The curve will be 

displayed in the whole screen. 

Parameter description: 

None 

7) Minimize application program 

Function description: 

Select this menu to minimize the soft key in operation in the vector network analyzer. 

Parameter description: 

None 

8) Toolbar 

Function description: 

Select this menu to control the toolbar display, such as the input toolbar, marker toolbar, 

measurement toolbar, sweep toolbar, stimulus toolbar and time domain toolbar. 

Parameter description: 

None 

9) Title bar ON/OFF 

Function description: 

Select this menu to display the title bar. 
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Parameter description: 

None 

10) Status bar ON/OFF 

Function description: 

Select this menu to display the status bar. 

Parameter description: 

None 

11) Table 

Function description: 

Select this menu to display the marker table, limit table and segment table. 

Parameter description: 

None 

5.2.5.5 Average 

This menu is used to set the scale. Click it to enter the menu of lower level. The specific 

menu includes: 

Table 5.16 Format 

Menu 

 Restart Average 

 Average factor 

 Average ON/OFF 

 Smoothing 

 IF bandwidth 

1) Restart Average 

Function description: 

Select this menu for a group of new average sweep. 

Parameter description: 

None 

2) Average factor 

Function description: 

Select this menu to set the average times of curve sweep. 

Set and adjust the parameter by the mouse/keyboard or the knob, number keys and stepping 

keys on the front panel. 

Parameter description: 

1[1~1024]. 
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3) Average ON/OFF 

Function description: 

Select this menu to open the trace averaging function. 

The more times averaging is done, the more noise will be reduced, and the larger the dynamic 

range will be. 

The noise reduction effect of sweep averaging is the same as that of reduction of the 

intermediate frequency bandwidth. 

Parameter description: 

OFF [OFF|ON]. 

4) Smoothing 

This menu is used for smoothing setting. Click it to enter the menu of lower level. The 

specific menu includes: 

Table 5.17 Smoothing 

Menu 

 Smoothing ON/OFF 

 Smoothing percentage 

 Number of smoothing points 

a) Smoothing ON/OFF 

Function description: 

Select this menu to enable the smoothing function. 

The smoothing function is used to reduce the peak-peak noise of bandwidth measurement 

data. 

Data averaging is done for part of the displayed trace. The number of adjacent data points 

averaged at the same time is also known as the smoothing aperture. The aperture can be 

defined as the number of data points or the percentage of X-axis span. 

Parameter description: 

OFF [OFF|ON]. 

b) Smoothing percentage 

Function description: 

Select this menu to set the smoothing percentage. 

Set and adjust the parameter by the mouse/keyboard or the knob, number keys and stepping 

keys on the front panel. 

Parameter description: 

0 [0-25%]. 

c) Points 

Function description: 
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This menu is used to set the number of smoothing points. 

Set and adjust the parameter by the mouse/keyboard or the knob, number keys and stepping 

keys on the front panel. 

Parameter description: 

0[0~N (total point number)*25%]. 

5) Group delay aperture 

Function description: 

Select this menu to set point/percentage/frequency range of group delay aperture. The setting 

is only effective for group delay measurement. The parameters can be adjusted through 

mouse/keyboard/knob on the front panel/number key/step key.  

Parameter description: 

Point: 11[ 2 ~ Nsweep point] 

Percentage: 5% [ 1% ~ 100% ] 

Frequency range: Ffrequency span[ Ffrequency span between two points ~ Ffrequency span]. 

6) IF bandwidth 

Function description: 

Select this menu to set the intermediate frequency bandwidth. 

Set and adjust the parameter by the mouse/keyboard or the knob, number keys and stepping 

keys on the front panel. 

Parameter description: 

1kHz[1Hz~5MHz]. 

5.2.6 Calibration 

Press the [Cal] key on the front panel or the [Cal] menu item on the user interface. The 

calibration-related menu will pop up. Specific items include: [Cal], [Correction ON/OFF], 

[Interpolation ON/OFF], [Port extension], [Fixture>>], [Edit calibration kit], [Attribute] and 

[Power calibration]. The specific description of menu items is as follows. 

5.2.6.1 Calibration 

Function description: 

Select this menu to enter the calibration interface, including three calibration types: guided 

calibration, non-guided calibration and electronic calibration. Select the appropriate 

calibration method according to the measurement type and accuracy requirements. See details 

in 6.3 “Calibration Guide”. 

Parameter description: 

None 

5.2.6.2 Correction ON/OFF 

Function description: 

Select this menu to enable the correction function and add calibration data. 

Parameter description: 
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OFF [OFF|ON]. 

5.2.6.3 Interpolation ON/OFF 

Function description: 

Select this menu to enable the interpolation function. 

Parameter description: 

OFF [OFF|ON]. 

5.2.6.4 Port Extension 

Function description: 

Select this menu to move the measurement reference plane in an electrical manner. Thus, 

other kinds of calibration can be avoided. 

Add a cable after calibration. The port extension function is used to “tell” the length of the 

cable added to the specific port of the analyzer. In case of failure of direct calibration, the 

delay (phase shift) caused by the clamp can be compensated by port extension. For the 

method of port extension setting, refer to the section of port extension in 5.5 “Improvement 

of Phase Measurement Accuracy”. 

Parameter description: 

None 

5.2.6.5 Fixture>> 

This menu is used to set the fixture function. Click it to enter the menu of lower level. The 

specific menu includes: 

Table 5.18 Fixture 

Menu 

 Fixture enabling ON/OFF 

 Port matching 

 2-port de-embedding 

 Port Z conversion 

 4-port Embed/De-embed 

1) Fixture enabling ON/OFF 

Function description: 

Select this menu to enable the fixture simulator function. The functions of the fixture 

simulator are effective only in this mode. 

Parameter description: 

OFF [OFF|ON]. 

2) Port matching 

Function description: 

Select this menu to enable the port matching function. For setting of port matching, refer to 

“7.9.3 Port matching” in “7.9 Fixture Compensation Calibration”. 
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Parameter description: 

None 

3) 2-port de-embedding 

Function description: 

Select this menu to enable the double-port fixture de-embedding function. For setting of 

double-port fixture de-embedding, refer to “7.9.4 Double-port fixture de-embedding” in “7.9 

Fixture Compensation Calibration”. 

Parameter description: 

None 

4) Port Z conversion 

Function description: 

Select this menu to enable the port impedance conversion function. For setting of port 

impedance conversion, refer to “7.9.5 Port Z conversion” in “7.9 Fixture Compensation 

Calibration”. 

Parameter description: 

None 

5) Four-port fixture de-embedding/embedding 

Function description: 

Select this menu to enable the four-port fixture de-embedding/embedding function. For 

setting of port z conversion, refer to “7.9.6 4-port de-embedding/embedding” in “7.9 Fixture 

Compensation Calibration”. 

Parameter description: 

None 

5.2.6.6 Editing of Calibration Kit 

Function description: 

Select this menu to define and edit the calibration kit information. For calibration kit editing, 

refer to “7.6.3 Edit calibration kit” in “7.6 Definition of Calibration Kit Editing”. 

Parameter description: 

None 

5.2.6.7 Attribute 

Function description: 

This menu is effective after calibration of the instrument. Select this menu to display the 

current calibration attribute, such as the channel, calibration time, calibration type, frequency, 

number of sweep points, sweep time, port power, sweep type, etc. 

Parameter description: 

None 

5.2.6.8 Power Calibration 

Function description: 
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Select this menu to set the source power, receiver calibration, etc. For power calibration 

setting, refer to “Port power calibration” in “6.3 Calibration of scale mixer measurement” of 

“Appendix 6 Mixer Measurement”. 

Parameter description: 

None 

5.2.7 Marker 

Press the [Marker] key on the front panel or click the [Marker] menu item on the user 

interface. The marker-related menu will pop up. Specific items include: [Marker], [Marker 

function], [Marker search], [Marker attribute] and [Marker display]. The specific description of 

menu items is as follows. 

5.2.7.1 Marker 

This menu is used to set the marker. Click it to enter the menu of lower level. The specific 

menu includes: 

Table 5.19 Marker 

Menu 

 Marker 1/2/3 

 Reference marker 

 More markers 

 Close marker 

1) Marker 1/2/3 

Function description: 

Select this menu to enable the function of Marker 1/2/3. Read the measurement data, search 

the value of specific type or change the stimulus setting. 

Parameter description: 

None 

2) Reference marker 

Function description: 

Select this menu to enable the reference marker function for relative measurement. 

Parameter description: 

None 

3) More markers 

Function description: 

Select this menu to enter the “More markers” page. The system is configured with Marker 4, 

Marker 5, Marker 6, Marker 7, Marker 8 and Marker 9. 

Parameter description: 

None 

4) Close marker 
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Function description: 

Select this menu to close the corresponding marker. 

Parameter description: 

None 

5.2.7.2 Marker function 

This menu is used to set the marker function. Click it to enter the menu of lower level. The 

specific menu includes: 

Table 5.20 Marker Function 

Menu 

 Marker→start 

 Marker→stop 

 Marker→center 

 Marker→span 

 Marker→reference 

 Marker→delay 

1) Marker→start 

Function description: 

Select this menu to set the frequency of the active marker as the start frequency. 

Parameter description: 

None 

2) Marker→stop 

Function description: 

Select this menu to set the frequency of the active marker as the stop frequency. 

Parameter description: 

None 

3) Marker→center 

Function description: 

Select this menu to set the frequency of the active marker as the center frequency. 

Parameter description: 

None 

4) Marker→span 

Function description: 

Select this menu to set the active Δ marker frequency as the frequency span. 

Parameter description: 
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None 

5) Marker→reference 

Function description: 

Select this menu to set the power of the active marker as the power reference value. 

Parameter description: 

None 

6) Marker→delay 

Function description: 

Select this menu to normalize the group delay of active marker points into 0. 

Parameter description: 

None 

5.2.7.3 Marker search 

This menu is used to set marker search. Click it to enter the menu of lower level. The specific 

menu includes: 

Table 5.21 Marker search 

Menu 

 Maximum value 

 Minimum value 

 Peak value 

 Target value 

 Bandwidth search 

 Marker search 

 Tracking ON/OFF 

 Filter statistics 

 Filter test 

1) Maximum value 

Function description: 

Select this menu for marker search of the maximum measurement data point. 

Parameter description: 

None 

2) Minimum value 

Function description: 

Select this menu for marker search of the minimum measurement data point. 

Parameter description: 
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None 

3) Peak value 

This menu is used to set the peak search. Click it to enter the menu of lower level. The 

specific menu includes: 

Table 5.22 Peak Value 

Menu 

 Next peak value 

 Right peak value 

 Left peak value 

 Peak/valley type 

 Threshold 

 Offset 

a) Next peak value 

Function description: 

Select this menu to search next peak value lower than the current marker amplitude value. 

Parameter description: 

None 

b) Right peak value 

Function description: 

Select this menu to search next effective peak value on the right side of the marker position. 

Parameter description: 

None 

c) Left peak value 

Function description: 

Select this menu to search next effective peak value on the left side of the marker position. 

Parameter description: 

OFF [OFF|ON]. 

d) Peak/valley type 

Function description: 

Select this menu to select the peak type. 

Parameter description: 

Peak [Valley|Peak]. 

e) Threshold 

Function description: 
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Select this menu to define the minimum peak value. The effective peak value must be more 

than the threshold. The valley values on both sides may be less than the threshold. 

Set and adjust the parameter by the mouse/keyboard or the knob, number keys and stepping 

keys on the front panel. 

Parameter description: 

-100dB[-500dB to 500dB]. 

f) Deviation 

Function description: 

Select this menu to define the minimum vertical distance between the peak value and valley 

value. The vertical distance between the effective peak value and valley values on both sides 

must be more than the deviation. 

Set and adjust the parameter by the mouse/keyboard or the knob, number keys and stepping 

keys on the front panel. 

Parameter description: 

3dB[-500dB~500dB]. 

4) Target value 

Function description: 

Select this menu and enter the search target value. If this menu is clicked once, the marker 

will move to the first target value on the right side of the current marker position. Continue 

the above operation to reach to the highest stimulus value. Then return to the minimum 

search target value of stimulus. 

Set and adjust the parameter by the mouse/keyboard or the knob, number keys and stepping 

keys on the front panel. 

Parameter description: 

0dB[-500dB~500dB]. 

5) Bandwidth search 

This menu is used to as the bandwidth search. Click it to enter the menu of lower level. The 

specific menu includes: 

Table 5.23 Bandwidth 

Menu 

 Bandwidth ON/OFF 

 Bandwidth level 

 Track ON/OFF 

a) Bandwidth ON/OFF 

Function description: 

Select this menu to enable the bandwidth search function. 

Parameter description: 

OFF [OFF|ON]. 



5 Menu 

5.2. Description of menu 

      183 

 

b) Bandwidth level 

Function description: 

Select this menu to set the levels of both sides, falling from the peak. 

Set and adjust the parameter by the mouse/keyboard or the knob, number keys and stepping 

keys on the front panel. 

Parameter description: 

-3dB[-500dB~500dB]. 

c) Tracking ON/OFF 

Function description: 

Select this menu to enable the bandwidth search tracking function. The search function will 

be executed according to the current search type and range settings after each sweep, so as to 

ensure that the marker is in the expected position after each sweep. 

Parameter description: 

OFF [OFF|ON]. 

6) Marker search 

Function description: 

Select this menu to enter the shortcut menu of marker search. 

Parameter description: 

None 

7) Tracking ON/OFF 

Function description: 

Select this menu to enable the marker search tracking function. 

Parameter description: 

OFF [OFF|ON]. 

8) Filter statistics ON/OFF 

Function description: 

Select this menu to enable the function of filter statistics. 

Parameter description: 

OFF [OFF|ON]. 

9) Filter test 

This menu is used to set the filter test. Click it to enter the menu of lower level. The specific 

menu includes: 

Table 5.24 Filter Test 

 

Menu 
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 Filter test ON/OFF 

 Bandwidth level 

 Frequency difference percentage 

 Track ON/OFF 

a) Filter test ON/OFF 

Function description: 

Select this menu to enable the filter test function. 

Parameter description: 

OFF [OFF|ON]. 

b) Bandwidth level 

Function description: 

Select this menu to set the filter bandwidth level. 

Set and adjust the parameter by the mouse/keyboard or the knob, number keys and stepping 

keys on the front panel. 

Parameter description: 

-3dB [-500dB~500dB]. 

c) Frequency difference percentage 

Function description: 

Select this menu to set the frequency difference percentage. 

Set and adjust the parameter by the mouse/keyboard or the knob, number keys and stepping 

keys on the front panel. 

Parameter description: 

10%[0% to 100%]. 

d) Track ON/OFF 

Function description: 

Select this menu to enable the marker tracking function for the filter test. 

Parameter description: 

OFF [OFF|ON]. 

5.2.7.4 Marker attribute 

This menu is used to set the marker attribute. Click it to enter the menu of lower level. The 

specific menu includes: 

Table 5.25 Marker Attribute 

Menu 

 ΔMarker ON/OFF 
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 Discrete ON/OFF 

 Type Normal/Fixed 

 Coupling ON/OFF 

Advanced 

1) ΔMarker ON/OFF 

Function description: 

Select this menu to enable the Δ marker function. 

Parameter description: 

OFF [OFF|ON]. 

2) Discrete ON/OFF 

Function description: 

Select this menu to enable the discrete marker function. The marker will be moved to the 

discrete data point equivalent to the target value. 

Parameter description: 

OFF [OFF|ON]. 

3) Type Normal/Fixed 

Function description: 

Select this menu to select the marker type. 

Normal: the X-axis position of the standard marker is fixed, and the Y-axis position changes 

along with the amplitude of trace data. The marker can be moved right and left on the X-axis 

by changing the stimulus value. 

Fixed: the X-axis and Y-axis coordinates of the marker remain unchanged, no matter whether 

the amplitude of trace data changes. The marker can be moved on the X-axis by changing the 

stimulus value, but the Y-axis coordinate remains unchanged. 

Parameter description: 

Normal [Normal|Fixed]. 

4) Coupling ON/OFF 

Function description: 

Select this menu to enable the marker coupling function. 

Parameter description: 

OFF [OFF|ON]. 

5) Advanced 

Function description: 

Select this menu to enter the shortcut menu of advanced marker. 

Parameter description: 
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None 

5.2.7.5 Marker display 

This menu is used to set the marker display. Click it to enter the menu of lower level. The 

specific menu includes: 

Table 5.26 Marker Display 

Menu 

 Marker reading ON/OFF 

 One marker for one trace ON/OFF 

 Large font ON/OFF 

 Decimal place 

 Rightward movement of display position 

 Downward movement of display position 

1) Marker reading ON/OFF 

Function description: 

Select this menu to enable the marker reading function. 

Parameter description: 

ON [ON|OFF]. 

2) One marker for one trace ON/OFF 

Function description: 

Select this menu to enable the function of one marker for one trace. 

Parameter description: 

OFF [OFF|ON]. 

3) Large font ON/OFF 

Function description: 

Select this menu to enable the function of large font display of the marker. 

Parameter description: 

OFF [OFF|ON]. 

4) Decimal place 

Function description: 

Select this menu to set the number of decimal places of marker display. 

Set and adjust the parameter by the mouse/keyboard or the knob, number keys and stepping 

keys on the front panel. 

Parameter description: 

2[0~4]. 
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5) Rightward movement of display position 

Function description: 

Select this menu to set the horizontal position of the marker. 

Set and adjust the parameter by the mouse/keyboard or the knob, number keys and stepping 

keys on the front panel. 

Parameter description: 

80%[-200% to 200%]. 

6) Downward movement of display position 

Function description: 

Select this menu to set the vertical position of the marker. 

Set and adjust the parameter by the mouse/keyboard or the knob, number keys and stepping 

keys on the front panel. 

Parameter description: 

80%[-200% to 200%]. 

5.2.8 Analysis 

Press the [Analysis] key on the front panel or the [Analysis] menu item on the user interface. 

The analysis-related menu will pop up. Specific items include: [Save], [Test], [Track 

statistics], [Gate], [Window], [Time Domain], [Structural return loss] and [Equation editor]. 

The specific description of menu items is as follows. 

5.2.8.1 Save 

This menu is used to save the settings. Click it to enter the menu of lower level. The specific 

menu includes: 

Table 5.27 Save 

Menu 

 Data→Memory 

 Normalization 

 Trace operation 

 Data trace 

 Memory trace 

 Data and memory 

 Hide trace 

1) Data>Memory 

Function description: 

Select this menu to save the current test curve data into the memory. 

Parameter description: 

None 
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2) Normalization 

Function description: 

Select this menu to save the current test curve data into the memory and perform 

data/memory operation. 

Parameter description: 

None 

3) Trace operation 

Function description: 

Select this menu to execute four types of mathematical operation of the current active trace 

and memory trace, including the data/memory, data*memory, data+memory and 

data-memory. 

Parameter description: 

None 

4) Data trace 

Function description: 

Select this menu to display the data trace curve. 

Parameter description: 

None 

5) Memory trace 

Function description: 

Select this menu to display the memory trace curve. 

Parameter description: 

None 

6) Data and memory 

Function description: 

Select this menu to display the data trace and memory trace curve. 

Parameter description: 

None 

7) Hide trace 

Function description: 

Select this menu to hide the data trace and memory trace. 

Parameter description: 

None 

5.2.8.2 Test 

This menu is used to set the test. Click it to enter the menu of lower level. The specific menu 

includes: 
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Table 5.28 Test 

Menu 

 Limit test 

 Ripple test 

 Bandwidth test 

1) Limit test 

This menu is used to set the limit test. Click it to enter the menu of lower level. The specific 

menu includes: 

Table 5.29 Limit Test 

Menu 

 Limit test ON/OFF 

 Limit line display ON/OFF 

 Sound ON Fail ON/OFF 

 Limit table ON/OFF 

 Fail Sign ON/OFF 

a) Limit test ON/OFF 

Function description: 

Select this menu to enable the limit test function. Clear this menu to close the function of 

limit test of the active trace. 

Parameter description: 

OFF [OFF|ON]. 

b) Limit line display ON/OFF 

Function description: 

Select this menu to enable the limit line display function. Clear this menu to close the 

function of limit line display of the active trace. 

Parameter description: 

OFF [OFF|ON]. 

c) Limit table ON/OFF 

Function description: 

Select this menu to enable the limit table function. 

Parameter description: 

OFF [OFF|ON]. 

2) Ripple test 

This menu is used to set the ripple test. Click it to enter the menu of lower level. The specific 
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menu includes: 

Table 5.30 Ripple Test 

Menu 

 Ripple test ON/OFF 

 Ripple display ON/OFF 

 Ripple value 

 Ripple limit segment 

 Edit ripple limit table 

 Fail Sign ON/OFF 

a) Ripple test ON/OFF 

Function description: 

Select this menu to enable the ripple test function. Clear this menu to close the function of 

ripple test of the active trace. 

Parameter description: 

OFF [OFF|ON]. 

b) Ripple display ON/OFF 

Function description: 

Select this menu to enable the ripple display function. Clear this menu to close the ripple line 

display of the active trace, however, the ripple test function must not be affected. 

Parameter description: 

OFF [OFF|ON]. 

c) Ripple value 

Function description: 

Select this menu to set the ripple type. Optional ripple type: none, absolute value and 

allowance. 

Parameter description: 

None 

d) Ripple limit segment 

Function description: 

Select this menu to select the number of ripple limit segments to be opened. Up to 12 

segments can be opened. 

Parameter description: 

None 

e) Edit ripple limit table 

Function description: 
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Select this menu to edit the ripple limit table. The ripple limit table can be added, deleted and 

edited. 

Parameter description: 

None 

f) Fail Sign ON/OFF 

Function description: 

Select this menu to enable the FAIL sign function. In case of failure of the trace data point 

test, the FAIL sign will appear on the screen. 

Parameter description: 

OFF [OFF|ON]. 

3) Bandwidth test 

This menu is used to set the bandwidth test. Click it to enter the menu of lower level. The 

specific menu includes: 

Table 5.31 Bandwidth Test 

Menu 

 Bandwidth test ON/OFF 

 Bandwidth display ON/OFF 

 Bandwidth marker ON/OFF 

 NdB point 

 Minimum bandwidth 

 Maximum bandwidth 

Fail Sign ON/OFF 

a) Bandwidth test ON/OFF 

Function description: 

Select this menu to enable the bandwidth test function to test the bandwidth of the bandpass 

filter. 

Parameter description: 

OFF [OFF|ON]. 

b) Bandwidth display ON/OFF 

Function description: 

Select this menu to enable the bandwidth display function. The tested bandwidth will be 

displayed on the screen. 

Parameter description: 

OFF [OFF|ON]. 

c) Bandwidth marker ON/OFF 
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Function description: 

Select this menu to enable the bandwidth marking function. The bandwidth position mark 

will be displayed on the screen. 

Parameter description: 

OFF [OFF|ON]. 

d) NdB point 

Function description: 

Select this menu to adjust the NdB point and determine the amplitude difference between two 

frequency points and the signal peak value of the passband. 

Parameter description: 

-3dB[-500dB~500dB]. 

e) Minimum bandwidth 

Function description: 

Select this menu to set the allowable minimum bandwidth. If the test bandwidth is less than 

the minimum value, the prompt of bandwidth test failure (FAIL) will appear on the screen, or 

the prompt sound will be sent, so that the user can directly observe whether the 

characteristics of the DUT meet the requirements. 

Parameter description: 

10kHz[0Hz~300kHz]. 

f) Maximum bandwidth 

Function description: 

Select this menu to set the allowable maximum bandwidth. If the test bandwidth exceeds the 

maximum value, the prompt of bandwidth test failure (FAIL) will appear on the screen, or the 

prompt sound will be sent, so that the user can directly observe whether the DUT meet the 

requirements. 

Parameter description: 

300kHz[300kHz~∞]. 

g) Fail Sign ON/OFF 

Function description: 

Select this menu to enable the FAIL sign function. In case of failure of the trace data point 

test, the FAIL sign will appear on the screen. 

Parameter description: 

OFF [OFF|ON]. 

5.2.8.3 Track Statistics 

This menu is used to set trace statistics. Click it to enter the menu of lower level. The specific 

menu includes: 

Table 5.32 Trace Statistics 

Menu 
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 Trace statistics ON/OFF 

Curve trace statistics 

1) Trace statistics ON/OFF 

Function description: 

Select this menu to enable the function of trace statistics. It is not required to search the 

maximum value and minimum value so as to easily measure the peak-peak value of passband 

ripple. 

Parameter description: 

OFF [OFF|ON]. 

2) Curve trace statistics 

Parameter description: 

Select this menu to enter the interface of curve trace statistics. Three functions of trace 

statistics are provided: average value, deviation value and peak-peak value, so as to calculate 

the statistical values within whole stimulus bandwidth or user-defined bandwidth. 

Parameter description: 

None 

5.2.8.4 Gate 

This menu is used to set the gate. Click it to enter the menu of lower level. The specific menu 

includes: 

Table 5.33 Gate 

Menu 

 Gate ON/OFF 

 Gate: start 

 Gate: stop 

 Gate: center 

 Gate: span 

Gate setup 

1) Gate ON/OFF 

Function description: 

Select this menu to enable the gate function. Select or remove one response in the time 

domain through the gate function, and then change into the frequency range for observation. 

Parameter description: 

OFF [OFF|ON]. 

2) Gate: start 
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Function description: 

Select this menu to set the start value of the gate. 

Parameter description: 

-10ns [-14.825797ns~14.825797ns] 

3) Gate: stop 

Function description: 

Select this menu to set the stop value of the gate. 

Parameter description: 

10ns [-14.825797ns~14.825797ns] 

4) Gate: center 

Function description: 

Select this menu to set the center value of the gate. 

Parameter description: 

0ns [-14.825797ns~14.825797ns] 

5) Gate: span 

Function description: 

Select this menu to set the span value of the gate. 

Parameter description: 

20ns[0ns-29.651594ns]. 

6) Gate: setup 

Function description: 

Select this menu to enter the window of time domain transformation function. The time 

domain transformation, gate, window and options can be set. 

Parameter description: 

None 

5.2.8.5 Window 

Function description: 

Select this menu to enter the window of time domain transformation function. The time 

domain transformation, gate, window and options can be set. 

Parameter description: 

None 

5.2.8.6 Time domain 

This menu is used to set the time domain. Click it to enter the menu of lower level. The 

specific menu includes: 

Table 5.34 Time Domain 
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Menu 

 Time domain ON/OFF 

 Start date 

 Stop time 

 Center time 

 Time span 

 Time domain transformation 

 Time domain window 

 Coupling 

 Time domain toolbar 

1) Time domain ON/OFF 

Function description: 

Select this menu to enable the time domain function. 

Parameter description: 

OFF [OFF|ON]. 

2) Start time 

Function description: 

Select this menu to set the start time. 

Parameter description: 

-10ns [-14.825797ns~14.825797ns] 

3) Stop time 

Function description: 

Select this menu to set the stop time. 

Parameter description: 

10ns [-14.825797ns~14.825797ns] 

4) Center time 

Function description: 

Select this menu to set the center time. 

Parameter description: 

0ns [-14.825797ns~14.825797ns] 

5) Time span 

Function description: 

Select this menu to set the time span. 

Parameter description: 
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20ns[0ns-29.651594ns]. 

6) Time domain transformation 

Function description: 

Select this menu to enter the window of time domain transformation function. The time 

domain transformation, gate, window and options can be set. 

Parameter description: 

None 

7) Time domain window 

Function description: 

Select this menu to enter the window of time domain transformation function. The time 

domain transformation, gate, window and options can be set. 

Parameter description: 

None 

8) Coupling 

Function description: 

Select this menu to enter the window of coupling function. 

Parameter description: 

None 

9) Time domain toolbar 

Function description: 

Select this menu to enable the time domain toolbar function so as to clearly observe the 

influence of setting changes on measurement. 

Parameter description: 

OFF [OFF|ON]. 

5.2.8.7 Structural Return Loss 

This menu is used to set the structural return loss. Click it to enter the menu of lower level. 

The specific menu includes: 

Table 5.35 Structural Return Loss 

Menu 

 SRL ON/OFF 

 Port connector 1/2/3/4 

 Automatic Z ON/OFF 

 Z Cutoff frequency 

 Manual Z 

1) SRL ON/OFF 
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Function description: 

Select this menu to enable the SRL function. 

Parameter description: 

OFF [OFF|ON]. 

2) Port connector 1/2/3/4 

Function description: 

Select this menu to set the length and capacity of the port connector 1/2/3/4. 

Parameter description: 

None 

3) Automatic Z ON/OFF 

Function description: 

Select this menu to enable the automatic Z function. 

Parameter description: 

OFF [OFF|ON]. 

4) Z cutoff frequency 

Function description: 

Select this menu to set the Z cutoff frequency. 

Parameter description: 

210MHz[10MHz~26.5GHz]. 

5) Manual Z 

Function description: 

Select this function to enable the manual Z function. 

Parameter description: 

OFF [OFF|ON]. 

5.2.8.8 Equation Editor 

Function description: 

Select this menu to enter the equation editor interface. Parameter description: 

Parameter description: 

OFF [OFF|ON]. 

5.2.9 System 

Press the [System] key on the front panel or the [System] menu item on the user interface. 

The system-related menu will pop up. Specific items include: [Configuration], [Record/Run 

1], [Record/Run 2], [Windows task bar], [Reset], [Custom user reset state], [Language: 

CN/EN] and [Spread spectrum]. The specific description of menu items is as follows. 

5.2.9.1 Configuration 
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This menu is used to set the configuration. Click it to enter the menu of lower level. The 

specific menu includes: 

Table 5.36 Configuration 

Menu 

 GPIB address 

 Control panel 

 System impedance 

 User configuration 

 IF options 

 Millimeter wave module configuration 

 Expansion to 16 ports 

 Touch screen 

1) GPIB address 

Function description: 

Select this menu to configure the GPIB address. 

Parameter description: 

16[0~30]. 

2) Control panel 

Function description: 

If this menu is selected, the control panel menu will pop up. The user can set the operating 

system. 

Parameter description: 

None 

3) System impedance 

Function description: 

Select this menu to set the system impedance. The system impedance must be changed in 

measurements of devices except those of 50Ω, such as waveguide devices. 

Parameter description: 

50Ω [0Ω-1kΩ]. 

4) User configuration 

Function description: 

If this menu is selected, the user can configure it. Configurable options include: “Enable 

touch screen”, “Save calibration file in the current time name”, “Not automatically save after 

calibration”, “Display marker on all the existing traces”, “Display limit test on all the existing 

traces”, “Press the UP/DOWN key to change the marker point by point”, “Install anti-virus 

software”, “Multi-port calibration” and “Identify port sweep state”. 
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Parameter description: 

None 

5) IF options 

Function description: 

Select this menu to select the intermediate frequency, including the internal intermediate 

frequency and external intermediate frequency. 

Parameter description: 

None 

6) Millimeter wave module configuration 

Function description: 

Select this menu to configure the millimeter wave module, including the model selection, 

port setting and frequency setting. 

Parameter description: 

None 

7) Expansion to 16 ports 

Function description: 

Select this menu to expand the instrument to 16 ports. 

Parameter description: 

None 

8) Touch screen 

Function description: 

Select this menu to enable the touch screen function and calibrate the touch screen. 

Parameter description: 

None 

5.2.9.2 Record/Run 1 

Function description: 

Select this menu to automatically start recording. If recording has been done, press this key to 

automatically start running. 

Parameter description: 

None 

5.2.9.3 Record/Run 2 

Function description: 

Select this menu to automatically start recording. If recording has been done, press this key to 

automatically start running. 

Parameter description: 

None 
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5.2.9.4 Windows Task Bar 

Function description: 

Select this menu to open the operating system task bar. 

Parameter description: 

None 

5.2.9.5 Reset 

Function description: 

Select this menu to run the application program of the 3672 series vector network analyzer. 

Parameter description: 

None 

5.2.9.6 Reset User State 

Function description: 

Select this menu to customize the user state interface. The user can customize the user reset 

state. 

Parameter description: 

None 

5.2.9.7 Language CN/EN 

Function description: 

Select this menu to select the operating language (CN|EN). 

Parameter description: 

CN [CN|EN]. 

5.2.9.8 Spread Spectrum 

Function description: 

Select this menu to select 364X series spread spectrum function. 

Parameter description: 

None 

5.2.10 Help 

Press the [Help] key on the front panel or the [Help] menu item on the user interface. The 

help-related menu will pop up. Specific items include: [User manual], [Programming 

manual], [Technical support], [Error information] and [About]. The specific description of 

menu items is as follows. 

5.2.10.1 User Manual 

Function description: 

Select this menu to open the “User Manual of 3672 Series Vector Network Analyzers”. 

Parameter description: 

None 
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5.2.10.2 Programming Manual 

Function description: 

Select this menu to open the “Program Control Manual of 3672 Series Vector Network 

Analyzers”. 

Parameter description: 

None 

5.2.10.3 Technical Support 

Function description: 

Select this menu to enter the home page of the 41st Institute of China Electronics Technology 

Group Corporation. 

Parameter description: 

None 

5.2.10.4 Error Information 

Function description: 

Select this menu to select the error parameter and view the error log. 

Parameter description: 

None 

5.2.10.5 About 

Function description: 

Select this menu to view the basic information of the instrument and the company 

information. 

Parameter description: 

None 
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6 Measurement Optimization 

The following methods can be applied to adjust the setting and optimize the measurement 

accuracy. 

● Reduction of accessory influence…………………………………………………………………………………202 

● Improvement of reflection accuracy of low-loss 2-port device………………………………..…….203 

● Increase of dynamic range…………………………………………………………………………………………..205 

● Improvement of measurement results of electrical long device……………………………208 

● Improvement of phase measurement accuracy………………………………………..…………………….209 

● Reduction of trace noise…………………………………………………………………………………………..….215 

● Increase of data point number……………………………………………………………………..……………….218 

● Improvement of measurement stability………………………………………………………………………...219 

● Improvement of sweep velocity……………………………………………………………………………………221 

● Improvement of efficiency of multi-state measurement………………………………………..……….225 

● Rapid data transmission……………………………………………………………………………………………….226 

● Macro use……………………………………………………………………………………………………………………227 

6.1 Reduction of Accessory Influence 

Some accessories may affect the measurement results of the DUT. Select one of two 

characteristics of the analyzer to reduce the accessory influence. In order to reduce the 

accessory influence, you can select the most suitable method to test the configuration. 

1) Compensate the cable loss with the power slope. 

If a long cable or other kind of accessory is used in measurement configuration, the power 

loss will be generated within the whole band. In this case, the power slope function should be 

applied. The defined ratio (dB/GHz) can be used in this function to increase the source power 

of the analyzer. The process of cable loss compensation is as follows. 

Menu path: [Stimulus] > [Power...]. 

If the power slope function is not activated, tick the [Power Slope] check box. Input the ratio 

to be increased in frequency sweep of the source power in the [dB/GHz] box. 

2) Selectively remove the response gate (only for the time domain). 

a) The gate is one of the time domain characteristics. It is used to remove the response 

mathematically. The gate of reflection response or transmission response can be set, but 

different results will be obtained. 

 Gate reflection response: the desired response (such as the return loss of the filter) can 

be separated from the undesired response (such as the adapter reflection or connector 

mismatch) by reflection response of the gate. 

 Gate transmission response: the specific path of large electrical length in the multi-path 

device can be separated by transmission response of the gate. 

In order to apply the gate in the time domain mode, the transformation can be disconnected, 
and the existing gate pulse can be used in study of the frequency response of the device. The 
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time filter gate pulse has the following shapes and features: 

 Band pass shape: the response beyond the passband zone can be removed. 

 Trap shape: unnecessary response in the frequency zone can be removed. 

b) Removal of unnecessary response 

Menu path: [Analysis] > [Time Domain] > [Time Domain Transformation...]. 

Click the [Transform] check box in the [Transform] dialog box to activate the 

transformation mode. Click the required transformation mode: low-pass impulse, low-pass step 

and band pass. Click [Frequency: low pass] to select the low pass mode. Click the drop-down list 

in the gate type box to select the gate type: band pass and trap. Set the gate threshold by setting 

the start value, stop value, center value or span. Click [Transform] in the trace menu. 

6.2 Improvement of Reflection Accuracy of Low-loss 2-port Device 

In order to realize accurate reflection measurement in one-port calibration, connect the 

unmeasured port. This method is particularly suitable for low-loss two-way devices, such as 

the filter passband and cable. The direction, source matching and frequency response error 

can be corrected by means of one-port calibration. The load matching error cannot be 

calibrated. Therefore, the load matching error must be minimized. 

Connect the unmeasured port in the following methods: 

 Connect the unmeasured port of the DUT to one high-performance terminal load (the 

calibration kit is also allowed). The measurement accuracy of this method is close to that of 

2-port calibration. 

 Connect the unmeasured port of the DUT directly to the analyzer. Insert one 10dB precision 

attenuator between the device output and analyzer. The effective load matching of the 

analyzer can be improved by once based on the measured value of the attenuator, i.e. 20dB. 

Prompt 

Matched load 

No consideration should be given to load matching in measurement of the device of high reverse isolation, 

such as the amplifier. 

Fig. 6.1 shows the instability of measurement of the DUT with or without 10dB precision 

attenuator at the end. 

 

Fig. 6.1 Comparison of Instability 
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Refer to the filter reflection. 

 

Refer to the instability of measurement without 10dB precision attenuator. 

 

Refer to the instability of measurement with 10dB precision attenuator. 

Fig. 6.2 shows the accurate reflection measurement of the 2-port device. The following 

calculation shows the improvement of loading matching with one high-quality 10dB 

attenuator. 

 

Fig. 6.2 Accurate Reflection Measurement of 2-port Device 

Attention 

The corresponding linear values are given in the brackets. 

 

Analyzer: Load matching (NALM)=18dB (.126) 

Direction (NAD)=40dB (.010) 

Filter: Insertion loss (FIL)=1dB (.891) 

Return loss (FRL)=16dB (.158) 

Attenuator: Insertion loss (AIL)=10dB (.316) 

SWR (ASWR)=1.05 (.024) Return loss: 32.26dB 

Calculation: without attenuator with attenuator 

 

 

Error in the worst case (EWC) NA =NA+Attn. 

=.1 =.01+.019 

 =.029 

Upper limit of 

instability=-20log{(FRL)+(EWC)+(NAD)} 

=-20log{(FRL)+(EWC)+(NAD)} 

=-20log{(.158)+(.100)+(.010)} =-20log{(.158)+(.029)+(.010)} 

=11.4dB =14.1dB 

Lower limit of =-20log{(FRL)-(EWC)-(NAD) 
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instability=-20log{(FRL)-(EWC)-(NAD)} 

=-20log{(.158)-(.100)-(.010)} =-20log{(.158)-(.029)-(.010)} 

=26.4dB =18.5dB 

Therefore, one of the following methods can be applied to obtain accurate results in 

reflection measurement of the low-loss 2-port device. 

 Connect one high-quality load to the output end of the DUT after one-port calibration. 

 Insert one 10dB attenuator between the output of the DUT and the analyzer after one-port 

calibration. 

 Directly connect the output of the DUT to the analyzer after 2-port measurement calibration. 

6.3 Increase of Dynamic Range 

The dynamic range refers to the difference between the maximum power allowed to be input 

into the analyzer and the minimum power (base noise) which can be tested. To make the 

measurement correct and effective, the input signal must be within the dynamic range. In 

order to greatly change the signal amplitude of measurement, such as the filter passband and 

stop-band, it is important to increase the dynamic range. Fig. 6.3 is a typical dynamic range 

of measurement. 

 

Fig. 6.3 Dynamic Range 

In order to reduce the instability of measurement, the dynamic range of the analyzer should 

be larger than the response of the DUT. For example, the accuracy can be improved if the 

response of the DUT is at least 10dB more than the base noise. The following methods can 

help to increase the dynamic range. 

Attention 

Dynamic range and measurement time 

As some analyzers have the characteristics of alternating sweep, the dynamic range can be increased so as to 

increase the measurement time. 

6.3.1 Increase of Input Power of Device 

1) The input power of the DUT can be increased so that the output power of the DUT can be 

accurately tested and measured by the network analyzer. 

2) If the input of the receiver is too high, compression distortion may be caused. If the input 

reaches to a certain degree, the receiver may be damaged. 

 

Warning 



6 Measurement Optimization 

6.3 Increase of Dynamic Range 

206  

 

If the input level reaches +15dBm, the receiver may be damaged. 

 

Attention 
 

Do not apply the maximum source output power. 

If the test equipment has gain, the maximum source output power cannot be applied; 

otherwise, the receiver may be damaged. 

Menu path: [Stimulus] > [Power]. The power shortcut key is set on the auxiliary menu bar 

and front panel. 

Input the power value directly in the input toolbar, or click [Power...] to set the power in the 

dialog box. 

6.3.2 Reduction of Base Noise of Receiver 

The following methods can be applied to reduce the base noise and increase the dynamic 

range of the analyzer. 

a) Reduce the intermediate frequency bandwidth. 

b) Use the sweep average value. 

Prompt 

Reduction of crosstalk between receivers 

When the measurement signal is close to the base noise of the analyzer, the crosstalk between receivers should 

be reduced. 

1) Reduction of intermediate frequency bandwidth 

As shown in Fig. 6.4, the intermediate frequency bandwidth has influence on measurement 

results. 

 The bandwidth of the intermediate frequency receiver can be reduced so as to reduce the 

influence of random noise in measurement. Once the intermediate frequency bandwidth is 

reduced by 10 times, the base noise will be reduced by 10dB. However, the smaller the 

intermediate frequency bandwidth is, the longer the sweep time is. 

 The network analyzer can change the received signal from the RF/microwave frequency into 

the intermediate frequency (7.606MHz). The bandwidth of the intermediate frequency band 

pass filter can be reduced from 5MHz to 1Hz (min.). 

 The intermediate frequency bandwidth can be independently set for each channel or each 

segment in segment sweep. 
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Fig. 6.4 Influence of Intermediate Frequency Bandwidth on Measurement Results 

a) Setting of intermediate frequency bandwidth 

Menu path: [Response] > [Avg] > [IF Bandwidth]. 

Input the intermediate frequency bandwidth value in the input toolbar or directly input the 

value in the [IF Bandwidth] dialog box or select a value with the arrow button. 

2) Increase or change of the average value of sweep 

a) Increase or change of the average value of sweep 

 Sweep averaging is a method to reduce the influence of random noise in measurement. 

 Each data point is calculated based on the average value of several continuous sweep 

procedures. 

 The more times averaging is done, the more noise will be reduced, and the larger the dynamic 

range will be. 

As shown in Fig. 6.5, sweep averaging has influence on measurement results. 

 

Fig. 6.5 Influence of Sweep Averaging on Measurement Results 

Prompt 

Reduction of random noise 

 The average value of measurement can be independently set for each channel. 

 The total measurement time increases along with the increase of averaging times. 

 General noise can be minimized by setting the average value and intermediate frequency bandwidth. 

 In order to minimize the low-frequency noise, measurement averaging is more effective than reduction of the 

system bandwidth. 

b) Setting of sweep average value 
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Menu path: [Response] > [Avg]. Set the average value by the [Average] key in the auxiliary 

menu bar or in the [Average] dialog box. Enable or disable the averaging function by [Average 

on/OFF]. Directly enter the value or press the arrow button to increase/decrease the averaging 

times according to the average factor. 

Attention 

Select [Restart Average] to start a group of new average sweep. 

6.4 Improvement of Measurement Results of Long Device of Each Point 

The frequency of the signal from the DUT may be different from the frequency of the signal 

into the DUT at the given time. This may result in inaccurate measurement results sometimes. 

The following contents can help to understand why inaccurate measurement results are 

obtained and how to compensate. 

Why are inaccurate results produced as a result of delay? 

 The source and receiver can be locked at the same time, and sweep can be done for one 

frequency interval with the vector network analyzer. 

 The signal through the DUT (DUT) represents different colors corresponding to different 

frequencies. 

 If the stimulus frequency passes through the DUT and the analyzer is tuned to new frequency 

before the signal reaches the receiver, inaccurate measurement results will be produced. 

As shown in Fig. 6.6, if a long cable is measured by the analyzer, the signal frequency of the 

cable end will lag behind the source frequency of the analyzer. If the frequency offset 

(typically dozens of kHz) is obvious relative to the intermediate frequency test bandwidth of 

the network analyzer, measurement results may be wrong due to the roll-down characteristics 

of the intermediate frequency filter. 

 

Fig. 6.6 Schematic Diagram of Test of Long Cable 

The delay of the electrical long device can be compensated in the following methods. 

1) Reduction of sweep velocity 

The sweep velocity can be reduced by increasing the sweep time, reducing the intermediate 

frequency bandwidth or increasing the number of sweep points. 

a) Increase the sweep time. 

Menu path: [Stimulus] > [Sweep] > [Sweep Time...]. 

Enter the time or select the time with the arrow. 

b) Reduce the intermediate frequency bandwidth. 
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Menu path: [Response] > [Avg] > [IF Bandwidth...]. 

Directly enter the value or select the time with the arrow. 

c) Increase the number of sweep points. 

Menu path: [Stimulus] > [Sweep] > [Points]. 

Directly click the required point number in the sub-menu or click [Custom...]. Enter the 

value in the [Points] dialog box or select the value with the arrow. 

2) Use of step sweep. 

Change analog sweep into step sweep so that the source can step over each test point. In this 

case, the sweep velocity of the analyzer can be reduced. The dwell time of each step or test 

point can also be set. 

Menu path: [Stimulus] > [Sweep] > [Sweep Setup...]. 

Tick the step sweep. Directly enter the dwell time in the [Dwell time] box or select the 

required dwell time of each test point. 

6.5 Improvement of Phase Measurement Accuracy 

The following characteristics of the analyzer can be applied to improve the accuracy of phase 

measurement. 

● Electrical delay········································································································································· 209 

● Port extension ·········································································································································· 209 

● Phase deviation ········································································································································ 212 

● Frequency point interval ··························································································································· 213 

● Specific operation····································································································································· 214 

6.5.1 Electrical Delay 

 The electrical delay can be applied to compensate the linear phase deviation of the DUT so as 

to highlight the linear phase deviation of the DUT. 

 The electrical delay is a kind of mathematical function. The transmission line of no loss and 

adjustable length can be simulated. 

 The electrical delay which is not associated with each measurement trace can be set. 

6.5.2 Port Extension 

1) The measurement reference plane can be moved electrically by means of port extension 

after calibration. Thus, other kinds of calibration can be avoided. Port extension is introduced 

in the following two cases. 

a) Decide whether to add one cable in the measurement configuration after calibration. The 

port extension characteristics can be applied to “tell” the analyzer to increase the cable length 

to the specific port. 

b) If calibration cannot be done directly on the DUT in the test fixture, port extension can be 

applied to compensate the delay (phase deviation) arising from the fixture. 

2) Use of port extension function 

a) If the electrical length of the tested fixture or added cable is known, enter the value in the 

[Time] box. 

file:///C:/Users/guozhenxing/Desktop/3672%20Series%20Vector%20Network%20Analyzer%20User%20Manual.docx%23_6.5.1_Electrical_Delay
file:///C:/Users/guozhenxing/Desktop/3672%20Series%20Vector%20Network%20Analyzer%20User%20Manual.docx%23_6.5.1_Electrical_Delay
file:///C:/Users/guozhenxing/Desktop/3672%20Series%20Vector%20Network%20Analyzer%20User%20Manual.docx%23_6.5.2_Port_Extension
file:///C:/Users/guozhenxing/Desktop/3672%20Series%20Vector%20Network%20Analyzer%20User%20Manual.docx%23_6.5.2_Port_Extension
file:///C:/Users/guozhenxing/Desktop/3672%20Series%20Vector%20Network%20Analyzer%20User%20Manual.docx%23_6.5.3_Phase_Deviation
file:///C:/Users/guozhenxing/Desktop/3672%20Series%20Vector%20Network%20Analyzer%20User%20Manual.docx%23_6.5.3_Phase_Deviation
file:///C:/Users/guozhenxing/Desktop/3672%20Series%20Vector%20Network%20Analyzer%20User%20Manual.docx%23_6.5.4_Frequency_Point
file:///C:/Users/guozhenxing/Desktop/3672%20Series%20Vector%20Network%20Analyzer%20User%20Manual.docx%23_6.5.4_Frequency_Point
file:///C:/Users/guozhenxing/Desktop/3672%20Series%20Vector%20Network%20Analyzer%20User%20Manual.docx%23_6.5.5_Specific_Operations
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b) If the physical length of the tested fixture or added cable is known, enter the value in the 

[Distance] box. 

c) If the above two items are unknown, the open-circuit device or short-circuit device can be 

used instead of the DUT on the reference plane after extension. Generally, the new reference 

plane is regarded in the open-circuit state after removal of the DUT. 

3) The appropriate port extension value can be obtained in the following methods. 

a) Select the S11 measurement after calibration and set the phase format as the display 

format. 

b) Connect the open-circuit device or short-circuit device to the calibration plane and check 

whether the displayed phase curve is within the measurement frequency range and around 0°. 

c) Connect the fixture or transmission cable and use the open-circuit device or short-circuit 

device instead of the DUT (the circuit is regarded as an open circuit if the DUT is removed). 

Adjust the value of the [Time] or [Distance] box in the [Port extension] dialog box until the phase 

trace is flat. 

d) If the loss characteristics of the extension part are known, compensation can be done in the 

one-dimensional or two-dimensional manner in the [Loss compensation] part. 

Attention 

Nonzero delay 

The nonzero delay is specified in the majority of short circuit standards and can be applied to adjust the error 

which is twice that of short-circuit calibration as a result of port extension and further view the definition of the 

calibration kit so as to determine the appropriate extension value. 

4) Setting of port extension 

Menu path: [Cal] > [Port Extension]. 
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Fig. 6.7 Setting of Port Extension 

The [Port Extension] dialog box will appear. Tick the [Port extension] check box. Then the 

port extension function will be effective for all ports. 

 [Port]: select the current extension port in the drop-down box. The port extension 

settings are effective for all measurements of active channels on the current port. 

 [Dist]: display the port extension toolbar. 

 [Time]: set the delay time of port extension. 

 [Distance]: set the physical length of the delay time of port extension. 

 [Unit]: set the calculation unit of port extension distance: meter, foot or inch. 

 [Loss @DC]: set the deviation of the whole frequency band. 

 [Loss][@Freq]: set the loss and frequency. If only [Loss 1] is selected, the compensation 

equation is as follows: 

Loss (f)=Loss 1* (f/ frequency 1)^0.5 

If Loss 1 and 2 are selected, the compensation equation is as follows: 

Loss (f)=Loss 1* (f/ frequency 1)^n, where: 

n=log10 (|Loss 1/Loss 2|)/log10 (Frequency 1/ Frequency 2) 

 [Velocity Factor]: set the velocity factor. Note that this velocity factor is the same as that 

of the system. 

 [Coaxial]: set the coaxial characteristics of the current port extension. 

 [Waveguide] and [Cutoff Freq]: set the waveguide characteristics of the current port 

extension. In this case, the cutoff frequency of waveguide can be set. Note that the set 

medium type is the same as that of the system. 

 [Reset]: recover the default mode of the system. Note that the port extension state 

remains unchanged. 

 [Auto Ext]: recall the [Auto Ext] dialog box. 

Manual port extension can be done automatically in the automatic port extension mode. If the 

extension plane is connected with an open-circuit device or short-circuit device, the system 

will automatically calculate the delay time and loss of port extension, and the measurement 

end face will be compensated to the extension part. 

Steps of automatic port extension: 

1) Connect the new transmission line or fixture and then connect the open-circuit device or 

short-circuit device to the new measurement end face. Generally, no connection with the 

calibration kit is equivalent to the open-circuit state. 

2) Click [Automatic Ext…] in the port extension toolbar and then click [Show 

configuration] to view more options. 

3) Click [Meas] to start the port extension calculation. The calculated delay time and loss 

value will be automatically displayed in the toolbar. 
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Fig. 6.8 Automatic Port Extension 

 [Open circuit] and [Short circuit]: connect the open-circuit device or short-circuit 

device to the port requiring automatic extension. 

 [Show configuration] and [Hide configuration]: display and hide the configuration of 

automatic port extension. 

 Measure On Port Number: select the port to be subject to automatic extension 

calculation. 

 Method: set the frequency range of the data collected for automatic port extension 

calculation. 

[Current Span]: the same as the frequency range of current measurement. 

[Active Marker]: use the data between the active marker and the part of the highest 

frequency to calculate the automatic port extension. 

[User Span]: the user enters the frequency range of calculation. 

 [Include Loss]: select it to automatically calculate the loss arising from the current port 

extension. 

 [Adjust for Mismatch]: select it to automatically compensate the error arising from 

mismatch. 

 [Prompt for Each Standard]: if this item is selected, the [Calculation kit connection] 

prompt box will pop up. 

 [Close]: apply the current calculation results to the active channel and exit the dialog 

box. 

6.5.3 Phase Deviation 

The phase deviation is a kind of mathematical phase measurement, and the deviation range is 

0-360°. Use this characteristic in the following methods: 

 Improve the display of phase measurement results. 

This is similar to the improvement of reference level in amplitude measurement. Change the 

phase response to make it at the screen center or on the same straight line as the screen. 

 Simulate the phase deviation determined in measurement. 

For example, if it is known to add a cable and the cable length may result in phase deviation 

of measurement results, the phase deviation can be increased by movement and the 

measurement of the whole device can be simulated. 
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1) Setting of phase deviation 

Menu path: [Response] > [Scale] > [Phase Offset...]. The [Phase Offset] dialog box will 

appear. 

Set the phase deviation in the [Phase deviation] box. 

 

Fig. 6.9 Automatic Port Extension 

6.5.4 Frequency Point Interval 

1) Sample the data of discrete frequency points, connect each sampling point and form a trace 

on the screen. 

2) If the phase deviation of two adjacent frequency points of the device is more than 180°, 

the displayed phase slope will look like the reverse phase. This is caused by mixing as a 

result of insufficient data sampling. 

If the group delay is measured but the phase slope is opposite, the symbol will be changed as 

a result of the group delay. For example, Fig. 6.10 shows the measurement results of the 

surface acoustic wave (SAW) bandpass filter. 

a) The first figure shows the measurement results of 51 points, and the group delay is 

negative. But this is impossible in the actual situation, as the response will not be below the 

reference line (0s). 

b) The second figure shows the measurement results of 201 points, and the group delay is 

positive, that is, the response is above the reference line (0s). 

 

Fig. 6.10 Influence of Frequency Interval on Phase Measurement 

Prompt 

Mixing check 

In order to check mixing in measurement, you can check whether the display data change by reducing the 

frequency interval. You can increase the number of frequency points or reduce the frequency interval to avoid 
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mixing. 

6.5.5 Specific Operations 

1) Compensation of linear phase deviation 

Menu path: [Response] > [Scale] > [Electrical Delay...]. 

Enter the required value in the [Electrical Delay] box or select the value with the arrow. 

Enter the value in the [Velocity Factor] box or select the value between 0 and 1.0 with the 

arrow. 

 1.0 corresponds to the light velocity in vacuum. 

 0.66 corresponds to the typical light velocity in the polyethylene medium. 

 0.70 corresponds to the typical light velocity in the Teflon medium. 

 

Fig. 6.11 Setting of Electrical Delay 

2) Electrical movement reference plane 

Menu path: [Cal] > [Port Extension...]. 

Select the [Port Extension on/OFF] check box. 

Add the port extension value in the reference plane to be extended. 

Select a value between 0 and 1.0 in the [Velocity Factor] box as the relative velocity of the 

added cable or medium after calibration. Then click [OK]. 

 1.0 corresponds to the light velocity in vacuum. 

 0.66 corresponds to the typical light velocity in the polyethylene medium. 

 0.70 corresponds to the typical light velocity in the Teflon medium. 

Prompt 

You can perform the following operation to check whether the sufficient delay is added: 

 Connect one short-circuit device. 

 Adjust the port extension until the phase correspondingly becomes flat. 
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Attention 

Determine the deviation delay of the standard short-circuit device. 

The delay time of the majority of short-circuit calibration kits is not zero. Therefore, the delay error caused by 

this method is twice that of the short-circuit device. Determine the deviation delay of the standard short-circuit 

device according to the definition of the inspection standards. 

3) Phase deviation measurement 

Menu path: [Response] > [Scale] > [Phase Offset...]. 

Enter the value in the [Phase Offset] dialog box or select the required value with the arrow. 

4) Inspection of mixing 

Menu path: [Stimulus] > [Sweep] > [Points]. 

Select one value in the list, or click [Custom...], and enter the value smaller than the current 

value through the number keys of the keyboard or input zone. 

The problem of changes of the displayed data can be solved by increasing the number of 

points or reducing the frequency span. 

6.6 Reduction of Trace noise 

Reduce the noise on the measurement trace by the network analyzer function. The following 

functions of the analyzer can help to reduce the influence of trace noise. 

● Sweep averaging ······································································································································ 215 

● Track smoothing ······································································································································ 216 

● Intermediate frequency bandwidth ············································································································ 217 

6.6.1 Sweep Averaging 

1) Sweep averaging 

a) Sweep averaging is a function to reduce the influence of random noise on the 

measurement. 

b) Each data point is calculated based on the average value of several continuous sweep 

operations. The times of continuous sweep are determined according to the setting of the 

average factor. 

c) The average value of traces will be applied on all measurements of one channel, and the 

average number of each channel will be displayed. 

d) The noise reduction and dynamic range can be improved by increasing the averaging 

times. 

e) The noise reduction effect of sweep averaging is the same as that of reduction of the 

intermediate frequency bandwidth. 

2) Influence of sweep averaging 

As shown in Fig. 6.12, sweep averaging has influence on measurement results. 
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Fig. 6.12 Influence of Sweep Averaging on Measurement Results 

3) Setting of sweep averaging 

Menu path: [Response] > [Avg] > [Average...]. 

Select [Average on/OFF] to enable the averaging function. 

Directly enter the value in the [Average Factor] box or increase/decrease the averaging times 

of the analyzer with the arrow button. 

 

Fig. 6.13 Setting of Sweep Averaging 

Attention 

Click [Restart Average] in the sub-menu to start a group of new average sweep. 

6.6.2 Track Smoothing 

The smoothing function is used to reduce the peak-peak noise of broadband measurement 

data. The data of part of the displayed trace are averaged by the analyzer. The number of 

adjacent data points subject to averaging at the same time is also known as the smoothing 

aperture. The aperture can be defined as the number of data point or the percentage of X-axis 

span. 

Prompt 

Use of the smoothing function: 

 Use sufficient points in the display to avoid misleading results. 

 The smoothing function must not be applied to the highly resonant device or the device subject to broad trace 
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changes, as measurement errors may be caused. 

 The smoothing function can be independently set for each trace. 

1) Influence of trace smoothing 

 

Fig. 6.14 Influence of Track Smoothing on Measurement Results 

2) Setting of trace smoothing 

Menu path: [Response] > [Avg] > [Smoothing...]. 

Click [Smoothing] to enable the smoothing function. 

Select the method to specify the value of the smoothing aperture: 

a) Enter the smoothing percentage in the [Percent] box. (Max. 25%) 

b) Enter the number of smoothing points in the [Points] box. (The maximum value is 25% of 

the total number of sweep points of the test.) 

 

Fig. 6.15 Setting of Smoothing 

6.6.3 Intermediate Frequency Bandwidth 

You can reduce the bandwidth of the intermediate frequency receiver so as to reduce the 

influence of random noise in measurement. Once the intermediate frequency bandwidth is 

reduced by 10 times, the base noise will be reduced by 10dB.However, if the intermediate 

frequency bandwidth is small, the sweep time will be long. The signal received by the 

analyzer will be changed into the intermediate frequency (7.606MHz) from the network 

analyzer can change the received signal from the RF/microwave frequency into the 

intermediate frequency (7.606MHz). The bandwidth of the intermediate frequency band pass 

filter can be reduced from 5MHz to 1Hz (min.). The intermediate frequency bandwidth can 
be independently set for each channel or in segment sweep. 
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1) Reduction of influence of intermediate frequency bandwidth 

The influence of the intermediate frequency bandwidth on measurement results is shown in 

Fig. 6.16. 

 

Fig. 6.16 Influence of Intermediate Frequency Bandwidth on Measurement Results 

2) Setting of intermediate frequency bandwidth 

Menu path: [Response] > [Avg] > [IF Bandwidth...]. 

Directly enter the value in the [Intermediate frequency bandwidth] dialog box or select the 

value with the arrow button. 

 

Fig. 6.17 Setting of Intermediate Frequency Bandwidth 

6.7 Increase of Data Point Number 

The data point or “point” refers to the sampling results of next value after one stimulus. You 

can define the number of measurement points within one sweep. 

 The trace can be swept through a large number of data points so as to better define the device 

response. 

 The majority of data processing is done between adjacent points. One “sweep” refers to the 

measurement results of a series of continuous data points, corresponding to the stimulus 

value within one sequence. 

 The default number of points of each sweep is 201. 

The sweep time of the analyzer can be changed according to the number of sweep points and 

the scale. However, the total measurement period will not change according to the number of 

sweep points and the scale. Instead, it is affected by other factors, such as the flyback time, 

data calculation, formation time, etc. Refer to the technical specifications for the influence of 

the point number and other settings on the sweep time. 



6 Measurement Optimization 

6.8 Improvement of Measurement Stability 

      219 

 

Prompt 

Use of data points 

 In order to obtain the best trace resolution, use the maximum number of data points. 

 In order to realize rapid throughput, use the minimum number of data points, which can help to achieve the 

acceptable accuracy. 

 In order to find the optimal number of data points, find a value with measurement results subject to no 

significant difference from the required number of measurement points. 

 In order to ensure the accurate measurement calibration, the number of calibration points should be the same 

as that of measurement points. 

1) Specific operations 

Menu path: [Stimulus] > [Sweep] > [Number of Points]. 

Directly click the required point number in the [Number of Points] sub-menu, or click 

[Custom...], enter the value in the [Number of Points] dialog box, or select the value with the 

arrow. 

 

Fig. 6.18 Setting of Number of Sweep Points 

2) Optimization of measurement results 

One measurement includes several interdependent settings. You can modify the settings to 

achieve the purposes of measurement application: faster throughput or more accurate data. 

You can balance the settings to optimize measurement. 

 Increase the measurement throughput. 

 Improve the measurement accuracy. 

6.8 Improvement of Measurement Stability 

Measurement instability is caused under several conditions. For repeated measurement, you 

can apply several methods to create a stable measurement environment. The following factors 
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have adverse effects on the measurement accuracy. 

1) Frequency offset 

The frequency precision of the analyzer depends on the accuracy of the internal 10MHZ 

oscillator. If high frequency accuracy and stability are required in the measurement 

application, no consideration should be given to the internal frequency standard, and a 

high-stability external frequency source can be created by the 10MHz reference input 

connector on the rear panel. 

2) Temperature deviation 

a) The electrical characteristics of the following components can be changed as a result of 

thermal expansion and contraction. 

 Internal device of analyzer 

 Standard of calibration kit 

 Tester 

 Cable 

 Adapter 

b) The temperature deviation in measurement can be reduced in the following methods. 

 Apply a temperature-controlled environment. 

 Ensure the temperature stability of the calibration kit. 

 Avoid unnecessary operation of the calibration kit during calibration. 

 Ensure that the difference between the ambient temperature and calibration temperature 

is ±1℃. 

3) Improper measurement calibration 

Improper measurement calibration may result in failure to detect the correct response of the 

DUT. You can apply the following methods to ensure the proper calibration: 

a) Perform the measurement calibration of the connection of the DUT, i.e. reference plane. 

b) If an additional accessory (cable, adapter or attenuator) is inserted into the DUT after one 

measurement calibration, the additional electrical length and delay time can be compensated 

by the port extension function. 

c) Apply the calibration standard defined in the calibration process. For more details, see the 

section about accurate measurement calibration. 

4) Equipment connector 

A good connector is necessary in repeated measurement. Good connection can be realized in 

the following methods: 

a) Check and clean the connectors of all components in the test equipment. 

b) Apply the correct connection method. 

c) Do not move the cable during measurement. 

5) Apply the external reference frequency. 

Input the external frequency reference signal to the rear panel connector. 

a) Input frequency: 10MHz±10ppm 
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b) Input level: -15dBm to +20dBm 

c) Input impedance: 200ohms 

6) Control the room temperature. 

a) Run the analyzer for more than 30min before each measurement calibration or equipment 

measurement. 

b) Measure the equipment in the temperature-controlled environment. All the instructions and 

characteristics are applied at 23℃±3℃ (unless otherwise specified). 

c) Ensure that the difference between the ambient temperature and calibration temperature is 

±1℃. 

7) Stabilize the standard temperature of calibration. 

a) Open the calibration kit box and take out the standard kit out of the protective foam one 

hour before measurement calibration. 

b) Avoid unnecessary operation of the calibration kit in each measurement calibration. 

8) Use connectors in good conditions. 

a) Check all connectors with the magnifying glass. Check the following kinds of damage: 

wear, bending, breakage, deep scratch, dent, rounded shoulder, dirt or metal chippings. 

b) Clean all connectors with isopropyl alcohol and swabs. 

 Evaporate alcohol. 

 Gradually dry connectors with compressed air. 

c) Properly connect the parts. 

 Connect the body and other parts to the ground with anti-static pads and wrist straps. 

 Arrange the connectors in one row. 

 Rotate the connection nuts. 

 Perform final connection with the torque wrench. 

6.9 Increase of Sweep Velocity 

The measurement efficiency can be improved by increasing the sweep velocity. The highest 

sweep velocity can be achieved by optimizing the following settings in measurement. 

1) Sweep setting 

Carefully set the following items to achieve the highest sweep velocity. 

 Frequency span: only measure the frequency range of the DUT. See the setting method 

in “4.3 Setting of Frequency Range”. 

 Segment sweep: measure the relevant frequency range by means of segment sweep. See 

the setting method in the instructions of “Setting of sweep type” in “4.5.2 Setting of 

sweep type” of “4.5 Setting of Sweep”. 

 Shutdown of step sweep: the step sweep mode must not be used unless permitted in 

measurement, so as to minimize the sweep time. See the setting method in “4.5.3 Setting 

of sweep” of “4.5 Setting of Sweep”. 

 Automatic sweep time: use the default setting time in the current setting to achieve the 



6 Measurement Optimization 

6.9 Increase of Sweep Velocity 

222  

 

most rapid sweep. See the setting method in “4.5.3 Sweep time” of “4.5 Setting of 

Sweep”. 

 Number of sweep points: use the minimum number required in measurement. See the 

setting method in “6.7 Increase of Data Point Number”. 

2) Setting of noise reduction 

Reasonably set the following two items to reduce the sweep time but obtain the acceptable 

measurement results. 

 Intermediate frequency bandwidth: use the largest intermediate frequency bandwidth 

to ensure the acceptable trace noise and dynamic range. See the setting method in “6.6.3 

Intermediate frequency bandwidth” of “6.6 Reduction of Trace noise”. 

 Average: minimize the average factor or shut down the averaging function. See the 

setting method in “6.6.1 Sweep averaging” of “6.6 Reduction of Trace noise”. 

3) Selection of calibration type 

Apply the most rapid calibration meeting the measurement requirements. The time of sweep 

measurement is almost the same without error correction or with response calibration. The 

measurement parameters of fully 2-port calibration should be updated with error correction by 

forward and reverse sweep, even if only one S-parameter is displayed, so the measurement time is 

the longest. For calibration type details, see “6.2 Selection of Calibration Type”. 

4) Shutdown of unnecessary functions 

The information of all active functions must be updated. In order to increase the sweep 

velocity, the following unnecessary functions for measurement should be shut down. 

 Unnecessary trace 

 Unnecessary marker 

 Smoothing 

 Limit test 

 Trace operation 

 Display 

The sweep velocity of the analyzer depends on measurement settings. Therefore, you should 

try many times to achieve the highest sweep velocity and conforming measurement results. 

a) Delete the unnecessary trace. 

Right-click the mouse on the state bar button used to delete the trace. The right-click menu 

will appear. 

Click [Delete trace] in the right-click menu. 
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Fig. 6.19 Deletion of Unnecessary Trace 

b) Close the unnecessary marker. 

Menu path: [Marker] > [Marker] > [Active Marker Off]. 

Select the marker to be closed. 

 

Fig. 6.20 Closing of Unnecessary Marker 

c) Shutdown of smoothing function 

Menu path: [Response] > [Avg] > [Smoothing...]. The [Smoothing] dialog box will appear. 

Click [Smoothing ON/off] to shut down the smoothing function. 
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Fig. 6.21 Shutdown of Smoothing Function 

d) Shutdown of limit test 

Menu path: [Analysis] > [Limit Test...]. The [Limit Test] dialog box will appear. 

Click [Limit Test ON/off] check box to shut down the limit test function. 

 

Fig. 6.22 Shutdown of Limit Test 

e) Shutdown of trace operation function 

Menu path: [Analysis] > [Memory] > [Math/Memory]. 

Select the data in the [Data Math] box. 

 

Fig. 6.23 Shutdown of Track Operation Function 
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6.10 Improvement of Efficiency of Multi-state Measurement 

If multiple parameter measurements are required to represent the characteristics of one device, 

various methods can be applied to improve the measurement efficiency. You can try the 

following methods to find the most suitable application solution. 

● Improvement of measurement efficiency by measurement setting ····························································· 225 

● Automatic change of measurement setting ································································································ 226 

● Rapid recalling of measurement ················································································································ 226 

6.10.1 Improvement of Measurement Efficiency by Measurement Setting 

In order to improve the measurement efficiency of the DUT requiring various parameter 

measurements, you should be familiar with the analyzer operation, which can help to create the 

optimal application solution. See trace, channel and window details related to parameter 

measurements in “3.4 Track, Channel and Window of Analyzer”. 

1) Reasonably arrange one group of measurements. 

Arrange one group of measurements of the DUT in one instrument state. Save the instrument 

state so as to perform the previous group of measurements by recalling. Or, arrange a group of 

measurements by the preconfigured measurement setting function of the analyzer. See details in 

“Setting of preconfigured measurement” of “4.8 Observation of multiple traces and opening of 

multiple channels”. 

2) Apply the segment sweep function. 

Segment sweep can be applied to change the following settings to represent multiple 

parameter measurements of one device. 

 Frequency range 

 power level 

 intermediate-frequency bandwidth 

 Number of sweep point 

A group of frequency ranges with respective attributes can be defined in segment sweep. In this 

case, the DUT with multiple measurement settings can be measured by means of one sweep. See 

segment sweep details in the “Setting of segment sweep type” of “4.5.2 Setting of sweep type” of 

“4.5 Setting of sweep”. 

3) Selectively trigger the measurement. 

Set the measurement as follows by triggering. 

 Continuously update the measurement with rapid data changes. 

 Occasionally update the measurement with a few data changes. 

For example, the tuning measurement of one filter can be set by the following settings: 

 One channel is used to measure the passband response of the filter in tuning. 

 One channel is used to measure the out-of-band response of the filter. 

In this case, the turning measurement of the filter can be observed continuously. If all 

channels are updated constantly, the response velocity of the analyzer will be reduced, and 

the filter cannot be tuned rapidly. Measurement setting is introduced as follows. 

 Measurement data of Channel 1 will be updated continuously. 
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 Measurement data of Channel 2 will be updated when required. 

a) Use the mouse. 

1) Create the double-channel measurement. 

Menu path: [Response] > [Display] > [Measurement Setup] > [Setting D]. 

2) Set the trigger mode of Channel 1: constantly update measurement data. 

Menu path: [Stimulus] > [Trigger] > [Trigger...]. The [Trigger] dialog box will appear. 

Select the [Internal] radio box in the trigger source zone. 

Click the [Channel] box in the trigger setting zone and select Channel 1. 

Click the [Continuous] radio box in the trigger setting zone. 

3) Set the trigger mode of Channel 2: update measurement data when required. 

Click the [Channel] box in the trigger setting zone and select Channel 2. 

Click the [Single] or [Groups] radio box in the trigger setting zone. If the group triggering 

mode is selected, enter the group number in the [Groups] input box. 

4) Click [Soft keyboard] in the [System] menu. The [Soft keyboard] dialog box will appear. 

Click [Stimulus] > [Trigger] in the dialog box and the toolbar to trigger the corresponding soft 

key will appear. 

5) Click the window below to set Channel 2 as the current active channel. 

6) Update the measurement data of Channel 2. 

7) Click the [Single], [Groups] or [Re-sweep] on the trigger soft key toolbar. Measurement 

data of Channel 2 will be updated. 

6.10.2 Automatic Change of Measurement Setting 

Automatically change measurement settings by means of programming to effectively 

improve the efficiency of multi-parameter measurements. 

6.10.3 Rapid recalling of measurement 

The most effective method to recall the measurement is to save a group of measurements as 

one instrument state. 

 The time difference of recalling the instrument with one or more measurements is little. 

 The corresponding time is required in each recalling. The recalling time can be saved by 

setting a group of measurements. 

6.11 Rapid Data Transmission 

Rapid data transmission can help to improve the measurement efficiency. You can apply the 

following methods to increase the data transmission velocity. 

● Rapid recalling of measurement ················································································································ 227 

● Minimization of transmission data ············································································································ 227 

● Use of real number format ························································································································ 227 

● Use of LAN ············································································································································· 227 

● Use of COM program ······························································································································· 227 
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6.11.1 Use of “Single” Trigger Mode 

Use the “single” trigger mode to complete measurement before data transmission. 

Menu path: [Stimulus] > [Trigger] > [Trigger...]. The [Trigger] dialog box will appear. 

Select the [Internal] radio box in the trigger source zone. 

Select the measurement channel for data transmission by clicking the [Channel] box in the 

trigger setting zone. 

Click the [Continuous] radio box in the trigger setting zone and then click [OK] to close 

the dialog box. 

Update the measurement results: 

1) Click the corresponding trace state button to set the trace and channel to be updated as the 

active trace and channel. 

2) Click [Soft keyboard] in the [System] sub-menu. Then click [Stimulus] > [Trigger] in 

the [Soft keyboard] dialog box. 

3) Click [Single] in the trigger soft key toolbar. 

6.11.2 Minimization of Transmission Data 

Apply the segment sweep function to reduce the number of trace points, instead of 

transmission of the whole trace with a lot of linear points. 

6.11.3 Use of Real Number Format 

Select the real number format in automatic measurement using SCPI so as to achieve the 

highest transmission velocity. 

6.11.4 Use of LAN 

Use the LAN to increase the data transmission velocity in the automatic SCPI measurement 

application. 

6.11.5 Use of COM Program 

Use COM in the automatic measurement program to achieve the highest velocity of data 

transmission. 

6.12 Use of Macro 

The macro is an executable file installed and run in the analyzer. 3672 series vector network 

analyzers support up to 10 macros. 

● New macro ··············································································································································· 227 

● [Macro setting] dialog box ························································································································ 229 

● [Macro setting window] dialog box ·········································································································· 229 

6.12.1 New macro 

Menu path: [System] > [Macro] > [Macro Setup...]. The [Macro setting] dialog box will 

appear. 
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Fig. 6.24 Macro Setting 

Click the [Macro Setup] dialog box to activate the blank line under the macro settings. Click 

the [Edit...] button and the [Macro setting window] dialog box will appear. 

 

Fig. 6.25 [Macro setting] Dialog Box 

 Enter the macro title text in the [Macro Title] box. 

 Enter the detailed path of the executable file in the [Macro Executable] box, or click the 

[Browse...] button to find the executable file. 

 Enter the character string parameter of the executable file in the [Parameter] box. 

 

Fig. 6.26 [Macro setting window] Dialog Box 
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6.12.2 [Macro Setup] Dialog Box 

1) [Macro Name] box 

Display the macro title. If the [Macro/local] key is pressed, the macro title can be displayed 

in the current toolbar button. Click [Macro] in the system menu. The macro title will be displayed 

in the macro sub-menu. To display the complete macro title in the current toolbar button, the 

number of title characters should not exceed 14. The macro title can be associated with the 

executable file. It is better to describe the macro function so as to easily distinguish different 

macros. For example, the title of the macro to visit the home page of the 41st Institute can be 

named as “41st Institute Home Page”. 

2) [Executable File] box 

Display the full path of the executable file. Take the macro to visit the home page of the 41st 

Institute as an example. The path of the executable file is: 

C:\ProgramFiles\InternetExplorer\IEXPLORE.EXE. 

3) [Parameter] box 

Display the parameter to be transmitted to the executable file and used by the executable file. 

Take the macro to visit the home page of the 41st Institute as an example. The parameter of 

macro running is: http://www.ei41.com. 

4) [Edit] button 

Click it to display the [Macro editing window] dialog box to set and modify the selected 

macro. 

5) [Delete] button 

Click it to delete the selected macro. 

6) [UP] button 

Click it to move the selected macro up for one line. It is used to rearrange the macro 

sequence. The macro sequence in the dialog box is the same as that in the current toolbar. Four 

macros will be displayed in the toolbar each time. If [Macro/local] is pressed, four macros will be 

displayed. 

7) [DOWN] button 

Click it to move the selected macro down for one line. 

6.12.3 [Macro setting window] dialog box 

1) [Macro name] box 

Set the macro title name. 

2) Editing zone 

a) [Executable file] box 

Set the full path of the executable file. 

b) [Browse...] button 

Browse the drive and director, position the executable file and establish the full path of the 

executable file. 

c) [Parameter] box 

Used to set the character string parameter to be transmitted to the executable file for 
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7 Calibration 

Calibration can help to reduce the measurement error. This chapter includes the following 

contents: 

● Calibration overview………………………………………………………………………230 

● Selection of calibration type…………………………………………………………….…231 

● Calibration guide………………………………………………………………..…….……233 

● High-accuracy measurement calibration…………………………………………….…..…236 

● Measurement error…………………………………………………………………….……239 

● Editing of calibration kit definition…………………………………………………………242 

● Calibration standards…………………………………………………………………..……252 

● TRL calibration…………………………………………………………………………..…254 

● Fixture compensation calibration………………………………………………………...…255 

● Electronic calibration……………………………………………………………………….266 

7.1 Calibration Overview 

Measurement calibration is a process to determine the system errors according to the 

standards of the existing measurement characteristics and then eliminate the influence of 

system errors during measurement of the DUT. It can help to reduce the measurement error 

and improve the measurement accuracy of the analyzer. 

7.1.1 Definition of Calibration 

Calibration is a process to eliminate one or more system error(s) with the error model. The 

error item of the error model is solved by measurement according to high-quality calibration 

standards (including the open-circuit device, short-circuit device, load and through type part). See 

system error details in “7.5.3 System Error” of “7.5 Measurement Error” in this chapter. 

Select the appropriate calibration method according to the measurement type and accuracy 

requirements. See details in “7.2 Selection of Calibration Type”. 

Various kinds of calibration can be done according to the calibration guide of the calibration. 

See details in “7.3 Calibration Guide”. 
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The measurement accuracy after calibration depends on the quality of the calibration standard 

and the model definition accuracy of the standard calibration kit in the calibration kit definition 

file. The calibration kit definition file is saved in the analyzer. In order to ensure the measurement 

accuracy, the actual calibration kit must conform to the requirements of the calibration kit 

definition file. See accurate calibration details in “7.4 High-accuracy Measurement Calibration”. 

The user must correctly define the calibration standard in the calibration kit definition file of 

the user so as to use the custom calibration kit (e.g. for fixture measurement calibration). See 

details in “7.6 Editing of Calibration Kit Definition”. 

7.1.2 Significance of Calibration 

It is impossible to make an ideal analyzer requiring no error correction from the perspective 

of hardware circuit. Even if error correction can be ignored in good hardware circuits, the 

costs will be high. In addition, the measurement accuracy of the analyzer is largely 

influenced by external accessories. The amplitude and phase changes of test components such 

as the connecting cable and adapter will affect response the real response of the DUT. 

Therefore, the best method is to balance the hardware performance and cost, make 

high-quality hardware as practical as possible and improve the measurement accuracy by 

calibration. 

7.1.3 Applications of Calibration 

 High measurement accuracy is expected. 

 Different types of connector or impedance are used. 

 A cable is connected between the DUT and the test port of the analyzer. 

 The DUT is measured in a wide frequency range or a device of long electrical delay is 

measured. 

 An attenuator or similar device is connected to the input or output end of the DUT. 

7.1.4 Simple Calibration Process 

1) Connect the analyzer according to the measurement requirements. 

2) Select the appropriate analyzer to optimize measurement. 

3) Remove the DUT and select the calibration type and kit according to the calibration guide. 

4) Connect the standard calibration kit of the selected type in measurement according to the 

calibration guide. The error is calculated by measurement with the standard calibration kit 

and saved in the memory of the analyzer. 

5) Reconnect and measure the DUT. If error correction is applied during measurement, the 

error influence will be eliminated. 

7.2 Selection of Calibration Type 

3672 series vector network analyzers support six common calibration types, with details as 

follows: 

1) Open-circuit response 

a) Calibration accuracy: low to medium. 

b) Measurement parameter: S11, S22, S33 and S44. 

c) Standard calibration kit: open-circuit device. 

d) System error correction: reflection tracking. 
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e) Measurement application: reflection measurement of any port. 

2) Short-circuit response 

a) Calibration accuracy: low to medium. 

b) Measurement parameter: S11, S22, S33 and S44. 

c) Standard calibration kit: short-circuit device. 

d) System error correction: reflection tracking. 

e) Measurement application: reflection measurement of any port. 

3) Through type response 

a) Calibration accuracy: medium. 

b) Measurement parameter: S-parameter of transmission measurement. 

c) Standard calibration kit: through type device. 

d) System error correction: transmission tracking. 

e) Measurement transmission measurement in any direction. 

Attention 

The adapter is used as the through type device. 

The through type device is of zero length and loss according to the definition in the calibration kit definition file. If 

the adapter is used as the through type device in calibration, the characteristics of the adapter must be specified in the 

calibration kit definition file to ensure the accuracy of calibration. See details in “7.4 High-accuracy Measurement 

Calibration”. 

4) Through type response and isolation 

a) Calibration accuracy: medium. 

b) Measurement parameter: S-parameter of transmission measurement. 

c) Standard calibration kit: through type device and two load (one respectively for each port). 

d) System error correction: 

 Transmission tracking 

 Crosstalk 

e) Measurement application: 

 Transmission measurement in any direction. 

 Improvement of the dynamic range of the system by means of isolation calibration. 

Attention 

Isolation calibration 

Isolation calibration is not allowed if all the ports are not respectively connected with one load at the same time. 

5) One-port (reflection) 
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a) Calibration accuracy: high 

b) Measurement parameter: S11, S22, S33 and S44. 

c) Standard calibration kit: open-circuit device, short-circuit device and load. 

d) System error correction: 

 Direction 

 Source matching 

 Reflection tracking 

e) Measurement application: reflection measurement of any port. 

6) Full 2-port SOLT 

a) Calibration accuracy: high 

b) Measurement parameters: all 

c) Standard calibration kit: open-circuit device, short-circuit device, load and through type 

device. 

d) System error correction: 

 Direction 

 Source matching 

 Reflection tracking 

 Crosstalk 

 Transmission tracking 

e) Measurement application: 

 Measurement of all S-parameters. 

 Improvement of the measurement accuracy by 12 error corrections. 

7.3 Calibration Guide 

Select the calibration type and perform calibration according to the calibration guide of the 

analyzer. The through type response and isolation calibration are taken as examples below to 

demonstrate the calibration process (this kind of calibration is effective only in transmission 

measurement). 

Enable the calibration guide for calibration. 

1) Menu path: [Cal] > [Calibration…]. The [Calibration guide] dialog box will appear. 
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Fig. 7.1 Enabling of Calibration 

2) Click [Unguided calibration] and [Next]. 

 

Fig. 7.2 Start of Calibration 

3) Click [THRU Resp and Isol] and [Next]. 

 

Fig. 7.3 Selection of Type of Mechanical Calibration 

4) Click [Cal kit Select], and the [Select CalKit] dialog box will appear. Select the 

calibration kit and click [OK] to open the dialog box. Thus the calibration kit is changed. 
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Fig. 7.4 [THRU Resp and Isol] Dialog Box and [Select calibration kit] Dialog Box 

5) Click [Selected Standards], and the [Type information] dialog box will appear. Set the 

calibration standard and click [OK] to close the dialog box. 

 

Fig. 7.5 [Type information] Dialog Box 

6) To directly connect Port 1 and 2 through the cable, click [Through] and [(THRU)]. After 

connection, click [OK]. The standard calibration kit button in the [THRU Resp and Isol] dialog 

box will become green after through type calibration. Modify the frequency range of calibration in 

the [Min Freq] and [Max Freq] input box. 

 

Fig. 7.6 [Measurement of multiple standard kits] Dialog Box 

7) Respectively connect Port 1 and 2 to the load calibration kit. Click [Load] and the keys of 

the standard kit type and interface type (the display contents vary from calibration types). After 
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selection, click [OK]. Modify the frequency range of calibration in the [Min Freq] and [Max 

Freq] input box. The standard calibration kit button in the [THRU Resp and Isol] dialog box will 

become green after isolation calibration. 

 

Fig. 7.7 [Multiple Standards] Dialog Box 

8) Click [OK] in the [THRU Resp and Isol] dialog box after calibration. 

 

Fig. 7.8 [Through type response and isolation calibration] Dialog Box 

Notes: 1. The optional calibration type is associated with the measurement parameters of the 

current active channel. For example, if the measurement parameter is S11, the through type 

response mode or the through type response and isolation calibration mode cannot be selected. 

2. If isolation calibration is not required in the full 2-port calibration, tick the [Ignore 

isolation (2-port type)] check box. 

Attention 

Properly select the calibration standard to realize the highest calibration accuracy. 

The [Measurement of multiple standard kits] dialog box shows the standard connector types, instead of the 

connector types for non-test ports. In order to realize the highest calibration accuracy, the calibration standard must 

be selected properly. 

7.4 High-accuracy Measurement Calibration 

The calibration accuracy depends on the selected calibration type, calibration kit quality and 

calibration process. This section mainly discusses how to perform high-accuracy calibration. 

1) Measurement reference plane 

The DUT is not directly connected to the port of the analyzer in most of measurements. 

Instead, it is connected through the test fixture or cable. The connection point of the DUT 

must be calibrated to realize the highest measurement accuracy. This point is recalled the 

measurement reference plane. If the measurement reference plane is calibrated, the error 

related to the measurement composition (such as the cable, test fixture and adapter between 

the analyzer port and reference plane) can be measured and eliminated. 

2) Influence of calibration kit 
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Under normal conditions, the calibration standard of the calibration kit is the same as the 

connector type standard of the DUT. In some cases, however, the calibration kit 

corresponding to the connector type of the DUT is not provided. For example, the port size of 

the DUT is 2.4mm, but the connector size of the analyzer and calibration kit is 3.5mm. If the 

2.4mm calibration kit is used for calibration and the 2.4mm/3.5mm adapter is used in 

measurement, the measurement error will be obvious, especially in reflection measurement, 

as the adapter is not calibrated. If the applied calibration kit is different from the calibration 

kit specified for calibration, the calibration accuracy will be reduced. The degree of accuracy 

reduction depends on the difference between the specified calibration kit and actual 

calibration kit. 

3) Accuracy of interpolation measurement 

If the instrument settings are different from calibration settings, calibration data can be 

automatically interpolated into the analyzer. In this case, the measurement accuracy cannot be 

predicted and may drop greatly or not be affected. The measurement error must be 

determined depending on the actual situation. If the phase shift added by two measurement 

points exceeds 180 degrees, the measurement accuracy will drop greatly as the correct phase 

data cannot be interpolated. Generally, the probability of accuracy reduction may increase as 

a result of interpolation in the following cases: 

 When the frequency span between measurement points is increased; 

 When the frequency span between measurement points is too large; 

 When the measurement frequency is high, especially above 10GHz. 

4) Influence of power level 

The power level must not be changed after calibration in order to realize the highest accuracy 

of error correction. However, if the power level is changed under the same conditions as the 

attenuator settings in calibration, the accuracy of S-parameter measurement only declines a 

little. If the attenuator settings are changed, the accuracy of error correction will decline 

further. 

5) System impedance 

The system impedance must be changed in measurement of the impedance device (not 50Ω) 

such as the waveguide device. The default system impedance is 50Ω. 

a) Setting of system impedance 

Menu path: [System] > [Configuration] > [Impedance...]. 

Enter the system impedance value in the [Impedance] box and click [OK] to close the dialog 

box. 

6) Port extension 

The measurement reference plane may be changed as a result of connection of the cbale, 

adapter or fixture after calibration, which may lead to increase of the phase shift. In this case, the 

additional phase deviation can be compensated by means of port extension. Port extension is the 

simplest method to compensate the additional phase shift between the calibration plane and DUT 

plane, but cannot be used to compensate the loss and mismatch of the path between the calibration 

plane and DUT plane. Therefore, the loss and mismatch should be minimized to realize the highest 

measurement accuracy. For setting of port extension, refer to “Setting of port extension” in “6.5 

Improvement of Phase Measurement Accuracy”. 

7) Correct isolation calibration 

Isolation calibration in full 2-port calibration is applied to correct the crosstalk error between 

ports. It is required only in measurement of large insertion loss, such as the out-of-band 
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suppression of the filter, isolation of the switch, etc. When the crosstalk signal is close to the 

base noise of the analyzer, additional noise will be produced in the error model as a result of 

isolation calibration. In order to improve the calibration accuracy, you should: 

 Perform isolation calibration if necessary; 

 Use the narrow intermediate frequency bandwidth; 

 Reduce noise by sweep averaging. 

The test port of the analyzer should be connected with a load in isolation calibration. In order 

to realize the highest calibration accuracy, it is preferred to connect the loads to two measurement 

ports at the same time for isolation calibration. If only one load is provided, connect a well-fitted 

device to the non-measurement port. 

  



7 Calibration 

7.5 Measurement Errors 

      239 

 

7.5 Measurement Errors 

Understanding of the source of measurement error and the way of error correction can help to 

improve the measurement accuracy, as a certain degree of uncertainty still exits no matter 

how carefully the measurement is done. The following kinds of errors may be produced in 

measurement with the analyzer. 

7.5.1 Drift Errors 

 Drift errors are produced by performance changes of the instrument or test system after 

calibration. 

 The thermal expansion of the interconnected cables in the instrument and the performance 

changes of microwave mixer are main causes of the drift error. The drift errors can be 

eliminated by recalibration. 

 The duration of accurate calibration depends on the test environment. The stable environment 

can help to minimize the drift error. 

7.5.2 Random Errors 

The random error cannot be predicted or eliminated by means of calibration. The influence 

on measurement results can be reduced by some methods. Random errors are mainly divided 

into three types: 

1) Random error of instrument 

a) Electrical disturbance of internal components of the analyzer may result in random noise, 

mainly including: 

 Low-level noise arising from the base noise within the receiver broadband; 

 High-level noise or data trace jittering, which is mainly caused by the base noise inside the 

instrument and phase noise of the LO source. 

b) The random noise error can be reduced in the following methods: 

 Increase the source power input into the DUT; 

 Reduce the intermediate frequency bandwidth; 

 Apply the function of sweep averaging. 

2) Switch repeatability error 

The switch is used to change attenuator settings of the source. If the switch acts, contact 

closing may be different from previous closing sometimes. In this case, the measurement 

accuracy will be affected seriously. Therefore, the attenuator settings should not be changed 

in high-accuracy measurement so as to reduce the switch repeatability error. 

3) Connector repeatability error 

Connector wear may result in electrical performance changes. Proper connection 

maintenance can help to reduce the connector repeatability error. 

7.5.3 System Errors 

System errors are caused by non-ideal hardware properties and may be repeatable (therefore, 

it can be predicted). It is assumed that system errors do not change over time. System errors 

can be determined by calibration and eliminated by mathematical calculation in 

measurement. 

System errors cannot be fully eliminated. Due to limitations of the calibration process, some 
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residual errors may exist after calibration, mainly resulting from: 

 Non-ideal calibration standard; 

 Connector connection; 

 Interconnected cable; 

 Instrument. 

All measurements are affected by the dynamic accuracy and frequency errors. For reflection 

measurement, relevant residual errors include: 

 Effective direction; 

 Effective source matching; 

 Effective reflection tracking. 

For transmission measurement, relevant residual errors include: 

 Crosstalk 

 Effective load matching; 

 Effective transmission measurement. 

1) Direction errors 

The directional coupler or bridge is used for reflection measurement. The coupling end of the 

ideal coupler can only output the reflection signal to the receiver for measurement. Actually, 

a small number of incident signals will leak to the coupling port through the main channel of 

the coupler, which may result in directional errors in measurement. Directional errors can be 

determined and reduced in the following methods. 

 Connect the load to the measurement port during calibration and regard the load port free 

from reflection. 

 The output signal of the coupling port is the leakage error signal. 

 Reduce the directional error signals in reflection measurement. 

2) Crosstalk errors 

Ideally, only the transmission signal through the DUT can reach the receiver. Actually, a 

small number of signals reach the receiver through other paths in the analyzer. Such signals 

are known as crosstalk signals. Crosstalk errors can be determined and reduced in the 

following methods. 

 Connect the loads to Port 1 and 2 at the same time during calibration. 

 The signal measured by the measurement receiver is the leakage signal of the analyzer. 

 Eliminate the crosstalk errors by means of error correction during transmission measurement. 

3) Source matching errors 

Ideally, the measurement receiver can receive all signals reflected from the DUT in reflection 

measurement. Actually, parts of the signals reflected by the DUT are reflected by the 

measurement port back to the DUT. As such signals cannot be measured by the measurement 

receiver, source matching errors will be produced. They can be determined and reduced in the 

following methods. 

 Connect the short-circuit device to the measurement port in calibration. The signals reflected 

by the short-circuit device will be measured by the receiver. Measurement results will be 
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saved in the analyzer. 

 Connect the open-circuit device to the port. The signals reflected by the open-circuit device 

will be measured by the receiver. Measurement results will be saved in the analyzer. 

 The measurement results will be compared with the known values of the open-circuit device 

and short-circuit device to determine source matching errors. 

 Eliminate source matching errors by means of error correction in reflection and transmission 

measurement. 

4) Load matching errors 

In the ideal transmission measurement, transmission signals through the DUT are received by 

the measurement receiver. Actually, some signals are reflected by the test port and cannot be 

measured, thus resulting in load matching errors. The load matching errors can be determined 

and reduced in the following methods. 

 Directly connect Port 1 and 2, with zero length. 

 If the source is located on Port 1, measurement signals of Receiver A include the reflection 

signals of Port 2. If the source is located on Port 2, measurement signals of Receiver 2 

include the reflection signals of Port 2. Thus, load matching errors can be determined. 

 Eliminate source matching errors by means of error correction in reflection and transmission 

measurement. 

5) Reflection tracking errors 

The signals of Receiver A and R1 or B and R2 are compared in reflection measurement. This 

is known as ratio measurement. In the ideal reflection measurement, the frequency responses 

of Receiver A and R1 or B and R2 should be identical. Actually, this is impossible and 

reflection tracking errors may be produced, i.e. vector sum errors caused by test deviations. 

The error amplitude and phase change with the frequency. Deviations are mainly caused by 

the following factors: 

 Signal separator; 

 Test cable and adapter; 

 Difference between the reference and test signal paths. 

Reflection tracking errors can be determined and reduced in the following methods. 

 Connect the short-circuit device to the measurement port in calibration. The signals reflected 

by the short-circuit device will be measured by the receiver. Measurement results will be 

saved in the analyzer. 

 Connect the open-circuit device to the port. The signals reflected by the open-circuit device 

will be measured by the receiver. Measurement results will be saved in the analyzer. 

 The measurement results will be compared with the known values of the open-circuit device 

and short-circuit device to determine source matching errors. 

 Eliminate reflection tracking errors by means of error correction in reflection and 

transmission measurement. 

6) Transmission tracking errors 

The signals of Receiver A and R2 or B and R1 are compared in transmission measurement. 

This is known as ratio measurement. In the ideal transmission measurement, the frequency 

responses of Receiver A and R2 or B and R1 should be identical. Actually, this is impossible 

and transmission tracking errors may be produced, i.e. vector sum errors caused by test 
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deviations. The error amplitude and phase change with the frequency. Deviations are mainly 

caused by the following factors: 

 Signal separator; 

 Test cable and adapter; 

 Difference between the reference and test signal paths. 

Transmission tracking errors can be determined and reduced in the following methods. 

 Directly connect Port 1 and 2, with zero length. 

 Measure the signals of Receiver A and R2 or B and R1. 

 Determine transmission tracking errors by comparing the signals of two receivers. 

 Eliminate transmission tracking errors by means of error correction in transmission 

measurement. 

7.6 Editing of Calibration Kit Definition 

The [Edit calibration kit] dialog box is used to edit the definition of the calibration kit or 

create a user-defined calibration kit. 

● Calibration kit definition ·························································································································· 242 

● Custom calibration kit ······························································································································ 242 

● Create calibration kit ································································································································ 243 

● Edit calibration kit ···································································································································· 243 

● [Edit calibration kit] dialog box ················································································································ 245 
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7.6.1 Calibration Kit Definition 

Each standard calibration kit (represented by the standard kit ID) is a specific and accurately 

defined physical device. For example, ID1 of 85056A calibration kit means a 2.4mm male 

open-circuit device. Standard kits are divided into four types: open-circuit device, 

short-circuit device, load and through type device/adapter/air line. Each type of calibration kit 

is has the specific model structure, including the number and physical characteristics of the 

standard kit. The majority of calibration kits are equipped with a group of adapters subject to 

accurate phase matching. The other standard calibration kits must be defined before use. 

7.6.2 Custom Calibration Kit 

Sometimes you may need to edit the calibration kit definition file or create the user-defined 

calibration kit. In most of measurement applications, the default calibration kit model is 

suitable for accurate calibration. However, the user-defined calibration kit should be created 
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in the following applications. 

 The connector type is different from that defined in the calibration kit model. 

 The standard calibration kit different from the defined is used. For example, use three 

short-circuit devices of different deviations instead of the open-circuit device, short-circuit 

device and load in one-port calibration. 

 Improve the accuracy of the predefined calibration kit model. If the actual properties of the 

standard calibration kit can be described with the model, the calibration will be more accurate. 

For example, change the load impedance into 50.1Ω, instead of the defined 50Ω. 

To create the user-defined calibration kit, first define the connector type, such as APC7, 

3.5mm, APC2.4mm (50Ω), etc. Although more than one connector type can be defined, it is 

preferred to define one connector type for each kind of calibration kit. The female and male 

connectors must be defined separately. 

7.6.3 Create Calibration Kit 

1) Click [Cal] >[Edit calibration kit...]. The [Edit calibration kit] dialog box will appear. 

2) Click [Insert new calibration kit]. The [Edit calibration kit] dialog box will appear. 

a) Input the name of the user-defined calibration kit in the [Calibration kit name] box. 

b) Click [Add] in the connector type zone. The [Add connector] dialog box will appear. 

3) In the [Add connector] dialog box: 

a) Enter the connector name in the name box. 

b) Select the connector type of the calibration kit in the connector type zone: [Female], 

[Male] or [No Gender]. 

c) Set the minimum and maximum working frequency range of the connector in the 

frequency range zone. 

d) Enter the characteristic impedance (such as 50Ω) of the connector in the impedance zone 

[Z0]. 

e) Select the connector medium type in the [Medium] box: coaxial or waveguide. 

f) Check the entered contents and click [OK] to close the dialog box. Then it is not allowed 

to edit connector information. 

g) The connector of the other polarity can be added by click [Add] in the connector type zone 

of the [Edit calibration kit] dialog box and repeated the above steps. 

4) Click [Add] under the [Standard kit] box of the [Edit calibration kit] dialog box. The 

[Add standard kit] dialog box will appear. Select the standard kit to be added: [Open-circuit 

device], [Short-circuit device], [Load], [Through type], [Adapter] and [Transmission line]. 

Click [OK] to close the [Add standard kit] dialog box. At the same time, the [Edit] dialog box 

corresponding to the selected standard kit will appear. 

5) In the [Standard] (such as open-circuit device) dialog box, enter the definition data. For 

the limited standard kit, the frequency range may be different from that of the connector. Set the 

frequency range according to the actual minimum and maximum frequency of the standard kit, 

and click [OK] to close the dialog box. 

6) Repeat Step 4) and 5) to define all standard calibration kits among custom calibration kits. 

7.6.4 Edit calibration kit 

1) Click [Cal] > [Edit calibration kit...]. The [Edit calibration kit] dialog box will appear. 
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2) Click the calibration kit to be modified in the dialog box. 

3) Click [Edit calibration kit]. The [Edit calibration kit] dialog box will appear. Edit the 

calibration kit. 

 

Fig. 7.9 [Edit calibration kit] Dialog Box 

4) [Open] button 

Open the calibration kit list and calibration kit definition file. 

5) [Save as] button 

Save the current calibration kit list and calibration kit definition as a file. 

6) [Restore Defaults] button 

Reinstall all calibration kits supported by the network analyzer. 

7) Calibration kit installation zone 

a)[Import Kit] button 

Recall the [Open] dialog box and import the calibration kit definition in the hard disc or 

other drives. 

b) [Save as] button 

Open the [Save as] dialog box to save the selected calibration kit definition. 

c) [Insert New] button 

Open the [Insert New] dialog box to create a new calibration kit definition. 

d) [Edit Kit] button 

Open the [Edit Kit] dialog box and modify the selected calibration kit definition. 

e) [Delete] button 

Delete the selected calibration kit definition. 

f) [Restore Kit] button 

Restore the modification of the selected calibration kit into the factor setting state. 
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g) [∧] and [∨] button 

Click the [∧] and [∨] button to select the calibration kit. 

7.6.5 [Edit Kit] Dialog Box 

 

Fig. 7.10 [Edit calibration kit] Dialog Box 

1) Calibration kit identification zone 

a) [Kit Number] box 

Display or edit the ID number of the existing calibration kit (or the inserted new calibration 

kit). 

b) [Kit Name] box 

Display or edit the name of the calibration kit. 

c)[Kit Description] box 

Display or edit the characteristic description of the calibration kit. 

2) Connector type zone 

a)[Connectors] box 

Click the [Connectors] box or arrow button to select the connector type. 

b)[Add] button 

Click the [Add] button. The [Add] dialog box will appear. Add the new connector type of the 

calibration kit. 

c)[Change] button 

The [Change] dialog box will appear. Modify the connector name. 
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Fig. 7.11 [Change connector name] Dialog Box 

3) Class zone 

a)[Calibration method] box 

Click it to select the calibration method corresponding to the type. 

b)[Edit type] button 

Click it and the [Type information] dialog box to set the type of the calibration kit. 

4) Standard zone 

a) [Cal Kit] box 

Display the ID, name and description of the calibration kit supported by the analyzer at 

present. 

b) [Add] button 

The [Add standard] dialog box will appear. Add the new definition of calibration standard. 

c) [Edit] button 

Click it and the [Standard (such as the open-circuit device, short-circuit device, load, 

through type connector/air line/adapter)] dialog box will appear. Modify the definition of the 

selected standard calibration kit. 

d) [Delete] button 

Delete the definition of the selected standard calibration kit. 

e) [Delete All] button 

Delete the definitions of all standard calibration kits. 

f) [∧] and [∨] button 

Select the standard calibration kit. 
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7.6.6 [Add Connector] Dialog Box 

 

Fig. 7.12 [Add connector] Dialog Box 

1) Identification zone 

a) [Connector Family] box 

Define the name of the calibration kit connector. 

b) [Description] box 

Define the characteristic description of the calibration kit connector. 

2) Frequency Range 

a) [Min Freq] box 

Define the allowable minimum frequency of the standard calibration kit in calibration. 

b) [Max Freq] box 

Define the allowable maximum frequency of the standard calibration kit in calibration. 

3) Connector type zone 

Select the connector polarity of the standard calibration kit: [Female], [Male] and [No 

Gender]. 

4) Impedance zone 

Define the characteristic impedance of the standard calibration kit. 

5) Media zone 

Define the media of the standard calibration kit: [Coax] or [Waveguide]. 
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7.6.7 [Calibration Kit Class] Dialog Box 

 

Fig. 7.13 [Add connector] Dialog Box 

1) Calibration Kit Class zone 

Select the calibration type to be edited or observed. 

2) [>>] and [<<] button 

Click the [>>] and [<<] button to add or delete the standard calibration kit of the selected 

type or select the standard calibration kit in the [Unselected standard] box. Click the [>>] button 

to add the selected standard calibration kit into the [Selected standard] box. Select the standard 

calibration kit in the [Selected] box. Click the [<<] button to delete the standard calibration kit of 

the selected type. 

3) [∧] and [∨] button 

Adjust the sequence of the standard calibration kits in the [Selected standard] box. All the 

standard calibration kits in the [Selected standard] box will appear in the [Measurement of 

multiple standard kits] dialog box. Select the corresponding standard calibration kit according to 

the polarity (female or male) of the measurement port and the frequency range of the 

measurement. 

Select the standard calibration kit in the [Selected standard calibration kits] box. Click [∧] 

or [∨] to change the sequence of standard calibration kits. This is usable in the following 

measurement applications. Multiple standard calibration kits are required for one calibration type 

to cover the whole frequency range. The sequence of the standard calibration kits in the [Selected 

standard calibration kits] box is the same as that in the [Measurement of multiple standard 

kits] dialog box. 

7.6.8 [Add standard] Dialog Box 

 

Fig. 7.14 [Add standard] Dialog Box 



7 Calibration 

7.6 Editing of Calibration Kit Definition 

      249 
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7.6.9 [Open-circuit device] Dialog Box 

 

Fig. 7.15 [Open-circuit device] Dialog Box 

1) Identification zone 

a) [Standard ID] box 

Display or edit the serial number of the standard calibration kit. 

b) [Label] box 

Display or edit the name of the standard calibration kit. 

c) [Open Description] box 

Display or edit the characteristic description of the standard calibration kit. 

2) Frequency Range 

a) [Min Freq] box 

Define the minimum working frequency of the open-circuit device in calibration. 

b) [Max Freq] box 

Define the maximum working frequency of the open-circuit device in calibration. 

3) Connector zone 

Define the connector polarity of the open-circuit device: male, female or no gender. 

4) Open Characteristics 

Define the fringe capacitance of the open-circuit device with [C0], [C1], [C2] or [C3]. 

5) Delay Characteristics 

a) [Delay] box 

Define the one-way transmission time from the calibration plane to standard calibration kit. 

b) [Loss] box 

Define the energy loss caused by the skin effect of the standard calibration kit, in ohms/S, 

corresponding to the frequency in 1GHz. Respectively measure the loss and delay time of the 

standard calibration kit at 1GHz and calculate the loss by the following equation: 
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c) [ZO] box 

Define the impedance of the standard calibration kit. 

7.6.10 [Short Characteristics] Dialog Box 

 

Fig. 7.16 [Short-circuit device] Dialog Box 

1) Short Characteristics 

Define the residual inductance of the short-circuit device with [L0], [L1], [L2] and [L3]. 

7.6.11 [Load] Dialog Box 

 

Fig. 7.17 [Load] Dialog Box 

 

1) Load type zone 

a) [Fixed Load] radio box 

Select it to set the load type as the fixed load. 
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b) [Sliding Load] radio box 

Select it to set the load type as the sliding load. 

c) [Arbitrary Impedance] radio box 

Select it to set the load different from the system impedance Z0. The settings of the complex 

impedance zone are not effective until the [Arbitrary Impedance] radio box is selected. 

2) Complex impedance zone 

a) [Real] box 

Define the real part of the impedance. 

b) [Imag] box 

Define the imaginary part of the impedance. 

7.6.12 [THRU type/transmission line/adapter] Dialog Box 

 

Fig. 7.18 [THRU/air line/adapter] Dialog Box 

1) Connector zone 

Define the connector types of two ports of the standard calibration kit in the [Port 1] and 

[Port 2] box 

7.7 Standard Calibration Kit 

This section mainly introduces the basic principle of the calibration kit and some terms in the 

calibration kit definition file. 

1) Calibration kit 

The calibration kit is a set of physical devices known as standard calibration kits. Each 

standard calibration kit is accurately known or predicted according to the frequency change 

amplitude and phase response. To use the definition of the standard calibration kit, the 

response value must be defined mathematically. Then the calibration type corresponding to 

the error correction model is formed. 

2) Standard calibration kit 

The standard calibration kit is the reference benchmark of error correction measurement. The 

electrical delay, impedance, loss and other characteristics of each standard calibration kit 
have been accurately defined. The definitions are saved in the analyzer and used to calculate 

various errors of the error model. The analyzer can measure the responses of standard 
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calibration kits in calibration, and errors can be calculated by comparing the measurement 

results and the known values of the model. The influence of errors on measurement results is 

eliminated by mathematical operation which is also known as error correction. 

3) Types of standard calibration kit 

Four types of standard calibration kits are provided, corresponding to the structures or types 

of various definitions. The four types are as follows: 

Standard calibration kit Terminal impedance 

Open-circuit device ∞Ω 

Short-circuit device 0Ω 

Load System impedance 

Through type connector/air line/ adapter No terminal impedance 

4) Definition of standard calibration kit 

The definition of the standard calibration kit describes the electrical characteristics and 

frequency range, including: 

a) Minimum frequency 

Specify the allowable minimum frequency of the standard calibration kit in calibration. 

b) Maximum frequency 

Specify the allowable maximum frequency of the standard calibration kit in calibration. 

c) Z0 

Specify the characteristic impedance of the standard calibration kit, instead of the 

characteristic impedance of the system or the terminal impedance of the standard calibration 

kit. 

d) Delay 

Specify the uniform length of the transmission line between the defined standard calibration 

kit and actual calibration plane. 

e) Type 

Specify the type of the standard calibration kit: open-circuit device, short-circuit device, load 

and through type connector/air line/adapter. 

f) Loss 

Specify the energy loss caused by skin effects. 

g) Definition of loss model 

The loss unit is ohms/S, corresponding to the frequency unit 1GHz. Respectively measure the 

loss and delay time of the standard calibration kit at 1GHz and calculate the loss by the 

following equation: 

 

h) Fringe capacitance model of open-circuit device 

The open-circuit device almost has no ideal reflection characteristics as a result of the effects 

of fringe capacitance at high frequency. The phase shift changes with the frequency. Such 
effects cannot be eliminated. The fringe capacitance is defined in the open-circuit device 
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model. The capacitance model is a cubic polynomial function of the frequency. The 

polynomial coefficient is determined according to the actual characteristics of the 

open-circuit device. The equation of the fringe capacitance model is as follows: 

(F refers to the measurement frequency). 

i) Residual inductance model of short-circuit device 

The short-circuit device almost has no ideal reflection characteristics as a result of the effects 

of residual inductance at high frequency. The phase shift changes with the frequency. Such 

effects cannot be eliminated. The fringe inductance is defined in the short-circuit device 

model. The inductance model is a cubic polynomial function of the frequency. The 

polynomial coefficient is determined according to the actual characteristics of the 

open-circuit device. The equation of the residual inductance model is as follows: 

(F refers to the measurement frequency). 

7.8 TRL Calibration 

TRL (Thru-Reflect-Line) calibration includes a series of calibration technologies, such as 

TRM (Thru-Reflect-Match). In the TRL calibration, 12 error coefficients are determined with 

two standard calibration kits for transmission and one standard calibration kit for reflection. 

In the traditional SOLT calibration, however, 12 error coefficients are determined with one 

standard calibration kits for transmission (T) and three standard calibration kits for reflection 

(SOL). 

1) Why to perform TRL calibration? 

TRL calibration is accurate and even more accurate than SOLT calibration in some cases. 

However, only a few calibration kits support TRL. TRL calibration is always done when high 

measurement accuracy is required but the calibration kit of the same connector type as the 

DUT is provided, such as use of the fixture in measurement or use of the probe in wafer 

measurement. In this case, the calibration kit with the same medium as the DUT must be 

created and defined. It is easier to make three TRL standard calibration kits then to make four 

SOLT standard calibration kits. One disadvantage of TRL calibration is that multiple standard 

calibration kits are required for the transmission line in broadband calibration. For example, 

two standard calibration kits are required for the transmission line at 2GHz to 26GHz. The 

standard calibration kits for the transmission line should be particularly long at low 

frequency. 

2) TRL standard calibration kit 

Three standard calibration kits should be defined for TRL calibration: through type, reflection 

type and transmission type. 

a) Through type standard calibration kit 

The length of the through type can be zero or not zero. The zero-length through type is more 

accurate as a result of no loss or characteristic impedance. The electrical delay of the through 

type is different from that of the transmission type. The through type standard calibration kit 

with the amplitude and phase defined accurately can be used to establish the measurement 

reference plane. 

b) Reflection standard reflection kit 

The reflection standard calibration kit is a physical device of large reflection coefficient. The 

reflection standard calibration kits connected to two measurement ports must have the same 

characteristics. If the reflection amplitude is not required but the phase is required in 

calibration, the electrical length of the standard calibration kit must be within 1/4 of the 
wavelength. The reflection standard calibration kit with the amplitude and phase defined 
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accurately can be used to establish the measurement reference plane. 

c) Transmission line type standard calibration kit 

The transmission line type standard calibration kit is used to measure the measurement 

reference impedance after calibration. TRL calibration has the following disadvantages as a 

result of limitations of the transmission line type standard calibration kit. 

 The impedance of the transmission line type standard calibration kit must be the same as that 

of the through type standard calibration kit. 

 The electrical length of the transmission line type standard calibration kit must be different 

from that of the through type standard calibration kit. 

 The transmission line type standard calibration kit must have the appropriate electrical length 

within the whole frequency range. The phase difference of the transmission line type standard 

calibration kit and through type standard calibration kit must be between 20° and 160° at 

each frequency point. Therefore, the actual coverage range of a single transmission line is 8:1. 

In order to cover a wider frequency range, multiple transmission line type standard 

calibration kits are required. 

 The transmission line type standard calibration kit should be particularly long at low 

frequency. The optimal length is 1/4 of the wavelength corresponding to the geometric 

average frequency (square root of the product of the start frequency × stop frequency) within 

the frequency span. 

d) Matching standard calibration kit 

If the transmission line of specific length or loss cannot be made, use the matching standard 

calibration kit instead of the transmission line. 

 The matching standard calibration kit is a low-reflection terminal to be connected to the port. 

 Use the matching standard calibration kit as the transmission line of high loss and infinite 

length in calculation of the error coefficient of TRL calibration. 

 Change the impedance of the matching standard calibration kit into the reference impedance 

of measurement. 

7.9 Fixture Compensation Calibration 

The fixture simulator function is used for network port Z conversion, 2-port de-embedding, 

port matching, and 4-port embedding/de-embedding in the mathematical sense. It can be used 

to simulate various measurements based on measurement results in applications, and also 

rapidly simulate the corresponding measurement results in a real-time manner. The 

measurement results of the port with the impedance of 50Ω can be transformed into 

measurement results of any impedance by means of port Z conversion. The double-port 

fixture de-embedding function can be applied to remove any network characteristic between 

the measurement end face and DUT end face, which is defined in the Touchstone data file, so 

as to extend to the corresponding calibration surface. The port matching function is used to 

transform the original measurement results into the specific simulation result determined by 

inserting the matching circuit between the DUT and test port (one-port). The four-port fixture 

embedding/de-embedding function is used to simulate embedding/de-embedding of the 

four-port fixture, so as to obtain the simulation results of the DUT after 

embedding/de-embedding of part of the network. 

The handling process of the whole fixture simulator is shown in Fig. 7.19. 
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Fig. 7.19 Handling Process of Fixture Simulator  

Prompt 

S-parameter 

The S-parameter of the fixture or matching circuit can be obtained at first to realize the above functions. It is 

represented by the circuit model or Touchstone data file. Fixture embedding/de-embedding is realized according to 

the known S-parameter of the fixture. 
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7.9.1 Terms of Fixtures 

 Fixture 

The fixture refers to a device which is set between the DUT and cable and used to fix the 

DUT. The S-parameter is the key to fixture embedding and de-embedding. However, it is 

difficult to determine the S-parameter. One of the current feasible methods is to establish the 

fixture model by linear simulation or simulate the fixture with the three-dimensional 

electromagnetic structure, and the other method is used to determine the fixture loss and 

delay time by means of port extension. 

 Touchstone data file (SnP file) 

It is a data format created by EEsoft before purchase by HP, or widely known as the S2P 

format. If multiple ports are extended, the file is generally known as the SnP file, where n 

represents the number of ports. The corresponding S-parameters of n ports are saved in this 

file. 

 Circuit parameter model 

The impedance of the components and circuits should be matched in the microwave 

component and circuit design phase. Generally, the conjugate matching circuit is composed 

of the resistance (R), inductance (L), capacitance (C) and conductance (G) in the impedance 

matching design. The parameter form of the conjugate matching circuit is referred to as the 

circuit parameter model. 
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7.9.2 Fixturing On/Off 

Menu path: [Cal] > [Fixtures]. Click [Fixturing on/OFF] under [Fixtures]. Then this option 

will change into [Fixturing ON/off]. Thus the fixture simulator function is enabled (in this case, 

all the functions of the fixture simulator are effective). In the default mode, this option is 

[Fixturing on/OFF], indicating that the fixture function is shut down. 

 

Fig. 7.20 Enabling of Fixture Simulation Function 

7.9.3 Port Matching 

This function is used to transform the original measurement results into one characteristic 

determined by inserting the matching circuit between the DUT and test port (one-port). The 

inserted matching circuit is selected from the five preset circuit models or from the circuits 

defined in the double-port Touchstone file. 

 

Fig. 7.21 Schematic Diagram of Matching Circuit Embedding (take the double-port DUT as 

an example) 

1) [Port Matching] dialog box 
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Fig. 7.22 [Port Matching] Interface 

a) [Port Matching] drop-down menu 

Select the port number of the matching circuit embedded into the vector network. 

b) [Circuit Parameter] drop-down menu 

Select the embedded matching circuit type. The network analyzer is provided with the 

following import formats: None (with no circuit embedded), 5 circuit parameter models and S2P 

file. Different schematic diagrams will appear in the [Matching Circuit] bar when different types 

are selected. 

 

Fig. 7.23 [Matching circuit type] Drop-down Menu 
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(1) Series inductance-shunt capacitance (2) Shunt capacitance-series inductance 

 

 

 

(3) Shunt inductance-series 

capacitance 

(4) Series capacitance-Shunt 

inductance 

(5) Shunt inductance-shunt 

capacitance 

 

Fig. 7.24 Five Parameter Types of Embedded Matching Circuit 

c) [Custom] button 

This is not available in the default mode. If [User] is selected in the [Matching circuit type] 

drop-down menu is selected, this button will be available. Click this button and select the S2P file 

for import of fixture S-parameters in the pop-up dialog box. After the file is selected, the name of 

the imported file will be displayed in the box on the right side of the [Custom] button. 

 

Fig. 7.25 Selection of S2P File to Be Imported 

d) [Port Reverse] check box 
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This is not available in the default mode. If [User] is selected in the [Matching Circuit Type] 

drop-down menu is selected, this check box will be available. Click this check box to turn the port 

number of the imported S2P file. 

e) [Circuit parameter mode setting] edit box 

This is not available in the default mode. If one of the five circuit parameter models is 

selected in the [Matching circuit type] drop-down menu, this edit box will be available. Modify 

the parameter in the edit box to change the relevant parameter of the corresponding circuit 

parameter model. 

f) [Parameter Reset] button 

This is not available in the default mode. If one of the five circuit parameter models is 

selected in the [Matching Circuit Type] drop-down menu, this button will be available. Click this 

button to reset all the contents in the [Circuit Parameter Model Setup] edit box. 

g) [Port matching on/OFF] check box 

Click it to enable the port matching function. 

h) [OK] button 

Click it to make the settings in the dialog box effective for the current active channel. 

2) Steps of port matching 

Menu path: [Cal] > [Fixtures]. Click [Matching Circuit Embedding...] in the [Fixtures] 

sub-menu. The [Port Matching] dialog box will appear. 

Tick [Port matching on/OFF] in the dialog box to enable the port matching function. 

Click the [Port selection] drop-down menu and select the port matching port. 

Select the type of the embedded circuit in the drop-down menu on the right side of [Port 

selection]. The network analyzer is configured with five circuit parameter models and custom 

mode. The schematic diagram is shown in the [Circuit] box. 

If the circuit parameter model is selected as the circuit type, edit the corresponding 

capacitance, inductance, resistance and conductance in the corresponding circuit parameter 

bar. Click [Parameter Reset] to recover the default parameter. If “User-defined” is selected as the 

circuit type, the [Custom] button will be available. Click the [Custom] button and select the S2P 

file to be used in the pop-up dialog box. The file name will be displayed in the lateral square box. 

Thus the [Port Reverse] check box will appear. Click this check box to customize port turning in 

the S2P file. 

Click [OK] to complete the setting. 

7.9.4 2-port De-embedding 

The network de-embedding function can be used to eliminate the characteristics of any 

network defined by the Touchstone data file between the measurement end face and DUT end 

face, so as to extend the corresponding calibration plane. 
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Fig. 7.26 Schematic Diagram of Fixture De-embedding (take the double-port DUT as an 

example) 

1) [2-port De-embedding] dialog box 

a) [Port selection] drop-down menu 

Select the vector network port number of the fixture to be de-embedded. 

b) [De-embedding Type] drop-down menu 

Select the de-embedding type in the drop-down menu on the right side of [Port selection]. 

The network analyzer is configured with the user-defined de-embedding type. The contents in 

the schematic diagram will change if different types are selected. 

c) [Load File] button 

This is not available in the default mode. If [User] is selected in the [De-embedding Type] 

drop-down menu, this button will be available. Click this button and select the S2P file for import 

of the fixture S-parameter in the pop-up dialog box (as shown in Fig. 7.25). After the file is 

selected, the file name will be display in the box on the right side of the [Load File] button. At the 

same time, the relevant maximum/minimum frequency will be updated on the frequency range 

display bar of the vector network port and file. 
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Fig. 7.27 [Double-port fixture de-embedding] Interface 

d) [Port Reverse] check box 

This is not available in the default mode. If [User] is selected in the [De-embedding type] 

drop-down menu, this check box will be available. Click this check box to turn the port number of 

the imported S2P file. 

e) [De-embedding on/OFF] check box 

Click it to enable the double-port fixture de-embedding function. 

f) [OK] button 

Click it to make the settings in the dialog box effective for the current active channel. 

2) Steps of double-port fixture de-embedding 

Menu path: [Cal] > [Fixtures]. Click [2-port De-embedding...] in the [Fixtures] sub-menu. 

The [Double-port Fixture De-embedding] dialog box will appear. 

Click the [De-embedding on/OFF] button in the dialog box to enable the double-port fixture 

de-embedding function. 

Click the [Port selection] drop-down menu and select the port for fixture de-embedding. 

Select the de-embedding type in the drop-down menu on the right side of [Port] selection. 

The network analyzer is configured with the user-defined de-embedding type. 

If [User] is selected in the [De-embedding Type] drop-down menu, this button will be 

available. Click the [Load File] button and select the S2P file to be used in the pop-up dialog box. 

The file name will be displayed in the lateral square box. The vector network frequency 

information and file frequency information will be updated. 

Click the [Port Reverse] check box to turn the power in the custom S2P file. The 

corresponding schematic diagram will change accordingly. 

Click [OK] to complete the setting. 

7.9.5 Port Z Conversion 

The measurement result with the port impedance as the system impedance can be 

transformed into the measurement result of any impedance. 
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Fig. 7.28 [Port Z Conversion] Interface 

1) [Port Z Conversion] dialog box 

a) [Port selection] drop-down menu 

Select the number of the vector network port for impedance transformation. 

b) [Real] edit box 

Modify the parameter in the edit box to set the impedance value to be obtained by 

transformation. 

c) [Z Conversion on/OFF] check box 

Select it to enable the port Z conversion function. 

d) [OK] button 

Click it to make the settings in the dialog box effective for the current active channel. 

2) Steps of port Z conversion 

Menu path: [Cal]> [Fixtures]. Click [Port Z Conversion...] in the [Fixtures] sub-menu. The 

[Port Z Conversion] dialog box will appear. 

Tick the [Impedance Conversion on/OFF] button in the dialog box to enable the port Z 

conversion function. 

Click the [Port Selection] drop-down menu and select the port for impedance 

transformation. 

Edit the real part and imaginary part of the impedance to be transformed in the [R (real part 

of impedance)] and [jX (imaginary part of impedance)] edit box. 

Click [OK] to complete the setting. 

7.9.6 4-port Embed/De-embed 

Simulate embedding/de-embedding of the four-port fixture to obtain the simulation results of 
the DUT after embedding/de-embedding of part of the network. 
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1) [4-port Embed/De-embed] dialog box 

 

Fig. 7.29 [Four-port fixture embedding/de-embedding] Interface 

a) [Type] drop-down menu 

Select the fixture embedding/de-embedding mode. The vector network analyzer is configured 

with three network models (Mode A, B and C). 
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Fig. 7.30 Three Modes of Fixture Embedding/De-embedding 

b) [Network] drop-down menu 

The network embedding/de-embedding type is the first item of the drop-down menu of 

Network 1 (Network 2 is enabled in Mode C). The drop-down menu includes three options: 

none, de-embedding and embedding. 

c) [Load File] button 

Click this button and select the S4P file for import of the fixture S-parameter in the pop-up 

dialog box (as shown in Fig. 7.25). After the file is selected, the file name will be display in the 

box on the right side of the [Load File] button. 

d) [Port Matching] drop-down menu 

The port selection part includes the vector network port and fixture port. The [Fixture port] 

drop-down menu is not displayed in the default mode. The selected mode and network 

embedding/de-embedding type will be displayed in the schematic diagram. Select the 

corresponding port relationship to determine the number of the embedding/de-embedding 

port and the corresponding relationship to the port for file import. 

e) [Enable on/OFF] check box 

Select this check box to enable the fixture embedding/de-embedding function. 

f) [OK] button 

Click it to make the settings in the dialog box effective for the current active channel. 

2) Steps of 4-port embedding/de-embedding 

Menu path: [Cal] > [Fixtures]. Click [4-port Embed/De-embed...] in the [Fixtures] 
sub-menu. The [4-port Embed/De-embed] dialog box will appear. 
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Tick the [Enable on/OFF] button in the dialog box to enable the four-port fixture 

embedding/de-embedding function. 

Click the [Mode selection] drop-down menu and select the embedding/de-embedding 

network model. The vector network analyzer is configured with three network models (Mode A, B 

and C). 

Select the embedding/de-embedding type of Network 1 in the drop-down menu of Network 

1 (Network 2 is enabled in Mode C). 

If embedding or de-embedding is selected, the [Load File] button will be available. Click 

the [Load File] button and select the S4P file to be used in the pop-up dialog box. The file name 

will be displayed in the lateral square box. 

Click [OK] to complete the setting. 

7.10 Electronic Calibration 

Electronic calibration is a process to obtain system errors by means of standard 

measurements of the electronic calibration kit through the network analyzer and calculation 

according to the fixed value of the electronic calibration kit. The accuracy of electronic 

calibration is close to that of mechanical calibration. At the same time, artificial errors arising 

from connection of the standard calibration kit in calibration of the vector network analyzer 

can be reduced, thus improving the calibration accuracy, calibration velocity and calibration 

result consistency and reducing the losses of the test port and expensive test cable. 

Each electronic calibration kit is configured with a unique S-parameter saved in the internal 

memory. In the calibration process, the vector network analyzer can recall the standard 

S-parameter of the electronic calibration kit to obtain the vector error coefficient by means of 

complex measurement and calculation. 

Compared with mechanical calibration, electronic calibration has obvious advantages: 

1) High velocity and automatic operation. All the calibration can be completed by one 

connection, thus reducing the times of calibration kit connection, menu button selection 

operations, operation time, connector wear and costs for maintenance of the test port 

connector of the test instrument and the calibration kit connector. 

2) Low risk and high measurement accuracy. The requirements for operators are low, and the 

possibility of errors caused by operators is reduced, which is conducive to the promotion of 

the network analyzer in the military, research and production applications. 

3) New technology and high quality. New calibration and error correction technologies are 

applied to make the accuracy higher than that of mechanical calibration. 

 

 

Prompt 

Electronic calibration kit and electronic calibration: 

For more details, refer to the User Manual of 2040X Electronic Calibration Kit. 

 

Attention 

Precautions of electronic calibration: 
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1. Do not disconnect or insert or connect the USB interface equipment during communication with the USB 

interface. Do not pull down the USB cable immediately after calibration, as data communication may not be 

over. 

2. Do not change the cable connection during calibration. Keep the ambient temperature stable in calibration; 

otherwise, calibration indicators will be affected. 

 

Fig. 7.31 [Electronic calibration kit] Interface 

Process of electronic calibration: 

A. Connect one end of the USB cable to the USB interface of the electronic calibration kit 

and the other end to the USB interface of the front panel or rear panel of the vector network 

analyzer. Run the vector network analyzer to preheat it for 30min at least. At the same time, 

the red WAITING indicator of the electronic calibration kit will be lit, indicating that 

preheating of the electronic calibration kit is started. Generally, the double-port electronic 

calibration kit should be preheated for 10min, and the four-port electronic calibration kit for 

18min. When the internal temperature of the electronic calibration kit reaches the set 

temperature, the red READY indicator will be ON (the preheating time is related to the 

ambient temperature). 

B. According to the characteristics of the DUT, set the frequency range, intermediate 

frequency bandwidth, power level and other stimulus information of the vector network 

analyzer. 

C. After preheating, connect the port of the electronic calibration kit to the test port of the 

vector analyzer through the test cable, and execute the required calibration according to the 

prompts of the vector network analyzer. Calibration steps are as follows: 

Step 1: select [Calibration (V)…] in the menu. 
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Fig. 7.32 Calibration Menu 

Step 2: Select [Use Electronic Calibration (ECal)] and click [Next] to enter the electronic 

calibration function. 

 

Fig. 7.33 Selection of Calibration Type 

Step 3: Select the module and characteristic data of the electronic calibration kit with the 

[Cal Type Selection…] button, as shown in the following figure. 

 

Fig. 7.34 Selection of Electronic Calibration Kit and Characteristic Data 

 

Attention 
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Selection of electronic calibration kit and characteristic data: 

If only one electronic calibration kit is connected to the vector network analyzer, the following calibration 

steps can be directly performed without calibration kit selection. 

Step 4: Select the multi-port or one-port calibration in the [Cal Type Selection], as shown in 

the following figure. 

 

Fig. 7.35 Calibration Port Setting 

Step 5: Tick the [Auto Check] function. 

You can select whether to tick the [Auto Check] function in the “calibration selection” 

combined box. If this option is ticked (default), the vector network analyzer can test the 

connection of the port of the electronic calibration kit and the measurement port of the vector 

network analyzer, as shown in the following figure. If this option is not ticked, calibration 

will be done directly according to the set connection mode. (If the frequency measurement 

range set in the vector network analyzer is beyond the frequency range of the electronic 

calibration kit, the information shown in the following figure will appear. Exit the window, 

reset the calibration frequency range and repeat the electronic calibration process). 

 

 

Fig. 7.36 [Auto Check] Option 

Step 6: Click [Meas] to start the measurement of electronic calibration. If necessary, click the 

[Abort Sweep] to interrupt sweep. 

 

 

 

Fig. 7.37 Start and Abortion of Sweep 
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Step 7: Click [OK] to save calibration results after measurement. 

 

 

Fig. 7.38 Completion of Calibration 

Step 8: Connect the test cable and check the through curve (S21) after calibration. You can 

roughly observe whether calibration is successful. If the vector network analyzer has good 

hardware performance, the amplitude of the through curve will be within plus or minus 0.2dB. 

Remove the test cable from the port of the electronic calibration kit and connect the DUT to 

start measurement. 
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8 Basis of Network Measurement 

This chapter introduces the following contents: 

● Reflection measurement……………………………………………………………………271 

● Phase measurement…………………………………………………………………………274 

● Amplifier parameter specifications…………………………………………………………276 

● Complex impedance……………………………………………………………………..…279 

● Group delay…………………………………………………………………………………282 

● Absolute output power…………………………………………………………………...…286 

● AM-PM transformation………………………………………………………………….…287 

● Linear phase deviation………………………………………………………………...……289 

● Reverse isolation……………………………………………………………………………291 

● Small signal gain and flatness………………………………………………………………293 

8.1 Reflection Measurement 

Reflection measurement is an important part of network measurement. At first, the reflection 

measurement will be introduced. In order to better understand reflection measurement, the 

optical wave is applied to simulate the traveling wave transmission along the transmission 

line. 

If any optical element such as the lens is set, part of light will be reflected by the lens, but the 

majority of light will be transmitted continuously through the lens. If the surface of the 

optical element is a mirror, the majority of light will be reflected, and only a little light will 

be transmitted or no light will be transmitted. 

 

1. Incident 

light 

2. Reflected 

light 

3. Transmitted 

light 

Fig. 8.1 Light Reflection and Transmission 

The RF signal will be reflected if the impedance of two connectors is different from each 

other. Reflection measurement is a process to measure the ratio of the reflected signal and incident 

signal. The incident signal is measured by Receiver R, and the reflected signal is measured by 

Receiver A. Therefore, the result of reflection measurement is a ratio of A and R (i.e. A/R). The 

reflection characteristic of the DUT can be fully quantified with the signal amplitude and phase 

information of Receiver A and R. Among the S-parameter terms, S11 represents the reflection of 

Port 1 (input port) of the DUT and S22 represents the reflection of Port 2 (input port) of the DUT. 

Reflection measurement aims to ensure the efficient transmission of RF energy. If energy is 

reflected, only a little energy will be transmitted to the expected place. In addition, if too much 

energy is reflected, the device may be burnt, such as the output power amplifier. 

● Reflection measurement expression ·········································································································· 272 

● Summary of reflection measurement expression ······················································································· 273 
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8.1.1 Reflection Measurement Expression 

The data of reflection measurement can be expressed in various methods according to the 

requirements. Various expressions are based on the same reflection measurement data and can be 

respectively displayed in one or more graphic format(s). See details in “4.7 Selection of Data 

Format and Scale”. 

8.1.1.1 Return Loss 

A simple way to express reflection data is the return loss, which is a scalar in dB. The return 

loss refers to the dB difference between the reflected signal and incident signal. If the 

impedance matches exactly, the return loss will be infinite. For the open, short or no-loss 

reactive circuit, the return loss is 0dB. For example, if the logarithmic format is applied in 

measurement, the reflection measurement data will be -18dB, indicating that the return loss is 

18dB (ignoring the minus sign). 

8.1.1.2 Standing Wave Ratio 

The standing wave will be produced if two groups of waves are transmitted in the opposite 

directions along one transmission line. In this case, the voltage standing wave ratio (VSWR 

or SWR for short) can be applied. SWR is defined as the ratio of the maximum RF envelope 

voltage and minimum RF envelope voltage at the given frequency. It is a scalar. If the 

impedance matches exactly, SWR is 1. For the open, short or no-loss reactive circuit, SWR is 

infinite. 

8.1.1.3 Reflection Coefficient 

Another way to express reflection measurement is the reflection coefficient (Γ), including the 

amplitude and phase information. The amplitude part of Γ is referred to as ρ. The reflection 

coefficient is a ratio of the reflection voltage and incident voltage. The ρ value range is 0-1. If 

the transmission line is connected with characteristic impedance, all the energy will be 

transmitted to the load, with no energy reflection. ρ＝0. If the transmission line is connected 

through the open-circuit device or short-circuit device, all the energy will be reflected. ρ＝1. 

There is no unit of measurement for ρ. 

Below is the phase information of reflection. If the signal wavelength is larger than the 

conductor length at high frequency, the reflected wave can be regarded as the wave 

transmitted in the direction opposite to the incident wave. The standing wave will be 

produced in case of mixing of the incident and reflected wave. In this case, the 

voltage-enveloped amplitude will change along with the transmission line position. 

If the transmission line is connected with characteristic impedance, with no reflection signal, 

the energy will be transmitted in one direction along the transmission line, and all the energy 

of the incident signal will be transmitted to the load, as shown in the following figure. 

 

Fig. 8.2 Signal Transmission of Transmission Line Connected through Load 

If the transmission line is connected through the short-circuit device, all the energy will be 

reflected to the signal source, and the amplitude of the reflected wave will be the same as that 

of the incident wave (ρ=1), and the voltage of both ends of the short-circuit device is 0. The 

phase of the reflected voltage wave of the short-circuit point is the same as that of the 

incident voltage wave (180-degree difference), and the voltage will be counterbalanced. 
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Fig. 8.3 Signal Transmission of Transmission Line Connected through Short-circuit Device 

If the transmission line is connected through the open-circuit device, all the energy will be 

reflected to the signal source, the amplitude of the reflected wave is the same as that of the 

incident wave (ρ＝1), no current flows through the open-circuit device, and the reflected 

voltage wave is the same as the incident voltage wave. 

 

Fig. 8.4 Signal Transmission of Transmission Line Connected through Open-circuit Device 

If the transmission line is connected through a 25Ω resistor, part of the energy will be 

absorbed, and part of the energy will be reflected to the signal source. The amplitude of the 

reflected wave is 1/3 of that of the incident wave. The voltage is subject to 180-degree 

difference at the resistor. The phase relationship changes with the distance of the end resistor 

along the transmission line. The valley of the standing wave figure is not approaching zero, 

and the peak is smaller than that of the open-circuit device and short-circuit device. 

 

Fig. 8.5 Signal Transmission of Transmission Line Connected through 25Ω Resistor 

8.1.1.4 Impedance 

The impedance is another way to express the reflection data. For impedance details, refer to 

the “Smith Chart Format” section of “4.7 Selection of Data Format and Scale”. 

8.1.2 Summary of Reflection Measurement Expression 

Various kinds of reflection data are calculated based on the same measurement data. The data 

relationship is shown in Fig. 8.6. 
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Fig. 8.6 Relationship of Reflection Expressions 

8.2 Phase Measurement 

8.2.1 What is phase measurement? 

It is important to understand the amplitude and phase information of the DUT to integrate 

high-level devices. Similar to the amplitude measurement, the S-parameter is also applied in 

phase measurement. Phase measurement is a kind of relative (ratio) measurement instead of 

absolute measurement. The phase of the signal into the device (incident signal) and the 

response signal are compared in phase measurement. The response signal may be reflected 

signal or transmitted signal. Given that the analyzer is accurately calibrated, the phase 

difference (i.e. phase shift) of two signals is the measurement result of phase characteristics 

of the DUT. The following figure shows the phase deviation between the incident signal and 

transmitted signal observed through the oscilloscope. 

 

Fig. 8.7 Phase Shift between Signals 

8.2.2 Why to perform phase measurement? 

Phase measurement is an important function of the vector network analyzer. Fig. 8.8 shows 

the reasons for accurate measurement of the amplitude and phase. 
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Fig. 8.8 Reasons for Accurate Amplitude and Phase Measurement 

If the element and circuit are used to transmit signals in the communication system, signal 

distortion must be within the normal limits. The signal distortion can be divided into two 

types. 

1) Linear distortion: refer to the failure to keep the flat amplitude and linear phase shift 

within the relevant frequency range as a result of frequency changes. 

2) Nonlinear distortion: refer to the new spectrum component of the circuit, such as AM-PM 

transformation. 

It is important to accurately measure the amplitude and phase characteristics of the element 

or circuit, so as to ensure the efficient transmission or adsorption of energy in the circuit and 

prevent the distortion in signal transmission. A good example to prevent distortion is to 

measure the complex impedance of the antenna. 

8.2.3 Use of Phase Format of Analyzer 

The phase format of the analyzer is used to display the phase changes over the frequency or 

power. The phase difference beyond ±180° between the reference signal and response signal 

cannot be measured by the analyzer. If the phase value varies from +180° to -180°, the 

sawtooth type phase measurement trace will be displayed on the analyzer. The sawtooth 

waveform may not reach +180° or -180° sometimes in measurement at the discrete frequency 

points. The data points of +180° and -180° may not be the points of sweep measurement. 

 

 

 

Phase Format 
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Fig. 8.9 Phase Format of Analyzer 

8.2.4 Type of Phase Measurement 

1) Complex impedance: the complex impedance data such as the resistance, reactance, 

amplitude and phase can be determined by S11 and S22 measurement and observed in the Smith 

chart and polar coordinate format. See details in “8.4 Complex Impedance”. 

2) AM-PM transformation: the unexpected phase deviation may be caused by system 

amplitude changes in the AM-PM transformation measurement, defined as the output phase 

change of each 1dB increase of the power input into the amplifier, in degree/dB. Measurement is 

done at the 1dB gain compression point. See details in “8.7 AM-PM Transformation”. 

3) Linear phase deviation: refer to the phase distortion produced in measurement of the DUT. 

Ideally, the phase shift of the DUT is linear to the frequency. The deviation produced relative to 

the theoretical phase deviation is referred to as the linear phase deviation (also known as the phase 

linearity). See details in “8.9 Linear Phase Deviation”. 

4) Group delay: it is another way to measure the phase distortion of the device. The transition 

time of the signal of specific frequency through the device is measured, and the group delay is 

calculated according to the derivative of the measured phase response. See details in “8.5 Group 

Delay”. 

8.2.5 Linear Phase Deviation and Group Delay 

The linear phase deviation and group delay are phase information of the measurement device 

but for different purposes. 

1) Advantages of linear phase deviation measurement: 

a) The noise is lower than that of group delay measurement. 

b) The characteristics of the device transmitting phase-modulated signals can be better 

represented. In this case, it is more appropriate to use the phase as the unit instead of the 

second. 

2) Advantages of group delay measurement: 

a) Compared with the linear phase deviation measurement, phase distortion can be explained 

more easily. 

b) The characteristics of the DUT can be represented accurately. The phase ripple slope is 

calculated by the analyzer in group delay measurement and depends on the ripple quantity 

within the unit frequency. Phase responses with the same phase ripple peak-peak value are 

compared. Large phase slope response may result in large group delay changes and signal 

distortion. 

8.3 Amplifier Parameter Specifications 

This section introduces the measurement parameters of the amplifier. 

8.3.1 Gain 

The gain refers to the ratio between the output power (to the characteristic impedance load) 

and input power (from the characteristic impedance source) of the amplifier and can be calculated 

by the following equation. 
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The output power of the amplifier is proportional to the input power in the case of small 

signal. The small-signal gain is within the linear zone. With the power level of the input signal 

increasing, the amplifier will be saturated, and the output power will reach the limit, leading to 

gain decline. The large signal gain is within the nonlinear zone. See details in “Appendix 5 Gain 

Compression Measurement of Amplifier”. 

8.3.2 Gain Flatness 

The gain flatness refers to the gain change of the amplifier within the working frequency 

range. See details in “8.10 Small Signal Gain and Flatness”. 

8.3.3 Reverse Isolation 

Reverse isolation is applied to measure the transmission between the output end and input 

end. Similar to gain measurement, only the stimulus signal is applied to the output end of the 

amplifier. See details in “8.9 Reverse Isolation”. 

8.3.4 Gain Drift Changes over Time (temperature and bias) 

The gain drift refers to the maximum gain change over time, with the other parameters 

unchanged. It is a function of the time. The gain drift related to other parameters can be 

measured, such as the gain deviation over the temperature, humidity and bias voltage. 

8.3.5 Linear Phase Deviation 

Refer to the deviation of linear shifts. Ideally, the phase shift of the amplifier is a linear 

function of the frequency. See details in “8.8 Linear Phase Deviation”. 

8.3.6 Group Delay 

The group delay refers to the transition time of the signal through the amplifier. It is a 

function of the frequency. The ideal linear phase shift has a constant change rate over the 

frequency. In this case, the group delay is a constant. In the actual measurement, the group 

delay is calculated by the following equation: 

 

See details in “8.5 Group Delay”. 

8.3.7 Return Loss (standing wave ratio, ρ) 

The return loss refers to the reflection matching of the amplifier relative to the system 

impedance Z0 in measurement of the input or output port. It can be calculated by the 

following equation: 
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8.3.8 Complex Impedance 

The amount of energy reflected by the device is associated with the complex impedance of 

the device. The complex impedance is composed of the resistance component and reactance 

component and can be calculated with the system characteristic impedance and reflection 

coefficient by the following equation: 

 

See details in “8.4 Complex Impedance”. 

8.3.9 Gain Compression 

The amplifier is configured with one gain zone, in which is the gain is not associated with the 

input power level (i.e. small signal gain). When the power level increases to a certain value, 

the amplifier will be saturated, which may result in gain declining. 

Gain compression is determined by measuring the 1dB gain compression point of the 

amplifier. The 1dB gain compression point refers to the output power at which the amplifier gain 

decreases by 1dB relative to the small signal gain. Generally, the measured value is used to 

describe the power output capacity of the amplifier. See details in “Appendix 5 Gain Compression 

Measurement of Amplifier”. 

8.3.10 AM-PM Transformation Coefficient 

The output signal phase change arising from the input signal amplitude change is measured in 

AM-PM transformation. The unit of AM-PM transformation is degree/dB. Measurement is done at 

the 1dB gain compression points. See details in “8.7 AM-PM Transformation”. 

8.4 Complex Impedance 

The complex impedance data can be observed in S11 or S22 measurement of the DUT, 

including the phase and amplitude information such as the series resistance, series reactance 

and impedance, in the Smith chart or polar coordinate format. 

8.4.1 What is complex impedance? 

The complex impedance data can be determined according to the S11 or S22 measurement 

results of the DUT. The reflection power of the DUT is associated with the impedance of the 

device and measurement system. For example, the complex reflection coefficient (Γ) will not 

be 0 unless the impedance of the device and system is fully identical (that is, the efficiency of 

power transmission from the source to load is the highest). Each Γ value corresponds to the 

unique complex impedance of the device. The complex impedance is a function of the 

frequency. 

 

Where, ZL is the impedance of the DUT, and Z0 is the characteristic impedance of the 

measurement system. The Smith chart format and polar coordinate format are the most 

suitable for impedance measurement. See details in the “Smith chart format” and “Polar 

coordinate format” of “4.7 Selection of Data Format and Scale”. 

8.4.2 Improvement of Impedance Measurement Accuracy 

1) If the full scale value is 1, Smith chart is the easiest to understand. 

2) If the marker is used in the Smith chart or polar coordinate format, the discrete marker 
mode can be applied to obtain higher measurement accuracy. 
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3) The uncertainty of reflection measurement is influenced by the following factors: 

a) Direction 

b) Reflection tracking 

c) Source matching 

d) Load matching 

The influence of these factors can be reduced in the full double-port calibration. If the output 

end of the DUT is connected with a high-quality load, the same measurement accuracy can 

be achieved by means of one-port calibration. 

 

Fig. 8.10 Connection in Impedance Measurement 

1) If the DUT is connected between two ports of the analyzer after one-port calibration, it is 

recommended to connect a 10dB attenuator to the output end of the DUT to improve the 

measurement accuracy. If the full double-port calibration has been done, the attenuator is not 

required as the load matching error is modified in the full-port calibration. 

2) If the double-port device is connected to one port of the analyzer after one-port calibration, 

a high-quality load (such as the standard load of the calibration kit) must be connected to the 

output port of the device. 

8.4.3 Steps of Complex Impedance Measurement 

1) Reset the analyzer. 

2) Set and calibrate the analyzer. 

3) Connector shown in Fig. 8.10 for S11 or S22 measurement. 

4) Observe the impedance data: 

a) Select the Smith chart format. 

b) Set the scale of the displayed measurement results to facilitate observation. 

c) Open the marker, and move the marker along the trace to read the resistance and reactance 

component of the complex impedance of the data point. 

d) Print or save the data. 

5) Observe the admittance data (if necessary): 

a) Open the marker and select the G+jBmarker format to read the admittance data. 

b) Set the scale of the displayed measurement results to facilitate observation. 

c) Move the marker along the trace to read the conductance and susceptance component of 
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the complex admittance of the data point, in siemens (S). 

d) Print or save the data. 

6) Observe the amplitude and phase of the reflection coefficient: 

a) Select the Smith chart or polar coordinate format. 

b) Open the marker and select the logarithmic/phase or linear/phase format. 

c) Set the scale of the displayed measurement results to facilitate observation. 

d) Move the marker along the trace to read the amplitude and phase information of the data 

point. 

e) Print or save the data. 
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8.5 Group Delay 

The phase distortion of the DUT is measured in group delay measurement. The group delay 

refers to the actual transition time of the signal through the DUT and changes over the 

frequency. The aperture of group delay measurement must be specified to describe the group 

delay indicator. 

8.5.1 What is group delay? 

The group delay refers to: 

1) Measure of phase distortion of the device. 

2) Relationship between the signal transition time through the device and the frequency. 

3) Derivative of the phase characteristic of the device relative to the frequency. 

 

Fig. 8.11 Phase Shift and Group Delay 

Group delay 

 

Φ is in radian, ω in radian/second, θ in degree and f in Hz. 

The phase characteristic of the device includes the linear phase shift component and 

high-order phase shift component. 

1) Linear phase shift component: refer to the average transition time of the signal, indicating 

the electrical length of the device. 

2) High-order phase shift component: refer to the transition time change over the frequency, a 

cause of signal distortion. 

 

Fig. 8.12 Group Delay 

In the group delay measurement: 

1) The linear phase shift component represents the average group delay. 

2) The high-order phase shift component represents the average group delay deviation (group 

delay ripple). 

3) Similar to the linear phase deviation resulting in distortion, the group delay deviation will 

also result in signal distortion. 

4) The trace of group delay measurement indicates the passing time of each frequency signal 
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through the DUT. 

The group delay of the analyzer is calculated in the following methods: 

Group delay 

 

Φ is in radian, ω in radian/second, θ in degree and f in Hz. 

1) Calculate the phase change (-dΦ) according to the phase data. 

2) Use the specified frequency aperture as the frequency change (dω). 

3) Using the above two values, calculate the approximate value of the phase change rate over 

the frequency. The approximate value is the group delay (assuming that the phase changes 

linearly within the specified frequency aperture). 

8.5.2 Why to measure the group delay? 

 

The group delay is more accurate than the linear phase deviation to represent the phase 

distortion, as shown in Fig. 8.13. 

Fig. 8.13 Comparison of Group Delay and Linear Phase Deviation 

1) The upper half part of the figure shows the measurement results of the linear phase 

deviation of Device 1 and 2. Although the trace shape varies, the linear phase deviations of 

both devices are identical. 

2) The lower half part of the figure shows the measurement results of the group delay of 

Device 1 and 2. The group delay of Device 1 is different from that of Device 2, as it is 

calculated by the analyzer according to the phase ripple slope. The phase ripple slope 

depends on the ripple quantity within the unit frequency. 

8.5.3 What is the aperture of group delay? 

The analyzer will measure the phase of two adjacent frequency points and calculate the phase 

slope in group delay measurement. The frequency interval (frequency interval) between two 

phase measurement points is referred to as the aperture. Different group delay values can be 

obtained by changing the aperture. This is why the aperture of measurement must be known 

before comparison of group delay data. 

The default aperture of group delay of the analyzer is the frequency interval of two adjacent 

sweep points. Apply the following two methods to change the aperture: 

1) Change the number of measurement points or the frequency span. 

a) Increase the number of points or reduce the frequency span to narrow the aperture. 

b) Decrease the number of points or increase the frequency span to widen the aperture. 
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Fig. 8.14 Influence of Group Delay Aperture on Measurement Results 

Attention 

Relationship of the aperture and group delay: 

If the aperture is too wide and the phase shift of adjacent frequency points is more than 180°, errors will occur 

in group delay calculation. 

2) Apply the smoothing function of the analyzer. 

Perform sweep once, enable the smoothing function and change the value percentage in 

smoothing settings. This is similar to change of the frequency interval between sweep points. 

This method allows a wider group delay aperture, and the phase shift is allowed to exceed 

180° within the smoothing aperture. 

Group delay measurement can be done in the following sweep types: 

a) Linear frequency; 

b) Logarithmic frequency; 

c) Segment sweep. 

The group delay aperture depends on the frequency interval and the sweep point density, 

therefore, it changes in the logarithmic frequency and segment sweep mode. 

8.5.4 Improvement of Measurement Accuracy of Group Delay 

It is important to keep the phase difference of adjacent measurement points less than180° 

during group delay measurement; otherwise, the phase and group delay information will be 

incorrect, as shown in Fig. 8.15. Insufficient sampling may occur in measurement of the 

device of long electrical delay. Adjust the following settings until the measurement trace does 

not change so as to ensure that the phase difference of two adjacent points is less than 180°. 

1) Increase the number of points. 

2) Reduce the frequency span. 
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Fig. 8.15 Influence of Insufficient Sampling on Group Delay Measurement 

The frequency response is a main error of group delay measurement. This error can be 

significantly reduced by means of through type response calibration. Perform the full 

double-port calibration to realize higher accuracy. For the amplifier, the response may vary 

with the temperature. Therefore, the test should be done at the working temperature of the 

amplifier. 

8.5.5 Steps of Group Delay Measurement 

1) Reset the analyzer. Adjust the source power of the analyzer to test the amplifier. 

a) Set the source power of the analyzer within the linear zone of the analyzer response 

(generally at least 10dB less than the 1dB input compression point). 

b) If required, connect one attenuator to the output port of the amplifier to fully attenuate the 

output power of the amplifier and prevent the receiver at the reception end of the analyzer 

from compression or burning. 

2) Connect the DUT, as shown in Fig. 8.16. 

 

Fig. 8.16 Connection in Group Delay Measurement 

3) Select the S21 measurement mode. 

4) Select the settings corresponding to the DUT, including: 

a) Format: phase. 

b) Scale: automatic scale. 

c) Number of measurement points: select the appropriate number to avoid insufficient 

sampling. 

5) Remove and calibrate the DUT. 

6) Reconnect the DUT. 

7) Set the group delay display format and the scale of measurement display to realize the best 

observation effect. 

8) Increase the aperture and reduce the noise on the trace by the smoothing function of the 

analyzer. At the same time, keep meaningful details. Take the following steps to increase the 

aperture: 

a) Enable the smoothing function of the analyzer. 

b) Change the smoothing aperture (max. 25% of the frequency span). 

9) Read the group delay of the relevant frequency through the marker. 

10) Print or save the data. 
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8.6 Absolute Output Power 

The absolute output power is the relationship between the displayed absolute power (dBm or 

W) and frequency. 

8.6.1 What is the absolute output power? 

The absolute output power is the power of the reception port of the analyzer. This is the 

absolute power, not based on the incident power or source power (or the ratio). The value 

indicated on the longitudinal axis of the grid is in dBm in the logarithm amplitude format. It 

is the power tested based on 1mW. 

0dBm=1mW 

-10dBm=0.1mW 

+10dBm=10mW 

The value indicated on the vertical axis of the grid in the logarithm amplitude format is in W. 

8.6.2 Why to measure the absolute output power? 

If the absolute power instead of the relative power must be used as the amplifier output, the 

absolute output power must be measured. In gain compression measurement, the absolution 

output power of the amplifier should be measured based on 1dB compression. In order to 

improve the measurement accuracy, considerations must be given to the following factors: 

1) If necessary, fully attenuate the output power of the amplifier. Too high power may lead to 

the following results: 

a) The output power is higher than the input compression level of the receiver of the analyzer, 

which may lead to inaccurate measurement results. 

b) The receiver of the analyzer may be burnt. 

2) Attenuate the output power of the amplifier with the attenuator or coupler. 

3) The amplifier has different response values corresponding to temperature differences. The 

test must be done at the working temperature of the amplifier. 

8.6.3 Steps of Measurement of Absolute Output Power 

1) Reset the analyzer. 

2) Select the non-ratio power measurement (the source is set on Port 1 and Receiver B is used 

for input). 

3) Set the source power of the analyzer as 0dBm. 

4) As shown in Fig. 8.17, connect the amplifier and provide the DC bias. If necessary, use an 

external attenuator to fully attenuate the output power of the amplifier so as to prevent the 

receiver on Port 2 of the analyzer from compression or burning. 
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Fig. 8.17 Connection in Absolute Output Power Measurement 

5) Select the analyzer settings corresponding to the amplifier to be tested. 

6) Remove the amplifier, and connect the attenuator and cable between two ports. Apply the 

trace operation function and save the data trace into the memory. Apply the data/saving 

function for normalization. If the attenuator and cable are used in amplifier measurement, 

they must be included in normalization measurement. 

7) Reconnect the amplifier. 

8) Set the scale of measurement display to realize the best observation effect. Read the 

absolute output power corresponding to the frequency through the marker. 

9) Print or save the data. 

8.7 AM-PM Transformation 

AM-PM transformation of the amplifier represents the phase deviation caused by system 

amplitude changes. 

8.7.1 What is AM-PM transformation? 

AM-PM transformation represents the unexpected phase deviation (PM) caused by system 

amplitude changes (AM). The unexpected phase deviation (PM) in the communication 

system may be caused for the following reasons: 

1) Accidental amplitude change (AM): 

a) Power fluctuation; 

b) Thermal drift; 

c) Multipath attenuation. 

2) Deliberate signal amplitude modulation: 

a) QAM (quadrature amplitude modulation); 

b) Sudden pulse modulation. 

AM-PM transformation is generally defined as the output phase change in radian/dB, 

corresponding to 1dB increase of the sweep power applied on the input end of the amplifier 

(at the 1dB gain compression point). The phase response of the ideal amplifier is not 

associated with the power level of the input signal. 

8.7.2 Why to measure AM-PM transformation? 

AM-PM transformation is a key parameter in the following phase (angle) modulation system. 
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1) FM 

2) QPSK 

3) 16QAM 

The unexpected phase deviation (PM) will result in deterioration of the analog signal 

performance or increase of the bit error rate (BER) of the digital communication system. It is 

easy to measure the bit error rate (BER) of the digital system, but this is not helpful to 

understand the root causes of bit errors. AM-PM transformation is one of the main factors 

resulting in bit errors. Therefore, it is critical to quantify this parameter in the communication 

system. The following I/O figure shows why bit errors are produced in AM-PM 

transformation. 

 

Fig. 8.18 Bit Errors in AM-PM Transformation 

1) The expected state change is from the small solid-line vector into large solid-line vector. 

2) As a result of AM-PM transformation, the large solid-line vector may end like that shown 

by the dotted line in the actual situation. This is caused by the phase shift arising from 

changes of the input power level. 

3) For the 64QAM signal (only the quadrant is drawn) shown in Fig. 8.18, bit errors occur in 

the statistics if the noise circles of each state are overlapped. 

8.7.3 Factors Related to Measurement Accuracy 

When the network analyzer is used to measure AM-PM transformation, the frequency of the 

amplitude modulation signal is approximate to the reciprocal of the sweep time. Even if the 

highest sweep power is set, the modulation frequency is low (generally less than 10Hz). This 

may result in slight temperature changes of the DUT in the sweep process, especially the 

thermal mass of the amplifier is small (typically for the unsealed device). If the nonlinear 

characteristic of the amplifier is sensitive to thermal changes, the measurement result 

obtained in this method may have errors. In order to improve the measurement accuracy, 

considerations should be given to the following factors. 

1) The amplifier response may vary with the temperature. The test must be done at the 

working temperature of the amplifier. 

2) If necessary, fully attenuate the output power of the amplifier. Too high power may lead to 

the following results: 

a) The output power is higher than the input compression level of the receiver of the analyzer, 

which may lead to inaccurate measurement results. 

b) The receiver of the analyzer may be burnt. 

3) Attenuate the output power of the amplifier with the attenuator or coupler. 
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4) The influence of the frequency response of the attenuator or coupler must be taken into 

consideration during calibration. They are part of the test system and must be included in the 

calibration process. The influence of such accessories can be reduced or eliminated by the 

perfect technology of error correction. 

5) The frequency response is an error which plays a dominant role in AM-PM transformation 

measurement. The through type response calibration can be applied to significantly reduce 

the error. 

8.7.4 Step of AM-PM Transformation Measurement 

1) Reset the analyzer. 

2) Select S21 measurement in the power sweep mode. 

3) Set the start and stop power level of power sweep of the analyzer. The start power level 

should be within the linear zone (generally at least 10dB less than the 1dB compression point) 

of the amplifier response, and the stop power level should be within the compression zone of 

the amplifier response. 

4) If necessary, use the external attenuator or coupler to fully attenuate the output power of 

the amplifier and prevent the receiver on Port 2 of the analyzer from compression or burning. 

5) As shown in Fig. 8.19, connect the amplifier and provide the DC bias. 

 

Fig. 8.19 Connection in AM-PM Transformation Measurement 

6) Select the analyzer settings corresponding to the tested amplifier so as to perform gain 

compression measurement in the power sweep mode at the selected frequency. See details in 

“Appendix 5 Gain Compression Measurement of Amplifier”. 

7) Remove and calibrate the amplifier. The attenuator, coupler and cable used in amplifier 

measurement must be included in calibration. 

8) Reconnect the amplifier, open the marker R and set the marker at the 1dB gain 

compression point of the amplifier. Open the second marker, activate the Δmarker mode, and 

set the stimulus value of the second marker as -1dBm. 

9) Change S21 measurement from the logarithmic amplitude format into the phase format 

(requiring no re-calibration). 

10) Read the phase difference between the markers. This value is the AM-PM transformation 

coefficient at the 1dB gain compression point. 

11) Print or save the data. 

8.8 Linear Phase Deviation 

The linear phase deviation refers to the phase distortion of the device. The electrical delay 
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function of the analyzer is applied in measurement to eliminate the linear part of the phase 

shift and realize high-resolution nonlinear part, i.e. linear phase deviation. 

8.8.1 What is linear phase shift? 

The signal wavelength will decrease with the incident signal frequency increasing during 

signal transmission. In this case, the obvious phase shift will be produced. The phase shift is 

linear when the phase response of the device is proportional to the frequency. The trace 

indicating the relationship between the phase and frequency on the analyzer is an oblique line. 

The slope is proportional to the electrical length of the device. The phase shift must be linear 

for signal transmission without distortion. 

8.8.2 What is linear phase deviation? 

In the actual cases, the delay time of many devices corresponding to some frequencies is 

longer than that corresponding to the other frequencies so as to form the nonlinear phase shift, 

including distortion of many frequency component signals. One method to determine the 

nonlinear phase shift is to measure the linear phase deviation. 

As phase distortion is caused by linear phase deviation, the linear part of the phase response 

should be removed in measurement. This can be realized by the electrical delay function of 

the analyzer. If the electrical length of the DUT is removed mathematically, the linear phase 

deviation or phase distortion will be left. 

8.8.3 Why to measure the linear phase deviation? 

Linear phase deviation measurement has the following advantages: 

a) The measurement result is the phase data, instead of the group delay data in second. The 

phase data may be more usable for the device transmitting modulation signals. 

b) Provide a measurement method with noise lower than that of group delay measurement. 

8.8.4 Use of Electrical Delay Function 

The electrical delay characteristic of the analyzer has the following functions: 

1) Simulate the transmission line of adjustable length and no loss to facilitate the installation 

in or removal from the signal path. 

2) Compensate changes of the electrical length of the DUT. 

3) Make the phase measurement trace on the analyzer flat, to realize the high-resolution 

observation of the trace and find nonlinear details of the phase. 

4) Provide a method to easily observe the linear phase deviation of the DUT. 

 

Fig. 8.20 Observation of Linear Phase Deviation by Electrical Delay Function 

See electrical delay details in “6.5.1 Electrical Delay”. 
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8.8.5 Factors Related to Measurement Accuracy 

The frequency response is an error which plays a dominant role in linear phase deviation 

measurement. The through type response calibration can be applied to significantly reduce 

the error. In order to achieve higher accuracy, the full double-port calibration should be done. 

8.8.6 Steps of Linear Phase Deviation Measurement 

1) Reset the analyzer. Adjust the source power of the analyzer to test the amplifier. 

a) Set the source power of the analyzer to make the amplifier working within the linear zone 

(generally at least 10dB less than the 1dB compression point). 

b) If necessary, use the external attenuator or coupler to fully attenuate the output power of 

the amplifier and prevent the receiver on Port 2 of the analyzer from compression or burning. 

2) Select the S21 measurement mode. 

3) Connect the DUT as shown in Fig. 8.21. 

 

Fig. 8.21 Connection in Linear Phase Deviation Measurement 

4) Select the analyzer settings corresponding to the DUT, including the phase format. 

5) Remove and calibrate the DUT. 

6) Reconnect the DUT and set the scale of measurement display to facilitate observation. 

7) Change the electrical delay to make the phase trace flat. 

8) Read the linear phase deviation through the marker. 

9) Print or save the data. 

8.9 Reverse Isolation 

Reverse isolation aims to measure the reverse transmission response from the output to input 

of the amplifier. 

8.9.1 What is reverse isolation? 

The degree of isolation from the output end to input end of the device is measured in reverse 

isolation. Reverse isolation measurement is similar to positive gain measurement, but with 

the following differences. 

1) The stimulus signal is applied on the output port of the amplifier. 

2) The response signal is measured at the input end of the amplifier. 

3) The equivalent S-parameter is S12. 

8.9.2 Why to measure reverse isolation? 

The ideal amplifier should have infinite reverse isolation, and no signal is transmitted from 
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the output end back to the input end. Actually, the signal may be transmitted through the 

amplifier in the opposite direction. This kind of unexpected reverse transmission may result 

in the interference of the reflected signal of the output port to the signal transmitted forwards. 

Therefore, it is important to quantify reverse isolation. 

8.9.3 Factors Related to Measurement Accuracy 

As the amplifier generally has high loss in the reverse direction, the attenuator or coupler is 

not required to protect the receiver of Port 1 in reverse transmission measurement. In case of 

no attenuator, the dynamic range and measurement accuracy will be improved. The source 

power can be increased to improve the dynamic range and accuracy. 

 

Warning 

The power must not be overloaded forward sweep or full double-port calibration. 

With the attenuator eliminated and RF power increased, the receiver of Port 2 of the analyzer may be burnt in 

forward sweep. Thus, forward sweep or full double-port calibration must not be done until the forward power is 

low enough, which cannot result in burning of the receiver of Port 2 of the analyzer. 

If the tested amplifier is highly isolated, the level of the reverse signal may be close to the 

base noise or crosstalk level of the receiver. In order to reduce the base noise, the averaging 

function can be applied. The dynamic range and accuracy of measurement can be improved 

by increasing the averaging times or reducing the intermediate frequency bandwidth, at the 

sacrifice of measurement velocity. 

1) If the measurement accuracy is affected by the crosstalk, the through type response and 

isolation calibration can be implemented to reduce crosstalk errors. Use the same average 

factor and intermediate frequency bandwidth during calibration and measurement. 

2) The frequency response of the test is a main error source in reverse isolation measurement. 

It can be eliminated by through type response or through type response/isolation calibration. 

3) If the temperature varies, the amplifier response may be thoroughly difference. The test 

should be done at the working temperature of the amplifier. 

8.9.4 Steps of Reverse Isolation Measurement 

1) Reset the analyzer. 

2) Select the S12 measurement type. 

3) Connect the amplifier as shown in Fig. 8.22 and provide the DC bias. 

 

Fig. 8.22 Connection in Reverse Isolation Measurement 

4) Set the analyzer corresponding to the tested amplifier. 

5) Remove and calibrate the amplifier and perform through type response calibration or 
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through type response/isolation calibration. 

6) Reconnect the amplifier and set the scale of measurement display to facilitate observation. 

7) Read the reverse isolation value at the corresponding frequency point through the marker. 

8) Print or save the data. 

8.10 Small Signal Gain and Flatness 

The small signal gain refers to the gain of the amplifier within the linear working zone. 

Generally, it is measured at the constant input power within the frequency sweep range. The 

gain flatness refers to the gain change within the specified frequency range. 

8.10.1 What is gain? 

The amplifier gain is defined as the power difference between the output signal and input 

signal of the amplifier (power unit: dBm), given that the input impedance of the amplifier is 

the same as the output impedance. It is the characteristic impedance of the system. 

1) The gain is referred to as S21 among the S-parameter terms. 

2) The gain is expressed as the logarithmic ratio of the output power and input power (dB). 

3) If the input level and output level are expressed in dBm (equivalent to the power 1mW), 

the gain can be calculated by subtracting the output level by the input level. 

4) The amplifier gain generally refers to the minimum gain within the working frequency 

range. Some amplifiers are provided with the minimum and maximum gain at the same time 

to prevent under-stimulus or over-stimulus at subsequent levels of the system. 

8.10.2 What is flatness? 

The flatness refers to the amplifier gain change within the specified frequency range. The 

amplifier gain change may result in distortion of the signal through the amplifier. 

8.10.3 Why to measure the small signal gain and flatness? 

The gain deviation within the specified bandwidth may result in unequal amplification of 

frequency components of the signal and distortion of the transmitted signal. The small signal 

gain refers to the amplifier gain at the specific frequency of the 50Ω system and the flatness 

refers to the amplifier gain deviation within the specified frequency range of the 50Ω system. 

8.10.4 Factors Related to Measurement Accuracy 

1) If the temperature varies, the amplifier response may be thoroughly difference. The test 

should be done at the working temperature of the amplifier. 

2) If necessary, fully attenuate the output power of the amplifier. Too high output power may 

lead to the following results: 

a) The output power exceeds the input compression level of the receiver of the analyzer, 

resulting in inaccurate measurement results. 

b) The receiver of the analyzer may be burnt. 

3) The output power of the amplifier can be attenuated with the attenuator or coupler. As the 

attenuator or coupler is part of the test, the influence of mismatch and frequency response on 

the measurement accuracy must be taken into consideration in calibration. Proper error 

correction can be implemented to reduce the influence of such accessories. 

4) The frequency response of the test is the most important error source of small signal gain 

and flatness measurement. This kind of error can be reduced significantly by through type 
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response calibration. The measurement accuracy can be improved by full double-port 

calibration. 

5) The dynamic range and accuracy can be improved by reducing the intermediate frequency 

bandwidth or using the measurement averaging function, but at the sacrifice of measurement 

velocity. 

8.10.5 Steps of Small Signal Gain and Flatness Measurement 

1) Reset the analyzer. 

2) Select the measurement parameter S21. 

3) Set the source power of the analyzer to make the amplifier working within the linear zone 

(generally at least 10dB less than the 1dB compression point). 

4) If necessary, use the external attenuator or coupler to fully attenuate the output power of 

the amplifier and prevent the receiver on Port 2 of the analyzer from compression or burning. 

 

5) Connect the amplifier as shown in Fig. 8.23 and provide the DC bias. 

Fig. 8.23 Connection in Small Signal Gain and Flatness Measurement 

6) Set the analyzer corresponding to the tested amplifier. 

7) Remove and calibrate the amplifier. The attenuator, coupler and cable used in 

measurement must be included in calibration. 

8) Reconnect the amplifier. 

9) Set the scale of measurement display to facilitate observation. Read the small signal gain 

at the corresponding frequency point through the marker. 

10) Observe the peak-peak ripple within the whole frequency range through the marker to 

measure the gain flatness. 

11) Print or save the data. 
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9 Remote control 

This chapter mainly describes the program control basics, program-control interface and 

configuration method and basic VISA interface programming method of 3672 series vector 

network analyzers, as well as the concept of I/O instrument driver library. to facilitate remote 

control of the user. Specific contents include: 

● Basis of remote control…………………………………………………………………..…295 

● Remote control port and configuration……………………………………………..………309 

● Basic VISA interface programming method…………………………………………….…312 

● I/O library………………………………………………………………………………..…320 

9.1 Basis of Remote Control 

9.1.1 Remote Control Interface 

The instrument with the remote control function generally supports four kinds of remote 

control interface: LAN, GPIB, RS-232 and USB. Specific port models depend on the 

instrument functions. 

The remote control interfaces and associated VISA addressing character strings are shown in 

the following table. 

Table 9.1 Types and VISA Addressing Character Strings of Remote Control Interfaces 

Program Control 

Interface 
VISA Addressing Character String 

Description 

LAN 

(LocalAreaNetwork) 
VXI-11 protocol: 

TCPIP::host_address[::LAN_device_name][::INSTR] 

Original socket protocol: 
TCPIP::host_address::port::SOCKET 

Remote control 

can be realized by the 

connecting the 

instrument through 

the network port on 

the rear panel of the 

instrument. For 

details, refer to: 

9.2.1 LAN 

Interface 

GPIB 

(IEC/IEEEBusInterface) 

GPIB::primaryaddress[::INSTR] Remote control 

can be realized by the 

connecting the 

instrument through 

the port on the rear 

panel of the 

instrument. 

Comply with the 

IEC625.1/IEEE 418 

bus interface 

standard. 

 For details, 

refer to: 

9.2.2 GPIB 

interface 

9.1.1.1 LAN Interface 
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The vector network analyzer can be controlled remotely by the 10Base-T and 100Base-T 

LAN computer. Various instruments in the LAN are combined into a system for unified 

control with the computer in the network. In order to realize the remote control within LAN, 

the vector network analyzer should be configured with the port connector, network card, 

network protocol and network service in advance. At the same time, the controlling computer 

in the network should be configured with the instrument control software and VISA library in 

advance. Three working modes of the network card: 

 10Mbit/s Ethernet IEEE802.3; 

 100Mbit/s Ethernet IEEE802.3u; 

 1Gbit/s Ethernet IEEE802.3ab. 

Connect the controlling computer and vector network analyzer to the common TCP/IP 

network through the network ports. Use the RJ45 cable (shielded or non-shielded Class 5 

twisted pair) between the computer and vector network analyzer. Use the packet transmission 

mode in data transmission, as the velocity of LAN transmission is high. Generally, the cable 

between the computer and vector network analyzer must be no more than 100m long 

(100Base-T and 10Base-T). For more details of LAN communication, visit 

http://www.ieee.org. LAN interfaces are introduced below. 

1) IP address 

Ensure that the physical connection is smooth for remote control of the vector network analyzer 

by LAN. Click [Start] in the Menu ->[Control panel]->[Network &Internet]->[Network & 

Shared service center]->[Change adapter setting]->[Local connection], right click [Property]. 

Open “Local IP” in the menu of the vector network analyzer and set the address within the 

subnet. Example: if the IP address of the master control computer is 192.168.12.0, the IP address 

of the vector network analyzer should be 192.168.12.XXX, where XXX is 1 to 255. 

Only the IP address is required to establish the network connector. The VISA addressing 

character string is as follows: 

TCPIP::hostaddress[::LANdevicename][::INSTR] or 

TCPIP::hostaddress::port::SOCKET 

Where： 

 TCPIP refers to the applied network protocol. 

 hostaddress refers to the IP address of the instrument or the host name, used to identify and 

control the controlled instrument. 

 LANdevicename refers to the handle number of the protocol and device (optional). 

– Select the VXI-11 protocol for No. 0 device. 

– Select a new high-velocity LAN instrument protocol for No. 0 high-velocity LAN 

instrument. 

 INSTR refers to the instrument source type (optional). 

 “port” refers to the socket port number. 

 SOCKET refers to the original network socket resource class. 

Example: 

 If the IP address of the instrument is 192.1.2.3, the effective resource string of VXI-11 

protocol is: 

TCPIP::192.1.2.3::INSTR 
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 Use the following string for original socket connection: 

TCPIP::192.1.2.3::1024::SOCKET 

Prompt 

Identification of multiple instrument in remote control system 

If multiple instruments are connected in the network, distinguish them with the separate IP address and 

associated resource string. The respective VISA resource string is used by the master control computer to identify 

the instrument. 

2) VXI-11 protocol 

XI-11 standard is based on the ONCRPC (Open Network Computing Remote Procedure 

Recall) protocol and suitable for the network/transmission layer of the TCP/IP protocol. The 

TCP/IP network protocol and related network services are configured in advance. The 

connection-oriented communication complies with the sequential exchange requirements, 

and connection interruptions can be identified to prevent the loss of information. 

3) Socket communication 

The TCP/IP protocol is connected to the network analyzer in the network through the LAN 

socket. Socket is a basic approach used in computer network programming, which enables 

network communication among applications employing different hardware and operating 

systems. In this method, the vector network analyzer is connected to the computer through 

the port for two-way communication. 

Socket is a kind of software specially programmed and has defined the information necessary 

for network communication such as IP address and device port number and integrated some 

basic operations of network programming. Socket can be used as long as the packaged 

libraries are installed in the OS. Berkeley Socket Library applied in UNIX and Winsock 

Library applied in Windows constitutes the two common socket libraries. 

The socket of the vector network analyzer is compatible with the Berkeley socket and 

Winsock through the application program interface (API). Besides, it is also compatible with 

other standard socket API. The command will be sent by the socket program to control the 

vector network analyzer through SCPI commands. The socket port number of the vector 

network analyzer must be set before the LAN socket is used. The socket port number of the 

vector network analyzer is 1024. 

9.1.1.2 GPIB Interface 

The GPIB is a kind of remote control interface which is widely applied at present. Various 

kinds of instruments can be connected through GPIB cables to form a test system with the 

master control computer. In order to realize remote control, the master control computer 

should be configured with the GPIB bus card, drive program and VISA library in advance. In 

the communication process, the controlled instrument is addressed by the master control 

computer according to the GPIB bus address, and the user can set the GPIB address and ID 

query string. The default GPIB communication language is SCPI command. 

Refer to ANSI/IEEE 488.1-1987 and ANSI/IEEE 488.2-1992 for detailed definitions and 

descriptions on GPIB and relevant interface operations. For details, visit the IEEE website 

http://www.ieee.org. 

The byte is used in information processing of GPIB. The data transmission rate can reach 

8MBps. Therefore, the velocity of data transmission of GPIB is high. The data transmission 

velocity is limited by the distance between the equipment/system and computer, pay attention 
to the following items in GPIB connection. 
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 At most 15 instruments can be connected through GPIB interfaces. 

 The total length of the transmission cable must not exceed 15m or twice of the number of 

instruments in the system. Generally, the maximum length of the transmission cable between 

devices must not exceed 2m. 

 For parallel connection of instruments, use “or” connecting lines. 

 Connect the terminal of the IEC bus cable to the instrument or controlling computer. 

9.1.2 Message 

Messages transmitted through the data lines are divided into the following two types. 

1) Interface message 

The low attention line should be installed for communication between the instrument and 

master control computer, and then interface messages can be transmitted to the instrument 

through the data line. Interface messages must be transmitted by the instrument with the 

GPIB bus function. 

2) Instrument message 

For the structure and grammar of instrument messages, refer to “5.1.4 SCPI Commands”. 

According to the transmission direction, instrument messages can be divided into the 

command and instrument response. Unless otherwise specified, the same method should be 

applied for use of instrument messages with the remote control interface. 

a) Command: 

The command (programming message) is a kind of message transmitted by the master 

control computer to the instrument, used for remote control of the instrument function and 

query of the state information. Commands are divided into the following two types: 

 According to the influence on the instrument: 

– Setting command: change the instrument setting state, such as resetting, frequency setting, 

etc. 

– Query command: inquire and return data, such as instrument identification or parameter 

query. The query command ends with a suffix question mark. 

 According to the definition in the standard: 

– General command: the function and grammar are defined in the IEEE488.2 standard, and this 

kind of command is suitable for all kinds of instruments, and if possible, used for standard 

state register management, resetting, automatic testing, etc. 

– Instrument control command: a kind of instrument characteristic command, used to realize 

the instrument functions. Example: frequency setting. 

The grammar should comply with the SCPI specifications. 

b) Instrument response: 

The instrument response (response message and service request) is a kind of query result 

message transmitted by the instrument to the computer. This kind of message includes the 

measurement result, instrument state, etc. 

9.1.3 SCPI Command 

9.1.3.1 SCPI Command Introduction 

SCPI (Standard Commands for Programmable Instruments) is a command set, which is 
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established based on the IEEE488.2 Standard and suitable for all instruments. It mainly aims 

to apply the same programmed commands for the same functions to realize the universality 

of programmed commands. 

The SCPI command is composed of the command head and one or more parameter(s), which 

are separated by spaces. The command head includes one or more key field(s). The command 

with the suffix question mark is the query command. The command can be divided into 

general command and special command of different grammatical structures. The SCPI 

command has the following features: 

1) Program control commands are applicable to the test function, but not for instrument 

description. 

2) Program control commands can help to reduce the repetition of similar test functions and 

ensure the program compatibility. 

3) Program control messages are defined in the layer which is not related to the hardware of 

the physical layer in communication. 

4) Program control messages are not related to the programming method and language. The 

SCPI test program is easy to transplant. 

5) Program control commands are scalable to adapt to measurement control of various scales. 

6) The SCPI command is “live” due to the extensibility. For more SCPI details, refer to: 

IEEE Standard 488.1-1987, IEEE Standard Digital Interface for Programmable 

Instrumentation. New York, NY, 1998. 

IEEE Standard 488.2-1987, IEEE Standard Codes, Formats, Protocols and Comment 

Commands for Use with ANSI/IEEE Std488.1-1987.NewYork, NY, 1998. 

Standard Commands for Programmable Instruments (SCPI) VERSION 1999.0. 

For details of the program control command set, classification and specifications of 3672 

series vector network analyzers, refer to: 

1) “3 Program Control Commands” of the program control manual. 

2) “Appendix A Table of Subsystem-based SCPI Command Classification” of the program 

control manual. 

9.1.3.2 SCPI Command Specifications 

1) General Terms 

The following terms are applicable to this section. In order to better understand the contents, 

you should know the exact definitions of such terms. 

Controller 

Any computer used to communicate with SCPI devices. The PC, minicomputer or card in a 

card cage can be used as the controller. Also, some intelligent devices can be used as 

controller. 

Equipment 

Any device supporting SCPI. The majority of devices are electrical measurement or stimulus 

devices for communication through the GPIB interface. 

Program Message: 

A combination of one or more properly formatted SCPI commands. Programming messages 
instruct a device how to measure and output signals. 
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Response Message 

A combination of data in specified SCPI formats. Response messages are always transmitted 

from a device to a controller or monitor. Response messages inform the controller of the 

internal state or measured values of a device. 

Command 

Any command compliant with SCPI standard. Messages control the combination of device 

commands. Generally, the commands consist of keyword, parameter and punctuation. 

Event Command 

Some commands are events and cannot be queried. Generally, there is no front panel key 

corresponding to the event command. The event command is used to trigger an event at the 

specific time. 

Query 

A special type of command. For query of control equipment, return to the response message 

conforming to the controller grammar requirements. Query string always end with a question 

mark. 

2) Command type 

The SCPI command is divided into two types: general command and special instrument 

command. Figure 5.2 shows the differences of two types of commands. The general 

command is defined according to the IEEE488.2 standard, used for macro and state register 

management, synchronization and data storage. It can be easily identified with the star mark 

in front of the command. For example, *IDN？ , *OPC and *RST are common commands. 

The general command is not the special instrument command and can be explained in the 

same method, regardless of the current path setting. 

The special instrument command is easy to identify with the colon (:). The colon is used at 

the beginning and between key words of the command expression, such 

as:SENS<cnum>:FREQuency[:CW？]. Based on the internal functional modules of the 

instrument, special instrument commands are divided into corresponding subsystem 

command subsets. For example, the power subsystem (:POWer) includes relevant power 

commands, and the state subsystem (:STATus) includes the state control register commands. 

 

Fig. 9.1 Types of SCPI Commands 

3) Grammar of special instrument command 

A typical command is made up of keywords prefixed with colons (:). The keywords are 

followed by parameters. The following is an example syntax statement: 

[:SOURce]:POWer[:LEVel]MAXimum|MINimum 

In the above example, “:POWer” is followed by [:LEVel], with no space. 

“MINimum|MAXimum” behind [:LEVel] is the parameter part. A space is used between the 
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command and parameter. For the other parts of the grammar expression, see Table 9.2 and 

9.3. 

Table 9.2 Special Characters of Command Grammar 

Sy

mbol 

Meaning Examples 

| 

The vertical line between the 

keyword and parameter means a variety 

of options. 

TRIGger[:SEQuence]:SCOPe 

ALL|CURRent 

“ALL” and “CURRent” are optional. 

[] 

The square bracket means that the 

included keywords or parameters are 

optional in the command. 

 Even if the included keywords or 

parameters are ignored, the command 

will be executed. 

TRIGger[:SEQuence]:SCOPe 

ALL|CURRent 

Where, SEQuence is optional. 

<> 

The part in the angle brackets must 

not be used according to the literal 

meaning in the command. The angle 

brackets mean the necessary part. 

TRIGger[:SEQuence]:SCOPe 

<char> 

In this command, <char> must be replaced with the 

actual trigger range string. 

Example: “:TRIG:SCOPALL”. 

{} 

The braces mean that the parameter 

is optional. 

[:SOURce]:LIST:POWer 

<val>{,<val>} 

Example: LIST:POWer5 

Table 9.3 Command Grammar 

Character, Keyword and Grammar Examples 

Upper-case lettering indicates the minimum set of 

characters required to execute the command. 

[:SOURce]:FREQuency[:CW]?, FREQ is the short 

part of the command. 

The lowercase character part of the command is 

optional. This flexible format is known as “flexible 

listening”. For more information, refer to the “Command 

Parameter and Response” section. 

:FREQuency 

:FREQ, 

:FREQuency or FREQUENCY, both of which are 

correct. 

If a colon is applied between two command 

mnemonics, the current path in the command tree will be 

moved to next layer. Refer to “Command Tree” for more 

information on command paths. 

:TRIGger:OUTPut:POLarity? 

TRIGger is the keyword of the top layer of the 

command. 

Adjacent parameters in the command should be 

separated with commas. The parameters have no 

influence on the path layer and do not belong to the 

command path part. 

[:SOURce]:LIST:DWELl 

<val>{,<val>} 

The semicolon is used to separate two adjacent 

commands, with no influence on the current command 

path. 

 

:FREQ2.5GHZ;:POW10DBM 

The blank character, such as <space> or <tab>, is 

generally ignored when not used between or in keywords. 

 However, you must use the blank character to 

separate the command and parameter, with no influence 

on the current path. 

“:FREQuency” or “:POWer:LEVel6.2” is not 

allowed. 

“:LEVel” and “6.2” must be separated with the 

space. i.e. :POWer:LEVel6.2 

4) Command tree 

Special instrument commands are used in most of remote control programs. To analyze this 
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kind of command, the SCPI structure should be similar to the file system, known as the 

command tree, as shown in Fig. 9.2. 

 

Fig. 9.2 Schematic Diagram of Simplified Command Tree 

The top command is the root command, referred to as the “root”. Follow the specific path of 

the tree structure to next layer in command analysis. Example: :POWer:ALC:SOURce？ 

Where, “:POWer” refers to AA, “:ALC” refers to BB, and “:SOURce” refers to GG. The 

whole command path is (:AA:BB:GG). 

The command interpreter, a module of the instrument software, is dedicated to analysis of 

each received SCPI command. It is used to divide the command into separate command elements 

according to a series of rules to distinguish command tree paths. The current command should be 

kept unchanged after analysis, so as to analyze the subsequent command more rapidly and 

efficiently as the same command keyword may be used in various paths. The current command 

path should be set as the root after the instrument is started or reset (*RST). 

5) Command parameter and response 

SCPI defines different data formats for use in program and response messages. It does this to 

accommodate the principle of forgiving listening and precise talking. Refer to IEEE488.2 for 

more information. Forgiving listening means the command and parameter formats are flexible. 

Example: power level command of the vector network analyzer: 

SOURce<cnum>:POWer<port>[:LEVel][:IMMediate][:AMPLitude]<num>,[src] 

The following commands are used to set the power level: 

:SOURce:POWer:LEVel:IMMediate:AMPLitude-5, :SOURce:POWer-5, 

:SOUR:POW:LEV:IMM:AMP-5, :SOUR:POW-5. 

Various parameter types correspond to one or more response data type(s). The numeric type 

of the parameter will change into the data type in query. Response data are accurate, strictly 

referred to as “precise talking”. 

For example, if the setting is -5dBm in the power level (:SOURce:POWer?) query, the 

returned response data will be -5.00000000000e+000 no matter the setting command is 

“:SOUR:POW:LEV:IMM:AMP-5” or “:SOUR:POW-5”. 

Table 9.4 SCPI Command Parameters and Response Types 

Parameter type Response Data Types 

Numeric Real or integer 

Extended Numeric Integer 

Discrete Discrete 

Boolean Numeric Boolean 

String String 
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Piece 
Block with Definite Length 

Block of uncertain length 

Non-decimal Numeric 

Hexadecimal system 

Octal 

Binary system 

Numerical parameter 

Special instrument commands and general commands can be expressed as numeric 

parameters. All kinds of common decimal counting can be applied for reception of numeric 

parameters, including the plus or minus, decimal and scientific counting methods. If one 

device can only receive the specific numeric type, such as the integer, the received numeric 

parameter will be automatically rounded. 

The following are examples of numeric parameters: 

0 no decimal point required 

100 fractional digits optional 

1.23 leading signs allowed 

4.56e<space>3 space allowed after the E in exponential 

-7.89E-01 use either E or e in exponential 

+256 leading + allowed 

5 digits left of decimal point optional 

Extended Numeric Parameters 

The numeric parameter is extended to specify the physical quantity in the majority of 

measurements related to special instrument commands. Extended numeric parameters accept 

all numeric parameter values and other special values as well. The extended numeric 

parameters include the MAXimum and MINimum. Other special values, such as UP and 

DOWN, are received depending on the analysis capability of the instrument. All effective 

parameters are listed in the SCPI command table. 

Note: The extended numeric parameters are not applicable to general commands or STATus 

subsystem commands. The following are examples of extended numeric parameters: 

101 Numerical parameter 

1.2GHzGHz can be used as the index (E009). 

200MHzMHz can be used as the index (E006). 

-100mV negative 100 millivolts 

10 degrees 10 degree 

MAXimum sets parameter to largest possible value 

MINimum sets parameter to smallest possible value 

UP a stepper up 

DOWN a stepper down 

Discrete Parameters 

Discrete parameters are used to identify a limited number of parameters to be set. Discrete 

parameters use mnemonics to represent each valid setting. Similar to the programmed 

command mnemonics, discrete parameter mnemonics are divided into long type, short type 

and uppercase/lowercase mixed type. 

Discrete parameters and commands are used together in the following examples. 
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:TRIGger[:SEQuence]:SOURceBUS|IMMediate|EXTernal 

MANual Manual triggering 

IMMediate immediate triggering 

EXTernal external triggering 

Boolean Parameters 

The Boolean parameter represents one true or false binary condition, and only four possible 

values can be applied. 

The following are examples of Boolean parameters: 

ON boolean true 

OFF boolean false 

1 boolean true 

0 boolean false 

String Parameters 

For the character string type, the ASCII character string is allowed to be transmitted as the 

parameter. Single and double quotes are used as delimiters. The following are examples of 

string parameters: 

“This is Valid” “This is also Valid” “SO IS THIS” 

Real Response Data 

Most of test data are of real type, in the basic decimal or scientific counting format. Both 

formats are supported by most of advanced program languages. 

The following are examples of real response data: 

1.23E+0 

-1.0E+2 

+1.0E+2 

0.5E+0 

0.23 

-100.0 

+100.0 

0.5 

Integer Response Data 

Integer response data are decimal representations of integer values including signs. For state 

register query, integer response data will be returned in most cases. 

Examples of integer response data: 

0 Signs are optional 

+100 leading + allowed 

-100 leading + allowed 

256 not any decimal point 

Discrete Response Data 
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Discrete response data are essentially similar to discrete parameters. The major difference is 

that only the discrete response data in the short uppercase format are returned. 

Example of discrete response data: 

MLINear Display format is linear amplitude 

MLOGarithmic Display format is logarithm amplitude 

PHASe Display format is phase 

 

Numeric Boolean Response Data 

Boolean response data returns a binary numeric value of 1 or 0. 

String Response Data 

String response data are similar to string parameters. The main difference is that the double 

quotation marks instead of single quotation marks must be used as the separator of the string 

response data. Double quotation marks are allowed to be embedded in the string response 

data, with no character. Some examples of string response data are shown below. 

“This is a string” 

“one double quote inside brackets: (“”)” 

6) System of numeric value of command 

The command value can be entered in the binary, decimal, hexadecimal or octal format. An 

appropriate identifier should be applied in front of the value in the binary, hexadecimal or 

octal format. The identifier is not required in the decimal format (default). The entered value 

with no identifier will be saved in the decimal format. The following list shows the identifiers 

for the formats that require them: 

 #B means that the figure is a binary value. 

 #H means that the figure is a hexadecimal value. 

 #Q means that the figure is an octal value. 

The following are examples of SCPI command values and identifiers for the decimal value 

45: 

#B101101 

#H2D 

#Q55 

In the following example, the hexadecimal value 000A is used to set the RF output power as 

10dBm (or equivalent to the value in the selected unit, such as DBUV or DBUVEMF). 

:POW#H000A 

In the non-decimal format, the measurement unit such as DBM or mV is not used together 

with the value. 

7) Command line structure 

One command line may include multiple SCPI commands. The following methods can be 

applied to end the current command line: 

 Enter; 

 Enter key and EOI; 
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 EOI and the last byte. 

Commands in the command line are separated by semicolons. Commands of different 

subsystems begin with the colon. For example: 

MMEM:COPY"Test1","MeasurementXY";:HCOP:ITEM ALL 

This command line includes two commands, the first of which is the MMEM subsystem 

command and the second of which is the HCOP subsystem command. If adjacent commands 

belong to the same subsystem and the command paths are subject to partial overlapping, the 

commands can be abbreviated. For example: 

HCOP:ITEM ALL;:HCOP:IMM 

This command line includes tow commands which belong to the same level of the HCOP 

subsystem. The second command is started at the level lower than the HCOP command, and 

the colon at the beginning of the command can be omitted. The command line can be 

abbreviated as follows: 

HCOP:ITEM ALL; IMM 

9.1.4 Command Sequence and Synchronization 

IEEE488.2 defines the difference of the overlapping command and continuous command. 

 The continuous command refers to the command sequence to be executed continuously. 

Generally, the velocity of command execution is high. 

 The overlapping command refers the command which is not executed automatically before 

execution of next command. The processing time of the overlapping command is generally 

long. The program is allowed to process other events synchronously. 

Even if one command line includes multiple setting commands, commands may not be 

executed according to the reception sequence. In order to execute each command according 

to a certain sequence, all the commands must be transmitted as a separate command line. 

Example: command line including setting and query commands. 

If one command line includes query commands, query results are unpredictable. The returned 

value will be fixed if the following command is entered: 

:FREQ:STAR 1 GHZ; SPAN 100;:FREQ:STAR? 

Returned value: 1000000000(1GHz) 

The returned value will not be fixed if the following command is entered: 

:FREQ:STAR1GHz;STAR?;SPAN1000000 

The returned result may be the current start frequency of the instrument before command 

sending, as the commands will be executed one by one by the host program after command 

messages are received. The returned result may be 1GHz in the case of execution after the 

commands are received by the host program. 

Prompt 

Setting commands and query commands are sent separately. 

General rules: setting commands and query commands should be sent in different program messages in order 

to ensure that the returned results of query commands are correct. 

9.1.4.1 Prevention of Overlapping Execution of Commands 
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In order to prevent overlapping execution of commands, multiple threads or commands can 

be applied, including *OPC, *OPC? or *WAI. The three commands cannot be executed until 

the hardware is set. The computer may be forced to wait for a certain period to synchronize 

certain events in the programming process. The above methods are described below. 

 Use multiple threads in the control program. 

Multiple threads are used to complete waiting commands and synchronize the user interface 

and program, that is, the command “*OPC?” is executed in each single thread, with no 

blockage of GUI or program threads. 

 The use of three commands in synchronous execution is shown in the following table. 

Table 9.5 Command Grammar 

Me

thod 
Execution Action Programming Method 

*O

PC 

After command execution, set the 

operation completion bit in the ESR register. 

Set ESEBIT0; 

Set SREBIT5; 

Send the overlapping command and *OPC; 

Wait for the service request signal (SRQ). 

The service request signal means that the 

overlapping command has been executed. 

*O

PC? 

Stop executing the current command 

and return to 1. Only when the operation 

completion bit in the ESR register is set, the 

command will be returned, indicating that the 

previous command has been processed. 

End the current command processing before 

executing other commands. Directly send the command 

after processing of the current command. 

*W

AI 

Before executing *WAI, wait for 

sending of all commands. Then process the 

uncompleted commands. 

End the current command processing before 

executing other commands. Directly send the command 

after processing of the current command. 

9.1.5 State Report System 

The state report system is used to save all operation state information and error information 

of the current instrument. The operation state information and error information are 

respectively saved in the state register and error queue and can be inquired through the 

programmed interface. 

9.1.5.1 Structure of State Register Organization 

Register categories are as follows: 

1) STB and SRE 

The top register of the state report system is composed of the state byte (STB) and associated 

shielding register, i.e. service request enabling register (SRE). STB is used to collect the 

information of registers of the lower layers and save the general working conditions of the 

instrument. 

2) ESR and SCPI state register 

STB is used to receive the following register information: 

a) Relevant values of event state registers and event state enabling (ESE) shielding registers. 

b) SCPI state registers, such as STATus:OPERation and STATus:QUEStionable registers 

(defined by the SCPI standard), including specific operations of the instrument. All the SCPI state 

registers have the same internal structure (refer to “2.1.5.2 Structure of SCPI State Register” of the 

program control manual). 
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3) IST and PPE 

The separate bit of SRQ and IST sign (“IndividualSTatus”) is composed of the combination 

of all states of the instrument. The STB data bit for the IST sign depends on the associated 

Parallel Poll Enable (PPE) Register. 

4) Output buffer zone 

The output buffer zone is used to save messages returned by the instrument to the controller. 

It does not belong to the state report system, but is decisive to the MAV bit of STB. For details of 

the above registers, refer to “2.1.5 State Report System” of the program control manual. Refer to 

Fig. 9.3 for the hierarchical structure of the state register. 

 

Fig. 9.3 Hierarchical Structure of State Register 

Prompt 

SRE and ESE 

The Service Request Enable (SRE) register is used as the enabling part of STB. Similarly, ESE can be used as 

the enabling part of ESR. 

9.1.5.2 Application of State Report System 

The state report system is used to monitor the state of one or more instrument(s) in the test 
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system. In order to properly realize the functions of the state report system, the controller in 

the test system must receive and evaluate the information of all instruments. Standard 

methods to be applied include: 

1) Service request (SRQ) sent by the instrument. 

2) Series query sent by the controlled to all instruments in the bus system, aiming to find the 

sender and causes of service request. 

3) Parallel query of all instruments. 

4) Query of specific instrument states with programmed commands. 

For specific operations, refer to “2.1.5.4 Application State Report System” of the program 

control manual. 

9.1.6 Programming Precautions 

1) Initialize the instrument state before changing the setting. 

For instrument setting of remote control, initialize the instrument state (sending “*RST”, etc.) 

and then set the required state. 

2) Command sequence 

Generally, the setting command and query command should be transmitted separately. 

Otherwise, the returned value of the query command will change according to the current 

instrument operation sequence. 

3) Fault response 

The service request must be sent by the instrument. The controller of the test system should 

be programmed to guide the instrument to actively send the service request if required, so as 

to enable the corresponding service interruption program. 

4) Error queue 

The error queue instead of the state register should be inquired once the service request is 

processed by the controller program, so as to find more accurate causes. The queue should be 

always inquired in the controller program test phase to obtain the commands sent by the 

controller to the instrument. 

9.2 Programmed Port and Configuration of Instrument 

● LAN ························································································································································ 309 

● GPIB ························································································································································ 311 

9.2.1 LAN 

The programmed LAN (Local Area Network) system is configured with SICL-LAN to 

control 3672 series vector network analyzer. 

Attention 

Use of USB master control port connector of the front panel: 

The Type-A connector of the front panel is a USB master control port connector. In the 3672 series vector 

network analyzer, this port is connected to the flash disc with USB1.1 interface to upgrade the software in the 

instrument. It can also be connected to the USB keyboard and mouse to control the vector network analyzer. It 

must not be used for program control of the instrument. 

file:///C:/Users/guozhenxing/Desktop/3672%20Series%20Vector%20Network%20Analyzer%20User%20Manual.docx%23_9.2.1_LAN
file:///C:/Users/guozhenxing/Desktop/3672%20Series%20Vector%20Network%20Analyzer%20User%20Manual.docx%23_9.2.1_LAN
file:///C:/Users/guozhenxing/Desktop/3672%20Series%20Vector%20Network%20Analyzer%20User%20Manual.docx%23_9.2.2_GPIB
file:///C:/Users/guozhenxing/Desktop/3672%20Series%20Vector%20Network%20Analyzer%20User%20Manual.docx%23_9.2.2_GPIB
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9.2.1.1 Establish Connection 

Connect the 3672 series vector network analyzer and external controller (computer) to LAN 

through network cables, as shown in Fig. 9.4. 

IP 地址

IP 地址

LAN

 

Fig. 9.4 Connection Diagram of LAN Interface 

 

Fig. 9.5 LAN Interface of Rear Panel of Instrument 

9.2.1.2 Interface Configuration 

Ensure that the physical connection is smooth for remote control of the vector network 

analyzer by LAN. As the DHCP, domain name access and WAN are not supported, the 

network programming of the vector network analyzer is relatively simple. In the menu shown 

in Fig. 9.6, set the “IP address”, “Subnet mask” and “Default gateway” to be within the 

subnet with the master controller. 

 



9 Remote control 

9.2 Programmed Port and Configuration of Instrument 

      311 

 

Fig. 9.6 LAN Interface Setting 

Attention 

Ensure normal physical connection of the vector network analyzer through the 10Base-TLAN or 

100Base-TLAN cable. 

The vector network analyzer only supports the establishment of one LAN control system and static IP address 

setting, and does not support DHCP or access to the host through the DNS and domain name server. Therefore, it is 

not required to modify the subnet mask. The subnet mask of the instrument should be set as the fixed value 

255.255.255.0. 

9.2.2 GPIB 

9.2.2.1 Establish Connection 

Connect the 3672 series vector network analyzer to the external controller (computer) 

through the GPIB cable, as shown in Fig. 9.7. 

GPIB

GPIB 地址

 

Fig. 9.7 Connection Diagram of GPIB Interface 

 

Fig. 9.8 GPIB Interface of Rear Panel of Instrument 

9.2.2.2 Interface Configuration 

When the system is built with the vector network analyzer, the user may need to modify the 

GPIB address. The default local GPIB address is 16. Change the GPIB address as follows: 

Press [System] > [Configuration] > [GPIB address (G)...] to enter the interface shown in Fig. 

9.9. Modify the GPIB address in the [Local GPIB address] input box through the keyboard 

and mouse or number keys of the front panel. 
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Fig. 9.9 GPIB Interface Setting 

 

9.3 Basic Programming Method of VISA Interface 

The following example shows the basic method of instrument programming with the VISA 

library. Take the C++ language as the example. 

● VISA library ············································································································································ 312 

● Initialization and default state setting ········································································································ 313 

● Sending of setting command ····················································································································· 315 

● Reading of measurement instrument state ································································································· 317 

● Reading of frequency marker ···················································································································· 318 

● Reading of trace data ································································································································ 318 

● Command synchronization ······················································································································· 319 

9.3.1 VISA Library 

VISA is a general term of the standard I/O function library and related standards. The VISA 

library is a set of functions which can be easily recalled. The core function can be used to 

control various kinds of devices, regardless of the interface type and I/O interface software 

operations. The function library is used to write the instrument drive program and complete 

command and data transmission between the computer and instrument to realize the 

programmed control of the instrument. The instrument connection with the 

program-controlled port (LAN, USB, GPIB, RS-232, etc.) can be established by initializing 

the address character string (“VISA resource string”). 

The VISA library must be installed at first for remote control. The VISA library includes the 

transmission functions of the bottom VXI, GPIB, LAN and USB interface to facilitate direct 

recalling. The vector network analyzer supports the following programmed interfaces: GPIB, 

LAN and RS-232. Such interfaces are used with the VISA library and programming 

languages to remotely control the vector network analyzer. At present, AgilentI/OLibrary 

provided by Agilent is commonly used as the bottom I/O library. 

Fig. 9.10 shows the relationship between the programmed interface, VISA library, 

programming language and vector network analyzer, with GPIB interface as an example. 

file:///C:/Users/guozhenxing/Desktop/3672%20Series%20Vector%20Network%20Analyzer%20User%20Manual.docx%23_9.3.1_VISA_Library
file:///C:/Users/guozhenxing/Desktop/3672%20Series%20Vector%20Network%20Analyzer%20User%20Manual.docx%23_9.3.1_VISA_Library
file:///C:/Users/guozhenxing/Desktop/3672%20Series%20Vector%20Network%20Analyzer%20User%20Manual.docx%23_9.3.2_Initialization_and
file:///C:/Users/guozhenxing/Desktop/3672%20Series%20Vector%20Network%20Analyzer%20User%20Manual.docx%23_9.3.2_Initialization_and
file:///C:/Users/guozhenxing/Desktop/3672%20Series%20Vector%20Network%20Analyzer%20User%20Manual.docx%23_9.3.3_Sending_of
file:///C:/Users/guozhenxing/Desktop/3672%20Series%20Vector%20Network%20Analyzer%20User%20Manual.docx%23_9.3.3_Sending_of
file:///C:/Users/guozhenxing/Desktop/3672%20Series%20Vector%20Network%20Analyzer%20User%20Manual.docx%23_9.3.4_Reading_of
file:///C:/Users/guozhenxing/Desktop/3672%20Series%20Vector%20Network%20Analyzer%20User%20Manual.docx%23_9.3.4_Reading_of
file:///C:/Users/guozhenxing/Desktop/3672%20Series%20Vector%20Network%20Analyzer%20User%20Manual.docx%23_9.3.5_Reading_of
file:///C:/Users/guozhenxing/Desktop/3672%20Series%20Vector%20Network%20Analyzer%20User%20Manual.docx%23_9.3.5_Reading_of
file:///C:/Users/guozhenxing/Desktop/3672%20Series%20Vector%20Network%20Analyzer%20User%20Manual.docx%23_9.3.6_Reading_of
file:///C:/Users/guozhenxing/Desktop/3672%20Series%20Vector%20Network%20Analyzer%20User%20Manual.docx%23_9.3.6_Reading_of
file:///C:/Users/guozhenxing/Desktop/3672%20Series%20Vector%20Network%20Analyzer%20User%20Manual.docx%23_9.3.7_Command_Synchronization
file:///C:/Users/guozhenxing/Desktop/3672%20Series%20Vector%20Network%20Analyzer%20User%20Manual.docx%23_9.3.7_Command_Synchronization
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Fig. 9.10 Programming Software and Hardware Layer 

9.3.2 Initialization and Default State Setting 

Initialize the VISA resource manager at the beginning of programming. Open the VISA 

library and establish the communication connection between the VISA library and instrument. 

Specific steps are as follows. 

9.3.2.1 Generation of Global Variables 

At first, generate global variables to be recalled by other program modules, such as 

instrument handle variables. The following global variables are included in the program 

example. 

ViSession analyzer; 

ViSessiondefaultRM; 

Const char analyzerString [VI_FIND_BUFLEN] = "GPIB0::16::INSTR"; 

ConstanalyzerTimeout = 10000; 

The constant analyzerString refers to the instrument descriptor, “GPIB0” refers to the 

controller, and “16” refers to the instrument connected to the controller. Assuming that the 

instrument is connected LAN, the IP address is “192.168.1.1” and the port number is “1024”, 

the variable is: 

Const char analyzerString [VI_FIND_BUFLEN] = 

“TCPIPO::192.168.1.1::1024::SOCKET”; 

9.3.2.2 Controller Initialization 

The following example shows how to establish the communication connection between the 

VISA library and instrument (with the specified descriptor). 

//Controller initialization: open the default resource manager and return the instrument handle 

to the analyzer. 

voidInitController() 
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{ 

ViState state; 

state = viOpenDefaultRM(&defaultRM); 

state = viOpen(defaultRM, analyzerString, VI_NULL, VI_NULL, &analyzer); 

} 

9.3.2.3 Instrument Initialization 

/*************************************************************************/ 

The following example shows the initialization of the default instrument state and clearing of 

the state register. “\n” refers to the terminator. The character string of each command should 

be ended with ‘\n’. This will not be described later. 

/*************************************************************************/ 

voidInitDevice() 

{ 

ViState state; 

longretCnt; 

state = viWrite(analyzer, "*CLS\n", 5, &retCnt); //reset state register 

state = viWrite(analyzer, "*RST\n", 5, &retCnt); //reset instrument 

} 

9.3.2.4 Query of Instrument Measurement Information 

/*************************************************************************/ 

The following example shows all measurements, windows and traces defined at present. 

/*************************************************************************/ 

voidQueryMesaurement() 

{ 

ViState state; 

longretCnt; 

charrd_Buf_CW[VI_READ_BUFLEN]; // #define VI_READ_BUFLEN 20 

charrd_Buf_LVL[VI_READ_BUFLEN]; 

// query all measurements of Channel 1 

state = viWrite(analyzer, ": CALC:PAR:CAT?\n", 15, &retCnt); 

Sleep(10); 

state = viRead(analyzer, rd_Buf_CW, 50, &retCnt); 

// query all windows 

state = viWrite(analyzer, ": DISP:CAT?\n", 11, &retCnt); 

Sleep(10); 
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state = viRead(analyzer, rd_Buf_CW, 20, &retCnt); 

// query all traces of Window 1 

state = viWrite(analyzer, ": DISP:WIND1:CAT?\n", 18, &retCnt); 

Sleep(10); 

state = viRead(analyzer, rd_Buf_CW, 20, &retCnt); 

} 

9.3.3 Sending of Setting Command 

9.3.3.1 Setting of Sweep Parameters 

/*************************************************************************/ 

The following example shows how to set the sweep parameters of 3672 series vector network 

analyzers. 

/*************************************************************************/ 

voidSweepSettings() 

{ 

ViState state; 

longretCnt; 

// selection of measurement 

state = viWrite(analyzer, ":CALC:PAR:SEL „CH1_WIN1_LINE1‟ \n", 50,&retCnt); 

 

// set the sweep type as linear sweep 

state = viWrite(analyzer, ":SENSe1:SWEep:TYPE LIN\n", 30, &retCnt); 

 

// set the intermediate frequency bandwidth as 3KHz 

state = viWrite(analyzer, " :SENSe1:BANDwidth 3000\n", 30, &retCnt); 

 

// set the start frequency as 1GHz and stop frequency as 10GHz 

state = viWrite(analyzer, ":SENS:FREQ:STAR 1e9\n", 30, &retCnt); 

state = viWrite(analyzer, ":SENS:FREQ:STOP 1e10\n", 30, &retCnt); 

 

// set the number of sweep points as 401 

state = viWrite(analyzer, ":SENSe1:SWEep:POINts 401\n", 30, &retCnt); 

// automatic setting of sweep time 

state = viWrite(analyzer, ":SENSe1:SWEep:TIME:AUTO ON\n", 40, &retCnt); 

 

// set the output power as -10dBm 
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state = viWrite(analyzer, ":SOUR:POW -10dBm\n", 22, &retCnt); 

} 

9.3.3.2 Setting of Display Parameters 

/*************************************************************************/ 

The following example mainly includes: 

Setting of data format; 

Display of trace, title and frequency notes; 

Automatic scaling of trace; 

Query of scale, reference level and reference position; 

Opening and setting of averaging; 

Opening and setting of smoothing. 

/*************************************************************************/ 

voidDisplaySettings() 

{ 

ViState state; 

longretCnt; 

charrd_Buf_Data[VI_READ_BUFLEN]; // #define VI_READ_BUFLEN 20 

 

// selection of measurement 

state = viWrite(analyzer, ":CALC:PAR:SEL „CH1_WIN1_LINE1‟ \n", 50,&retCnt); 

 

// set the data format as logarithmic amplitude format 

state = viWrite(analyzer, ":CALCulate1:FORMat MLOG\n", 30, &retCnt); 

 

// display the trace, title and frequency notes 

state = viWrite(analyzer, ":Display:WINDow1:TRACe1:STATe ON\n", 40, &retCnt); 

state = viWrite(analyzer, ":DISPlay:WINDow1:TITLe:STATe ON\n", 40, &retCnt); 

state = viWrite(analyzer, ":DISPlay:ANNotation:FREQuency ON\n", 40, &retCnt); 

 

// automatic scaling of trace 

state = viWrite(analyzer, ":Display:WINDow1:TRACe1:Y:Scale:AUTO\n", 50, &retCnt); 

 

// query the scale, reference level and reference position 

state = viWrite(analyzer, ": DISPlay:WINDow1:TRACe1:Y:SCALe:PDIVision?"\n", 60, 

&retCnt); 
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Sleep(10); 

state = viRead(analyzer, rd_Buf_Data L, 20, &retCnt); 

state = viWrite(analyzer, ":DISPlay:WINDow1:TRACe1:Y:SCALe:RLEVel?\n", 60, 

&retCnt); 

Sleep(10); 

state = viRead(analyzer, rd_Buf_Data, 20, &retCnt); 

state = viWrite(analyzer, ": DISPlay:WINDow1:TRACe1:Y:SCALe:RPOSition?\n", 60, 

&retCnt); 

Sleep(10); 

state = viRead(analyzer, rd_Buf_Data, 20, &retCnt); 

 

// open the averaging function and set the average factor as 5 

state = viWrite(analyzer, ": SENSe1:AVERage:STATe ON\n", 30, &retCnt); 

state = viWrite(analyzer, ": SENSe1:AVERage:Count 5\n", 30, &retCnt); 

 

// open the smoothing function and set the smoothing aperture as 20% 

state = viWrite(analyzer, ": CALCulate1:SMOothing:STATe ON\n", 40, &retCnt); 

 

state = viWrite(analyzer, " CALCulate1:SMOothing:APERture 20\n", 40, &retCnt); 

} 

9.3.4 Reading of Measurement Instrument State 

The following example shows how to read the setting state of the instrument. 

voidReadSettings() 

{ 

ViState state; 

longretCnt; 

charrd_Buf_CW[VI_READ_BUFLEN]; // #define VI_READ_BUFLEN 20 

charrd_Buf_LVL[VI_READ_BUFLEN]; 

 

// Querys the CW frequency 

state = viWrite(analyzer, "FREQ:CENT?", 10, &retCnt); 

Sleep(10); 

state = viRead(analyzer, rd_Buf_CW, 20, &retCnt); 

// query the amplitude 

state = viWrite(analyzer, "POW:ALC:LEV?", 12, &retCnt); 
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Sleep(10); 

state = viRead(analyzer, rd_Buf_LVL, 20, &retCnt); 

// print the commissioning information 

sprint("Cw is %s", rd_Buf_CW); 

sprint("LEVel is %s", rd_Buf_ LVL); 

} 

9.3.5 Reading of Frequency Marker 

/*************************************************************************/ 

The following example shows how to read the frequency scale information. 

/*************************************************************************/ 

voidReadMarker () 

{ 

ViState state; 

longretCnt; 

charrd_Buf_Marker[VI_READ_BUFLEN]; // #define VI_READ_BUFLEN 20 

 

// open the frequency marker 1 and query the frequency marker peak (frequency and 

amplitude) 

state = viWrite(analyzer, ":CALC:MARKER ON;MARKER:  

FUNCtion:EXECuteMAXimum\n", 25, &retCnt); 

// read the X-axis information 

state = viWrite(analyzer, ":CALC:MARK:X?; ", 15, &retCnt); 

state = viRead(analyzer, rd_Buf_Marker, 30, &retCnt); 

// read the Y-axis coordinate information 

state = viWrite(analyzer, ":CALC:MARK:Y?; ", 15, &retCnt); 

state = viRead(analyzer, rd_Buf_Marker, 30, &retCnt); 

} 

9.3.6 Reading of Trace data 

/*************************************************************************/ 

The following example shows how to read the trace data of the vector network analyzer. 

/*************************************************************************/ 

voidQueryData () 

{ 

ViState state; 

longretCnt = 0; 
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int points= 0 

// #define VI_READ_BUFLEN 1000000 

charrd_Buf_BigData[VI_READ_DATABUFLEN]; 

charrd_Buf_Data[VI_READ_BUFLEN]; // #define VI_READ_BUFLEN 20 

 

// selection of measurement 

state = viWrite(analyzer, ":CALCulate:PARameter:SELect ' CH1_WIN1_LINE1'\n", 25, 

&retCnt); 

// obtain the number of sweep point 

state = viRead(analyzer, rd_Buf_Data, 30, &retCnt); 

9.3.7 Command Synchronization 

The method of command synchronization is introduced below, taking the sweep process as an 

example. 

voidSweepSync() 

{ 

ViState state; 

longretCnt; 

ViEventTypeetype; 

ViEventeevent; 

int stat; 

charOpcOk [2]; 

/*********************************************************************/ 

/* Command INITiate[:IMMediate] start single sweep ( closed in continuous 

sweepINIT:CONT OFF)*/ 

/* Execute next command of command buffer zone after single sweep */ 

/*********************************************************************/ 

state = viWrite(analyzer, "INIT:CONT OFF", 13, &retCnt); 

// Method 1 of waiting for stop of sweep: use *WAI 

state = viWrite(analyzer, "ABOR;INIT:IMM;*WAI", 18, &retCnt); 

 

// Method 2 of waiting for stop of sweep: use *OPC？ 

state = viWrite(analyzer, "ABOR;INIT:IMM; *OPC?", 20, &retCnt); 

state = viRead(analyzer, OpcOk, 2, &retCnt); //Wait for*OPC and return to “1” 

 

// Method 3 of waiting for stop of sweep: use *OPC 
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// To enable GPIB service request, set "Disable Auto Serial Poll" as "yes" 

state = viWrite(analyzer, "*SRE 32", 7, &retCnt); 

state = viWrite(analyzer, "*ESE 1", 6, &retCnt); // enable service request ESR 

// set event enabling bit to complete operation 

state = viEnableEvent(analyzer, VI_EVENT_SERVICE_REQ, VI_QUEUE, VI_NULL); 

// enable SRQ event 

state = viWrite(analyzer, "ABOR;INIT:IMM;*OPC", 18, &retCnt); 

// start sweep synchronously with OPC 

state = viWaitOnEvent(analyzer, VI_EVENT_SERVICE_REQ, 10000, &etype, &eevent) 

// wait for service request 

state = viReadSTB(analyzer, &stat); 

state = viClose(eevent); // close event handle 

// prohibit SRQ event 

state = viDisableEvent(analyzer, VI_EVENT_SERVICE_REQ, VI_QUEUE); 

// main program continues…… 

} 

9.4 I/O Library 

9.4.1 Overview of I/O Library 

The I/O library is a library of pre-written software programs for the instrument, known as the 

instrument drive program, i.e. instrument driver. It is an intermediate software layer between 

the computer and instrument hardware equipment. It is composed of the function library, 

utility program, tool kit, etc., and is a set of software code modules. This set corresponds to a 

series of planned operations, such as instrument configuration, reading, writing, triggering, 

etc. It is installed the computer and used as a connecting bridge and link between the 

computer and instrument. With the easy-to-program high-level modular library, the user does 

not need to the complex special low-level programming protocol for the specific instrument. 

It is key to use the instrument driver to rapidly develop the test measurement application. 

From the functional perspective, one general instrument driver is composed of five parts: 

functional body, interactive developer interface, program developer interface, subprogram 

interface and I/O interface, as shown in Fig. 9.14. 
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Fig. 9.11 Instrument Driver Structure Model 

Details are as follows: 

1) Functional body. This is the main functional part of the instrument driver and can be 

understood as the framework program of the instrument driver. 

2) Interactive developer interface. To facilitate use, the graphical interactive developer 

interface is generally set in the application environment supporting instrument driver 

development. For example, the function panel of Labwindows/CVI is a kind of interactive 

development interface. Each parameter of the instrument driver function in the function panel 

is expressed in the graphical control form. 

3) Programming developer interface. This is a software interface for the application program 

to recall the instrument driver function, such as the dynamic link library file of instrument 

driver.dll in the Windows system. 

4) I/O interface. It is used for actual communication between the instrument driver and 

instrument. It is allowed to use the special bus I/O software, such as GPIB and RS-232, or the 

general standard I/O software (VISAI/O) to be used over multiple buses. 

5) Subprogram interface. It is a software interface for the instrument driver to visit other 

supporting libraries, such as the data library, FFT function, etc. It will be used when other 

software modules, operating systems, program code libraries and analysis function libraries 

are recalled by the instrument driver after completion of tasks. 

9.4.2 I/O Library Installation and Configuration 

With applications in the test field, the I/O library has experienced various development 

phases from the traditional instrument to virtual instrument. In order ensure the instrument 

interchangeability in the automatic test system and the reusability of the test program, the 

instrument drive program has also experienced various development phases. At present, the 

popular universal driver is an IVI (Interchangeable Virtual Instruments) instrument driver. 

Based on the IVI specification, the new instrument programming interface, inserted drive 

program and VPP architecture on VISA are defined, so that the test application program is 

fully independent of the instrument hardware. In addition, the unique functions of instrument 

simulation, range detection and state caching are added to improve the system operating 

efficiency and truly realize the instrument interchangeability. 

The IVI driver is divided into two types: IVI-C and IVI-COM. IVI-COM is based on the 

Microsoft component object model (COM) technology, in the COMAPI form, and IVI-C is 

based on ANSIC, in the CAPI form. The two types of drivers are designed in accordance with 

the instrument categories defined in the IVI specifications. The application development 

environments are the same, including Visual Studio, Visual Basic, Agilent VEE, LabVIEW, 
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CVI/LabWindows, etc. 

The IVI driver of the vector network analyzer supports IVI-C. For specific installation and 

configuration, refer to the accompany files of the selected control card and I/O library. 

The installed IVI driver is divided into the IVI inherent function group and instrument 

function group (basic function group and extended function group). For specific functional 

classification, functions and attribute details, refer to the help file of the driver. 

Prompt 

Port configuration and I/O library installation: 

Before controlling the vector network analyzer with a computer, check whether the necessary port and I/O 

library are properly installed and configured. 

 

Prompt 

Use of I/O library: 

If the accompanying IVI-COM/C drive program installation package is installed, the function panel, help file 

and drive function example programs will be installed automatically to facilitate development and integration 

of the programmed functions. 
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The 3671 series vector network analyzer has a variety of optional devices as well as complex measurement 

settings, which require a certain level of technical skills and practical experience. In order for you to 

quickly master the vector network analyzer measurement process, the following is an example of 

measuring attenuators to introduce the process of measuring common two-port devices and related settings. 

Preparation before measurement: one 3671 series vector network analyzer, one pair of 3.5mm test cables, 

one set of calibrated parts (31121), the DUT (attenuator), and adapters (if necessary). 

1.1 Power on and warm up for 30 minutes, reset the analyzer 

 

The reset here should be a system reset state to ensure that the analyzer settings are known. 

1.2 Setup the frequency and power 

For more information please see Section 4.3 Setting the Frequency Range and Section 4.4 Setting the 

Signal Power Level. 

Press the [Frequency] and [Power] button on the front panel, click the modification item in the auxiliary 

menu bar, then enter through the front panel input area to set the instrument. See figures below: 
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Setting frequency and power 

1) The default frequency range of the system is 100kHz ~ 14GHz/20GHz/26.5GHz/43.5GHz with power 

level -5dBm. 

2) The frequency range can be set according to the measurement needs, and the power level is the power 

value of the output port of the excitation source. In principle, as long as the power of the output port of the 

DUT does not exceed +10dBm, changing the power level does not affect the measurement. 

 

 

1.3 Choose measurement and new trace 

For more information please see Section 4.2 Selecting the Measurement Parameters. 

If you want to change the S-parameter of the current trace, right click on the title bar and select Measure. 

Check the S-parameters to be measured in the dialog and click OK. 

Right-click within this range 

to change the S-parameter of 

trace measurement，adjust 

the scale， delete the trace，
etc.

 

 

To add a measurement traces, right click in the blank area and select New trace. Select the S-parameter to 

be added and click OK. 

 

Tip 
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If [Create in New Window] 

is ticked, a new trace will be 

created in a new window.

 

1.4 Calibration 

For more information please see Section 7 Calibration. 

Press the [Calibration] button on the front panel and click [Calibration] in the auxiliary menu bar. 

 

Select [Guided Calibration(Smart 

Cal)] and click [Next].

 

 

Select [2-Port Cal] and click 

[Next].

 

 

Select the DUT connectors and 

Cal Kits and click [Next].

 

Connect the Cal Kits according to the 

animation and text, then click [Measure]. 

Automatically skip to next step after 

calibration. Finish step1-7.
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Click [Done] after all calibration 

steps have been finished.

 

 

 

1.5 Connect the DUT 

 

1.6 Adjust scale and analyze data 

For more information please see Section 4.7 Setting the data format and scale. 

If necessary, press the [Response] button on front panel and click the [Scale] on auxiliary menu to complete 

setup. 
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Press the [Cursor] button on front panel to open the cursor, and turn the adjustment knob to adjust the 

frequency corresponding to the cursor. The reading of the cursor is displayed in the upper right corner of 

the screen. 

 

                      

1.7 Record or save data 

For more information please see Section 3.6 Data output. 

Path of Menu: clicking [File] → [Save As], choosing the saving path and saving type and clicking save. 



Annexes 

Attachment 1 Examples of Typical Measurements 

328  

 

 

Description: 

1) Although the status file and calibration file can be called back by the main program, they cannot be 

edited and processed by other programs. 

2) Data files can be exported and printed, and can be edited and processed with other software, but they 

cannot be called back. 

3) Graphical files can be exported and printed, but they cannot be called back. The default file save path 

is C:\Program Files\41\Network Analyzer\MemoryDocuments, and users can set the save path according to 

their needs. 

 



Annexes 

Attachment 2 Time Domain Measurements 

      329 

 

Attachment 2 Time Domain Measurements 

 Principals of time domain measurements……………………………………………329 

 Range and resolution of time domain measurements………………………………331 

 Window filtering…………………………………………………………………………336 

 Time-gated filtering………………………………………………………………………338 

 Time domain measuring data…………………………………………………………342 

 Bandpass and low-pass time domain modes………………………………………347 

 Time domain transform measurement settings……………………………………350 

2.1 Principals of time domain measurements 

You can observe the response of the device in the time domain if a time domain optional device is available 

for the analyzer. 

In a normal measurement, the response of the DUT along with frequency displayed on the analyzer, called 

frequency domain measurement. In a time domain measurement, the time domain data is obtained by 

analyzer performing an inverse Fourier variation of the frequency domain data. The measurement results 

are displayed with time on the X-axis, and the response values appear at discrete time points, allowing 

analysis of the characteristics or limitations of the DUT. The figure below shows the frequency and time 

domain reflectance measurements for the same cable having two bends, each of which causes a 

transmission line mismatch or impedance change. 

 

Fig. 2.1 Frequency and time domain measurements 

1) The S11 frequency domain response measured at the input shows a combined reflection response due 

to interaction of cable mismatch waves, but it is difficult to determine the exact physical location where the 

cable mismatch occurs. 

2) The time domain response shows where and how large each mismatch occurs, and from the response 

we can see that a significant mismatch occurs at the second bend of the cable. 

In the time domain, the analyzer uses the gating function to filter out unwanted responses before 

transforming the time domain data to frequency domain data. With the help of this function, the response of 

a specific signal in the network can be measured, and the influence of external devices such as connectors 

or adapters can be excluded. 

The time domain measurement function simulates a conventional time domain reflectometer (TDR), where 

the TDR emits an impulse or step signal to the DUT, and then observes the reflected signal energy. By 

analyzing the magnitude, duration and waveform of the reflected signal, it is possible to determine the 

impedance variation of the DUT. The network analyzer does not actually generate incident impulse or step 

signals, but rather performs swept frequency measurements and then calculates time domain information 

from the frequency domain measurements via a Fourier algorithm. Until now, most of the typical network 
analyzers perform time-domain transform measurements by means of S11 ratio measurements. The S11 

reflectance measurement is not simply a display of the reflected signal measured through receiver A or B. It 
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presents the ratio measurement between the measurement receiver and the reference receiver. In addition, 

the S11 ratio measurement can be calibrated to remove systematic errors, which is especially important for 

time domain measurements, as the calibration establishes a measurement reference plane where the 

calibration point becomes the zero point of the X time axis, and all time and distance data are referenced to 

this point so that both time and magnitude data are very accurate due to the calibration. The analyzer 

measures the time domain through the following steps: 

1) Acquisition of raw receiver (A and R) data. 

2) Performing ratio operations. 

3) Performing calibration error correction. 

4) Transforming frequency domain data to the time domain. 

5) Display of measurement. 
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2.2 Range and resolution of time domain measurements 

This section discusses how to observe all valid time domain data of the DUT and how to set up to obtain 

the highest resolution and maximum measurement range. 

 R e s o l u t i o n  o f  r e s p o n s e … … … … … … … … … … … … … … … … … … … … … … … 3 3 1 

 D i s p l a y  r e s o l u t i o n … … … … … … … … … … … … … … … … … … … … … 3 3 3 

 Range of measurements……………………………………………………………………334 

2.2.1 Resolution of response 

 Concept of resolution of response…………………………………………………………331 

 Factors affecting the resolution of the time domain response…………………………331 

 Tips for optimizing resolution of response………………………………………………333 

2.2.1.1 Concept of resolution of response 

The time domain response resolution of the analyzer is the ability of the analyzer to distinguish between 

two neighboring responses, which, for responses of equal magnitude, is equal to the pulse width of the 

impulse response defined by a 50% (6 dB) magnitude point, or the rise time of the step response defined by 

10% to 90% magnitude points, as shown in the Fig. 2.2. 

 

Fig. 2.2 Resolution of the time domain response 

2.2.1.2 Factors affecting the resolution of the time domain response 

1) Frequency span 

Fig. 2.3 shows the effect of frequency span on the resolution of response: 

 

Fig. 2.3 Effect of frequency span on the resolution of response  
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a) The response measured at a narrow frequency span behaves as if the impulse response pulses which 

should be separated overlap each other. 

b) When measuring over a wide frequency span, the analyzer is able to distinguish between different 

response pulses. 

c) The frequency span is inversely proportional to the pulse width, that is, the wider the frequency span, 

the narrower the impulse response pulse and the shorter the rising edge time of the step response. 

2) Window width (β parameter) 

a) The resolution of response is also a function of the window width of the time domain transformation. 

b) An approximate response resolution can be calculated using the following equations, which are only 

applicable to equal magnitude response and calculating 50% pulse width or 10%-90% step-up time. 

 

The response of the DUT determines the selection of window width. If the response signals have equal 

levels, to improve the resolution of the measurement the minimum window is used, and if the response 

signals have unequal levels, the maximum window is used to improve the dynamic range of the 

measurement. 
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Calculating pulse width during time domain transform measurements 

During the time conversion measurement, it is not necessary to calculate the pulse width manually. In the 

time conversion dialog, the analyzer automatically calculates the pulse width based on the current settings. 

 

3) Time domain transformation mode 

The resolution of the measured response is different in the low-pass and band-pass conversion modes. For 

the same frequency span and number of sweep points, it has higher resolution in low-pass mode, and the 

pulse width can be reduced by half compared to the band-pass mode. Following figure compares the 

resolutions in the two modes. 

 

Fig. 2.4 Effect of mode transformation on the resolution 

 

2.2.1.3 Tips for optimizing resolution of response 

1) In most cases, the maximum frequency span is chosen to obtain the highest temporal resolution, and 

the frequency setting must conform to the operating frequency requirements of the DUT. 

2) The resolution is affected by the frequency span, window width and time domain mode. 

2.2.2 Display resolution 

Time domain display resolution refers to the ability to precisely locate a signal response in a time span. A 

good display resolution improves the positioning accuracy of the peak and zero points of the response, and 

the display resolution is influenced by the time span and the number of sweeping points: 

Display resolution = time span / (sweep points - 1) 

The display resolution can be adjusted in the following two ways. 

1) Reducing the time span 

2) Increasing the number of sweeping points 

  

Tip 
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3)  

 

 

Changing the number of measurement points may reduce the calibration accuracy. 

 

The measurements of the same DUT at different time spans are given in Fig. 2.5: 

1) A resolution of 50ps can be obtained with a time span of 10ns. 

2) A resolution of 12.5ps can be obtained with a time span of 2.5ns. 

 

Fig. 2.5 Display resolution 

 

 

 

1) Changing the time span does not affect the ability of the analyzer to distinguish between two signals 

closed to each other; 

2) Changing the number of sweep points in low-pass mode alters the frequency span and therefore affects 

the resolution of the response. 

2.2.3 Range of measurements 

In time domain measurements, the measurement range is defined as the maximum length of time that can 

be set, and no repeated response occurs when measurements are taken over this length of time. The 

measurement range is inversely related to the response resolution, that is, increasing one decreases the 

other. 

As shown in the Fig. 2.6, the time domain waveform is a periodic signal that repeats over time, and 

therefore a repetitive response occurs. The repetitive response (false response) is not the true response of 

the DUT, it only appears at a specific time span (1/sweep point frequency interval), so the measurement 

range is also determined by the frequency interval ΔF of the sweep point. 

Tip 

Tip 
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Fig. 2.6 Definition of sweep point frequency interval 

During the time domain measurements, the maximum termination time setup is: 1/∆F. The measurement 

range is proportional to the number of sweep points-1 and inversely proportional to the frequency span. To 

improve the measurement range, you can modify the following two settings: 

1) Increasing the number of sweeping points 

2) Reducing the frequency span. 

 

 

 

The above changes must be made prior to calibration. 

 

The measurement range in meters can be obtained by dividing the constant velocity of light by the 

frequency interval ΔF. In order to calculate the physical length of the actual measurement range, it will 

multiply the relative velocity of light in the transmission medium which are given as follows: 

1) VPolyethylene=0.66 

2) VPolytetrafluoroethylene=0.66 

Physical length of the actual measurement range = 

8103
F

V

△ m/s 

  

Note 
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2.3 Window filtering 

The time domain transform has some limitations in time resolution due to the effect of side lobes and pulse 

width, and these effects can be mitigated by using the window filtering function. The analyzer provides a 

window function in the time domain transformation to distinguish the various responses more effectively. It 

can vary the width of the response pulse, the side lobe level and the rising time of the step response. 

 W i n d o w  f i l t e r i n g … … … … … … … … … … … … … … … … … … … … … … … … 3 3 6 

 S e t t i n g  t h e  w i n d o w  v a l u e  c o r r e c t l y … … … … … … … … … … … … … … … 3 3 7 

 Window character is t ics ………………………………………………………………… 337 

2.3.1 Window filtering 

2.3.1 Concept of window filtering 

Frequency domain measurements have abrupt changes at the start and end frequencies, which can cause 

overshoot and ringing in the time domain step response. Windowing filters can reduce the effects of 

frequency domain abrupt changes, however, it has the following shortcomings in the network analyzer: 

1) Pulse width of the impulse response or rising time of the step response: This is caused by the 

band-limiting characteristics of the system itself, and it will limit the ability of the analyzer to distinguish 

between two response signals adjacent to each other. The pulse width is inversely proportional to the 

measured frequency span, therefore you need to increase the frequency span to reduce the pulse width. 

2) Impulse response side lobe: This is caused by abrupt changes at the termination frequency. Side lobe 

adjacent to the high level response hide the low level response signal, limiting the dynamic range of the 

time domain measurements. Side lobes can be suppressed using window filtering, as shown in the Fig. 2.7: 

 

Fig. 2.7 Suppressing side lobe using window filtering 

2.3.1.2 Benefits of using window filtering 

1) Using a narrow window reduces the width of the impulse response pulse and improves the response 

resolution, allowing better discrimination between the two neighboring responses. 

2) Using a wide window reduces the side lobe level of the impulse response and improves the dynamic 

range, allowing better measurement of low level response. 

2.3.1.3 Effect of window filtering 
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Fig. 2.8 Effect of window on response signal 

As shown in Fig. 2.8, the analyzer has the following effects on the time domain measurement response of 

the DUT by window filtering the frequency domain measurement data. 

1) In impulse transformation mode, it affects the side lobe level and pulse width and changes the 

measurement resolution. 

2) In the low-pass step conversion mode, it reduces occurrence of overshoot and ringing. 

2.3.2 Setting the window value correctly 

As shown in the Fig. 2.9, the appropriate window value must be selected according to the type of response 

of the DUT: 

1) DUT having equal magnitude response: choosing a narrow window to obtain a narrow pulse width 

and therefore improves the resolution of the time domain measurement. 

2) DUT having unequal magnitude responses: choosing a wide window to obtain a low side lobe level 

and therefore improves the dynamic range of the time domain measurements. 

 

Fig. 2.9 Setting the window value correctly 

2.3.3 Window characteristics 

In the time domain measurements, the side lobe level is related to the chosen window, while the response 

resolution is related to the frequency span and the chosen window. Table 2.1 gives the window 

characteristics at a 2.997GHz frequency span. 

Table 2.1 Window characteristics in a 2.997GHz frequency span 

Transformation 

mode 
Window 

Resolution of response 

Side lobe level 
Rising time of 

step 
Pulse width 
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Table 2.2 Time domain waveforms of short-circuit breaker reflection measurements applied with a window 

 

2.4 Time-gated filtering 

In the time gating function, a response in the time domain can be selected or removed, and the analyzer can 

then transform the processed time domain data back to the frequency domain for observation. That is, after 

time-gate filtering of the time domain data, the time domain transform function can be disabled and the 

frequency domain response of the DUT can be observed with the time gate function in effect. For example, 

during the transmission measurements, the effect of multipath transmission can be mitigated by using a 

time gate, or by observing an individual time domain response signal and thereby analyzing the effect of 

each individual response on the measurement results in the frequency domain. 

 How to use gating function……………………………………………………………………338 

 Gate setup…………………………………………………………………………………………339 

 Types of gate…………………………………………………………………………………339 

2.4.1 How to use gating function 

During the measurement, perform following steps when using the time gating function: 

1) Perform measurements in the frequency domain on the DUT. 

2) Enable the time domain transformation function, and the analyzer will calculate the time domain 

response of the DUT. 

3) How to choose the gate shape: 

Lowpass@Step 

Min 150ps  -21dBc 

Normal 330ps  -60dBc 

Max 494ps  <-70dBc 

Low-pass 

impulse 

Min  200ps -13dBc 

Normal  320ps -44dBc 

Max  481ps <-75dBc 

Low-pass 

impulse 

Min  400ps -13dBc 

Normal  641ps -44dBc 

Max  941ps <-75dBc 
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a) Band Pass: Place the gate in the center of the response you want to keep, enable the gating function, 

and the responses outside the gate will be removed from the displayed measurements by mathematical 

operations. 

b) Band Stop: Place the gate in the center of the response you want to remove,enable the gating function, 

and the responses inside the gate will be removed from the displayed measurements by mathematical 

operations. 

4) Disable the time domain transformation function and figure out the effect of the removed response on 

the measurement results by observing the frequency domain response of the DUT. 

Fig. 2.10 shows a measurement application with a bandpass time gate. 

 

 

Fig. 2.10 Measurement application with a bandpass time gate 

2.4.2 Gate setup 

The boundaries and functions of the gate can be defined by the following settings: 

1) Start and End: Defining the -6dB cutoff time of the gate. 

2) Center: Defining the center time of the gate. 

3) Span: equaling to the end time minus the start time. 

4) Type of gate: 

a) Bandpass: filtering out the response outside the gate. 

b) Bandstop:  filtering out the response inside the gate. 

2.4.3 Gate shapes 

2.4.3.1 Gate shapes 

Gates have filter shapes similar to window filters, and measurements can be optimized by choosing the 

right filter shape: minimum, standard, wide and maximum: 

1) Minimum gate: such filter has the highest side lobe level, the steepest edge dip, and the largest 

passband ripple. 

2) Maximum gate: such filter has the lowest side lobe level, the slowest edge dip, and the smallest 

passband ripple. 
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2.4.3.2 Passband ripple 

A gate is a bandpass (or bandstop) shaped filter, each with different filter characteristics. The following 

figure shows the passband ripple of four different shaped filters, scaled to 0.5 dB/grid, and the smallest gate 

has the largest ripple as can be seen in the Fig. 2.11: 

 

Fig. 2.11 Passband ripple of different gate filters 

2.4.3.3 Side lobe level 

As shown in the Fig. 2.12, the four different shapes of filters have different side lobe levels, which must be 

balanced against a lower lobe level and a faster cutoff rate during actual measurements: 

1) The minimum gate has the highest side lobe level and the fastest cutoff speed, which is ideal for 

filtering out undesired responses near the measured response. 

2) The maximum gate has the lowest side lobe level, the slowest cutoff speed, the widest gate passband, 

and the greatest attenuation outside the gate's band. 

 

 

Fig. 2.12 Side lobe levels for different gates 

2.4.3.5 Gate characteristics 

Different shapes of gates have different characteristics. Table 2.3 provides characteristics of different gates, 

which are defined by the following indicators: 

1) Passband ripple and side lobe level: describing the shape of the gate. 

2) Cutoff time: the time between the end time of the gate (at -6 dB from the filter boundary) and the first 

peak of side lobe. 

3) Minimum gate span: twice of the cutoff time. 
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Table 2.3 Characteristics of different gates 

Shape 
Passband 

ripple 
Side lobe level Cutoff time Minimum gate span 

Min ±0.10dB -48dB 1.4/Frequency span 2.8/Frequency span 

Normal ±0.01dB -68 dB 2.8/Frequency span 5.6/Frequency span 

wide ±0.01dB -57 dB 4.4/Frequency span 8.8/Frequency span 

Max ±0.01dB -70 dB 12.7/Frequency span 25.4/Frequency span 

 

Fig.2.13 gives the meaning of the shape of a complete gate and its characteristic indicators: 

1) T1 is the span of the gate, which is equal to the termination time minus the start time. 

2) T2 is the time between the passband boundary and the -6 dB point, indicating the cutoff of the filter. 

3) T3 is the time between the -6 dB point and the boundary of the gate stop-band. 

For all shapes of doors, T2 and T3 are equal and both sides of the filter center point are perfectly 

symmetrical. 

      

Fig. 2.13 Schematic diagram of gate shape 

2.4.3.6 Minimum gate span 

Each shape of gate has a recommended minimum gate span for proper operation, which is determined by 

the limited gate cutoff rate, and such minimum gate span is given by the following equation, where the 

passband of the filter is equal to zero. 

T1MIN=2×T2 

If the gate span is set smaller than this minimum value, the analyzer will have the following effect: 

1) Absent passband for shape distortion of the gate; 

2) Shape distortion of the gate; 

3) Incorrect indication of start and end times. 

4) Increased side lobe level. 
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2.5 Time domain measuring data 

This section gives examples of multiple measuring ways to help the user understand the device response in 

the time domain. 

 M a s k i n g … … … … … … … … … … … … … … … … … … … … … … … … … … … … 3 4 2 

 Measuring reflection in bandpass mode……………………………………………………343 

 M e a s u r i n g  t r a n s m i s s i o n  i n  b a n d p a s s  m o d e … … … … … … … … … … … 3 4 4 

 Locating error in low-pass mode………………………………………………………345 

 Measuring reflection in low-pass mode………………………………………………345 

 Measuring transmission in low-pass mode………………………………………………346 

2.5.1 Masking 

2.5.1.1 Effect of masking 

As masking affects the response observed by the user during time-domain measurements, it helps the user 

to understand the measured data in the time domain. 

1) Masking occurs when an interruption or a loss closest to the reference channel occurs, and it will 

affect every concurrent interruption response. 

2) The energy reflected or absorbed from the first interruption cannot reach the second or subsequent 

interruptions. 

3) Therefore, each intermittent response is smaller than the first but invisible response it should have. 

2.5.1.2 Masking due to energy reflection 

Reflection-induced masking occurs when any of the larger error configurations are encountered. This 

phenomenon is shown in the following example of linear impedance, as shown in the Fig. 2.14. 

1) A 50Ω line is connected to a 25Ω air line, which is then connected to a 50Ω transmission line. 

2) The first breakpoint probably has a reflection with a factor of 0.333 (exactly equivalent to a 25Ω 

resistor). 

3) The response in the downstream of the 25Ω end would not be a reflection with a factor of 0.333 (it 

would be a resistor equivalent to 50Ω). The difference between them at this order of magnitude is 35.355 

mU as shown by the two △markers. The reason is that at the point of occurrence of the second pulse there 

is a smaller attenuation of the unit of reflected energy due to the detuning at the first point. 
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Fig. 2.14 Effect of masking on measurements due to energy reflection  

2.5.1.3 Masking due to energy absorption 

Masking due to energy absorption refers to the masking due to measuring the lossy circuits. Fig. 2.15 

shows an example about the masking of a cable under an open loop. 

1) The return loss of the open-loop response is shown on MARKER 1 as -2.445 dB (note that it is in 

LOG MAG mode). 

2) This expected response is a more typical value under open loop. 

3) This tagged value represents the sum of the forward and reverse path loss. 

Fig. 2.15 Effect of masking on measurements due to energy absorption 

2.5.2 Measuring reflection in bandpass mode 

2.5.2.1 Data on horizontal axis 

The time taken for a pulse refers to the time from the test port to the breakpoint and then back to the test 

port. 

2.5.2.2 Data on vertical axis 

1) If the LOG MAG method is used it refers to the return loss (dB). 

2) If the LIN MAG method is used it refers to the reflection coefficient. 

As shown in the Fig. 2.16, the following example is used to illustrate the reflection measurement in 

bandpass mode. 

3) There is a pulse at zero point on the time axis, indicating that the time from the output of the test port 

to the first breakpoint. 

4) A concurrent pulse indicates the next breakpoint encountered by the pulse. 
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Fig. 2.16 Measuring reflection in bandpass mode 

2.5.3 Measuring transmission in bandpass mode 

2.5.3.1 Data on horizontal axis 

It indicates the propagation latency of a test unit. 

2.5.3.2 Data on vertical axis 

1) A transmission loss or transmission gain if the LOG MAG method is used. 

2) A transmission coefficient if the LIN MAG method is used. 

As shown in the Fig. 2.17, the following example is used to illustrate the transmission measurement in 

bandpass mode. 

3) This example illustrates the information provided in this mode about the multiple paths transmitted in 

the surface acoustic wave (SAW) filter. 

4) The pulse closest to the 0 time point describes the propagation time of the network instrument from 

the output to the input on the shortest path. It may or may not be the largest pulse or the best propagation 

path. 

5) Each concurrent pulse may have other propagation paths from input to output, but either one is longer 

than the shortest path. 

 

Fig. 2.17 Measuring transmission in bandpass mode 
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Observe the main path of the SAW filter response 

In order to figure out the main path of the SAW filter response, you can set the gate that blocks all pulses 

except the main one. After that, in the frequency domain, only the frequency response on the main path is 

shown. 

2.5.4 Locating error in low-pass mode 

The low-pass mode simulates the response of testing device time domain reflectometer (TDR). This 

response contains a useful decision information at the point of interruption. The following figure illustrates 

the low-pass response for a known breakpoint. Each circuit element is passed through the low-pass time 

domain S11 response under the corresponding analog waveform. The low-pass mode allows you to observe 

either a step response or an impulse excitation response. 

 

Fig. 2.18 low-pass time domain response waveform of discontinuous circuit 

 

 

The step response makes it easier for you to understand the characteristics of breakpoints. This 

model is more similar to the conventional TDR measurement. 

 

2.5.5 Measuring reflection in low-pass mode 

2.5.5.1 Data on horizontal axis 

The data on the horizontal axis is the time a pulse from the test port to the breakpoint and then back to the 

test port. 

Note: To confirm the actual physical length, please enter the appropriate rate factor. 

2.5.5.2 Data on vertical axis 

If the reflection coefficient (ρ) is expressed by the REAL method. The following example is a reflection 

Tip 

Tip 
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measurement of the impulse response and step response in low-pass mode using the LOG MAG method. 

 

 Fig. 2.19 Measuring reflection in low-pass mode 

 

 

The following example illustrates the reflection measurements of two different cables in the low-pass mode 

using the REAL method. 

1) The low-pass response contains information such as the way the breakpoint is positioned for 

impedance calibration. 

 

Fig. 2.20 Low-pass step measurements for different cables 

2) Measurement in the left side - a capacitive breakpoint in the response of the curled cable. 

3) Measurement in the right side - ab inductive breakpoint in the response of the curled cable. 

2.5.6 Measuring transmission in low-pass mode 

2.5.6.1 Data on horizontal axis 

1) The average time to pass the device in a frequency range. 

2) An equipment's in time electrical latency. 

2.5.6.2 Data on vertical axis 

1) A real unit (e.g. voltage) if REAL method is used. 

2) A transmission loss or transmission gain if the LOG MAG method is used. 

The following example illustrates the low-pass step response of an amplifier. 

1) The average group latency covering the full measurement frequency range is different between the 

temporal step response and the amplifier response. 
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2) In the frequency domain swept the step time is balanced to reach the highest frequency point; the 

higher the frequency the faster the rising time. 

3) There is a suppression signal in the rise of the amplifier response. 

Fig. 2.21 Low-pass step measurements for an amplifier 

 

 

 

Scope of application of vertical axis format 

For the low-pass step response, the most useful is the REAL (radiation coefficient) method; for the impulse 

response, the REAL method can be used, but to get the best dynamic range for those observed large and 

small breakpoints, the LOG MAG method is used. 

2.6 Bandpass and low-pass time domain modes 

Measurement in time domain mode must be selected before the user set the measured value. 

 Mode comparison…………………………………………………………………………347 

 Model selection basis and test device……………………………………………………348 

 Frequency range and  data  po in ts …………………………………………………… 348 

 Impulse and step response………………………………………………………………349 

 U si ng  da t a  fo r ma t ………… ………………………… ………………………… …… 34 9 

2.6.1 Mode comparison 

2.6.1.1 Bandpass mode 

1) Simple application. 

2) Useful only for bandpass devices that do not operate down to 0Hz. 

3) Allows measurement of some frequencies for which the start and end frequencies have been set. 

4) Only impulse response measurements are allowed because the conversion data cannot include the 0Hz 

situation. 

Tip 



Annexes 

Attachment 2 Time Domain Measurements 

348  

 

5) Works on reflection and transmission measurements. 

6) Allows the wrong location to exist. 

2.6.1.2 Low-pass mode 

1) Apply to those low-pass devices that can operate down to 0Hz. 

2) Simulates a conventional time domain reflectometer (TDR). 

3) It is necessary to measure the frequencies that have a moderated association with the 0Hz situation and 

derive the first new data point in the frequency domain. 

4) Allows for Impulse and step response measurements since the conversion data includes the 0Hz 

situation. 

5) Allows for error location and proof of impedance (capacitive or inductive) presentation type at 

breakpoints. 

6) Works on reflection and transmission measurements. 

7) The low-pass mode has a higher response resolution (by a factor of 2) than the band-pass mode for the 

same frequency span. 

2.6.2 Model selection basis and test device 

1) Select bandpass mode - if the test device operates with bandpass, bandstop or high-pass filter. 

2) Select low-pass mode - If the test device can pass all frequencies down to 0 Hz, even if the device 

response has replication at the low end of the frequency span, still select low-pass mode. 

2.6.3 Frequency range and data points 

2.6.3.1 Bandpass mode 

1) The user can select a number of start and end frequency values within the measurement range. 

2) The analyzer will obtain data from the start to the end frequency. 

3) Only impulse response is provided. 

 

Fig. 2.22 Bandpass mode 

2.6.3.2 Low-pass mode 

1) A DC condition is required in the frequency domain that can be derived from the beginning few 

points. 

2) The requirement is equal to the number of data points in the space. 

3) The analyzer is set to measure the harmonics of all starting frequencies. 

4) Fcutoff = N × Fstart (N = number of sweep points) which places a limit on each value of N in the cutoff 

frequency. 
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F start and F cutoff parameters 

Since the minimum possible value for Fstart is 300 kHz, the Fcutoff is at least N × 300 kHz. 

2.6.4 Impulse and step response 

 

Fig. 2.23 Low-pass mode 

Once the device under test is excited through a pulse function or a step function, the network analyzer is 

able to present this time domain response. 

1) Low-pass impulse - a voltage waveform that goes up from 0 to maximum and then drop down to 0. 

The pulse width is determined by the frequency span at the time of measurement in the frequency domain. 

2) Low-pass step - a voltage waveform that goes up from 0 to maximum. The step-up time is determined 

by the highest frequency at the time of measurement in the frequency domain. 

 

 

 

Scope of application of two low-pass time domain transformation modes 

The low-pass step in the low-pass mode is the easiest time domain transformation mode to explain the 

breakpoint approach. The TDR display of general inductive and capacitive breakpoints can be given by 

these two methods. 

 

3) In the frequency response data, the analyzer relies on the conversion method chosen to calculate the 

step, pulse, or the set bandpass response. 

4) The analyzer displays these data in the time domain response. 

For more information on the effect of frequency span on pulse width and rising time please refer to 

Response and Range. 

2.6.5 Using data format 

2.6.5.1 Linear quantity 

1) For reflection measurements, this format shows the average linear quantity of the reflection coefficient 
in the measuring range. 

Note 

Note 
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2) For transmission measurements this format shows the average transmission coefficient over the 

transmission path in the measuring frequency range. 

3) This format is suitable for observing near-quantity responses. 

2.6.5.2 Log format 

1) For reflection measurements, this format shows the response in units of return loss (dB). The 

displayed value represents the average of the return loss of the breakpoints in the measuring frequency 

range. 

2) For transmission measurements, this format shows the response in units of transmission loss or gain 

(dB). This represents the average loss over the transmission path in the measuring frequency range. 

3) This format is suitable for observing the transmission response over a wide dynamic range. 

2.6.5.3 Standing wave ratio 

For reflection measurements, this format shows the average standing wave ratio (SWR) of the breakpoints 

in the measuring frequency range. 

2.6.5.4 For low-pass available formats - REAL 

1) This format shows the response in real units. 

2) If the device under test has a down-to-DC response, you can use the low-pass mode. 

3) If the device under test has no measured response at DC, you can use the bandpass mode. 

2.7 Time domain transformation measurement settings 

Path of Menu: clicking [Analysis] → [Time Domain] → [Time Domain Transformation...] to display the 

Time Domain Transformation dialog. 

Click to check the [Time Domain Transformation] checkbox to activate the time domain transformation 

function. 

Click the [Start], [End] or [Center], [Span] boxes to set the time domain measurement range. 

Select the transformation mode in the Transformation Mode area: [Low-pass Impulse], [Low-pass Step] 

or [Bandpass]. 

 

Fig. 2.24 Setting up the time domain transform measurement 

Setup the window function: Click the [Window] option button in the Time Domain Transformation 
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dialog and set the window filter using the following three methods: 

 Drag the slider with the mouse until the pulse width or bypass level meets the requirement; 

 Click on the [Kaiser Window β Parameters] box and adjust the β value setting until the pulse width 

or side lobe level meets the requirement. 

 Click the [Pulse width] box to set the response pulse width directly. 

 

 

Fig. 2.25 Time domain transformation measurement - setting the window 

Set the time domain gated filtering function: Click the [Gate] option button in the Time Domain 

Transformation dialog, check the [Gate] checkbox to enable the time domain gated filtering function. 

 Click the [Start], [End] or [Center], [Span] boxes to set the boundary of gate; 

 Select the gate type in the [Gate Type] box: bandpass, bandstop; 

 Select the gate shape in the [Gate Shape] box: Minimum, Standard, Wide, Maximum. 

 

 

Fig. 2.26 Time domain transformation measurement - setting the gate 

If you want to observe the frequency domain response of the measured pieces while the gate function is 

still active, click the [Time Domain Transformation] option button in the Time Domain Transformation 

dialog and clear the [Time Domain Transformation] checkbox. 

Tips for time domain transformation setup 
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 When closing the Time Domain Transformation dialog while the time domain transformation and 

time domain gate is enabled, you can change the boundary setting of the time domain gate by dragging the 

mouse: point the mouse at the start or end of the gate indicators presented by symbols " .. ." and "..." 

respectively, press and hold the left mouse button until the mouse pointer becomes "↔" for horizontal 

adjustment, drag the mouse to move the door boundary indicator to the desired position, release the left 

mouse button, then the door start or end setting is finished. 

 After completing the time domain measurement settings through the Time Domain Transformation 

dialog, you can close the Time Domain Transformation dialog and open the Time Domain toolbar to 

adjust the time domain measurement settings, so as to observe the effect of the setting changes on the 

measurement more precisely. See "Trigger Toolbar Display" in Section 4.9 Analyzer Display Setting for 

details on how to set up the time domain toolbar. 

2.8 Time domain reflection (TDR) impedance test 

With the rapid development of the information industry, the demand for network bandwidth is also 

increasing, which requires information equipment (such as large servers, computers and switches) to be 

able to carry increasingly faster data rates. Information equipment manufacturers are also paying more 

attention to signal integrity issues in high-speed interconnect channels, and TDR differential impedance is 

one of the important test items. 

Traditionally, TDR differential impedance testing is a common method of evaluating transmission lines by 

using a time domain reflectometer (TDR) oscilloscope. Vector Network Analyzer (VNA)-based TDR 

measurements are gaining interest as an alternative to such time-domain analysis. The test principles of the 

two methods are shown in the figure below. 

2.8.1 Test trace setup 

Path of Menu: clicking [Trace] → [New trace] → [Balance Parameters...] to display the Balance 

Parameter Topology dialog. 

Modify the balance topology setting, select [Balance to Balance], and set the relationship between the 

balance port and the network instrument port according to the connection of the DUT. 

Create differential test trace Sdd11. 

 

Fig. 2.28 Test trace creation 
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2.8.2 Time domain transformation mode setup 

Path of Menu: clicking [Analysis] → [Time Domain] → [Time Domain Transformation...] to display the 

Time Domain Transformation dialog. 

Click to check the [Time Domain Transformation] checkbox to activate the time domain transformation 

function. 

Click the [Start], [End] or [Center], [Span] boxes to set the time domain measurement range. 

Select the transformation mode in the Transformation Mode area:  [Low-pass Step] 

 

Fig. 2.29 Time domain transformation mode setup 

2.8.3 Calibration 

First, select the calibration method and connection method according to the calibrator and DUT; then select 

the calibrator and DUT; then follow the wizard steps to perform the four-port calibration, and finally click 

Finish. 

 

Fig. 2.30 Calibration process 

2.8.4 Impedance format selection 

Path of menu: clicking [Response] → [Format], select the impedance format. 
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Fig. 2.31 Time domain reflection (TDR) impedance display 

 

 

 

Calibration of time domain measurements 

If you want to perform calibration before performing time domain low-pass mode measurements, you must 

first select the low-pass measurement mode in the Time Domain Measurement dialog box or click the [Set 

Frequency- Low-pass] button to set the starting frequency of the measurement. It is recommended to 

perform calibration after all time domain measurement settings are completed. 

Note 
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Attachment 3 Advanced Time Domain Analysis 

The Chapter provides the following contents:  

 O v e r v i e w … … … … … … … … … … … … … … … … … … … … … … … … … … … … 3 5 5 

 M e a s u r e m e n t  s e t t i n g s … … … … … … … … … … … … … … … … … … … … … … … 3 5 7 

 M e a s u r i n g  p r o c e s s … … … … … … … … … … … … … … … … … … … … … … … … … 3 6 3 

 E y e  p a t t e r n  a n d  e y e  p a t t e r n  t e m p l a t e  m e a s u r e m e n t s … … … … … … … … … 3 6 6 

 A d v a n c e d  a n a l y s i s  o f  e y e  p a t t e r n  w a v e f o r m s … … … … … … … … … … … … 3 7 2 

3.1 Overview 

The Vector Network Analyzer Advanced Time Domain Analysis option provides the following features: 

• Wide frequency coverage with a four-port option to make testing of the latest high-speed data standards possible 

• Large dynamic range for testing the real performance of DUTs 

• Excellent noise background ensures accurate and repeatable testing 

• Fast measurement speed for real-time analysis of DUT characteristics 

• Advanced calibration technology reduces measurement errors 

• Automatic fixture removal technology ensures easy removal of fixture and probe effects on test results 

• Accurate TDR/TDT and S-parameter data of the measured parts can be obtained simultaneously 

• Simultaneous time and frequency domain analysis to help find the source of loss, reflection and crosstalk 

• Single connection for forward and reverse transmission and reflection measurements 

• Provides test results for all transmission modes (single-ended, differential and mode switching) 

• Evaluation of transmission performance of high-speed interconnects through simulated eye diagrams 

• Provide simulation code generator to get PRBS, K28.5 and ABS code pattern, and support user definition 

• Built-in predefined high-speed serial standard eye diagram templates 

• No pulse generator required, eye diagram generated based on frequency domain data 
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3.1.1 Screen display 

 

Fig. 3.1 Main operation interface for advanced time domain option 

 Graphic region 

Display of measurement results such as TDR/TDT, S-parameters, and eye diagrams shown in the graphics region. 

 Configuration wizard 

User can set the test status according to the wizard 

 Instrument status bar 

 Test mode selection 

You can choose from three advanced time domain analysis modes 

• Configuration 

• TDR/TDT 

• Eye diagram 

When one of the tabs is selected, the mode changes. The selected mode will be highlighted, and the displayed setup area 

will be changed accordingly to the selected mode. 

 Parameter setting 

The setting area changes and is displayed according to the selected mode. 

3.1.2 Start and exit the Advanced Time Domain Analysis option 

Ensure that the Advanced Time Domain Analysis option is installed and enabled. 

Start advanced time domain analysis option 

a) Click [Analysis] → [TDR] to open TDR. Start the Advanced Time Domain Analysis option. 

b) To exit, click the [X] button on the 3671 Advanced Time Domain Analysis optional application screen to 

close it. 
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Fig. 3.2 Advanced Time Domain Option menu selection 

3.2 Measurement setup 

3.2.1 Use of the configuration wizard 

The configuration wizard guides you step-by-step through the advanced time domain analysis measurement settings. 

The settings will appear automatically when you perform the Advanced Time Domain Analysis Option for the first time. 

 

Fig. 3.3 Overview of TDR configuration wizard 

a) If you do not want to use the Configuration Wizard to perform advanced time domain analysis settings, click the 

[Close] button to close the Configuration Wizard. 

b) Click [Next] → Start the setup process. 

c) Select the topology of the DUT. 
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Fig. 3.4 Topology settings of the TDR configuration for the DUT 

 

d) Click [Next]. 

e) The DUT length dialog of the configuration wizard will appear, click [Measure], the DUT length is measured 

automatically and used to set the measurement time reference. 

 

Fig. 3.5 DUT length test with the TDR configuration 

f) Click [Next]. 

g) To display the rising time Setting dialog of the Configuration Wizard, click [Rising Time] and [Type]. 
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Fig. 3.6 Test setup for the rising time with the TDR configuration 

h) Click [Finish] to complete setting of configuration wizard 

3.2.2 Manual configuration 

In addition to using the configuration wizard, user can manually perform advanced time domain analysis measurement 

settings. Manual settings are performed on the Configuration tab. It mainly includes 

• Reset 

• Selection of DUT topology 

• Setting the excitation magnitude level 

• Setting the DUT length 

• Port extension 

• Calibration 

• Average 

• Channel configuration 

 Reset 

a) Click the [Reset] button under Basic Configuration to reset the Advanced Time Domain Analysis option. 

b) All settings displayed in the Basic Area are changed to the default settings. 

Note: When you click the [Reset] button, the calibration and port extension data will be cleared. After reset all settings 

are default except for DUT type. 

 Topology setting of the DUT 

a) In the Topology under Basic Configuration, select one of the available options from the drop-down list. The 

function is the same as the topology of the DUT in Section 3.2.1 [Configuration Wizard]. 

b) A dialog requesting confirmation will appear. Click [OK] to continue. 
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Fig. 3.7 Topology Change prompting dialog for the DUT 

Note: Selecting the topology will reset the advanced time domain analysis option. Therefore, when you change from 

one topology to another, the calibration and port extension data will be cleared.  

 Setting the excitation level 

Used to set the magnitude of the excitation level 

Note: The excitation level magnitude is independent of the actual applied test level. 

a) Double click the [Excitation Level] text box in the basic settings, an input dialog box will appear. Enter the 

excitation level value and click [Enter]. The new value set is displayed in the [Excitation Level] text box. 

 

Fig. 3.8 Soft keyboard dialog 

 Set the length of the DUT 

The DUT length setting is mainly used to set the time span for the time domain measurement. Measurements can be 

performed on longer DUTs, but the minimum rising time value may be limited. 

The length of the DUT can be automatically or manually set. 

a) Automatic setting (recommended) 

1. Click [Auto] button in the length of the DUT under Basic Configuration. 

2. The DUT Length dialog box of the configuration wizard will appear. 

3. Click [Measure]. 

4. The length of the DUT is measured automatically and used to set the time reference. 

5. When finished, a check mark will appear next to [Measure]. 
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Fig. 3.9 DUT length test setup dialog (manual configuration) 

Note: The auto setup feature can be a step in the configuration wizard. 

b) Manual setting 

If the length of the DUT is known, the length of the DUT can be set manually. 

1. Enter the length value in the length of the DUT text box under Basic Configuration. 

Note: Any DUT that is shorter than the DUT length setting can be measured. Therefore, when testing multiple DUTs of 

different lengths, the longest DUT is used to set the length value to allow the same instrument settings to be used for all 

measurements. 

 Perform calibration 

The Advanced Timing Analysis option has three calibration methods available, as follows: 

• Port extension 

• Port extension and loss compensation 

• Regular calibration 

 More features 

a) Reference impedance setting 

1. Double click Reference Impedance once under the More option. An input dialog will appear. Type in the reference 

impedance value and click OK. The new value is displayed at [Reference Impedance]. 

b) Dielectric constant and rate factor 

Rate factor = 1 /√(dielectric constant). 

When changing any of them, the other values will be changed automatically. 

1. Change the value of the dielectric constant. Double click [Dielectric constant] once under the More option. An 

input dialog will appear. Type in the dielectric constant value and click [Enter]. The new value is displayed at 

[Dielectric constant].  

2. You can set the value of the rate factor in the same way as the dielectric constant in [Rate Factor] under the More 
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option. 

c) Port power 

1. Double-click Port Power once under the More option. An input dialog will appear. Enter the port power and click 

[Enter]. The new value is displayed at [Port Power]. 

d) Avgs 

The averaging function reduces trace noise. When the Swept Averaging function is on, it performs the number of swept 

specified by the average factor. To activate the Averaging option, select Average. 

1. To turn on the averaging function, select the checkbox before Average. 

2. Enter the number of times to be averaged (the number of sweeping to be performed). 

e) IFBW 

Double click [IF Bandwidth] once. An input dialog will appear. Enter the IF bandwidth value and click [Enter]. The 

new value is displayed on the IF bandwidth. Reducing the IF bandwidth will increase the dynamic range and reduce the 

measurement noise level. 

 Channel configuration 

Refer to the section on advanced analysis of eye diagram waveforms. 

3.2.3 Error correction 

There are many different ways to remove the influence of test fixtures and cables from measurements. The Advanced 

Time Domain Analysis option for 3671 analyzer provides you with three available error correction methods, as follows: 

• Port extension 

• Port extension and loss compensation 

• Regular calibration 

Error correction can be performed in the [Basic Configuration] of Configuration tab. 

 

Fig. 3.10 Basic configuration 

Click the [Port Extension] button to the Auto Port Extension dialog. See Section 6.5.2 for the specific steps of port 

extension and loss compensation. 
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Fig. 3.11 Port extension dialog 

Click the [Calibrate] button to the Calibration dialog, see Chapter 7 for the specific steps of normal calibration. 

 

Fig. 3.12 Calibration wizard dialog 

3.3 Measurement process 

3.3.1 Trace parameter setting 

 Trace selection 

There are two ways to select trace to be displayed: 

a) Using the mouse 

1. Double click on any area of the graphic box to exit the full view. 

2. Click to select the desired trace. 

b) Using the list box 

Click the [Trace] list box and select the trace number from the list, as shown below: 
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Fig. 3.13 Trace control 

Note: The number of traces is variable, up to 16 traces can be displayed in this option, and all time domain, frequency 

domain and mixed mode parameter traces can be selected. 

 Selecting parameters 

Clicking on the TDR/TDT tab allows you to select the parameters shown below. 

All measurements and formats are given in the table below: 

Measurement Format 

Frequency domain parameter 

format 

Logarithmic magnitude 

Linear Amp 

Real quantity 

Imaginary quantity 

Group latency 

VSWR 

Phase 

Expanded phase 

Positive phase 

Smith (Lin/Phase) 

Smith (Log/Phase) 

Smith (Re/Im) 

Smith (R + jX) 
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Smith (G + jB) 

Polar coordinates (Lin/Phase) 

Polar coordinates (Log/Phase) 

Polar coordinates (Re / Im) 

Time domain parameter format 

Impedance 

Voltage 

Logarithmic magnitude 

Linear Amp 

Real quantity 

 

Fig. 3.14 Parameter setting 

 

The list boxes in the Parameters area change as the measurement is selected, as follows: 

Measurement 
The beginning of the table 

content 

S-parameter 
Single-ended S 

Differential Sc, Sd 

Time Domain 
Single-ended T 

Differential Tc, Td 

 Choice of excitation method 

There are two options for the excitation types: 

• Low-pass step 

• Low-pass impulse 
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There are two options for the rising time: 

• 10 - 90% 

• 20 - 80% 

The rising time settings for TDR/TDT mode and eye diagram mode are independent. 

3.3.2 Cursor and cursor search function 

Refer to Section 5.2.7 for the general cursor and cursor search functions. 

 Incremental cursor 

Incremental cursors can be used for time-incremental measurements in the time domain. Traces other than in the time 

domain cannot be used for time incremental measurements. 

a) Click on the starting trace where the time increment needs to be measured. 

b) Click the [Incremental Cursor] button in the Trace Control. 

c) The Incremental Cursor dialog box appears, select the end trace, and set the [Start Trace Target Value] and [End 

Trace Target Value], check the [Incremental Cursor] checkbox to complete the test. 

d) Set the [Limit Value] text box and check the [Limit Test] checkbox to complete the limit test for incremental time. 

For limit test, the absolute value of the time increment less than the limit value indicates a successful test. 

The time increment data is displayed in the upper left corner of the graphical area of the application interface. 

3.3.3 Use of time domain gates 

The time domain gated function provides an ability to measure the response of a particular circuit element in the 

frequency domain by algorithmically removing unwanted responses. When you define a time domain gate on the time 

domain response curve, the time domain gated part is removed or retained. By observing the original frequency domain 

response and the frequency domain response after adding the time domain gate, the effect of the time domain gate 

function on the S-parameter data can be seen. 

See Section 2.4 in Attachment 2 for the specific steps for the time domain gate operation. 

3.4 Eye diagram and eye diagram template measurements 

3.4.1 Eye diagram measurement 

In the oscilloscope, eye diagrams are commonly used to analyze signal quality. You can determine problems such as 

fading, attenuation, jitter, and dispersion on the system by using an eye diagram. 

The 3671 Analyzer's advanced time domain analysis option provides simulated eye diagram analysis, eliminating the 

need for a pulse pattern generator hardware. The simulation code pattern generator is used to define an simulation code 

pattern and then convolve the defined simulation code pattern with the impulse response of the DUT to create a very 

accurate eye-diagram based measurement. 

a) Eye diagram test 

1. Select the trace of the eye diagram you want to observe. 

2. Click [Draw Eye Diagram] to display the eye diagram. 

3. When you change the setting of the excitation type, click [Draw Eye Diagram] to reflect the setting to the waveform. 

b) Show results 

1. Select [Rising time] under Test Results. 

2. Click [Draw Eye Diagram] to display the results. When you change the Rising Time setting, you need to click 

[Draw Eye Diagram] to show the result. 



Annexes 

Attachment 3 Advanced Time Domain Analysis 

      367 

 

 

Fig. 3.16 Main interface of eye diagram measurement 

 

 

 

Name Unit Description 

Rising time Picosecond 
Rising time definition = 10%-90%: time at 90% level - time at 10% level 

Rising time definition = 20%-80%: time at 80% level - time at 20% level 

Falling time Picosecond 
Falling time definition = 10%-90%: time at 90% level - time at 10% level 

Falling time definition = 20%-80%: time at 80% level - time at 20% level 

Jitter root mean 

square 
Picosecond 1σ width of the histogram at the eye intersection 

Peak to peak jitter Picosecond Full width of the histogram at the eye intersection 

Crossover percentage % Crossover height / Range × 100 

Open factor None (1 Level-σ1)-(0 Level+σ0)/Magnitude 

Signal/noise ratio None (1 level - 0 level)/(σ1+σ0) 

Duty cycle distortion Picosecond |T rising center -T falling center| 

Duty cycle distortion 

(%) 
% Duty cycle distortion (s)/bit period × 100 

0 level Voltage Histogram average of 0 level 

1 level Voltage Histogram average of 1 level 
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Average level Voltage (0 level + 1 level)/2 

Level magnitude Voltage 1 level - 0 level 

Eye diagram height Voltage (1 level-3σ1)-(0 level+3σ0) 

Eye diagram width Picosecond Bit period-2×3×jitter root square mean 

 Bit period = 1/bit rate 

 Input magnitude = Set 1 level - Set 0 level 

 T rising center = time for the rising edge to cross the middle threshold (50%) 

 T falling center = time for the falling edge to cross the middle threshold (50%) 

c) Save the results to a file 

The results can be saved as a text file. 

1. Click [Export to csv], the [Save Eye diagram Results] dialog will be displayed. 

2. Type in the desired file name and then click [Save]. 

Case results 

 

Fig. 3.17 Text file of eye diagram parameters 

d) Eye diagram scaling 

By default, the eye diagram is set to auto, or you can set the scale manually. 

1. In the Scale/Template area, select the [Manual Settings] check button, which will activate the [Scale] and 

[Reference Value] options. 

2. Click the [Scale] input box and enter the Y coordinate value. 

3. Click the [Reference Value] input box and enter the Y coordinate reference value. 
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Fig. 3.18 Scale/Template settings 

e) Continuous measurement 

By default, the eye diagram is set to trigger a single measurement by clicking the [Draw Eye Diagram] button, or 

it can trigger a measurement continuously. 

1. In the Test Results area, select the [Continuous Measurement] check button. 

2. Click the [Draw Eye Diagram] button, and the eye diagram will be continuously triggered for measurement. 

f) Statistics 

By default, the eye diagram is drawn using monochrome lines, or you can count the line density and display the 

eye diagram using a color scale. 

1. Under Test Results, select the [Statistics] check button. 

2. Click [Draw Eye Diagram] to display the results. 

3.4.2 Simulation code pattern selection 

The 3671 Analyzer's advanced time domain analysis option provides the ability to simulate eye diagram analysis, 

eliminating the need for a pulse pattern generator hardware. The simulation code pattern is selected from the followings: 

• PRBS 

• ABS 

• K28.5 

• User-defined 

a) Simulation code pattern selection 

1. Select the emulation code pattern you need in the "Stimulation" area under [Type]. 

2. If you choose [PRBS] or [ABS], [Length] will be activated, and after that, select [Length]. 

 

Fig. 3.19 Excitation code pattern setting 

3. User-defined simulation code pattern 

Users can easily create custom simulation code patterns. The bit length should be between 8 and 32768 (2^15). 

Simulation code patterns that contain only 0 or 1, or only 1 change edge are not allowed to be set (e.g. 00,111,0000). 

a) Simulation code pattern setting 

The following parameters can be used for the simulation code pattern 
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Tags Description 

1 level 
The Y-coordinate scale of the eye diagram expressed in volts is bit "1", allowing 

negative voltages. For differential eye diagrams, these scale values become doubled. 

0 level 
The Y-coordinate scale of the eye diagram expressed in volts is bit "0", allowing 

negative voltages. For differential eye diagrams, these scale values become doubled. 

Data rate 
The speed at which data is transmitted over a circuit or communication line, 

measured in bits per second. 

Rising time 

The time it takes for a signal to go from low to high, with a maximum value of 40% 

of the bit bandwidth (bit bandwidth = 1/bit rate). The time can be defined as 

"10%-90%" or "20%-80%". The rising time is set independently in [Eye Diagram] 

and [TDR/TDT]. 

3.4.3 Eye diagram template test 

The Eye diagram template test allows you to verify that an eye diagram conforms to the industrial definition. To comply 

with industrial standards, the input waveform must remain outside the shaded template area. Template testing can be 

found under Scale/Template. 

 

Fig. 3.20 Template setup 

a) Define a template 

Set up the top/bottom template and the polygon template in the center of the eye diagram according to the requirements 

of the DUT in the eye diagram template setting window, click OK and check the template test function in the eye 

diagram setting panel to enable the eye diagram template test. 

The available template shapes are "octagonal", "hexagonal" and "quadrilateral". 
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Fig. 3.21 Template definition dialog 

b) Executing template tests 

1. Select the [Template Test] checkbox under Scale/Template. 

2. Click [Draw Eye Diagram] to redraw the eye diagram pattern and template. 

3. The template and success/failure results will be displayed on the screen. 

 

Fig. 3.22 Template test 
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3.5 Advanced analysis of eye diagram waveforms 

In the advanced analysis of the eye diagram waveform, pre-emphasis and equalization help to improve the quality of the 

waveform at the receiver side, which in turn improves the quality of the eye diagram. 

a) Click the [Channel Settings] button under the [Eye Diagram] page to enter the advanced analysis function of the 

eye diagram waveform. 

 

Fig. 3.23 Channel settings dialog 

According to the left and right buttons, the observation point of the eye diagram can be selected. 

• The eye diagram of the source is represented by the observation before the DUT. 

• The eye diagram of the receiver is represented by the observation after the DUT. 

3.5.1 Jitter injection 

a) Click the [Jitter] button and check [Enable] to perform jitter injection on the source, 

b) When jitter injection is enabled, a check mark appears on the [Jitter] button. 

There are three types of jitter injection are available. 

• Random jitter - follows a Gaussian distribution and is expressed as the root mean square value of a random jitter 

distribution. 

• Cycle jitter - expressed as peak-to-peak value. 

• Dirac jitter. 

 

Fig. 3.24 Jitter injection setting dialog 
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3.5.2 Noise injection 

a) Click the [Noise] button and check [Enable] to perform noise injection on the source. 

b) When noise injection is on, a check mark appears on the [Noise] button. 

 

Fig. 3.25 Noise injection settings dialog 

3.5.3 Pre-emphasis 

a) In order to perform pre-emphasis, click the [Pre-emphasis] button and check [Enable]. 

b) When pre-emphasis is on, a check mark appears on the [Pre-emphasis] button. 

 

•  The pre-cursor is the ratio of Vd to Vc: 

    Pre-cursor = 20 Log10 (Vd/Vc) 

•  Post 1 cursor is the ratio of Vb to Va: 

    Post 1 cursor = 20 Log10 (Vb/Va) 

•  Post 2 cursor is the ratio of Vc and Vb. 

    Post 2 cursor = 20 Log10 (Vc/Vb) 

Note: When pre-emphasis is on, the sum of the absolute values of the pre-emphasized FIR filters is normalized. 

 

Fig. 3.26 Pre-emphasis settings dialog 
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3.5.4 Equilibrium 

a) In order to perform equilibrium, click the [Equilibrium] button and check [Enable]. 

b) When pre-emphasis is on, a check mark will appear on the [Equilibrium] button. 

 

Fig. 3.27 Equilibrium settings dialog 

The user can choose to use the Equilibrium by specifying either the variable or the equation file. 

In order to generate the filter, four variables must be specified in this equation. 

These variables are: 

• DC gain 

• Zero frequency 

• Polarity 1 frequency 

• Polarity 2 frequency 
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Attachment 4 Automatic Fixture Removal 

The Chapter provides the following contents:  

 Overview……………………………………………………………………………………375 

 Principles of automatic fixture removal…………………………………………………376 

 Operation processes of automatic fixture removal……………………………………378 

 Results of automatic fixture removal……………………………………………………385 

4.1 Overview 

The measurement area of vector network analyzers is mainly focused on component S-parameters, especially for 

devices with standard coaxial connectors and waveguide connectors. With the increasing demand for testing, 

vector network analyzers are involved in measuring on non-standard connector devices, such as packaged 

microwave devices and on-chip devices. The most significant feature of these devices is that they cannot be 

directly connected to a vector network analyzer. Therefore, it is necessary to use a test fixture (or adapter) to 

connect the DUT to the instrument port. 

      

Figure 4.1 Non-standard connector devices 

The test fixture is ideal to solve the connecting problem between the vector network analyzer and the DUT. 

However, as the test requirements increase, the influence of fixtures must be removed. Previously, the most 

effective means of eliminating the effects of fixtures was TRL calibration. However, TRL calibration parts need to 

be customized individually, and the calibration process is tedious and requirement for operators is relatively high. 

Moreover, TRL calibration cannot eliminate errors such as near-end crosstalk and far-end crosstalk caused by 

differential fixtures. 

 

Figure 4.2 Multiple types of adapters 

     

Figure 4.3 Test fixture for connectors (Type-C on the left, QSFP+ on the right) 
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Figure 4.4 Universal microstrip test fixture and chip test fixture 

Using the automatic fixture removal function of the vector network analyzer, parameter extraction and storage of 

fixtures and de-embedding of fixtures can be performed to obtain the real parameters of the DUT. This function 

has the advantage of easy operation and high accuracy compared to TRL calibration, and it can eliminate both 

near-end crosstalk and far-end crosstalk of differential fixtures. The automatic fixture removal function is also 

suitable for cases where one end of the fixture is open. 

4.2 Principle of automatic fixture removal 

Automatic fixture removal is divided into two processes: fixture parameter extraction and multi-port fixture 

de-embedding. 

4.2.1 Fixture parameter extraction method 

 

Figure 4.5  Diagram of single end fixture 

Test fixtures are usually presented in the form of straight-through or left and right side fixtures, as shown in Figure 

4.5. And test fixtures and straight-through standards are usually made of the same material. The straight-through 

criteria can be described by a signal flow diagram: 
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Figure 4.6  Straight-through standard signal flow diagram 

 

Figure 4.7  Time domain transformation of reflection and transmission parameters 

By performing time domain transformation of the transmission and reflection parameters and time domain gate 

interception, as shown in Figure 4.7, the 
11AS

 and 
11BS

 are therefore obtained for the fixture. Figure 4.8 

Gives the comparison curves of the fixture 
11AS

 and original 11S . 

 

Figure 4.8  Comparison between the 
11AS

 (blue) and 11S  (red). 

4.2.2 Multi-port fixture de-embedding method 

The fixture de-embedding feature is able to remove the network between the measurement end and the DUT end 

defined by .snp data file, thus extending the calibration surface from the coaxial port to the DUT measurement 

surface. 

  

Refl
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Tran

slat



Annexes 

Attachment 4 Automatic Fixture Removal 

378  

 

 

Figure 4.9  Fixture de-embedding example diagram 

The de-embedding of the multi-port fixture can be described by a signal flow diagram, as shown in Figure 4.10. 

The left side of the DUT is connected to a four-port network and the right side to a two-port network. The network 

instrument measures the overall S-parameter [TS], while the operator wants to get the real parameter [S] of the 

DUT after de-embedding. 

 

Figure 4.10 Schematic diagram of the de-embedding of the DUT 

The incident and reflected waves of the network instrument and the DUT are represented in matrix form and 

transformed into: 

  1 1[ ( ) ]S C TS A B D   
                    

4.3 Automatic fixture removal operation procedure 

4.3.1 Reset instrument 

4.3.2 Setting of sweeping parameters 
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Fixture parameter extraction and de-embedding can be understood as two different processes. Because the 

de-embedding is for the actual DUT, its sweeping parameters can be set according to the actual test. The fixture 

parameter extraction is related to the fixture characteristics rather than the characteristics of the DUT. In 

order to obtain the fixture parameters more accurately, the sweeping parameters need to be set separately for the 

fixture characteristics. 

 

Set the frequency, power, IF bandwidth, sweep points according to the characteristics of the fixture. 

1) Set the frequency and the number of sweeping points. 

  

Figure 4.11 Frequency setting interface 

Click [Excitation] → [Frequency] → [Start/End...] in the menu to set the instrument start and end frequencies 

in the frequency setting dialog, and set the number of sweeping points at the same time. 

 

 

Set the frequency span as wide as possible 

This is because the automatic fixture removal function is based on parameter extraction in the time domain. In the 

time domain transformation process, the wider the measured frequency, the better the calculation effect, so try to 

set the frequency span as wide as possible. 

For example, extracting the parameters of SMA-SMP connectors, it is possible to set the termination frequency to 

26.5 GHz, although such connectors cannot operate to such a high frequency. 

 

 

Sweeping points are as much as appropriate 

1. Since the automatic fixture removal function is based on time domain parameter extraction. In the time domain 

transformation process, the more points measured, the better the calculation effect, so try to set as many sweeping 

points as possible. 

2. Since the extracted fixture is used for the de-embedding calculation, and the de-embedding calculation is not 

necessarily the same as the frequency setting of this extraction, try to set the number of sweeping points as much 

as possible. 

 

Note 

Note 

Note 
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Since the increase in the number of sweep points affects the test speed, it is recommended to ensure that there is a 

sweep point within the 30MHz sweep interval. For the 24.5GHz frequency span, you can set 1000 points. 

 

2) Set the power. 

Click [Excitation] → [Power] → [Power...] in the menu to set the instrument output power in the power setting 

dialog. Usually the power is set to default after instrument reset 

    

Figure 4.12 Power setting interface 

3) Set the IF bandwidth. 

Click [Response] → [Average] → [IF Bandwidth...] in the menu to set the IF bandwidth of the instrument in the 

IF bandwidth setting dialog. Usually set to 1 kHz or less to improve the accuracy of the measurement. 

      

Figure 4.13 IF bandwidth setting interface 

4.3.3 Setting the frequency to low-pass 

As mentioned before the fixture parameter extraction is based on time domain calculation. The resolution of the 

measured response is different in the low-pass and band-pass conversion modes. For the same frequency span and 

number of sweep points, it has higher resolution in low-pass mode, and the pulse width can be reduced by half 

compared to the band-pass mode. Following figure compares the resolutions in the two modes: 
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Figure 4.14 The effect of the transformation mode on the resolution 

   

Figure 4.15  Set frequency low-pass interface 

Click on the menu [Analysis] → [Time Domain Transformation...]. Click [Set Swept Frequency...] in the Time 

Domain Transformation dialog box to set the instrument. The instrument will automatically set the frequency 

interval to low-pass according to the current setting. 

4.3.4 Fixture parameter extraction 

1) Calibrate the vector network analyzer. 

2) Go to the Automatic Fixture Removal screen. 

Path of Menu: [Calibration] → [Automatic Fixture Removal...] to display the Auto Fixture Removal Wizard 

dialog. 
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Figure 4.16  Access to the automatic fixture removal function 

3) Perform the description of the fixture. 

Select the fixture type and number of fixture ports in the fixture description screen. 

For the adapter shown in Figure 4.2, set the fixture port type to single-end and the total number of fixture ports to 

1, and click [Next]. 

For the differential connector shown in Figure 4.3, set the fixture port type to equilibrium and the total number of 

fixture ports to 4, and click [Next]. 

 

Figure 4.17  Fixture description screen 

4) Perform standard descriptions. 

 

Figure 4.18 Standard description interface 
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The relationship between standards and fixtures 

In most cases the fixture can also be used as standard. In this case, the fixture standard is usually open circuit, i.e., 

the fixture is not connected to the DUT and one end is suspended. 

In order to obtain the parameters of the fixture more precisely, the corresponding standard can be designed while 

constructing the fixture. This case is particularly applicable to the fixture of the circuit board, because the fixture 

of the circuit board can be easily designed to pass through the line standard during the production process, as 

shown in Figure 4.3 and Figure 4.5. 

 

Performing the extraction of fixture parameters requires the measurement of fixture standards. In the standard 

description screen, the fixture standard contains three types: straight-through standard, open-circuit standard, and 

short-circuit standard. Where the straight-through standard is the straight-through standard shown in Figure 4.5, 

and its length is the sum of the left and right side fixture. When the left and right side clamps are connected to 

open or short circuit, it can constitute an open standard or short circuit standard. 

Complete the settings of the standard description and click [Next] to enter the standard data acquisition interface. 

5) Perform standard data acquisition. 

In the standard data acquisition screen, there are two ways for standard data acquisition, i.e. [Load...] and 

[Measure...]. After completing data acquisition for all fixture criteria, click [Next] to enter the fixture 

de-embedding interface. 

 

Figure 4.19  Standard data acquisition interface 

6) Perform the de-embedding of the fixture. 

Connect the fixture and the DUTs to the network instrument port and configure the number of [Network 

Instrument Port]. Check [Fixture De-embedding ON/OFF] to finish de-embedding the current fixture. Click 

[Next] to enter the fixture data saving screen. 

Note 
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Figure 4.20  Fixture de-embedding interface 

7) Perform data saving of the fixture. 

Change the location of the saved file by clicking [Browse...], and edit the basic name in the [Basic File Name] 

edit box. Click [Save Fixture File] to save the fixture data. The fixture parameters are saved as .snp file. Click 

[Finish] to exit the automatic fixture removal settings. 

4.3.5 Fixture de-embedding 

The de-embedding of the fixture parameters can be achieved directly except for step 6) of the 4.3.4 procedure. 

Usually, the first step is to extract the fixture parameters (.snp file) through the automatic fixture removal function; 

the second step is to use the fixture simulation function to perform the fixture de-embedding operation during the 

subsequent testing of the DUT. 

1) Enable the fixture simulation function. 

Click [Calibration] → [Fixture] → [Fixture Enable ON/Off] to enable the fixture emulation function. 

 

Figure 4.21  Fixture simulation menu 

2) Set de-embedding of the fixture. 

For single-end fixture, click [Calibration] → [Fixture] → [Dual Port Fixture De-embedding...] to enter the 

Dual Port Fixture De-Embedding dialog, as shown in Figure 4.22. According to the connection method between 
fixture and vector network analyzer, set the port and snp file of de-embedding fixture, and then enable the 

[Fixture De-embedding ON/OFF] checkbox. 
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Figure 4.22  Dual port fixture de-embedding interface 

For differential fixture, click [Calibration] → [Fixture] → [Four-Port Fixture De-Embedding/Embedding...] 

to enter the four-port fixture de-embedding dialog box, as shown in 错误!未找到引用源。. Set the port, 

de-embedding type, snp file of the de-embedding fixture according to the connection method of the fixture and 

vector network analyzer, and then enable the [Enable ON/OFF] checkbox. 

4.4 Automatic fixture removal results 

In this manual, the differential fixture is validated and tested.Figure 4.23 And Figure 4.24 6 are the raw parameters 

of the tested differential fixture and the straight-through of the fixture (after coaxial port calibration), respectively. 

 

Figure 4.23  Differential fixture 
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Figure 4.24  Raw parameters for differential fixture straight-through 

Parameter extraction and de-embedding are then performed in two ways using the automatic fixture removal 

function mentioned above. 

1) Then perform single-ended parameter extraction for the differential straight-through as single-ended devices 

without coupling relationship. Then perform differential straight-through and de-embedding of the dual ports. This 

process the same lines as calibration using homemade TRL calibrators. The test results are as shown in Figure 

4.25, the transmission parameters are well removed, but the near-end crosstalk and far-end crosstalk in the 

differential pairs are not removed. 

 

Figure 4.25  Results of single-ended parameter extraction and double-port de-embedding 

2) Equilibrium parameters are extracted by taking the DUT as a whole and performing de-embedding of the 

four ports. The test results are shown in Figure 4.26, and the transmission parameters are well removed, so as to 

remove the near-end crosstalk and far-end crosstalk. 
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Figure 4.26  Results of equilibrium parameter extraction and four-port de-embedding 


